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Safety Instructions

Be sure to read these instructions in order to operate the product safely. Follow these instructions to prevent
injury or harm to the operator of the product or others.

A\ WARNING

Denotes the risk of serious injury or death.

e Stop using the product in any case of unusual circumstances such as the presence of smoke or a strange
smell.

¢ Do not touch any exposed internal parts.

e Do not get the product wet. Do not insert foreign objects or liquids into the product.

¢ Do not touch the product connected to a power outlet during lightning storms. This may cause electric shock.

¢ Do not disassemble or modify the product.

* Do not expose the product to strong shocks or vibration.

e Use only power sources specified in this instruction manual for use with the product.

¢ Observe the following instructions when using a battery charger or AC adapter.

- Do not touch the battery charger or AC adapter connected to a power outlet during lightning storms.

- Do not use the product if the power plug is not fully inserted into the power outlet.

- Do not unplug the product by pulling the power cord.

- Do not plug in or unplug the product with wet hands.

- Do not place heavy objects on the power cord. Do not damage, break or modify the power cord.

- Do not leave the product connected to a power source for long periods of time.

- Do not expose the power plug and terminals to dirt or let them come into contact with metallic pins or other
metal objects.

- Do not charge batteries/battery packs at temperatures outside the range of O - 40 °C (32 - 104 °F).

e Observe the following instructions when using commercially available batteries or provided battery packs.

- Do not use leaking batteries/battery packs.
If a battery/battery pack leaks and the material contacts your skin or clothing, flush the exposed area
thoroughly with running water. In case of eye contact, flush thoroughly with copious amounts of clean
running water and seek immediate medical assistance.

- Use batteries/battery packs only with their specified product.

- Do not heat batteries/battery packs or expose them to fire.

- Do not charge batteries/battery packs using non-authorized battery chargers.

- Do not expose the terminals to dirt or let them come into contact with metallic pins or other metal objects.

- Keep batteries out of the reach of children.

- When disposing of batteries/battery packs, insulate the terminals with tape or other means.

¢ Do not shoot the sun directly or point a lens or a camera/camcorder with a lens attached at the sun. Even
when the sun does not appear on the screen or is behind the subject, the lens may concentrate the sunlight
and cause a malfunction or fire.

¢ Do not leave a lens or a camera/camcorder with a lens attached, exposed without the lens cap attached. The
lens may concentrate the light and cause fire.

e Do not leave the lens exposed without the lens cap attached.

e Do not wrap the product in cloth or other materials when in use or shortly after use when the product is still
warm in temperature.

e Do not allow the product to maintain contact with the same area of skin for extended periods of time during
use. This may result in low-temperature contact burns, including skin redness and blistering, even if the
product does not feel hot. The use of a tripod or similar equipment is recommended when using the product in
hot places and for people with circulation problems or less sensitive skin.

e Keep the product out of the reach of young children.

e A strap wrapped around a person’s neck may result in strangulation.

e Periodically remove any dust buildup from the power plug and power outlet using a dry cloth.

e Follow any indications to turn off the product in places where its use is forbidden. Not doing so may cause
other equipment to malfunction due to the effect of electromagnetic waves and even result in accidents.

¢ Before installing, be sure the surface is capable of supporting the total weight of the camera and connected
devices, and sufficiently reinforce the surface if necessary.




A\ cauTions
Follow the cautions below. Otherwise physical injury or property damage may result.

e Strap is intended for use on the body only. Hanging the strap with any product attached on a hook or other
object may damage the product. Also, do not shake the product or expose the product to strong impacts.
This may cause injury or damage to the product.

¢ Do not leave the product in places exposed to extremely high or low temperatures. The product may become
extremely hot/cold and cause burns or injury when touched.

¢ Only mount the product on a tripod that is sufficiently sturdy.

¢ Do not look at the screen for prolonged periods of time. This may induce symptoms similar to motion
sickness. In such a case, stop using the product immediately and rest for a while before resuming use.

-India only-

This product is not to be disposed of with your household waste. This product should be handed over to
a designated collection point. For more information regarding return and recycling of WEEE products,
please visit https://in.canon/en/consumer/web/e-waste or write to us at cipl.ewaste@canon.co.in

Also, this product including its components, consumables, parts and spares complies with the “E-Waste
(Management) Rules, 2022” and prohibits use of lead, mercury, hexavalent chromium, polybrominated
biphenyls or polybrominated diphenyl ethers in concentrations exceeding 0.1 % by weight and 0.01 %
by weight for Cadmium, except for the exemptions set in Schedule Il of the Rules.

Only for European Union and EEA (Norway, Iceland and Liechtenstein) and United Kingdom
These symbols indicate that this product is not to be disposed of with your household
Ei E waste, according to the WEEE Directive (2012/19/EU), the Battery Regulation ((EU) 2023/
1542) and/or national legislation implementing those Directive and Regulation and the UK
Waste Electrical and Electronic Equipment Regulations and the UK Batteries and
Accumulators Regulations.
If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery
Regulation and the UK Batteries and Accumulators Regulations, this indicates that a heavy metal (Hg =
Mercury, Cd = Cadmium, Pb = Lead) is present in this battery or accumulator at a concentration above
an applicable threshold specified in the Battery Regulation and the UK Batteries and Accumulators
Regulations.
This product should be handed over to a designated collection point, e.g., on an authorized one-for-one
basis when you buy a new similar product or to an authorized collection site for recycling waste electrical
and electronic equipment (EEE) and batteries and accumulators. Improper handling of this type of waste
could have a possible impact on the environment and human health due to potentially hazardous
substances that are generally associated with EEE. Your cooperation in the correct disposal of this
product will contribute to the effective usage of natural resources.
For more information about the recycling of this product, please contact your local city office, waste
authority, approved scheme or your household waste disposal service or visit
WwWw.canon-europe.com/sustainability/approach/.
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Introduction

About this Manual

Thank you for purchasing the Canon EOS C400. Please read this manual carefully before you use the camera
and retain it for future reference. Should the camera fail to operate correctly, refer to 7roubleshooting (11 248).

Conventions Used in this Manual

* @ MPORTANT: Precautions related to the camera’s operation.
* (1)NOTES: Additional topics that complement the basic operating procedures.
¢ [11]: Reference page number.
¢ The following terms are used in this manual.
- “Screen” refers to the LCD screen on the supplied LCD monitor.
- “LCD monitor” refers to the supplied LCD Monitor.
- “LCD attachment unit” refers to the supplied LCD Attachment Unit.
- “Camera grip” refers to the supplied Camera Grip.
- “Battery pack” refers to a Canon BP-A30N Battery Pack (optional) or BP-A60N Battery Pack (supplied).
- “AC adapter” refers to a commercially available power adapter.
- “SD card” refers to an SD, SDHC or SDXC memory card.
- “Recording media” or “card” alone, not specified: refers collectively to CFexpress cards and SD cards.
- “CAMERA mode”: operating mode for making recordings (shooting mode).
“MEDIA mode”: operating mode for playing back and managing recordings (playback mode).

- “Access indicator”: when not specified, refers collectively to the SD CARD and CFexpress access
indicators.

- “RAW’ refers to the data recorded using Cinema RAW Light.
- “Multi-Camera Control” refers to Canon Multi-Camera Control.
e Photographs in the manual are for illustration purposes only.

e Some screenshots have been altered to make them easier to read. Furthermore, screenshots used are from a
product in development and may differ slightly from the actual screens due to product enhancement.



Supplied Accessories

Supplied Accessories

The following accessories are supplied with the camera.

10

LCD Monitor LCD Attachment Unit Handle Unit
(for use only with the C400)

Microphone Holder BP-A60N Battery Pack CG-A20 Battery Charger CA-CP300 B Compact Power Adapter
(incl. M4 fixation bolts, x2) (incl. terminal cover) (for the CG-A20; incl. power cord)
C=> = 9%
Body Cap* MC-5U Monitor Cable Hex wrench (x1, for 1/4" bolts) Tape Measure Hook*
Quick Guide

* Comes pre-attached to the camera.



Supplied Accessories

Before Using the Camera

e Before making important recordings for the first time, make test recordings using the video configuration(s) you
plan to use to check that the camera operates correctly. Should it fail to operate correctly, refer to
Troubleshooting (11 248).

¢ Copyright notice: Unauthorized recording of copyrighted materials may infringe on the rights of copyright
owners and be contrary to copyright laws.

¢ Notes on privacy and publicity rights regarding the use of video: \When using the camera, exercise proper caution
in order to protect privacy and avoid any violation of publicity rights.

¢ About the LCD screen: The screen is produced using extremely high-precision manufacturing techniques, with
more than 99.99% of the pixels operating to specification. Very rarely, pixels may misfire or light up
permanently. This has no effect on the recorded image and does not constitute a malfunction.

@ rorTANT

e CFexpress cards can become hot due to the high operating temperature inside the camera. Removing a
CFexpress card immediately after using it for recording may cause burns or cause you to drop the card,
resulting in damage to the card.

¢ Observe the following precautions while an access indicator ([1] 44) is illuminated or flashing in red. Failing to
do so may result in permanent data loss.
- Do not turn off the camera and do not remove the battery or other power source.
- Do not open the card compartment cover.

11



Names of Parts

Names of Parts

Camera
12 Refer to Assignable Buttons (11 133) for details about the camera’s assignable buttons.
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Canon 12
EOS C400 ﬂ
[ ) 13
=
14
D
&0
1 MEDIA button (1] 149) 8 SELECT dial/SET button ([I1 40)
Toggles the camera between CAMERA mode and 9 switch
MEDIA mode. @ Key lock.
2 Tape measure hook and ¢ focal plane mark CAMERA: Starts the camera in CAMERA mode.
e Used to measure the distance from the imaging OFF: Turns off the camera.
surface. 10 Power indicator/Rear tally lamp (1] 53)
3 MAGN. (magnification) button (] 90)/ 11 Air intake vent ([11 51)
Assignable button Camera 1 12 ISO/GAIN button ([11 76)/
4 PEAKING button (3] 90)/ Assignable button Camera 5
Assignable button Camera 2 13 SHUTTER (shutter speed mode) button ([11 74)/
5 ND FILTER +/- buttons ([1] 80) Assignable button Camera 6
6 WFM (video scope) button ([11 120)/ 14 S&F FPS (slow & fast shooting frame rate) button
Assignable button Camera 3 (13 126)/Assignable button Camera 7

7 S&F (slow & fast motion recording) button
([T 126)/Assignable button Camera 4

Locking the camera’s controls (key lock)

You can set the switch to i@ (key lock) to lock all the camera’s buttons and switches. This is useful in
preventing settings from being changed due to inadvertently pressing one of the buttons. Set the
switch back to CAMERA to reactivate the controls.

When the camera’s controls are locked, you can still operate the camera using an optional RC-V100 Remote

Controller or the Browser Remote application.
* In CAMERA mode, REC buttons are not locked by default but you can choose to lock them too ([T 225).



Names of Parts
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1 Audio level dials for CH1 (top) and CH2 (bottom) 11 REC (start/stop recording) button (1] 53)

(M 116) 12 WB (white balance) button ([ 85)/
2 Audio level switches for CH1 (top) and CH2 Assignable button Camera 9

(oottom) (11 116) »/ 11 (play/pause) button (1] 151)
3 Cover for audio controls 13 % (white balance adjustment) button ([ 85)/
4 Card compartment cover ([1] 44) Assignable button Camera 10/
5 CFexpress card release button ([ 44) INDEX button (11 150)/
6 SD card slot ([1] 44) H (stop) button (11 151)
7 CFexpress card slot ([I1 44) 14 AUDIO STATUS (display the [d) Audio Setup]
8 CFexpress card access indicator ([11 44) status screens) button/Assignable button Camera
9 SD card access indicator ([1] 44) 8 (11 133)
10 Control dial (11 79, 82) 15 & (illumination) button
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Names of Parts

EXHAUST VENT

INPUT 1 i wic
LINES | = +48V

|

| o
e
=] o0
=5
6

1 INPUT 1 (top) / INPUT 2 (bottom) switches
(T 114)

2 Ethernet terminal

3 Exhaust ventilation outlet ([J] 51)

-
=

Camera grip attachment thread/Rosette ([1] 34)
Compliant with ARRI rosettes.

GRIP (camera grip connection) terminal (1] 34)
Air intake vent (11 51)



~NOoO o WN =

VIDEQ terminal lock cover
VIDEO terminal ([11 30)

Front tally lamp ([11 53)
Monaural microphone ([11 115)
RF lens mount index (1] 35)
Lens release button ([] 35)
Lens lock pin

8 LENS terminal

9 Assignable button Camera 12

10 RF lens contacts ([1] 35)

11 AF LOCK button /
Assignable button Camera 13

Names of Parts



Names of Parts

6 MON..
UsB @ 12
== .. 7 ) oo
1 —%5 UHH UHH USB | fspi out 3 2 @ 13
2 m @ C\r @ N | 0 INPUT 1
i DHH UHH ! INPUT 1 MIC @ 2 14
ﬂ CANCEL @L 8 | 9 @ Z
3
q Q HHH Bgaga HLH)H = 1 INPUT 2
| U U U » % 15
E::  — )  S— ) @ 10 DS
D D gi GLOCK/SYNC/RET -TC l E% @ @ 17
= 73 [ L
0 [@ B2 | GLOCK/SYNCRET LTC
— j— — : ‘ ‘| ‘| ——U - o
e ° 18
— o
DCIN
12v
-—
19 20 21
1 FUNC (main functions) button ([ 64)/ 13 SDI OUT terminal (] 167)
Assignable button Camera 11 ([J1 133) 14 INPUT 1 terminal (31 114)
2 Joystick (11 40) 15 INPUT 2 terminal (1] 114)
3 CANCEL button ([17 40) 16 G-LOCK/SYNGC/RET terminal
4 MENU button (11 40, 133) 17 TIME CODE terminal (11 108, 109)
5 Card compartment cover switch 18 DC IN 12V terminal ([11 27)
6 Screw holes for M4 bolts (7.5 mm (0.30 in.) deep, 19 REMOTE terminal (1] 132)
x4) For connecting the optional RC-V100 Remote
7 USB terminal Controller or commercially available remote
8 () (headphone) terminal (1] 118) controllers.
9 MIC (microphone) terminal ([J] 114) 20 Battery compartment ([I] 26)
10 HDMI OUT terminal (11 167, 168) 21 Speaker

11 BATTERY RELEASE button (11 27)
12 MON. terminal (1] 167, 168)

Removing and attaching the terminal covers

You can remove the covers of the camera’s terminals. To remove a terminal’s cover, open the cover and gently
pull it straight out. To attach back the terminal cover, insert the connecting strip into the opening.

If screwed in, use a commercially available Phillips head (“crosshead”) screwdriver to remove the screws that
secure the terminal covers.

(i) NoTes

e |f the connecting strip is difficult to grasp, use a pair of tweezers or similar tool.



Names of Parts
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1 Accessory mount with socket for 1/4"-20 6 Multi-function shoe
mounting screws (6.9 mm (0.27 in.) deep) (1130) 7 Shoe cover
2 Screw holes for 1/4"-20 mounting screws 8 Screw hole for 3/8"-16 mounting screws (7.8 mm
(9 mm (0.35 in.) deep, x6) (0.31in.) deep)
3 Screw hole for 1/4"-20 mounting screws (7.6 mm 9 Screw holes for tripod reinforcements and
(0.30in.) deep) accessories with 1/4"-20 mounting screws
4 Sockets for tripod’s anti-rotation pin (5.6 mm (7.6 mm (0.30 in.) deep, x2)

(0.22in.) deep)

5 Strap mounts
Pass the ends of the optional SS-1200 Shoulder
Strap through the strap mounts and adjust the
length of the strap.

@ vrorTANT

¢ Do not use tripods and other accessories with mounting screws exceeding the depth of the screw holes on
the camera as this may damage the camera.

¢ Mounting the camera on a tripod using only one of the 1/4"-20 screw holes for tripod reinforcement may
damage the camera.

17
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Names of Parts

LCD Monitor

I -

(@]

LCD panel with touch screen ([] 30, 33)
FUNC (main functions) button ([1] 64)/
Assignable button LCD 1 (1] 133)

MENU button ([11 40, 133)

Joystick (1 40)

MIRROR (invert the displayed image) button
(33)

CANCEL button ([1] 40)

DISP (display) button ([11 55, 59)/
Assignable button LCD 2 ([1] 133)

8 VIDEO terminal lock cover

9 LCD monitor’s position alignment mark A (11 30)
10 Screw hole for 1/4"-20 mounting screws
(11.2 mm (0.44 in.) deep)
11 VIDEO terminal ([1] 30)
12 Screw hole for 1/4"-20 mounting screws
(11.2 mm (0.44 in.) deep)



LCD Attachment Unit ([] 30)

Mounting hole

Lock lever (left/right)
Lock lever (front/back)
Sliding rail

LCD monitor mount

o~ wN =

— O 0o ~NO®

LCD monitor fixation bolt
Position alignment mark
Pivot B
Pivot A

0 Sliding rod

Names of Parts

10
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Names of Parts

Handle Unit ([1] 30)

—

Multi-function shoe

2 Shoe cover

3 Screw holes for 1/4"-20 mounting screws
(6 mm (0.24 in.) deep, x2)

4 Accessory mount

Microphone Holder (1] 34, 114)

1 Microphone lock screw
2 Microphone holder
3 Microphone cable clamp

0 N O O

LCD attachment mounting hole
Cable clamp

Fixation bolts

Locking knob




Camera Grip ([11] 34)

At the time of purchase, the camera grip is pre-attached to the camera.

M ON =

Grip control dial (1] 79, 82)

REC (start/stop recording) button ([I] 53)
Assignable button Grip 3

Grip belt

Adjust the grip belt so that you can reach the REC
button on the camera grip with your index finger
but still have a comfortable but secure grip.

Names of Parts

0 N O O,

9

Assignable button Grip 2 ([ 133)
Joystick ([1] 40)

Assignable button Grip 1 ([1] 133)
Rosette

Compliant with ARRI rosettes.
Mount screw

10 Grip connection cable
11 Connection plug

21
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4K and Higher Resolutions: Workflow Overview

4K and Higher Resolutions: Workflow Overview

The following illustrates the typical workflow for 6K/4K recording with the camera.

————— Recording ] Post-production
4K recordin -quali
SDI OUT / (2] g Fu||d2?:my
HDMI OUT
. External
terminal
recorder . )
output Primary clips
@ 6K/4.3K recording (RAW), | [3EaG |
4K recording (XF-AVC / " | XF-AVCS '
XF-AVC S / XF-HEVC S) ' XF-QETVC S \
. ata '
L
CFexpress o Full-quality o
card Cinema data
RAW Color
Development grading

@ Shooting g o< recording (XF-AVC /
XF-AVC S / XF-HEVC S)

SD card NLE software

© Shoot in 6K/4K mode ([I] 65).

© You can record 6K/4.3K RAW or 4K YCbCr 4:2:2 data on a CFexpress card in the camera, or record
4K data using an external recorder connected to the camera’s SDI OUT or HDMI OUT terminal
(M 167).
e Clips other than 6K/4K RAW need no further processing and can be color graded directly (step @).

© While recording 6K/4.3K/4K primary clips, you can simultaneously record 2K proxy clips on an SD
card.
¢ The file names of 2K proxy clips (XF-AVC / XF-AVC S / XF-HEVC S) and 6K/4.3K/4K clips are linked and

identical for the most part ([J1 49).

@ After recording, develop the 6K/4.3K RAW clips using the Cinema RAW Development software
(M 177) to generate full-quality data.
® You can also generate proxy data.

© You can use the 2K proxy clips recorded on the SD card or proxy files generated by Cinema RAW
Development on NLE software to edit the video offline and create an EDL.

@ Perform color grading based on the full-quality data.



4K and Higher Resolutions: Workflow Overview

Color Grading with the ACES Workflow

You can perform color grading using ACES, the color encoding system defined by the Academy of Motion
Picture Arts and Sciences. This workflow allows you to perform on-set color grading* while continuing to shoot.
* Requires monitors compatible with ASC-CDL and 3D LUT color correction.

23

Post-production

RAW Input
> Developmen Transform =>
CFexprgss Cinema RAW
card RAW > Development Color grading
SD card data Input OpentxR| | ACESce/ACESCe)
— Transform ben
(ACES)
SDI OUT / X)éFAC\éCS —
MON. / A npu
XF-HEVC S > >
HDMI OUT data Transform ASC-
; a 1
terminal output L — CDL ‘
CanonlLog 2 /3 Outout
Cinema Gamut utpu
Transform
| |
ACESproxy
Output
Inverse log ASC-CDL Transform
On-set Color Grading

1 Color grading equipment that supports ASC-CDL is required.
2 Only CFexpress cards can be used for RAW data.
ACESproxy: ACESproxy video data that is output from the camera’s output terminals when performing

on-set color grading. Select the [ACESproxy] option for the LUT setting, depending on where
the video is to be output (11 171).

Color spaces: 129 e BT.709
ST2065-1: APOQ primaries, linear floating-point encoding. IS BT.2020
ACEScc: AP1 primaries, log floating-point encoding. 1 PN T ﬁg‘:ma Gamut
ACEScct: AP1 primaries, log floating-point encoding. Differs 08 '

from ACEScc by adding a ‘toe’ to the encoding,
with a behavior resembling that of the Cineon 0.6
curve. >
Input Transform:  Refers to the table used for converting color 041
information of the input device to ST2065-1 color 024
space. It can be downloaded from Canon’s
website. 04
Output Transform: Refers to the table used for mapping ST2065-1 0
color space information to the specific color 02 0 02 04 06 08 1
information scheme used by the display device. X

ASC-CDL: Refers to the list that contains color grading
adjustment data. This step requires equipment compatible with ASC-CDL.
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Preparations

Preparing the Power Supply

You can power the camera using a battery pack or the DC IN 12V terminal. Even when a battery pack is
attached, if a power source is connected to the DC IN 12V terminal, the camera will not draw power from the
battery pack.

Using a Battery Pack

You can power the camera using the supplied BP-ABON Battery Pack or the optional BP-A30N Battery Pack.
Both battery packs are compatible with Intelligent System so you can check the approximate remaining battery
usage time (in minutes) on the screen. For more accurate readings, when using a battery for the first time, charge
it fully and then use the camera until [Change the battery pack] appears on the screen.

Compact power adapter

Charging the Battery Pack

Charge battery packs using the supplied CG-A20 Battery
Charger and CA-CP300 B Compact Power Adapter. Before
charging, remove the terminal cover of the battery pack.

1 Connect the compact power adapter to the battery charger
and plug the power cord into a power outlet.
2 Attach the battery pack to the battery charger.

e Press lightly and slide the battery pack in the direction of the
arrow until it clicks.

* The CHARGE indicator starts flashing and also indicates the
battery pack’s approximate charge. The indicator will stay on ~ CHARGE
when charging has completed. indicato

;

—J=
=
e

¥ ¥ approx. 0% to 49%: Flashes once every 2 seconds
K ¥k approx. 50% to 74%: Flashes twice every 2 seconds
KKKk approx. 75% to 99%: Flashes 3 times every 2 seconds

Battery Charger

3 Disconnect the compact power adapter from the battery charger and unplug the power cord.
4 Remove the battery pack from the battery charger.

@ vrorTANT

e Do not connect to the battery charger any product that is not expressly recommended for use with this
camera.

¢ \When using the battery charger or compact power adapter, do not fix it permanently to one place as this may
cause a malfunction.

e Even within the operating temperature range of the included CG-A20 Battery Charger or the optional CG-A10
Battery Charger, charging may not be possible depending on the internal temperature of the battery.
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Preparing the Power Supply

¢ To prevent equipment breakdowns and excessive heating, do not connect the supplied battery charger or

compact power adapter to voltage converters for overseas travels or special power sources such as those on
aircraft and ships, DC-AC inverters, etc.

(i) notes

Attaching the Battery Pack

1

2 Insert the battery pack all the way into the compartment

We recommend charging the battery pack in temperatures between 10 °C and 30 °C (50 °F and 86 °F).
Outside the temperature range of 0 °C to 40 °C (32 °F to 104 °F), charging will not start.

If there is a malfunction with the battery charger, compact power adapter or battery pack, the charge indicator
will go out and charging will stop.

For handling precautions regarding the battery pack, refer to Safety Instructions (11 2), Battery Pack

([ 262).

For approximate charging times and usage times with a fully charged battery pack, refer to the Reference
Tables (11 274).

Charged battery packs continue to discharge naturally. Therefore, charge them on the day of use, or the day
before, to ensure a full charge.

We recommend that you prepare battery packs to last 2 to 3 times longer than you think you might need.
Repeatedly charging and completely depleting a battery pack will eventually shorten its battery life. You can
check the battery life on the [ System Setup] status screen (I 227). Fully charging the battery pack and
then depleting it until [Change the battery pack] appears on the screen will give you a more accurate reading.

Turn off the camera.

as shown in the illustration and press it gently toward the
left until it clicks.




Preparing the Power Supply

Removing the Battery Pack

1 Turn off the camera.

2 Holding down the BATTERY RELEASE button (D), slide
the battery pack toward the right and then pull it out ().

@ ENVEREL]
AY3L1VE

Checking the Remaining Battery Charge

You can check the approximate charge level on the battery pack itself. The remaining battery charge level
displayed on the recording/playback screen may not match the level shown on the status screen or the
indicators on the battery pack. When the camera is turned on, you can check the approximate remaining battery
usage time (in minutes) by looking at any recording/playback screen or the [§ System Setup] status screen

(@ 227).
Press the CHECK button on the battery pack. An

indicator will light for approximately 3 seconds and show i
the approximate remaining battery charge. 0 ®® e e100%

0-25%

o 26-50%
51-75% Battery charge CHECK button
76-100% indicator

Using the DC IN 12V Terminal

When selecting commercially available AC adapters, make sure the external power source meets the following
specifications and all the safety standards of the country/region where it is used. Closely follow the
manufacturer’s instructions regarding the use and maintenance of AC adapters.

For information about the camera’s power consumption, refer to Specifications (11 271).

Power source Specifications

AC adapter

(DC IN 12V terminal) 4-pin XLR plug (female connector), 11.5 Vto 20 V DC, 10 A (acceptable maximum load current)
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Preparing the Power Supply

1 Turn off the camera.

2 Connect the AC adapter’s 4-pin XLR connector to
the camera’s DC IN 12V terminal.

@ vPoRTANT

e Make sure to turn off the camera before connecting or
disconnecting an external power source to/from the
camera’s DC IN 12V terminal.

Checking the Power Supply Levels

You can check the voltage level of an AC adapter on the screen ([I1 58). You can use the MENU > [¥ System
Setup] > [DC IN Warning (V)] setting to set a critical power level for the AC adapter. When the power input to the
camera reaches the predetermined level, the onscreen power indicator will change to red and an error message
will appear.

(i) notes

¢ If the power supplied to the camera is at or below the level set for the power level warning (11 226), the
camera will not start recording. If the power supply’s voltage falls below the level necessary to operate the
camera while recording, recording will stop and the camera will turn off.



Preparing Other Accessories

Preparing Other Accessories

Your camera is incredibly versatile and allows you to build the shooting configuration that best fits your needs
and shooting conditions. In addition to the supplied accessories, Canon offers a variety of optional accessories
that expand the functionality of the camera ([J] 266). For details about accessories compatible with this camera,
please download the Cinema EOS System Expansion User Guide (PDF file), available from your local Canon
website.

How to attach and adjust the LCD monitor and handle was already explained in a previous section ([11 30). This
section will cover other supplied accessories such as the camera grip and microphone holder.

Examples of Camera Configurations

LCD Monitor

0 — [P
é

— =)

LCD Attachment Unit

,3-:-.)’
Microphone holder

Configuration with Configuration with handle, Configuration with handle Light configuration Minimal
LCD monitor LCD attachment unit and and monitor with grip configuration
monitor for hand-held shooting
@ vroRTANT

¢ Be careful not to drop the camera or accessories when attaching, removing or adjusting the various
accessories. Use a table or other stable surface to change the camera’s configuration.

29
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Preparing the Handle Unit and LCD Monitor

Preparing the Handle Unit and LCD Monitor

The LCD screen is necessary to complete the initial setup of the camera, so how to attach the supplied handle
and LCD monitor will be explained in this section.

Attaching the Handle Unit

1 Slide the mounting base at the bottom of the handle
unit into the camera’s top accessory shoe and gently
push it all the way forward (D).

2 Tighten the locking knob ((2)) and fixation bolts ((3®) to
firmly secure the handle in place.

(i) NoTES

¢ The handle unit has 0.64 cm (1/4") sockets, giving you the
option to attach a variety of commercially available
accessories.

If you plan to attach to the handle unit multiple heavy
accessories (optional or commercially available), use the
supplied hex wrench for 0.64 cm, 1/4" screws to tighten the
locking knob and fixation bolts.

Operation is not guaranteed when the optional OC-E4A Off-
Camera Shoe Cord is attached to the multi-function shoe of
the handle unit.

Attaching the LCD Monitor

Using the attachment unit, you can attach the LCD monitor to the handle unit or the camera itself.

Attaching the LCD Monitor to the Handle Unit
1 Turn off the camera.
2 Attach the LCD monitor to the LCD monitor mount.
e Align the A marks on the monitor and monitor mount ().

e Tighten the LCD monitor fixation bolt using the supplied hex
wrench for 0.64 cm, 1/4" screws (2).




3 Attach the LCD attachment unit to the handle unit.
e Insert the sliding rod of the LCD attachment unit
into the LCD attachment mounting hole of the
handle unit (3).
e Tighten the fixation bolt firmly (@).
4 Connect the camera to the LCD monitor’s VIDEO
terminal using the supplied MC-5U Monitor Cable.
e Turn the screw on the VIDEO terminal cover to

open the cover and insert the cable. Close the
cover when firmly inserted and tighten the screw

(®).
5 Put the cable through the handle unit’'s cable clamp
©®).

e |f necessary, adjust the position of the cable so that
it does not get in the picture or obstruct the view.

Preparing the Handle Unit and LCD Monitor
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Preparing the Handle Unit and LCD Monitor

Attaching the LCD Monitor to the Camera

1 Turn off the camera.
e [f the handle unit is attached to the camera, remove it.

2 Turn the screw on the LCD attachment unit to remove
the sliding rail (D).

3 Attach the LCD attachment unit to the camera’s
accessory mount with a screw ((2).

4 Connect the camera to the LCD monitor’s VIDEO
terminal using the supplied MC-5U Monitor Cable.

e Turn the screw on the VIDEO terminal cover to open
the cover and insert the cable. Close the cover when
firmly inserted and tighten the screw (3)).




Preparing the Handle Unit and LCD Monitor

Adjusting the LCD Monitor

The LCD attachment unit can be rotated and moved in a number of ways to match your shooting style. The
following are suggested positions, assuming the user is behind the camera and can see the LCD monitor and
the subject. 33

You can move the LCD monitor to the left and right, or forward and backward by operating the respective lock
lever.

Lock lever (left/right)

Lock lever (front/back)

(i) NoTES

e Based on the LCD monitor’s position, you can invert the image displayed on the screen. Repeatedly pressing
the MIRROR button will change the displayed image in the following order: Image inverted horizontally -
Image inverted vertically - Image inverted horizontally and vertically - Original image.

¢ You can adjust the brightness, contrast, color saturation, sharpness and luminance of the LCD screen with the
respective settings in the MENU > [[Z)) Monitoring Setup] menu (11 218). These settings do not affect the
recorded video.

¢ In CAMERA mode, you can use the MENU > [[Z)) Monitoring Setup] > [B&W Image: VIDEO Term.] setting to
change the LCD monitor to black and white display. Even when the captured image is displayed in black and
white, onscreen displays and icons will be shown in color.

* You can use the MENU > [ System Setup] > [Touch Screen Response] setting to adjust the LCD monitor’s
response to touch input.
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Preparing the Handle Unit and LCD Monitor

Removing and Attaching the Camera Grip

The camera grip comes originally attached to the camera. You can remove it when a minimal configuration is
necessary.

Removing the Camera Grip
1 Turn off the camera.
2 Disconnect the camera grip’s connection plug ().

3 Unscrew the camera grip’s locking screw and gently
detach the grip (2).

Attaching the Camera Grip

1 Turn off the camera.

2 Attach the camera grip to the camera aligning it at the
desired angle and tighten the camera grip’s locking
screw (®).

3 Firmly insert the camera grip’s connection plug all the
way into the GRIP terminal on the camera (@).

* Make sure to insert the plug all the way in, until the
terminal is not visible.

e If the plug is not correctly connected, all the controls
on the camera may be disabled ([ 248).

Attaching the Microphone Holder
1 Attach the microphone holder to the handle unit.

2 Use a commercially available Phillips head (“crosshead”)
screwdriver to secure it firmly with the supplied M4 bolts.




Preparing the Lens

Preparing the Lens

As much as possible, attach and remove the lens quickly and in a clean environment free of dust. Refer also to
the instruction manual of the lens used.

@ vrorTANT
¢ \When attaching/removing a lens, avoid direct sunlight or strong light sources. Also, be careful not to drop the
camera or lens.

(1) NoTES

¢ After removing a lens/When a lens is not attached to the camera:
- Do not touch the lens’s surfaces, the lens mount or any components inside the lens mount area.
- Place the body cap back on the lens mount and the dust caps on the lens. Clean any dust or dirt from the
body cap and dust caps before using them.

Attaching a Lens
1 Turn off the camera.

2 Remove the body cap from the camera and the dust
caps from the lens (D).

3 Attach the lens to the camera and turn the lens in the
direction of the arrow until it clicks in place ((2).

¢ Align the red mark on the lens with the red lens mount
index mark.

Removing a Lens

1 Turn off the camera.

2 Hold down the lens release button (D) and turn the lens all
the way in the direction of the arrow until it stops (2).

3 Remove the lens ((®)).

4 Place the body cap back on the lens mount and the dust
caps on the lens.

(1) NoTES

¢ Turning on the image stabilization function of a lens may reduce the effective usage time of the battery pack.
When image stabilization is not necessary, for example if the camera is fixed to a tripod, it is recommended to
turn it off.

¢ Depending on the lens used, you may experience one or more of the following limitations.
- The lens model name may be shortened when displayed on the screen.
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Preparing the Lens

- You may not be able to focus manually when the focus mode switch is set to AF.
- You may not be able to use the focus preset function on super telephoto lenses.
- You may not be able to use the power zoom function on lenses with that function.

e This camera’s sensor is larger than the sensor size for which RF-S/EF-S lenses are designed (APS-C). When
using RF-S/EF-S lenses with this camera, you may notice peripheral illumination fall-off or vignetting.

* When using a compatible lens, you can use the MENU > [§ System Setup] > [Retract Lens] setting to retract
the lens automatically when the camera’s power is turned off with the focus mode set to AF.

e When a VR lens is attached, accessories attached to the handle unit or the hand holding the grip may be
reflected in the image. Check the image before recording.

Using the EF-EOS R 0.71x Mount Adapter

® You can use the EF-EOS R 0.71x Mount Adapter to attach a compatible EF lens to the camera and shoot
video with an angle of view equivalent to full frame (when the sensor mode is [Super 35mm (Cropped))).
Additionally, you can use autofocus, peripheral illumination correction and chromatic aberration correction. For

details on compatible lenses, visit your local Canon website.
* Setting the camera’s sensor mode to [Full Frame 3:2]/[Full Frame] causes vignetting.

¢ When using the EF-EOS R 0.71x Mount Adapter with some EF lenses, a frame that limits the AF range may be
displayed.

Updating the Firmware of a Lens/Mount Adapter/Power Zoom Adapter

You can update the firmware of the lens/mount adapter/power zoom adapter attached to the camera (only in
CAMERA mode). For details about firmware updates, visit your local Canon website. The following example
explains how to perform a firmware update for lenses.

1 Download the lens/mount adapter/power zoom adapter firmware update file from the Canon website and
save it on the root directory of an SD card. Insert the SD card containing the firmware update into the camera’s
SD card slot ([1] 44).

2 Attach the lens/mount adapter/power zoom adapter you want to update and turn on the camera in CAMERA
mode.
e Attach a lens also when updating the firmware of the mount adapter/power zoom adapter.

3 Select MENU > [¥ System Setup] > [Firmware] > [Lens], [Mount Adapter] or [Power Zoom Adapter].
e The current lens/mount adapter/power zoom adapter firmware version will appear on the screen.

¢ |f the menu option is grayed out, the attached lens/mount adapter/power zoom adapter may not support
firmware updates or the SD card used may not contain a valid lens firmware file. Check the lens/mount
adapter/power zoom adapter and SD card and repeat the procedure from the beginning.

4 Select [OK].
5 Select the lens firmware file (.LFU or .AFU file).
6 Select [OK].
e The firmware will be updated. Once in progress, the lens firmware update cannot be canceled.
7 When the confirmation message appears, press SET.

@ vPoRTANT
* Be sure to observe the following precautions while the lens firmware is being updated.
- Do not turn off the camera and do not remove the battery pack or other power source.
- Do not remove the lens/mount adapter/power zoom adapter.
- Do not operate any buttons or controls on the camera.
- Do not open the card compartment cover and do not remove the SD card.

(i) NOTES

® The lens firmware cannot be updated while pre-recording is activated.
e Power the camera using an AC adapter or a sufficiently charged battery pack.



Preparing the Lens

e \When using an EF extender, remove the extender before performing the procedure.

In-Camera Lens Correction

Depending on the characteristics of the lens used, the corners of an image frame may be darker than the center
due to light fall-off (peripheral illumination drop), color shift/color fringing may be visible along high-contrast
edges in the image (chromatic aberration), the image produced may not be as sharp at certain apertures (lens
diffraction), or the image might appear distorted (distortion aberration). In CAMERA mode, you can apply a
correction to compensate as necessary. To apply peripheral illumination or chromatic aberration correction,
correction data for the lens used is necessary. Distortion aberration correction is only possible for compatible RF
lenses.

1 Attach the lens you want to use and turn on the camera in CAMERA mode.

2 Select MENU > ["™ Camera Setup] > [Periph. lllum. Corr.], [Chromatic Aberr. Corr.], [Diffraction

Correction], or [Distortion Aberr. Corr.].

e [f correction data is not available, [Periph. lllum. Corr.] or [Chromatic Aberr. Corr.] will appear grayed out. Visit
your local Canon website and check if there is correction data available for the lens you are using. If so,
download the necessary update package, update the camera’s firmware version and repeat the procedure
from the beginning.

e |f the appropriate correction data for distortion aberration is not available for the lens attached, [Distortion
Aberr. Corr.] will appear grayed out.

3 Select [On].
® The camera will apply the correction for the attached lens to all future recordings.

(i) NoTES

¢ About in-camera lens correction data: The camera contains a register of correction data for compatible lenses
that were available at the time the camera went on sale. Correction data for future lenses will be made
available as part of the regular updates released for the camera’s firmware. For more details, visit your local
Canon website.
¢ When peripheral illumination/diffraction correction is activated:
- Depending on the recording conditions, noise may appear in parts of the image.
- The level of correction will be lower for lenses that cannot provide distance information.
- The level of correction will be lower the higher the ISO speed/gain setting used.
- When using RF-S/EF-S lenses, peripheral illumination fall-off may be more pronounced.
¢ Peripheral illumination/chromatic aberration correction cannot be applied in the following cases:
- When the appropriate correction data is not available for the lens attached.
- When using non-Canon lenses. Even if the corresponding menu setting is available (not grayed out), setting
it to [Off] is recommended.
e Diffraction correction cannot be applied when the camera cannot obtain the current aperture value of the lens.
e Chromatic aberration/diffraction/distortion aberration correction is not applied to RAW clips. Correction is
applied to proxy clips recorded simultaneously.
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PIN Code, Date, Time and Language Settings

PIN Code, Date, Time and Language Settings

You will need to set the PIN code, date and time on the camera the first time you power it on, or after the
camera's settings have been reset. Refer to Using the Menus ([1] 40) for instructions on setting operation.

Setting the PIN Code

First, set a 6-digit PIN code.

@ ]

1 Enter a PIN code (6-digit number).
e The numeric keypad screen is displayed by touching the input area in the center of the screen.
e Touch a key on the screen to select a number, then touch [OK] to confirm the entry.
e You can also use the SELECT dial or the joystick to select a number and press the SET button to enter it.

2 Select [OK].
3 Enter the PIN code again following the on-screen instructions and select [OK].

4 When the confirmation message appears, select [OK].
* You will need to enter the PIN code when starting up the camera.
e By configuring the following settings, you can omit entering the PIN code from next time.
- Select [Don't require PIN code again.] on the PIN code entry screen.
- Set MENU > [¥ System Setup] > [PIN Code Management] > [PIN Code Request] to [Disable].

@ wPoRTANT

e |f you forget your PIN code, you will need to reset the device. Please note that all camera settings will be
initialized.

e Setting a PIN code does not protect the recorded data stored on the card.

e Canon shall not be liable for the theft of this product or any memory cards.

e |f you configure the settings to omit entering the PIN code, please be careful to prevent third parties from
accessing the camera’s settings and other information.

(i) NoTES

e Until you enter the PIN code, these connections are not available while the PIN code screen is displayed.
- USB connection
- Network connection
¢ To change the PIN code, go to MENU > [ System Setup] > [PIN Code Management] > [PIN Code Changel.
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Setting the Date and Time

Date/Time

A
UTC-05:00 Jan 1 , 2024 12 : 00

v

New York

1 Select the desired time zone and move to the next field.
e Joystick: Push the joystick up/down to make the selection and then press SET (press the joystick itself).
Dial: Turn the SELECT dial to make the selection and then press the SET button.
e You can also push the joystick left/right to move between the fields.
e The default time zone is [UTC-05:00] (New York) or [UTC+01:00] (Central Europe), depending on the
country/region of purchase. Time zones are based on Coordinated Universal Time (UTC).
2 Change the rest of the fields in the same way.

3 Select [Set] and then press SET.

(i) NoTES

¢ You can display the date/time with the MENU > [(Z)) Monitoring Setup] > [Custom Display 2] (CAMERA
mode) or [Custom Display] (MEDIA mode) > [Date/Time] setting.

¢ \With the following settings, you can change the time zone, date and time also after the initial setup. You can
also change the date format and clock format (12 or 24 hours).
- MENU > [¥ System Setup] > [Time Zone], [Date/Time] and [Date Format]

¢ \When you do not use the camera for about 3 months, the built-in backup battery may be depleted completely
and the date and time setting may be lost. In such case, recharge the built-in backup battery (1] 264) and set
the time zone, date and time again.

e Using the optional GP-E2 GPS Receiver, you can have the camera adjust settings automatically according to
the UTC date/time information received from the GPS signal ([1] 225).

Changing the Language

The camera’s default language is English. You can change it to German, Spanish, French, Italian, Polish,
Portuguese, Russian, Ukrainian, Simplified Chinese, Korean or Japanese. Please note that some settings and
screens will be displayed in English, regardless of the language setting.

Refer to Selecting an Option from the Menu (11 40) for details on how to navigate the menu to complete this
procedure.

1 Select MENU > [¥ System Setup] > [Language &3 ].
2 Select the desired language and press the MENU button to close the menu.
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Using the Menus

Using the Menus

Many of the camera’s functions can be adjusted from the menu that opens after pressing the MENU button. In
CAMERA mode, you can also register frequently used menu settings in a customized menu (My Menu) for easy
40 access. For details about the available menu options and settings, refer to Menu Options (0 2193).

MENU button

%ENDU
..
CANCEL
@ . CANCEL
‘ button
CANCEL —— MENU
button button
Joystick SELECT dial/
SET button Jovstiok SET button
oystic Press the SET button (in the
manual, “press SET”) to confirm a
Joystick/SET button selection.

When making a menu
selection, push the joystick to
move the orange selection
frame in the menu. Then, press
the joystick itself (in the
manual, “press SET”) to select
the menu item indicated by the
orange selection frame.

SELECT dial

Turn the dial to move the orange

selection frame in the menu or to
browse quickly through a long list
of options.

CANCEL button

Press to return to the previous
menu/submenu level or to stop
some operations that are in
progress.

MENU button

Press the button to open the setup
menus and then press again to
close the menu after adjusting
desired settings.

Selecting an Option from the Menu

The following is a step-by-step explanation of how to select a typical option from the setup menus. Some menu
items may require additional steps. Such operations will be explained in the respective section of the manual.
For brevity’s sake, references to menu settings throughout the manual will be abbreviated as follows:

MENU > [¥ System Setup] > [Language &3] > Desired option

1 Press the MENU button.

* The menu opens with the orange selection frame indicating the menu item that was selected the previous
time the menu was closed (unless the camera was turned off).

2 Push the joystick left/right or turn the SELECT dial to select the icon of the desired setup menu.



Using the Menus

* In the example, the ¥ icon, corresponding to the [System Setup] menu.
¢ |f one of the icons in the top row is not selected when you open the menu, first push the joystick up or press
the CANCEL button to move the orange selection frame to one of the icons.
3 Press SET (press the SET button or press the joystick itself).
e You can also push the joystick down to move the cursor to the list of menu items.

4 Select the desired menu item ([Language & ], in the example) and then press SET.

e Joystick: Push the joystick up/down to select a menu item in the current page, or left/right to scroll through
the menu pages.
Dial: Turning the SELECT dial will scroll through all the menu items and all the menu pages consecutively.

5 Push the joystick up/down or turn the SELECT dial to select the desired setting option and then
press SET.
e The currently selected option is indicated with a b mark.
¢ \When many options are available, a scroll bar will appear on the right. Scroll up or down to see other
options.
e Press the CANCEL button instead to return to the menu page without changing the setting. In submenus,
you can also select [H] and press SET to return to the previous menu level.

6 Press the MENU button to close the menu.

(i) NoTES

e Unavailable items may appear grayed out.
¢ Pressing the MENU button at any time closes the menu.

e On some screens, the following icons may be displayed as a guide: (SET), (MENU), [CaNCED . They refer, respectively,
to pressing the joystick or SET button, the MENU button and the CANCEL button.

e \When an optional RC-V100 Remote Controller is connected to the camera, you can use the remote
controller’s up/down/left/right/SET buttons in the same way as the camera’s joystick. Pressing the SET button
is equivalent to pressing the joystick on the camera.

¢ You can check most of the current settings on the status screens (11 227).

Using the Customized Menus (My Menu)

In CAMERA mode, you can register up to 6 frequently used menu settings under a My Menu page for easy
access. You can save up to 5 separate sets of My Menu settings so you can customize different options for
different shooting situations. Furthermore, if you set an assignable button to [My Menu] ([11 133), you can press
the button to access your registered menu settings even faster and more easily.

Selecting a My Menu Set

Select MENU > [% My Menu] > Desired menu page.

e Each My Menu set corresponds to a separate menu page ([1] to [5]). Select the page of the My Menu set you
wish to use.

Adding Menu Settings

Select MENU > [ My Menu] > [Edit] > [Register].
e Select the menu setting you want to add, then select [OK] twice.

Rearranging Menu Settings
Select MENU > [ My Menu] > [Edit] > [Move].
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Using the Menus

¢ Select the menu setting you want to move (the & icon will appear next to the setting you selected). Move the
menu setting to the desired position and press SET.

Removing Menu Settings

Select MENU > [% My Menu] > [Edit] > [Delete].
e Select the menu setting you want to remove, then select [OK] twice.

Resetting All the My Menu Sets

Select MENU > [ My Menu] > [Edit] > [Reset Alll.
* Select [OK] twice.

Renaming My Menu Sets

You can give each of the 5 My Menu sets a more descriptive name to make them easier to identify.
Select MENU > [% My Menu] > [Edit] > [Rename].

¢ Enter the desired name (8 characters long) using the keyboard screen (see the following sidebar).

Entering text and numbers
There are two types of screens used to enter text and numbers — the keyboard screen, and the data entry
screen. Which screen is used, as well as the available characters will depend on the menu setting.

Keyboard screen
1 Touch the character you wish to enter.
e The characters you entered will appear in the input area at the top of the screen.

Key Function CAMERA!
“@/n Moves the cursor in the input area.

{ Shift key

,{f,} / Ae1 | Switches between letters, numbers and special characters.

— Space key

< Backspace key

* You can also move the cursor with the SELECT dial or the joystick, and select the desired character by
pressing SET.

2 After entering the desired text, touch [OK] to confirm.
Data entry screen
Use the SELECT dial or the joystick to select characters. Metadata > User Defined
1 Select a character and then press SET to confirm.
e The cursor will move to the next field.
e You can also push the joystick left/right to move between the fields.
e Change the rest of the characters in the same way.

2 Select [Set] to confirm the text or value.
e Press CANCEL to stop entering text.
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Preparing Recording Media

The camera records clips, photos and other recording media to a CFexpress card or SD card. You can select
the recording method for the card in each of the two card slots.

Initialize cards ([1] 45) when you use them with this camera for the first time.

1 The SD card is used also to save/read other settings files such as custom picture files.

Compatible Recording Media

The following types of memory card can be used with this camera. For the latest information about recording
media tested for use with this camera, visit your local Canon website.

CFexpress cards

CFexpress cards compliant with CFexpress 2.0 Type B specifications.

However, it may not be possible to record on the card depending on the camera mode and bit rate used. For
details about CFexpress cards tested for use with this camera, visit your local Canon website.

SD cards
SD card type: S» -)S(g
SD cards SDHC cards SDXC cards
SD Speed Class': CL Ass@ CL ASS@
UHS Speed Class': w BJ
Speed Class U1 Speed Class U3
Video Speed Class': V30, V60, V90

If the video speed class is not appropriate for the bit rate, a warning is displayed.
1 Standards that indicate the minimum guaranteed data transfer rate of SD cards.

Supported media for clips / photos

Recording data CFexpress cards SD cards
Clips: RAW (] _
Clips: XF-AVC, XF-AVC S, XF-HEVC S
(Depending on the recording method, only o o
CFexpress cards may be used)
Photos: JPEG - o
@ vrPoRTANT

e CFexpress cards can become hot due to the high operating temperature inside the camera. Removing a
CFexpress card immediately after using it for recording may cause burns or cause you to drop the card,
resulting in damage to the card.

e After repeatedly recording, deleting and editing clips (if the memory is fragmented), you may notice slower
writing speeds to the card and recording may even stop. In such case, save your recordings and initialize the
card with the camera. Be sure to initialize cards especially before shooting important scenes.

¢ About CFexpress and SDXC cards: You can use CFexpress and SDXC cards with this camera but these types of
cards are initialized by the camera using the exFAT file system.
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Preparing Recording Media

- When using exFAT-formatted cards with other devices (digital recorders, card readers, etc.), make sure that
the external device is compatible with exFAT. For more information on compatibility, contact the compuiter,
operating system or card manufacturer.

- If you use exFAT-formatted cards with a computer OS that is not exFAT-compatible, you may be prompted
to format the card. In such case, cancel the operation to prevent data loss.

e |f you repeatedly record for short periods of time at a low bit rate, you may not be able to record even if the
card has free space.

(i) NoTES

e Proper operation cannot be guaranteed for all cards.

e SDHC cards are formatted using the FAT32 file system so, when recording proxy clips, the video (stream) file in
the clip will be split approximately every 4 GB. Playback with the camera will be seamless.
SDXC cards use the exFAT file system so the stream file in the clip will not be split.

Inserting Cards

1 Make sure the card access indicator is off.

2 Slide the card compartment cover switch all the way in
the direction of the arrow ().

e The card compartment cover will open to the left.

CFexpress SD
3 Insert the card straight ((2)), with the label facing the back
of the camera (the side with the battery compartment) all

@
\
the way into one of the card slots.

e You can use two cards, one in each card slot. Gard access
indicators

4 Close the card compartment cover ().

e Do not force the cover closed if the card is not correctly
inserted.

Card access indicators

Card status

Red Accessing the card.
Green Recording/playback is possible and the card is selected for recording/playback.
off A card is not inserted or the card slot is not currently selected.

If you set MENU > [¥ System Setup] > [Card Access LED] to [Off], the card access indicators will not illuminate.
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Removing Cards

1 Wait until the card access indicator is off or is illuminated in
green.

2 Slide the card compartment cover switch in the direction of
the arrow.
e The card compartment cover will open to the left.

3 Make sure the card access indicator is off. For CFexpress

cards, push the card release button. For SD cards, push the
bottom of the SD card ().

4 Pull out the card ((2)) and close the card compartment cover

®).

Initializing Recording Media

Initialize cards when you use them with this camera for the first time. You can also initialize a card to permanently
delete all the recordings it contains.

1 Select MENU > [£% Recording/Media Setup] > [Initialize Medial.

2 Select [CFexpress] or [SD Card].

3 Select [OK].
* The card is initialized and all the data it contains is erased.

4 When the confirmation message appears, press SET.

@ vPorTANT

e SD cards are initialized using the FAT12 / FAT16 file system, SDHC cards using the FAT32 file system, and
SDXC and CFexpress cards using the exFAT file system.

e |nitializing a card will permanently erase all data, including photos and protected custom picture files. Lost data
cannot be recovered. Make sure you save important recordings in advance.

* Depending on the card, initialization may take up to a few minutes.

(i) NoTES

e |f you set an assignable button to [Initialize Media] ([J] 133), you can press the button to open the [Initialize
Media] submenu.

Switching Between Card Slots

If both slots contain a card, you can switch the card used for recording/playback as necessary.

1 Assign the [Slot Selection] function to an assignable button ([I] 133).
2 Press the assigned button during record standby mode (STBY) or on the index screen.

(i) NoTES

e You can also use the MENU > [ £% Recording/Media Setup] > [Main Recording Destination] setting.

¢ You cannot use the button assigned to [Slot Selection] to switch between card slots while recording or playing
back.

e You can also perform this function remotely using Browser Remote (11 204).
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Recovering Recordings

Some actions, such as suddenly turning off the camera or removing the card while data is being recorded, can
cause data errors in the recorded file. You may be able to recover recordings with corrupted data using the
46 following procedure.

1 Set the camera to MEDIA mode and open the index screen with the clip you wish to recover
(1 149).
2 Select the desired clip (a clip with the 2 icon instead of a thumbnail image).

3 Press SET to open the clip menu and select [Recover] > [OK].
e The camera will attempt to recover the corrupted data.

4 When the confirmation message appears, press SET.

(i) notes

¢ In the RAW or XF-HEVC S/XF-AVC S index screen, recovered clips appear with a B> icon instead of the usual
thumbnail.

¢ The file may not be recorded if the power is cut or if the SD card is removed immediately after starting
recording. In case of recordings with a duration of less than 0.5 seconds, such files may be deleted if file
recovery is attempted.

® |n some cases, it may not be possible to recover the data. This is more likely when the file system is corrupted
or the card is physically damaged.

e Only clips, WAV files and News Metadata files recorded with this camera can be recovered. Photos cannot be
recovered.
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Selecting the Video Recording Method

This camera features various recording modes, as well as video recording methods using two cards. You can
also stream the audio/video while recording it on a card ([1] 200). Below is an overview. For details, refer to each

function’s section.

Recording modes

[Recording Mode] [Main Rec Format] Description (A
[Normal Recording] Al Nor'rnall recording. .Records a clip in the selected recording format. The most | 53
basic video recording method.
Slow & fast motion recording. Records using a frame rate that differs from 126
. the recording format frame rate. A lower frame rate results in a fast motion
[Stow & Fast Motion] Al effect (undercrank shooting), and a higher frame rate results in a slow motion
effect (overcrank shooting). Sound is not recorded in this mode.
) ) If [S&F Clip / Audio (WAV)] is selected, audio (WAV) is recorded to the card 126
[S&F Clip / Audio (WAV)] Al that is not the video recording destination.
Pre-recording. Records onto a temporary memory (3 seconds) so the clip will | 127
[Pre-Recording] XF-AVC / XF-AVC S/ | contain a few seconds of video and audio recorded before you perform the
9 XF-HEVC S recording operation. Cannot be used in conjunction with slow & fast motion
recording.
Continuous recording. The CFexpress card is used for normal recording 127
[ Main / Continuous Rec] | XF-AVC S / XF-HEVC S (folloyvmg operatlons. such as start.lng anq stopping recordlr.lg), and the SD
card is used for continuous recording (uninterrupted recording). Useful for
preventing missed shots.
Frame recording. A preset number of frames are recorded each time the REC | 128
[Frame Recording] All button is pressed, and saved as one clip when frame recording mode ends.
Sound is not recorded in this mode.
(interval Recording] Al Interval recording. Automatically records a pre-defined number of frames at | 129
9 a pre-defined interval. Sound is not recorded in this mode.
Second card recording functions
[2nd Card Rec Functions] Description (A
Proxy recording. Simultaneously records a proxy clip (to the SD card, while the main clip is recorded to | 71
[E®] Main / Proxy Rec] the CFexpress card) with a smaller file size for offline editing. The proxy clip is recorded with a file
name associated with the main clip.
(5 Main / Sub Reg] Sub recording: Simultaneously records a clip to the SD card with a different video configuration from | 70
that of the main clip on the CFexpress card.
Audio recording. Simultaneously records a WAV file* to the SD card, while the main clip is recorded to | 113

[ Main / [so] Audio Rec]

the CFexpress card.
* Differs from the WAV files that can be recorded together with slow & fast motion recording.

[Relay Recording]

[Double Slot Recording]

Relay recording. Continues recording on the other card without interruption when the card you are
using becomes full.

Double slot recording. Records the same clip simultaneously to both cards, which is a convenient way
to make a backup copy of your recordings.

1 Select the recording mode
 Select MENU > [£% Recording / Media Setup] > [Recording Mode] > Desired option.

2 Select the second card’s recording function
e Select MENU > [E® Recording / Media Setup] > [2nd Card Rec Functions] > Desired option.
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Available simultaneous recording configurations

Second card recording function

off Proxy Sub Audio Relay Double Slot
Recording Recording Recording Recording3 Recording3
Normal Recording ] o o o o o
Slow & Fast Motion Recording () o' o' - - -
Slow & Fast Motion Recording / @ - - - - -
Recording Audio (WAV)?
mode Pre-recording® () ® ® - Y )
Continuous Recording® ® - - - - -
Frame Recording ] - - - o o
Interval Recording [ J - - - ([ o

" Only when the main recording format is RAW. Unavailable when the slow & fast motion recording frame rate exceeds 60P.
2 Unavailable when the slow & fast motion recording frame rate exceeds 60P.

3 Unavailable when the main recording format is RAW.

4 Unavailable when the main recording format is XF-AVC.

(i) NoTES

e |f a card becomes full during double slot recording, recording on both cards will stop. On the other hand, if an
error occurs with one of the cards, recording will continue on the other card.

Video Recording and Outputs (Diagram)

Image R oL HDMI OUT
Sensor processing i HDMI terminal
© Custom Picture O LUT:
— SDI =—p SDI OUT terminal

y
O Proxy

recording color O LUT:

conversion —b MON. = External monitor

\ v

XF-AVC QLT

RAW weacs/| | VIDEO terminal —* LCD monitor
XF-HEVC S

@ Main recording © Main recording © Sub recording @ Proxy recording
(RAW) (XF-AVC/XF-AVC S/
XF-HEVC S)

@ Select the main recording format ([1] 65)

@ Second card recording functions ([I1 47)

¢ Audio recording, relay recording and double slot recording are also available. Some functions are not
available depending on the main recording format and recording mode.

© Custom picture settings (11 138)

® You can control various aspects of the image produced using custom picture files.
@ For proxy clips: select the proxy recording color conversion (11 71)

e Changes the gamma and color space settings.
© Apply the LUT to the image displayed ([J1 171)

e Changes the gamma and color space settings.
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Setting a Card’s Volume Label

In CAMERA mode, you can set the volume label for CFexpress cards and SDXC cards used for recording, in
order to make it easier to identify and organize them later.

1 Select MENU > [£% Recording/Media Setup] > [Volume Label] > [Canon] or [Canon + Metadata).
2 Initialize the card ([1] 45).
3 If necessary, set the clip file name’s metadata elements (11 49).

4 Record clips on the card.
e The card’s volume label changes when the first recording is made on a just initialized card.

Options

[Canon: The volume label of CFexpress and SDXC cards will be “Canon” regardless of the clip file name
settings.

[Canon + Metadatal:
The volume label of CFexpress and SDXC cards will be “CanonXY9999” where “X” / “Y”
represents the camera index and “9999” represents the reel number set in the clip file name’s
metadata settings.

Setting the Clip File Name

The camera allows you to change several settings that determine the clip file name of recorded clips (only in
CAMERA mode). Personalize the clip file name according to your preferences or organizational conventions to
create files that are easier to identify and organize. To input characters during the following operations, use the
keyboard screen ([1] 42).

The basic file name structure is as follows.

A_0001CO001A150501_235959XX_CANON_001_Proxy

—/\ / \ / \/\ /\—/\ A — \ /

1 2 3 4 5 6 7 8 9 10 1"

1 Camera index: Two characters (Ato Z or “_") that 6 Special recording mode identifier: Identifies the

identify the camera used. recording mode (“_” for normal, “C” for the
2 Reel number: 4 characters (0001 to 9999) that continuous recording clip on the SD card) used
identify the card used. The number is assigned by the camera.
automatically but you can set the initial number. 7 Recording time: Recording hour, minute, and
After you insert a new card (just purchased or second (set automatically by the camera).
initialized), the number advances by one when the 8 Random component: 2 characters (numbers O
first recording is made. to 9 and capital letters A to Z) that change
3 Clip number: 4 characters (CO01 to D999). The randomly with each clip.
clip number advances automatically with each 9 User defined field: 5 characters (numbers 0 to 9
clip recorded (switching to D001 after C999), but and capital letters A to Z) for any other
you can set the initial clip number and select the identification purposes.
clip numbering method. 10 Stream number: When an SD or SDHC card is
4 Main codec identifier: One character that used to record clips, a stream number (001 to
identifies the main codec (X: RAW, A: AVC/H.264, 999) will be added.
H: HEVC/H.265). 11 Proxy clips only*: The camera will automatically
5 Recording date and time (set automatically by the add the suffix “_Proxy” to the file name of proxy
camera). clips.

* Apart from this component, the file name of the primary clip and the proxy clip will be identical.
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Setting the Components of the Clip File Name

To set the camera index
1 Select MENU > [ £% Recording/Media Setup] > [Metadata] > [Camera Index].
2 Select the desired camera index and then select [Set].

e Select two characters (Ato Z or “_”).

To set the clip numbering method

Select MENU > [£® Recording/Media Setup] > [Metadata] > [Clip Numbering] > [Reset] or
[Continuous].

Options
[Reset]: The clip number will restart from 001 every time you insert a new card.

[Continuous]:  Clip numbers will start from the initial number set with [Clip Number] (following procedure) and
continue across multiple cards.

To set the reel number or initial clip number

The initial clip number can only be set when [Clip Numbering] is set to [Continuous].

1 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Reel Number] or [Clip Number] > [Change].
e To reset the reel/clip number to [0001] or [001], select [Reset] instead.

2 Enter the reel/clip number.

To set the user-defined field

1 Select MENU > [£® Recording/Media Setup] > [Metadata] > [User Defined] > [Change].
e To reset the user-defined field to [CANON], select [Reset] instead.
2 Enter the desired text string.

Checking the Camera’s Inclination

You can display the level of the effective inclination compensation of the camera. You can check the vertical
inclination of the optical axis (tilt), and the amount of rotation around the optical axis (roll).

Select MENU > [[Z) Monitoring Setup] > [Custom Display 1] > [Level (Numeric)] or [Level (Bar)].
¢ The following settings are possible if you select [Level (Bar)].

- [Tilt+Roll]: Displays inclination for both tilt and roll.

- [Tilt]: Displays the vertical inclination of the optical axis.

- [Roll]: Displays the amount of rotation around the optical axis.

- [Off]: Inclination is not displayed.

(i) NoTES

* You can set the level sensitivity and reference angle from MENU > [¥ System Setup] > [Level Sensitivity] or
[Level Reference Setting]. The [Level Reference Setting] function uses the angle detected by the camera as
reference and displays an angle relative to that reference angle.

¢ The [Level Reference Setting] function allows you to fine-tune the angle of the level and is enabled only near
the following postures.

- Upright posture, vertical posture (rotation of 90°, —90° in the roll direction)
- Upside down (rotation of 180° in the roll direction)
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- Lens facing upward (90° in tilt direction)
- Lens facing downward (-90° in tilt direction)

Using the Fan

The camera uses a cooling fan to lower the camera’s internal temperature. In CAMERA mode, you can change
the fan’s operation mode and speed. In MEDIA mode, the fan runs at all times but you can select its speed.

Setting the Fan’s Operation in CAMERA Mode
1 Select MENU > [¥ System Setup] > [Fan Modeg] > Desired option.

If you selected [Always On]
2 Select MENU > [¥ System Setup] > [Fan Speed (Always)] > Desired fan speed.

If you selected [Automatic]
2 Select MENU > [ System Setup] > [Fan Speed (STBY)] > Desired fan speed in record standby mode.

3 Select MENU > [ System Setup] > [Fan Speed (REC)] > Desired fan speed while recording.

e The [Maximum)] option offers the maximum cooling effect but is available only for [Fan Speed (STBY)], as it is
noisier.

Options for [Fan Mode]

[Automatic]: The fan runs while the camera is not recording and is automatically turned off while the camera
is recording. However, if the internal temperature of the camera is too high (B appears in
yellow), the fan will be activated automatically (in that case, will appear next to the B
icon). When the camera’s temperature has decreased sufficiently, the fan will be turned off. Use
this setting when you do not want the camera to pick up the fan’s operating sound.

[Always On]:  The fan runs at all times.

Setting the Fan Speed in MEDIA Mode
1 Select MENU > [¥ System Setup] > [Fan Speed].
2 Select the desired option.

@ vPoRTANT
¢ While the fan is running, the exhaust vent will emit warm air.
¢ Be careful not to obstruct in any way the fan’s air vents ([J1 13, 14).

(i) NoTES

¢ Depending on the ambient temperature and other shooting conditions, the fan may not turn off even if you set
its operating mode to [Automatic].
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Adjusting the Black Balance

Adjusting the Black Balance

In CAMERA mode, you can have the camera adjust the black balance automatically when ambient temperature
changes considerably or if there is a noticeable change in a true black video signal.

1 Attach the body cap to the lens mount and set the camera to CAMERA mode.
e |f alens was attached, turn off the camera and remove the lens. Place the body cap back on the lens mount
and turn on the camera.
2 Select MENU > ["™ Camera Setup] > [ABB] > [OK].
e The automatic black balance procedure will start. It may take about 1 minute depending on the frame rate.

3 When the confirmation message appears, press SET.

e [f the sensor is not completely shielded from light, [Error] will appear on the screen. Repeat the procedure
from the beginning.

(i) NoTES

¢ Adjusting the black balance is necessary in the following cases:
- When using the camera for the very first time or after a long period of not using it.
- After sudden or extreme changes in ambient temperature.
- After changing the sensor mode.

- After activating or deactivating slow & fast motion recording (including switching to another special recording
mode).

- After changing the shooting frame rate, when slow & fast motion recording is activated.
- After resetting the camera’s settings.

¢ During the adjustment of the black balance, you may notice some irregular displays appear on the screen. This
is not a malfunction.
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Recording Video and Photos

This section explains the basics of recording clips* and photos. For details on recording audio, refer to Recording
Audlio (1] 111).

* “Clip” refers to a single movie unit recorded with a single recording operation. You can also include metadata with the clip.

Recording

Power indicator/
rear tally lamp Front tally lamp

CFexpress card
access indicator

CFexpress SD
D @D

1 Set the switch to CAMERA.
e The camera turns on in CAMERA mode and enters record standby mode ([STBY]).
® The power indicator (rear tally lamp) will illuminate in green.
e The access indicators of card slots with a card inserted will illuminate momentarily in red. Then, the access
indicators of cards selected for recording will change to green.

2 Press the REC button to begin recording.
e Recording starts. The tally lamps illuminate in red (the rear tally lamp changes from green (power indicator) to
red) and the recording indicator at the top of the screen changes from [STBY] to [@ REC].
e The access indicator of cards used for recording will illuminate in red.
e You can use the REC button on the camera or the one on the camera grip.
¢ You can also perform this function remotely using Browser Remote on a connected network device ([1] 202, 205)
or an XC protocol-compatible device.

3 Press the REC button to stop recording.
* The clip is recorded and the camera enters record standby mode. The front tally lamp goes out and the rear
tally lamp changes from red to green (power indicator).
* The access indicator of cards selected for recording will change back to green.
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To take photos
In CAMERA mode, you can take photos using an assignable button. Photos are saved onto the SD card and
their size depends on the sensor mode ([ 65) in use. For details, refer to Specifications (11 269).
1 Set an assignable button to [Photo] (1] 133).
2 When the camera is in record standby mode, press the assignable button.
° ) appears at the top right of the screen and the photo is recorded on the SD card.
e The SD CARD access indicator will illuminate in red.

Available photo resolution settings

Sensor mode Main recording format Main resolution Photo resolution
Full frame 3:2 RAW - 3240x2160
Full frame RAW - 4096x2160
XF-AVC 4096x2160, 2048x1080 4096x2160
XF-AVG S/XF-HEVC S 3840x2160, 1920x1080 3840x2160
Super 35mm (cropped) RAW - 4096x2160
XF-AVC 4096x2160, 2048x1080 4096x2160
XF-AVC S/XF-HEVC S 3840x2160, 1920x1080 3840x2160
Super 16mm (cropped) RAW - 2048x1080
XF-AVC 2048x1080 2048x1080
XF-AVG S/XF-HEVC S 1920x1080 19201080
@ vroRTANT

¢ Be sure to save your recordings regularly, especially after making important recordings. Canon shall not be
liable for any loss or corruption of data.

(i) notes

¢ You can use the review function ([J1 62) to play back part or all of the last clip recorded without having to
switch to MEDIA mode.

e |f you record using metadata or News Metadata settings, those settings will be recorded with the clip. For
more details, refer to Using Metadata (11 123).

e |f the camera switches to the other CFexpress card while recording video due to the relay recording function
(13 47), the two parts (before/after the switch) will be recorded as separate clips.

¢ A single clip can be recorded continuously for up to 6 hours. At that point, a new clip will be created
automatically and recording will continue on a separate clip (excluding RAW recording, slow & fast motion
recording).

o If you set MENU > [¥ System Setup] > [Tally Lamp Settings] to other than [REC], the tally lamp lights when
the tally information for PGM is input.

¢ To record clips and photos, make sure the SD card is not write-protected.

e Photos cannot be recorded in the following cases.
- While recording video.
- When slow & fast motion recording is activated.
- When pre-recording is activated.
- While color bars are displayed.
- While Browser Remote is activated.
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Onscreen Displays

Refer to this section for an explanation of the various screen displays that appear in CAMERA mode. You can
use the custom display function (11 218) to turn off individual onscreen displays if they are not required. The
menu item that controls each display is given in the following tables (1: indicates a menu item under [Custom
Display 1] and 2: indicates a menu item under [Custom Display 2]).

The position of some icons and onscreen displays may change depending on the display level settings. The
following screenshot and tables describe the onscreen displays at display level 1 with the [All Displays] setting

([159).

9 min

60(24)fps E
3840x2160 @D
YCC422 10 bit

Secl Yol (=2
$cc2 Tl {mza]
vorlol v Base 12800 PM 8:21
DD DD DD DD =+ AE+0.25 CH[p+4/CH3+4
¥ 15000K +20 Bclosed IS0 102400

AF frames
Depending on the focus function used you may see some of the following AF frames. You can also hide them
with the MENU > [[E) Monitoring Setup] > [Custom Display 1] > [Focus Mode] setting.

Continuous AF frame —
in white/gray/red/yellow ([11 92)
One-shot frame —

Foous adjustment frame: In red in white/green/red (1 91) Eye detection: Main subject’s eyes ([T] 94)

when it is not possible to stop at
or locate the focus position
during one-shot AF, or when the
subject is out of focus (outside
the close/far range of the lens)
during continuous AF.

18mm
Subject detection frame (main
subject): white/gray/green/red/
yellow ([1] 94)

Subject detection frame (subjects

Tracking: Subject selection other than the main subject): gray

(M 995)

=28 15000K}|20CC NP 2stops BF|.8 150800

Frame for trackable subjects ([I1 92) Tracking: During Focus frame with focus guide ([11 89)
tracking
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Left side of the screen

Icon/DispIay

Description
Network connection status, functions and upload status ([ 198).

Custom Display
2: [Network Functions]

Object distance (bar).

1: [Object Distance (Bar)]

0000 mm Approximate focal length of the lens. 1: [Focal Length]

000.0 m Object distance (numeric). 1: [Object Distance
(Numeric)]

(MF), Focus mode ([ 88). 1: [Focus Mode]

Subject to be detected ([ 94).

Detection priority, detection only.

@ -9.9 (Lens |nformat|on)

Digital tele-converter ([ 99)

1: [Tele-converter]

Lens information. 1: [Lens]
e Depending on the lens, the information displayed may differ.
(Mg (Emg Slw Image stabilization enabled/disabled (] 97). 1: [Digital IS]
(@) Lens optical IS ([11 97)
00 Custom picture file selected ([ 138).

=]
i—
O
G
RS
=)
i—
(=4
G
=
3l -
gl 5
5
=
(2]

[Gamma/Color Space] setting in the custom picture file (I 142).

1: [Custom Picture]

, (C.Gamut),
LOOK Look Files ([ 140)
LENS NURED)] Lens error warning (11 250).
(13N (in yellow)
= L Light metering mode ([ 83). 1: [Light Metering]
A viewing LUT has been applied to at least one display or output terminal 1: [LUT]
(m171).
Status of the accessory attached to the multi-function shoe ([1] 17). 2: [Multi-Function Shoe]
e Appears in red in case of a communication error or if the attached accessory is
turned off.
& GPS signal: continuously on - satellite signal acquired; flashing - satellite signal not | 2: [GPS]
acquired.
o Displayed only when an optional GP-E2 GPS Receiver is connected to the
camera.
FAN Fan operation: in white — normal ([J1 51); in red — fan warning ([ 250). 2: [Temperature/Fan]
B Temperature warning (11 51).
e When the camera internal temperature rises above a certain level, E3 will
appear in yellow. If the temperature rises further, E will appear in red.
(MEMO) User memo ([ 123).

2: [User Memo]




Top of the screen

Icon/Display

Recording Video and Photos

Description

Recording media status, estimated remaining recording time and video format

&r, [so] (in green)
0000 min

ion: CFexpress card; (so]: SD card.

The card’s status is indicated by the icon’s color: in green — can record; in yellow —
card almost full (5 minutes or less); in red — card almost full (less than 1 minute); in
white — reading the card.

¢ The card selected for recording is indicated with a b mark.

in, [so] (in red) END

Card is full.

g, (8 (in red)

No card or cannot record on the card.

[RAW MIXF-AVCRXF-AVC S B
XF-HEVC S

Video format ([ 65), audio format ((11 126)

Custom Display
2: [Remaining Rec Time]

D]} Double slot recording ([J1 47). 2: [Recording Mode]
Recording operation

STBY, @REC Clip recording: record standby, recording.

S&F STBY, Slow & fast motion recording ([ 126): record standby, recording.

S&F @REC

PRE STBY, Pre-recording ([0 127): record standby, recording.

PRE @ REC

CONT, @ CONT Continuous recording ([11 127)

INT STBY, Interval recording ([0 129): record standby, recording.

INT @ REC,

INT @ WAIT

FRM STBY, Frame recording ([J1 128): record standby, recording.

FRM @ REC,

FRM @ STBY
1s to 10m00s Interval counter. 2: [Interval Counter]
REC=, STBY % Recording command ([ 167). 2: [Rec Command(EXT
EXT REC#, EXT STBY % “EXT” is displayed when there is no recording media. REC)]
00.00P, 00.00i Frame rate ([ 66). 2: [Frame Rate]

When slow & fast motion recording is activated, the shooting frame rate is also
displayed (000/00.00P).

o Key lock ([ 12). 1: [Key Lock]
00:00:00.00 / 00:00:00:00 Time code (1 105). 2: [Time Code]
R,PFE Time code status ([I] 106).
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Recording Video and Photos

Right side of the screen

Icon/Display
Power supply level indicator+
- ) -
m - 1 -
(in red)
000 min

DC IN 00.0V

Description

Remaining battery charge of a BP-A60N (supplied) or an optional Battery Pack and

estimated remaining usage time (in minutes).

e When is displayed, replace the battery pack with a fully charged one.

¢ Depending on the conditions of use, the actual battery charge level may not be
indicated accurately or may not match the levels shown on the [§ System
Setup] status screen or the indicators on the battery pack.

Power supply voltage when using an AC adapter.

o When the voltage falls below the selected low-power warning level (1 226),
the voltage will be displayed in red.

Custom Display
2: [Remaining Battery]

60(24)fps, 60(30)fps

Output Terminals Status ([J7] 136).

2: [Output Terminals
Status]

(Full], (Supers), Sensor mode (1] 65). 2: [Sensor Mode]
0000x0000 Resolution ([] 65). 2: [Resolution/
00 bit, Color depth, color sampling (] 65). Color Sampling]
YCC422 00 bit

» Photos can be recorded ([ 54). 2: [Photo]

» (5% (in red) No SD card or cannot record photos on the SD card.

Gen. Genlock (1] 109). 2: [Genlock]
Return signal input state 2: [Genlock]

RET, Displaying return video

(in yellow) Output onscreen displays (11 169). 2: [0SD Output]
[PEAK 1 8 (in yellow) Peaking ([ 90). 1: [Peaking]
(XD (in yellow) Magnification (11 90). 1: [Magnification]

B8l Change Magn. Ratio

Audio level meter ([1] 116).

INPUT limiter (C00 117).

2: [Audio Level Indicator]

“r

» {OFF

Headphone volume ([] 154).

Date/time
CHO/CHO, CHO+CHO

Audio output channels ([ 175).

2: [Date/Time]
2: [Monitor Channels]

(horizontal/vertical)

Level (bar, numeric) ((11 50).

Bottom and center of the screen

Icon/Display
Base 0000
Bl Start Tracking EIE End §

Select Again Endf
I Stop Tracking

Description
Base IS0 ([11 77).
Tracking guide, warning.

1: [Level (Numeric))/[Level
(Bar)]

Custom Display
1: [Base IS0]

A_0001C001 to ZZ9999D999

Clip identification. Includes the camera index, reel number and clip number
components of the clip file name ([ 49).

2: [Reel/Clip Number]

00 00 00 00

User bit (11 107).

2: [User Bit]

v

/4

Exposure bar ([T 83).

1: [Exposure Bar]




Recording Video and Photos

Icon/Display Description Custom Display
AE +0.00 AE shift ([1] 83). 1: [AE Shift]
(s Direct touch control (11 63) -
A/ B, e, 38, [4, | White balance (1] 85). 1: [White Balance]
AWB
00000K +00 CC
ND 00 stops ND filter (11 80). 1: [ND Filter]
@, F00.0 / T00.0, closed Aperture value ([1] 81). 1: [Iris]
A, 1S0 000000, 00.0dB IS0 speed/Gain value ([] 76). 1: [ISO/Gain]
000.00 (000.00)°*, 1/0000.00, | Shutter speed ([T 73). 1: [Shutter]
000.00Hz * When [Shutter Mode] is set to [Angle], and 60 (24) fps or 60 (30) fps is
selected with an assignable button (set to [Output: 60<60(24)fps] or
[Output: 60=60(30)fps]), 60P and 24P or 30P angles are displayed.
Giccl: Gicc2, Vi, Cm Wireless microphone 2: [Audio Level Indicator]

Selecting the Onscreen Display Level

You can press the DISP button to change the onscreen display level and control the amount of information
shown over the image (excluding the screen in portrait mode). In CAMERA mode, you can customize each

display level individually.

Press the DISP button to select the desired display level.

¢ Repeatedly pressing the DISP button will change the display level:
Display level 1 — Display level 2 — Display level 3.

CAMERA mode

Display level! Options Description

[DISP Level 1] | [All Displays]

All onscreen displays at a larger size.

[All Displays (Periph. Border)] | All onscreen displays at a smaller size, more appropriate for use with the peripheral border.

[DISP Level 2]2 [Main Recording Displays] Only the onscreen displays most relevant for shooting.

[Only FUNG/MENU] Only the recording operation is displayed. However, when the FUNC button, an assignable
button or the joystick is pressed/operated, part of the shooting information is displayed
temporarily.

[DISP Level 3]2 [Only REC/STBY] No onscreen displays except for the recording operation (REC/STBY).

[No Displays]

No onscreen displays at all.

1 MENU > [[=) Monitoring Setup] > [DISP Level 1], [DISP Level 2] or [DISP Level 3].
2 Smaller onscreen displays (same size as when set to [All Displays (Periph. Border))).
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Recording Video and Photos

MEDIA mode
Display level During clip/photo playback Index screen/During audio playback
[DISP Level 1] All onscreen displays.
[DISP Level 2] No onscreen displays. All onscreen displays.
[DISP Level 3] -

(i) NoTES

¢ You can change the transparency level of onscreen displays ([1] 169).

Peripheral Border Display

You can apply the peripheral border display to all display levels. With the peripheral border display, the camera’s
image is reduced slightly so the onscreen displays are shown mostly around it and not on top of it, partially
hiding it. The peripheral border is linked with the display level. You can select the levels that use the peripheral
border with the MENU > [[Z) Monitoring Setup] > [Apply Peripheral Border] setting.

Full-screen display Peripheral border display

(i) NoTES

¢ When using a display level with the peripheral border display, if you set MENU > [[Z) Monitoring Setup] > one
of the [OSD Output:] settings to [Off] or [Off (Clean)], the video output from each video terminal will be
displayed in full screen.

e When [SDI Output Signal] is set to [4096x2160P/3840x2160P], the peripheral border display is not applied to
video output from the SDI OUT terminal.

Displaying the Tally OSD

While recording (REC), the tally OSD (red frame or bar) can be displayed on the screen. Displaying the tally OSD
allows you to easily check whether recording is in progress even when viewing the screen from a distance.

1 Select MENU > [[E) Monitoring Setup] > one of the [Tally OSD:] settings > [On].
e Confirm and/or change the screen for tally OSD display and the output destination.

2 Select MENU > [[Z) Monitoring Setup] > [Tally OSD Position] > Desired option.

Frame Top Bottom

(i) NOTES

¢ Recorded video/still images are not affected.



Onscreen Displays in Portrait Mode
When shooting in portrait mode, you can change the orientation of the onscreen
displays.

Select MENU > [[Z) Monitoring Setup] > Desired [OSD Orientation:] setting >
[ =) 90 Degrees Right] or [ ¢« 90 Degrees Left].

(i) NoTes

e Direct touch control (other than recording settings) and the peripheral border
display cannot be used when the CAMERA mode screen is rotated.

Recording Video and Photos

48/59.94P

00:00:08.00P

» & 112 min [ER DCINT2.4v
13min R

3840x2160
42 mm YCC422 10 bit
%

S

FAN]

== A 5600K +0
F5.0
12.008
1/48
A_0003C023 .
ol e e e e e e e e
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Reviewing a Recording

Reviewing a Recording

If you set an assignable button to [Review Recording] in advance, you can review the last clip (primary clip)
recorded on the recording media currently in use even with the camera set to CAMERA mode.

1 Set an assignable button to [Review Recording] (11 133).
2 Select MENU > [¥ System Setup] > [Review Recording] > Desired option.

3 After you finish recording a clip, press the assignable button.

¢ The last clip that was recorded is played back for the selected duration. [ REVIEW] appears at the top of
the screen.

¢ While the clip is reviewed, there will be no sound from the built-in speaker but the audio will be output from
the ) (headphone) terminal, MON. or HDMI OUT terminal and SDI OUT terminall.

® You can use the joystick to jump back/forward within the clip (11 153).
e Press the CANCEL button to stop reviewing the clip and return to record standby mode.
e After the clip finishes playing back, the camera returns to record standby mode.

Options
[Entire Clip]: Allows you to review the entire clip.
[Last 4 sec]:  Allows you to review just the last 4 seconds of the clip.

(i) Nnotes

e |f the camera switched cards during a recording, the camera will play back the clip on the card most recently
recorded on.



Adjusting Camera and Recording Settings

Adjusting Camera and Recording Settings

Using direct touch control, you can perform a variety of settings (camera, recording, assistance functions, etc.) in
CAMERA mode. White balance and exposure related settings can also be modified with the direct setting mode,

using the FUNC button.

Performing Basic Settings with Direct Touch Control

With direct touch control you can change commonly used settings such as camera and recording settings and
assistance functions. For details about each function, refer to the respective section on the manual.

Available Direct Touch Control Settings

Touch button Available settings

White balance White balance mode (custom, preset, color temperature setting, automatic (AWB)), color temperature, color

correction value.

Exposure Aperture (adjustment of the F value/T value), ND, I1SO/Gain (adjustment of ISO or gain value/adjustment value

preset), shutter speed (value adjustment in the current shutter mode).

(assistance functions) Focus guide (on/off), peaking (type), WFM, zebra (type), vectorscope (type), false color (on/off), markers (on/off),

LUT (on/off).

% (recording settings) Sensor mode, main recording destination, main recording format, main resolution, bit rate, frame rate, recording
mode, continuous recording, frame recording frame rate, interval recording time interval, second card recording
functions, slow & fast shooting frame rate, proxy recording color conversion, file selection, sub recording
format, sub recording bit rate, sub recording frame rate, LCD monitor luminance.

Recording settings 5 » & 73min (N 59.94P  00:00:45.00P
=0 £ 181 min DCIN12.4V

Fulll

47 mm 3840x2160
[AFIRGIY YCC422 100bit

A_0003C035 123

e e [
Opening (Cxg)/ Closing (X) the 3% NDOFF | F5.6 | 150200 | 1/60
direct touch control interface .I -_--

Camera settings

Turn on/off the Direct Touch Control Interface

Even when the direct touch control interface is displayed, you can still use other functions such as recording,

menu settings, direct setting mode or status screens.

1 Touch (9 to open the direct touch control interface.
2 Touch X to close the direct touch control interface.

3
l_ Assistance functions
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Direct Setting Mode (FUNC Button)

Direct Setting Mode (FUNC Button)

In CAMERA mode, you can adjust main camera functions—shutter speed, ISO speed/gain, aperture and white
balance —using the FUNC button (direct setting mode). This section will explain the basic operation of the direct
setting mode. For specific details about the functions refer to the each function’s section: shutter speed ([11 73),
ISO speed/gain ([11 76), aperture ([11 81), white balance ([J] 85).

Using the Direct Setting Mode

1 Press the FUNC button.
e The onscreen display of the selected function will be
highlighted in orange.
e Press the FUNC button repeatedly or push the joystick left/
right to select a different function.
2 Push the joystick up/down or turn the SELECT dial to
select the desired value or white balance mode.
e The selected value/mode will be set and direct setting
mode will end.

e The onscreen display of the selected function will return to
normal.

(i) NoTES

¢ The camera will automatically end the direct setting mode in the following cases.
- If no operation was performed for more than 6 seconds.
- If the menu or a status screen was opened.




Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Video Configuration: Video Format, Sensor Mode, System
Frequency, Resolution and Frame Rate

In CAMERA mode, you can set the video configuration used for primary clips with the following procedures.
Select the video format, sensor mode, main recording destination, main recording format, resolution (frame size),
system frequency and frame rate settings that best match your creative needs. Available options for some
settings may change depending on previous selections for other settings. See the tables following the
procedures for a summary.

Select the Main Recording Destination

Select the media on which the main clip will be recorded.

1 Select MENU > [£% Recording/Media Setup] > [Main Recording Destination].
2 Select the desired option.

Selecting the Sensor Mode

You can change the area of the imaging circle covered by the CMOS sensor to produce the recorded image.

1 Select MENU > [£% Recording/Media Setup] > [Sensor Mode].
2 Select the desired option.

Selecting the System Frequency

You can change the system frequency also in MEDIA mode if you want to play back clips from a card recorded
with a different system frequency setting.

1 Select MENU > [£% Recording/Media Setup] > [System Frequency].

2 Select the desired option.
e The camera will reset and restart in the selected mode.

Selecting the Main Recording Format

Select the combination of video format, color sampling and bit depth for primary clips.

1 Select MENU > [£% Recording/Media Setup] > [Main Rec Format].

2 Select the desired option.
¢ When [Sensor Mode] is set to [Full Frame 3:2], only the RAW format can be selected.

Selecting the Resolution for the Main Clip
1 Select MENU > [£% Recording/Media Setup] > [Main Resolution].
2 Select the desired option.
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Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Selecting the Frame Rate

Select the frame rate for the primary clips. This procedure is not necessary when the system frequency is set to

24.00 Hz.

1 Select MENU > [£% Recording/Media Setup] > [Frame Rate].

2 Select the desired option.
e The selected frame rate will appear at the top of the screen.

Selecting the Bit Rate
This setting is only available for clips in a format other than RAW.

1 Select MENU > [£% Recording/Media Setup] > [Bit Rate].
2 Select the desired option.

Available video configuration settings (RAW)
Target recording media: CFexpress cards only

Main
Sensor mode  recording Resolution
format
RAW HQ
Full Frame 3:2* | RAW ST 6000x4000
RAW LT
RAW HQ
Full Frame RAW ST 6000x3164
RAW LT
RAW HQ
Super 35mm oA ST | 436842304
(cropped)
RAW LT
RAW HQ
Super 16mm 1 pa st | 218441152
(cropped)
RAW LT

Color
depth

12 bit

59.94P

59.94 Hz
29.97P
2730 Mbps

23.98P
2180 Mbps

50.00 Hz

50.00P

25.00P
2280 Mbps

24.00 Hz
24.00P
2180 Mbps

1340 Mbps
871 Mbps

1080 Mbps
697 Mbps

1120 Mbps
727 Mbps

1080 Mbps
698 Mbps

2160 Mbps

1730 Mbps

1800 Mbps

1730 Mbps

2130 Mbps

1070 Mbps

850 Mbps

1780 Mbps

886 Mbps

850 Mbps

1380 Mbps

690 Mbps

552 Mbps

1160 Mbps

576 Mbps

553 Mbps

2290 Mbps
1130 Mbps
732 Mbps

1150 Mbps
563 Mbps
366 Mbps

915 Mbps
451 Mbps
293 Mbps

1910 Mbps
939 Mbps
611 Mbps

954 Mbps
470 Mbps
306 Mbps

916 Mbps
451 Mbps
293 Mbps

574 Mbps

287 Mbps

230 Mbps

479 Mbps

240 Mbps

230 Mbps

283 Mbps

142 Mbps

113 Mbps

236 Mbps

118 Mbps

114 Mbps

184 Mbps

92 Mbps

74 Mbps

154 Mbps

77 Mbps

74 Mbps

* When using [Full Frame 3:2] for the first time, be sure to perform the black balance adjustment ([11 52).



Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Available video configuration settings (XF-AVC)
Target recording media:
CFexpress cards only:
- When the frame rate is 59.94P, the main resolution is 4096x2160 / 3840x2160 and the bit rate is
1200 Mbps / 900 Mbps.
- When the frame rate is 50.00P, the main resolution is 4096x2160 / 3840x2160 and the bit rate is
1000 Mbps / 750 Mbps.
CFexpress and SD cards: Any configuration other than the above.
. System frequency / Frame rate
Main
recording Main resolution / bit rate 59.94 Hz 50.00 Hz 24.00 Hz
et 50.94P  59.94i 29.97P 2398P 50.00P  50.00i 25.00P  24.00P

1200 Mbps Intra-frame o - - - - _ _ _

1000 Mbps Intra-frame - - - - o - - -

900 Mbps Intra-frame [ ] - - - — _ _ _
750 Mbps Intra-frame - - - - o - - -

600 Mbps Intra-frame o - o - - - - —

500 Mbps Intra-frame - - - - (] - o -

480 Mbps Intra-frame - - - @ - - - o

4096x2160

3840x2160 450 Mbps Intra-frame - - [ ] - - - - _

375 Mbps Intra-frame - - - - - _ ™Y _
360 Mbps Intra-frame - - - o - - - o

XF-AVC

300 Mbps Intra-frame - - [ } - - - - _
YCC422

10 bit 250 Mbps Intra-frame - - - - - - [ —

240 Mbps Intra-frame - - - @ - - - o

250 Mbps Long GOP o - - - o _ — _

150 Mbps Long GOP - - o o - - [ J o
300 Mbps Intra-frame o - - - - _ _ _

250 Mbps Intra-frame - - - - (] - - _

150 Mbps Intra-frame - o' ) - _ _ _ _

2048x1080

R _ _ _ _ _ 1 _
1920x1080 125 Mbps Intra-frame o ™Y

120 Mbps Intra-frame - - -
50 Mbps Long GOP o o' ™
25 Mbps Long GOP - o' - _ _ o . -

1'1920x1080 only.
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Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Available video configuration settings (XF-AVC S)
Target recording media:
CFexpress cards only:

- When the frame rate is 59.94P, the main resolution is 4096x2160 / 3840x2160 and the bit rate is

1200 Mbps / 900 Mbps.

- When the frame rate is 50.00P, the main resolution is 4096x2160 / 3840x2160 and the bit rate is

1000 Mbps / 750 Mbps.
CFexpress and SD cards: Any configuration other than the above.

Main
recording
format

XF-AVC S
YCC422
10 bit

XF-AVC S
YCC420
8 bit

Main resolution / bit rate

4096x2160
3840x2160

2048x1080
1920x1080

4096x2160
3840x2160

1200 Mbps Intra-frame

59.94P
(]

59.94 Hz
29.97P

System frequency / Frame rate

23.98P

50.00 Hz

50.00P

25.00P

24.00 Hz
24.00P

1000 Mbps Intra-frame

900 Mbps Intra-frame
750 Mbps Intra-frame

600 Mbps Intra-frame

500 Mbps Intra-frame

480 Mbps Intra-frame

450 Mbps Intra-frame

375 Mbps Intra-frame
360 Mbps Intra-frame

300 Mbps Intra-frame

250 Mbps Intra-frame

240 Mbps Intra-frame

250 Mbps Long GOP

150 Mbps Long GOP
300 Mbps Intra-frame

250 Mbps Intra-frame

150 Mbps Intra-frame

125 Mbps Intra-frame

120 Mbps Intra-frame
50 Mbps Long GOP
150 Mbps Long GOP

100 Mbps Long GOP

2048x1080
1920x1080

35 Mbps Long GOP




Video Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Available video configuration settings (XF-HEVC S)
Target recording media: CFexpress and SD cards.

System frequency / Frame rate

Main
recording Main resolution / bit rate 59.94 Hz 50.00 Hz 24.00 Hz 69
format 50.94P  29.97P  2398P  50.00P  2500P  2400P @ —
4096x2160 225 Mbps Long GOP (] - - [ ) — _
XF-HEVC S 3840x2160 135 Mbps Long GOP _ P ° - ° °
YCC422 10 bit | 2048x1080
19201080 50 Mbps Long GOP L [ ] [ ] [ J () )
4096x2160 150 Mbps Long GOP o - - M) _ _
XF-HEVCS | 3840x2160 100 Mbps Long GOP . ° ° - ° °
YCC420 10 bit | 20481080
19201080 35 Mbps Long GOP o [ ) o o () o

(1) NOTES

e For details on the signal output from each terminal, refer to Video Outout Configuration (11 159).
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Sub Recording Clips

Sub Recording Clips

While recording a primary clip to a CFexpress card, you can simultaneously record the same scene (sub
recording clips) to an SD card in a different video recording configuration. See the following tables for more
details on the video configuration for sub recording clips. For details, refer to Recording / Outout Signal and
Detailed Settings (11 228).

Sub recording format

XF-AVC XF-AVC S XF-HEVC S
RAW YCC422 YCC422 YCC420 YCC422 YCC420
10 bit 10 bit 8 bit 10 bit 10 bit
RAW - o @ o o o
XF-AVC YCC422 10 bit o @ o - -
i i YCC422 10 bit - @ o - -
Main recorijmg XF-AVC S _
format YCG420 8 bit - - ® - -
YCC422 10 bit - - - [ J ([ J
XF-HEVC S -
YCC420 10 bit - - - - ( J

* Sub recording clips cannot be recorded when [Sensor Mode] is set to [Full Frame 3:2].
1 Insert a CFexpress card and an SD card into the respective card slot.

2 Select MENU > [£% Recording/Media Setup] > [2nd Card Rec Functions] > [ Main / Sub Rec].
3 Select MENU > [£% Recording/Media Setup] > [(s2] Rec Format] > Desired option.
4 Select MENU > [£% Recording/Media Setup] > [[s2] Resolution] > Desired option.

5 Select MENU > [£3 Recording/Media Setup] > [(s] Frame Rate] > Desired option.
® Frame rate can only be selected with some main recording formats.

6 Select MENU > [£% Recording/Media Setup] > [[s®] Bit Rate] > Desired option.

7 Press the REC button to start recording.
e Proxy clips will be recorded simultaneously with the primary clips.

(i) Nnotes

e [f there is no card inserted in the slot used for the primary clip, only the sub recording clip will be recorded.



Proxy Clips (Simultaneous Recording)

Proxy Clips (Simultaneous Recording)

In CAMERA mode, while recording a primary clip on a CFexpress card, you can simultaneously record the same
scene as a proxy clip on the SD card. Because proxy clips have smaller files, they are suitable for offline editing.

Available configurations

Proxy clip

Recording

XF-AVC XF-AVC S XF-HEVC S
format

Resolution 2048x 1920x1080 2048x  1920x  1920x  1280x  2048x  1920x  1920x  1280x
1080 1080 1280 1080 720 1080 1280 1080 720

Scanning
method

Color YCC420 YCC420 YCC420
Sampling 8 bit 8 bit 10 bit 8 bit
Bit rate 35 Mbps 16 Mbps, 9 Mbps 6 Mbps 16 Mbps, 9 Mbps 6 Mbps

P P i P P

Main clip

Recording ) Scanning
format Resolution method

6000x4000 - - - - - [ ] - - - [ ) - -

RAW | Other than
the above

4096x2160
2048¢1080
XF-AVC | 3840x2160
1920x1080
1920x1080 | i - e o - - ) ) - - - -

4096x2160
2048x1080

XF-AVC S

3840x2160
1920x1080

4096x2160
2048x1080

XF-HEVC S

3840x2160
1920x1080

T if the proxy clip has a larger bit rate than the main clip, the bit rate of the proxy video cannot be selected.

1 Select the main recording format ([ 65).

2 Select MENU > [£% Recording/Media Setup] > [2nd Card Rec Functions] > [©/ Main / Proxy
Rec].

3 Select MENU > [ %

4 Select MENU > [£% Recording/Media Setup] > [[s2] Resolution] > Desired option.
5 Select MENU > [£% Recording/Media Setup] > [[s2] Frame rate] > Desired option.
6 Select MENU > [£% Recording/Media Setup] > [[s0] Bit rate] > Desired option.

7 Select MENU > [£% Recording/Media Setup] > [Proxy Rec Color Conversion] > Desired option.

e |f you select [Conform to Custom Picture], the gamma curve and color space are determined to conform to
the gamma curve of Custom Picture. Furthermore, if you select [BT.709 (Canon 709)] or [BT.709 (CMT 709)],
they are converted as follows.

Recording/Media Setup] > [[s2] Rec Format] > Desired option.
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Proxy Clips (Simultaneous Recording)

Gamma curve of Custom Picture

Gamma curve after conversion

BT.709 (Canon 709) BT.709 (CMT 709)
BT.709 Standard BT.709 Standard BT.709 Standard
BT.709 Wide DR BT.709 Wide DR BT.709 Wide DR
Canon 709 Canon 709 Canon 709
The gamma curve and color space after applying
the Look File and after conversion is one of the SDR SDR
[SDR] settings.
Other Canon 709 CMT 709

Color space after conversion

BT.709

e |f the gamma curve/color space in the custom picture is [PQ: BT.2020] / [HLG: BT.2020], or if the gamma
curve/color space after enabling and applying a Look File is one of the [HDR] settings, the value set for
MENU > [[E) Monitoring Setup] > [Gain for HDR = SDR Conv.] (11 172) is applied to the proxy clips as

well.

8 Press the REC button to start recording.
e Proxy clips will be recorded simultaneously with the primary clips.

(i) notes

e |f the recording of the primary clip stops during simultaneous recording, recording of the proxy clip will stop as

well.

e [f there is no CFexpress card inserted in the camera, only the proxy clip will be recorded.
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Shutter Speed

In CAMERA mode, you can set the shutter speed according to the shooting conditions. For example, you may
want to set slower shutter speeds in darker environments. The camera offers the following modes.
You can also perform this function remotely using Browser Remote on a connected network device (11 202).

[Speed]: Allows you to set the shutter speed (in fractions of a second). You can select the increment to use when
adjusting the shutter speed between 1/3-stop and 1/4-stop increments.

[Angle]: You can set the shutter angle to determine the shutter speed.

[Clear Scan]: Set the frequency in order to record CRT computer monitors without displaying black bands or
flicker on the screen.

[Slow]: You can set slower shutter speeds to obtain brighter recordings in places with insufficient lighting.
[Off]: The camera uses a standard shutter speed based on the frame rate.

Available shutter speeds

The individual setting options that can be selected will change depending on the frame rate used.

System frequency/Frame rate

Shutter speed mode 59.94 Hz 24.00 Hz 50.00 Hz
59.94P / 59.94i" 29.97P 23.98P 24.00P 50.00P/ 50.00i" 25.00P
1/3-stop 1/110 1/2000 (34 setting options in total)
increments
[Speed® 474 ctop
. 1/1 10 1/2000 (47 setting options in total) 1/1 o 1/2000 (45 setting options in total)
increments
[Angle]2 360.00°, 240.00°, 180.00°, 120.00°, 90.00°, 60.00°, 45.00°, 30.00°, 22.50°, 15.00°, 11.25°
Also angle values equivalent to the following shutter speeds: 1/120, 1/100, 1/60, 1/50, 1/40, 3/100, 1/30, 1/25.
23.97 Hz t0 1971 Hz
[Clear Scan]? Within the above range, the frequency can be set with the minimum available resolution depending on the sensor
mode and frame rate.
1/4,1/8,1/15, 1/3,1/6, 1/12,
[Slow]3 1/30 1/4,1/8,1/15 1/3,1/6,1/12 125 1/3,1/6,1/12
[0ff]2 1/60 1/30 1/24 1/50 1/25

1'59.94i and 50.00i are available only for XF-AVC primary clips.
2 When slow & fast motion recording is activated, available setting options will vary depending on the selected shooting frame rate.
3 Not available when slow & fast motion recording is activated.
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Shutter Speed

Changing the Shutter Speed Mode and Value
1 Select MENU > "™ Camera Setup] > [Shutter Mode] > Desired shutter speed mode.

2 For [Speed] only: Select MENU > "™ Camera Setup] > [Shutter Increment] >
[1/3 stop] or [1/4 stop].
3 Adjust the shutter speed, angle value or clear scan frequency using the direct setting mode ([1 64).
e After closing the menu, press the SHUTTER button to
highlight the shutter speed.
® The selected shutter speed will appear at the bottom of
the screen.

SHUTTER

Using slow shutter mode

When recording in dark surroundings, you can obtain a brighter picture by using slow shutter mode. You can
also use this mode when you wish to add certain effects to your recordings, such as blurring the background
during panning shots or recording a moving subject with an afterimage trail.

¢ Image quality may not be as good as when using faster shutter speeds in brighter surroundings.

Recording Under High-Frequency Light Sources

Flickering may occur when recording video under a rapidly blinking light source. When you execute [Auto Clear
Scan Setting], the camera detects the frequency of the light source (in a range of 50.0 Hz to 2011.2 Hz) and
shoots at a shutter speed that matches the blinking cycle, reducing flickering.

1 Select MENU > ["™ Camera Setup] > [Shutter Mode] > [Clear Scan].
2 Select MENU > ["™ Camera Setup] > [Auto Clear Scan Setting] > [OK].

3 Change the shutter speed to the displayed speed.
e When you select [OK], the shutter speed changes to the displayed speed.

When [No flicker detected.] is displayed, or when the flickering does not disappear even after changing to the
displayed shutter speed, perform the following operations:
e Execute [Auto Clear Scan Setting] again.
e Execute [Auto Clear Scan Setting] after changing the camera’s orientation by about 90 degrees.
e Adjust manually.
- Set a control dial / control ring to [Clear Scan (Steps)] or [Shutter] (11 224).
- With [Clear Scan (Steps)], you can change the shutter speed to 2, 3, or 4 times, or to 1/2, 1/3, or 1/4 times
the frequency set using [Auto Clear Scan Setting].
- With [Shutter] you can make fine adjustments.

(i) NoTes

¢ The accuracy of high-frequency flickering detection may be reduced under the following conditions.



Shutter Speed

- When there are repetitive patterns (such as grid or stripe patterns).
- When the subject is in constant movement.

- In extreme brightness or darkness.

- When there are multiple light sources in the screen.

- When the blinking light source is too small.

- When the subject illumination is low.

Flicker Reduction

You can perform the following procedure to have the camera automatically detect and reduce flicker.

Select MENU > ["™ Camera Setup] > [Flicker Reduction] > [Automatic].

(i) NoTES

¢ \When recording under artificial light sources such as fluorescent, mercury or halogen lamps, the screen may
flicker depending on the shutter speed. You may be able to avoid flicker by setting the shutter speed mode to
[Speed] and the shutter speed to a value matching the frequency of the local electrical system: 1/50* or 1/100
for 50 Hz systems, 1/60 or 1/120 for 60 Hz systems.
* May not be available depending on the frame rate.

¢ Closing down the aperture when recording under bright conditions may cause the picture to appear soft or out
of focus. The following measures may be effective in avoiding the loss of sharpness due to diffraction.
- Using a denser ND filter (11 80).
- Using a faster shutter speed.
- Applying diffraction correction ([J] 37). Results may vary depending on the lens used.

¢ \When the shutter speed mode is set to [Slow], bright red, green or blue dots may appear on the screen. In
such case, use a faster shutter speed or select a lower ISO speed or gain value ([T] 76).

¢ \When an optional RC-V100 Remote Controller is connected to the camera, you can change the shutter speed
mode with the remote controller’'s SHUTTER SELECT button and the shutter speed value with the remote
controller's SHUTTER A /W buttons.
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ISO Speed/Gain

ISO Speed/Gain

You may want to adjust the brightness of the image according to the shooting conditions. You can choose
between manual and automatic settings. By choosing manual settings you can change the ISO speed or gain
value to adjust the sensitivity of the sensor. You can also set the camera’s base ISO speed by choosing from four

modes.

You can also perform this function remotely using Browser Remote on a connected network device (11 202,

206).

Available ISO speed and gain settings1

ISO
Increment Base ISO Available settings
[Auto Selection] 100", 1602, 200, 400, 800, 1600, 3200, 6400, 12800, 25600, 51200, 102400’
[Base IS0 1601/ [Base IS0 4001 /4551 1602, 200, 400, 800, 1600, 3200, 6400, 12800"
[Base 1SO 800]
1 sto
[1'stop] | [Base IS0 6401 / [Base ISO 1600}/ | y11 6402 g 1600, 3200, 6400, 12800, 25600, 51200"
[Base IS0 3200]
[Base IS0 2500] / [Base 1SO 6400] / | ) ’ |
[Base IS0 12800] 16007, 25002, 3200, 6400, 12800, 25600, 51200, 102400
1007, 125", 160, 200, 250, 320, 400, 500, 640, 800, 1000, 1250, 1600, 2000, 2500,
[Auto Selection] 3200, 4000, 5000, 6400, 8000, 10000, 12800, 16000, 20000, 25600, 32000", 40000,
51200, 64000, 800007, 102400
[Base IS0 160] / [Base IS0 400] / | 1007, 125, 160, 200, 250, 320, 400, 500, 640, 800, 1000, 1250, 1600, 2000, 2500,
[1/3stop] | [Base ISO 800] 3200, 4000, 5000, 6400, 8000", 10000", 12800"
[Base IS0 640] / [Base IS0 1600] / | 4007, 500", 640, 800, 1000, 1250, 1600, 2000, 2500, 3200, 4000, 5000, 6400, 8000",
[Base IS0 3200] 10000, 128007, 16000, 20000, 25600, 32000', 40000, 51200°
[Base SO 2500] / [Base IS0 6400] / | 16007, 2000, 2500, 3200, 4000, 5000, 6400, 8000, 10000, 12800, 16000, 20000,
[Base IS0 12800] 25600, 320007, 40000', 51200, 640007, 800007, 102400'
Gain
Increment Base ISO Available settings
[Auto Selection] -6 dB', -3 dB, —2 dB? to 42 dB, 45 dB', 48 dB', 51 dB', 54 dB!
[Base ISO 160] / [Base ISO 400] /
[Normal] | [Base ISO 640] / [Base IS0 800]/ | —6 dB, -3 dB, —2 dB? to 30 dB, 33 dB', 36 dB!
(3dB) | [Base ISO 1600] / [Base ISO 3200]
[Base IS0 2500] / [Base IS0 6400] / | . o1 o oy o 0o ; ; ) )
[Base 150 12800] 6 dB', -3 dB", -2 dB2 to 18 dB, 21 dB', 24 dB', 27 dB', 30 dB
) —2 dB to 54 dB!
[Auto Selection] 9 dB to 42 B2
[Base IS0 160] / [Base IS0 400] / | _ ]
[Fine] (0.5 dB) | [Base ISO 640] / [Base IS0 800] / _; gg :g gg ggz
[Base IS0 1600] / [Base SO 3200]
[Base ISO 2500] / [Base IS0 6400] / | —2 dB to 30 dB'

[Base ISO 12800]

T When [ISO/Gain Extended Range] is [On].
2 When [ISO/Gain Extended Range] is [Off].

—2 dB to 18 dB?
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ISO Speed/Gain

Set the base ISO speed for the recommended dynamic range. You can achieve low noise even at high ISO/gain
levels by switching to one of three settings that suit different lighting conditions (normal lighting, low light, and
dark places). Additionally, the [Auto Selection] setting automatically switches between three levels of base ISO
according to the ISO/gain value, ensuring an optimal dynamic range and S/N ratio.

Select MENU > '™

Camera Setup] > [Base ISO] > Desired option.

¢ Available values will depend on the [Gamma/Color Space] setting in the custom picture file and the recording

format.

(i) NoTes

e |f you select an ISO/gain value below the base ISO speed, white clipping in the highlights is more likely to

OcCcur.

e There is a difference in the amount of noise between each base ISO speed setting. Example: when comparing
base ISO 800/ISO 800, base ISO 3200/1SO 3200, and base ISO 12800/I1SO 12800, there is a difference in the
amount of noise generated in the dark areas.

Base ISO settings

Gamma curve

[Canon Log 2] / [Canon Log 3]
(Also applies when the main recording
format is RAW)

1S0]

[Auto Selection], [Base ISO 800], [Base IS0 3200],

[Base ISO 12800]

[Gain]

[Auto Selection], [Base IS0 800 (12 dB)],
[Base IS0 3200 (12 dB)], [Base IS0 12800 (12 dB)]

[PQ] / [HLG] / [Canon 709] /
[BT.709 Wide DR]

Base IS0 6400]

Auto Selection], [Base IS0 400], [Base ISO 1600],

[Auto Selection], [Base ISO 400 (6 dB)],

[BT.709 Standard]

Auto Selection], [Base ISO 160], [Base IS0 640],
Base IS0 2500]

[Base ISO 1600 (6 dB)], [Base ISO 6400 (6 dB)]
[

Auto Selection], [Base ISO 160 (-2 dB)],
[Base IS0 640 (-2 dB)], [Base ISO 2500 (-2 dB)]

Changing the ISO Speed or Gain Value

1 Select MENU > ['™
2 Select MENU > '™

speed) or [Gain Increment] (gain).

Camera Setup] > [ISO/Gain] > [ISQO] or [Gain].
Camera Setup] > [ISO/Gain Mode]
3 Depending on your previous selection, select MENU > "™

> [Manual].
Camera Setup] > [ISO Increment] (ISO

4 Adjust the ISO speed or gain value using the direct setting mode (1] 64).

e After closing the menu, press the ISO/GAIN button to highlight
the ISO speed or gain value.

e The selected ISO speed/gain value will appear at the bottom of

the screen.

ISO/GAIN

7
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Automatic ISO speed/gain settings

The sensitivity limit will be set automatically according to the [Gamma/Color Space] setting in the custom picture
file.

Gamma curve Base IS0" Lower sensitivity limit
[Auto Selection]
IS0 800 (Gain 12 dB)
[Canon Log 3] [Base IS0 800]
[Canon Log 2] [Base 1SO 3200] 1S0 3200 (Gain 12 dB)
[Base ISO 12800] 1SO 12800 (Gain 12 dB)
[Auto Selection] )
[BT.709 Wide DR] 1SO 400 (Gain 6 dB)
[PQ] [Base IS0 400]
[HLG] [Base 1SO 1600] 1S0 1600 (Gain 6 dB)
[Canon 709]
[Base IS0 6400] 1SO 6400 (Gain 6 dB)

[Auto Selection]
[Base ISO 160]
[Base IS0 640] IS0 640 (Gain —2 dB)
[Base IS0 2500] ISO 2500 (Gain —2 dB)

ISO 160 (Gain —2 dB)

[BT.709 Standard]

T When the main recording format is RAW, the available base 1SO settings are the same as when the gamma curve component of
the [Gamma/Color Space] setting in the custom picture file is set to [Canon Log 2] / [Canon Log 3].

Select MENU > ["™ Camera Setup] > [ISO/Gain Mode] > [Automatic].

(i) Nnotes

¢ You can set the responsiveness of the automatic exposure function with the MENU > ["™ Camera Setup] >
[AE Response] setting™.
* Except when using an incompatible lens ([1] 276).

Setting an automatic ISO limit
By setting an ISO limit in automatic mode, you can curb the amount of noise and keep a dark ambient.
Select MENU > "™ Camera Setup] > [Limit for Auto Mode] > Desired option.
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Using the Control Dials

You can also adjust the ISO speed or gain value using the control dial on the camera or the one on the camera
grip. You will need to set in advance the function of one of the control dials to [ISO/Gain]. You can select the
function assigned to each control dial independently.

1 Select MENU > [¥ System Setup] > [Camera Cirl Control dials
Dial] or [Grip Ctrl Dial] > [ISO/Gain].

2 After closing the menu, turn the control dial
assigned to [ISO/Gain] to set the desired ISO speed
or gain value.
¢ To select whether to change the ISO speed or the

gain, perform step 1 of the previous procedure

(@77).

(i) NoTes

¢ \When high ISO speeds or gain levels are set, the picture may flicker slightly.

¢ \When high ISO speeds or gain levels are set, bright red, green or blue dots may appear on the screen. In such
case, use a faster shutter speed ([ 73) or select a lower ISO speed or gain value.

e \When the ISO speed or gain level is changed, some noise may appear momentarily on the screen. Do not
adjust the ISO speed/gain level while recording.

¢ When an optional RC-V100 Remote Controller is connected to the camera, you can adjust the ISO speed or
gain value with the remote controller’s ISO/GAIN A /W buttons.
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ND Filter

ND Filter

In CAMERA mode, using the ND filter allows you to open up the aperture to obtain a shallower depth of field
even when recording in bright surroundings. You can also use the ND filter to avoid the soft focus caused by
diffraction when using small apertures. By default, you can select one of 3 density levels (up to 6 stops in 2-stop
intervals). If you enable the extended ND range, you can select one of 5 density levels (up to 10 stops in 2-stop
intervals).

You can also perform this function remotely using Browser Remote on a connected network device ([11 202).

Press the ND FILTER + or - button to select the desired ND
filter setting.

ND Filter Range FI’L‘TDIER
Displayed units °o Sa @
Stop Transmittance Optical Density og O] {7 - —
0 171 0.0 ° 0 < 0 @
2 1/4 0.6 0 0% B
4 116 12 o
6 1/64 1.8
8 1/256 24
10 1/1024 3.0

¢ Repeatedly pressing ND FILTER + button will change the ND filter setting in the following order: [ND 2 stops] —
[ND 4 stops] — [ND 6 stops] — [ND 8 stops]* — [ND 10 stops]* — ND filter off. (The ND FILTER - button cycles
through the settings in reverse order.)

e The selected ND filter setting will appear at the bottom of the screen.

* Only when MENU > ["™ Camera Setup] > [Extended ND Range] is set to [On].

¢ For the displayed units ("™ Camera Setup] > [ND Display Units]), you can choose from [Stop], [Transmittance]
or [Optical Density].

(i) notes

¢ |f you set an assignable button to [ND +] or [ND -] (11 133), you can press the button to change the ND filter
setting.
¢ Depending on the scene, the color may change slightly when turning the ND filter on/off. Setting a custom
white balance ([ 85) may be effective in such case.
¢ About the extended ND range: \When you switch to or from a density level in the extended range (8 or 10 stops),
you may notice one or both of the following circumstances.
- The focus may shift, affecting also the indication on the lens’s focus distance scale.
- Depending on the lens, the camera may not be able to focus at infinity focus.
e Changing the ND filter setting using the optional RC-V100 Remote Controller:
- When the remote controller is connected to the camera, you can use the remote controller’s ND button in
the same way as the camera’s ND FILTER + button.
- For settings between 2 and 8 stops, the corresponding ND filter indicator (1 to 4, respectively) will illuminate
in orange. When the ND filter is set to 10 stops, indicators 1 and 4 will both illuminate.



Aperture

Aperture

In CAMERA mode, you can affect the brightness of your recordings or change the depth of field by adjusting the
aperture. Depending on the lens used, the aperture value displayed may differ (F value or T value) and available
aperture values will vary as well. You can select the adjustment increment and even use the smallest iris
increment allowed by the lens.

Manual aperture: Adjust the aperture value manually.
Automatic aperture: The camera adjusts the aperture automatically.

Push Auto Iris: Momentary automatic aperture. During manual aperture, press the assignable button set to [Push
Auto Iris] to temporarily adjust the aperture automatically (only while the button is held pressed down).

Aperture Settings of the Lens

To adjust the aperture from the camera, you will need to enable automatic adjustment using the controls on the
compatible EF Cinema/RF (with iris ring) lens. Required settings vary depending on the lens. Refer to the
instruction manual of the lens used.

Set the lens or iris ring to automatic aperture.

Manual Aperture: Changing the Aperture Value

1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Manual].

¢ This setting is available only when a lens compatible with automatic aperture is attached to the camera. For

non-compatible lenses, the aperture mode is automatically set to [Manual] and cannot be changed.
2 Select MENU > ["™ Camera Setup] > [Iris Increment] > [1/2 Stop] or [1/3 Stop].

* You can also set MENU > ["™ Camera Setup] > [Fine Increment] to [On] to use the smallest iris increment
allowed by the lens attached. Nevertheless, the aperture value displayed on the screen will be the closest
value in the selected increment scale.

3 Adjust the aperture value using the direct setting mode ([ 64).

e The selected aperture value will appear at the bottom of the screen.
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Aperture

Using the Control Dials

You can also adjust the lens’s aperture value using the control dial on the camera or the one on the camera grip.
By default, the function of both control dials is set to [Iris]. You can select the function assigned to each control
dial independently.

1 Select MENU > [¥ System Setup] > [Camera Ctrl Dial] or [Grip Ctrl Dial] > [lris].
2 After closing the menu, turn the control dial assigned to [Iris] to adjust the aperture.

(i) NoTES

e If you set an assignable button to [Iris +] or [Iris -] (11 133), you can press the button to respectively open up
or close down the aperture.

¢ When using a lens with no lens contacts or unsupported lenses ([J1 276), you cannot adjust the aperture
using the camera. Adjust the aperture using the lens.

¢ \When using a lens that can correct the aperture value according to the position of the zoom, you can use the

MENU > "™ Camera Setup] > [Zoom-Iris Correction] setting to activate this correction.

When an optional RC-V100 Remote Controller is connected to the camera, you can adjust the aperture with

the remote controller’s IRIS dial. At default settings, turn the dial right to open up the aperture and left to close

the aperture.

Using an RF/EF Cinema lens

- The aperture value displayed on the screen will be a T value*. The aperture value (T value) displayed on the
screen may differ from the indication on the lens’s aperture scale.
* Updating the firmware is necessary for RF Cinema lenses (11 36).

- When the iris is almost fully closed, the aperture value (T value) will appear in gray on the screen.

- When you change the aperture value from a position of fully open or fully closed iris, multiple adjustment
operations may be required until the aperture changes.

If you use the EF-EOS R 0.71x Mount Adapter to attach an EF lens, the aperture will be approximately one

level brighter than the value indicated by the lens.

Momentary Automatic Aperture - Push Auto Iris

During manual aperture, you can press an assignable button set to [Push Auto Iris] to have the camera
temporarily take control and adjust the aperture automatically for an optimal exposure.
This function is not available when slow & fast motion recording is activated.

1 Assign an assignable button to [Push Auto Iris].
2 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Manual.

3 Press and hold the assigned button.
e The camera will automatically adjust the aperture to obtain optimal exposure. As long as you hold the button
pressed down, B will appear on the screen next to the aperture value.
¢ When you release the button, automatic aperture mode will end and the [ icon will disappear. The selected
aperture value will appear at the bottom of the screen.

(i) Nnotes

* You can use the MENU > ["™ Camera Setup] > [AE Response] setting to change how quickly the aperture
changes during automatic aperture mode. This setting has no effect when using an incompatible lens

(1 276).
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Automatic Aperture

When a compatible lens is attached to the camera, you can have the camera automatically adjust the aperture.
This function is not available when slow & fast motion recording is activated.

1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Automatic].

e The camera will automatically adjust the aperture to obtain optimal exposure. The selected aperture value
will appear at the bottom of the screen with an [ icon next to it.

(i) NoTEs

e If you set an assignable button to [Iris Mode] ((1d 133), you can press the button to toggle between the
[Automatic] and [Manual] settings when a compatible lens (1 276) is attached to the camera.

¢ The aperture value may change in the following cases.
- While using the built-in extender or iris compensation function of an EF Cinema lens, when you switch from

automatic aperture to manual aperture.

- When the aperture controls on the lens are switched between automatic/manual mode.

¢ When using EF Cinema lenses that let you adjust the aperture gain, if the aperture gain is set too high, the
aperture adjustment may not be stable (“aperture hunting”), depending on the shooting conditions. In such
case, reset the lens’s aperture gain to its initial value.

Exposure Compensation - AE Shift

Use AE shift to compensate the exposure that was set using automatic aperture, in order to darken or lighten the
image.

You can also perform this function remotely using Browser Remote on a connected network device ([1] 202).

1 Select MENU > ["™ Camera Setup] > [AE Shift].

2 Select the desired option.
® You can select one of 17 AE shift levels from -2.0 to +2.0.

¢ The selected AE shift level will appear next to the exposure bar and the camera will attempt to adjust the
exposure accordingly.

(i) NoTES

e |f you set an assignable button to [AE Shift +] or [AE Shift -] (1] 133), you can press the button to adjust the
AE shift level.

The exposure bar

The W on top of the exposure bar indicates optimal exposure without any shift
(AE+0); the scale markings indicate the deviation from optimal exposure in |

1/2 EV increments. The indicator inside the exposure bar represents the current
exposure. When the difference between current and optimal exposure is larger |

than +£2 EV, the indicator will flash at the edge of the exposure bar. Optimal Current exposure
exposure will change depending on the light metering mode used.

Optimal exposure AEx0

Light Metering Mode

Select the light metering mode to match the recording conditions. Using the appropriate setting will help achieve
a more appropriate exposure level when adjusting the exposure manually or using an automatic aperture
function.
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Aperture

1 Select MENU > ["™ Camera Setup] > [Light Metering].

2 Select the desired option.
e The icon of the selected mode (¥ or /e, no icon for [Standard]) appears on the left of the screen.

Options

[Backlight]: Suitable when recording backlit scenes.

[Standard]: Averages the light metered from the entire screen, giving more weight to the subject in the center.
[Spotlight]: Use this option when recording a scene in which only a certain part of the picture is lit, for

example, when the subject is lit by a spotlight.

(i) NOTES

e |f [EOS Standard] or [EOS Neutral] is selected for [Select File], the light metering mode cannot be selected
and will be the same as in the EOS R series. However, it can be selected if the custom picture file is edited
(gamma adjustment, registering a different LUT as a Look File).

¢ If you set an assignable button to [Backlight] or [Spotlight] (11 133), you can press the button to turn the
respective light metering mode on and off.
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White Balance

In CAMERA mode, the camera uses an electronic white balance process to calibrate the picture and produce
accurate colors under different lighting conditions. The camera offers the following ways to set the white
balance.

You can also perform this function remotely using Browser Remote on a connected network device ([1] 202).

Custom white balance: You can use a gray card or white object with no pattern to establish the white balance
and set it to one of two custom white balance positions, %A or 24 B. When recording under fluorescent lights,
we recommend setting the custom white balance.

V.

Preset white balance: Set the white balance to 8¢ (daylight) or $¢ (tungsten lamp). You can further adjust the
color temperature (K) value and the color compensation (CC) value, which adjusts the color along the green/
magenta gradation.

Color temperature: Allows you to set the color temperature between 2,000 K and 15,000 K, and further adjust
the color compensation (CC) value.

Auto white balance (AWB): The camera automatically adjusts the white balance to the optimal level.

(i) NoTEs

¢ The [White Balance] setting in the custom picture file ((J] 145) takes precedence over the white balance set
with these procedures.

¢ You can use the MENU > ["™ Camera Setup] > [Shockless WB] setting to make the transition look smoother
when you change the white balance settings.

* You can use the MENU > ["™ Camera Setup] > [C. Temp. Increment] setting to change the units for the color
temperature increment to [Mired] (5-mired increments) or [Kelvin] (100-kelvin increments). Even when [Mired] is
selected, the color temperature is converted to and displayed in kelvins. Changing this setting may change the
white balance setting.

¢ When an optional RC-V100 Remote Controller is connected to the camera, you can adjust the white balance
with the remote controller's AWB button, A button, B button, PRESET button and =4 button.

e The color temperatures displayed on the screen are approximate. Use them only as a reference.

Custom White Balance

1 Press the WB button.
¢ The camera will enter the direct setting mode ([ 64) with the
white balance mode icon highlighted.
2 Select the L4A or 4B icon.

e Press SET to apply the stored custom white balance setting as
is. The rest of the procedure is not necessary. To set a new
custom white balance, continue the procedure.

3 Point the camera at a gray card or white object so that it fills
the whole screen.

¢ Use the same lighting conditions you plan to use when
recording.

>/l INDEX/H
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White Balance

4 Press the = button.
* The o A or 4 B icon will flash quickly.
* Make sure the gray card or white object fills the screen until the procedure is completed.

¢ Once the icon stops flashing, the procedure is completed. The setting is retained even if you turn off the
camera.

e The color temperature and CC value registered by the camera will appear at the bottom of the screen next
to the oA or ®aBicon.

(i) notes

e Readjust the custom white balance if the light source or ND filter setting changes.
e \ery rarely and depending on the light source, x4 may keep flashing (it will change to a slow flashing). The
result will still be better than with auto white balance.

e After the camera registers a custom white balance the color temperature or CC value may appear in gray. This
indicates that the value registered exceeds the range of values that can be displayed but the white balance is
correctly calibrated and you can continue shooting.

Color Temperature/Preset White Balance

1 Press the WB button.

¢ The camera will enter the direct setting mode ([1] 64) with the
white balance mode icon highlighted.

2 Select the :8: or 8¢ icon (preset white balance), or the [d
icon (color temperature setting).
e Press SET to apply the stored preset setting or color
temperature as is. The rest of the procedure is not necessary.
To adjust the color temperature or CC value, continue the
procedure.

3 Press the =4 button.

® The camera will enter the direct setting mode with the color
temperature highlighted in orange. To adjust the CC value,
push the joystick right.

>/l INDEX/H

4 Select the desired value.

e The selected color temperature and CC value will be set and will appear on the screen next to the white
balance icon.

Adjustment ranges

. . Adjustment range
White balance mode/setting

Color temperature (K) Color compensation (CC) value
@z (daylight) 4,300 K to 8,000 K St045
-5t0 +
82 (tungsten lamp) 2,700 K to 3,700 K

8 (color temperature) 2,000 K to 15,000 K -20to +20




White Balance

Auto White Balance (AWB)

The camera constantly adjusts the white balance automatically to achieve an appropriate level. The camera will
adjust the white balance if the light source changes.

1 Press the WB button.

¢ The camera will enter the direct setting mode ([ 64) with the
white balance mode icon highlighted.

2 Select the [ icon.

® The color temperature and CC value set automatically by the
camera will appear at the bottom of the screen next to the [
icon.

(i) NoTES

e Custom white balance may provide better results in the following
cases:

- Changing lighting conditions

- Close-ups

- Subjects in a single color (sky, sea or forest)

- Under mercury lamps and certain types of fluorescent and LED lights

You can use the MENU > ["™ Camera Setup] > [AWB Response] setting to change how quickly the white
balance changes in auto white balance (AWB) mode.

If you set an assignable button to [AWB Lock] ([J] 133), you can press the button to lock the current white
balance settings set automatically by the camera. To cancel the lock, press the button again (resume auto
white balance mode) or select a different white balance setting.
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Focus

In CAMERA mode, the camera offers the following ways to focus, depending on the lens used. The camera
incorporates Dual Pixel CMOS AF technology for advanced autofocus performance with compatible lenses.
Refer to the list of compatible lenses and functions that can be used ([I] 276).

You can also adjust the focus remotely using Browser Remote on a connected network device ([1] 202).

Manual focus (MF): Turn the focus ring on the lens to adjust the focus. The camera offers several focus
assistance functions ([ 89) to help you focus more accurately when using the manual focus.

Automatic focus (AF): The focus is adjusted automatically.

- One-shot AF*: You will be able to focus manually but still have the option to press the One-Shot AF button to
let the camera focus automatically once on the subject inside the AF frame.

- Continuous AF*: The camera automatically keeps the subject inside the AF frame in focus at all times. You
can use the AF lock function (11 93) to change the composition of the picture while keeping the focus on
the selected spot.

Functions related to focus adjustment:

- Subject detection: Set a subject to be detected in advance to automatically detect the face/head, eyes or
body of a person or an animal.

- Subject tracking: After you select a subject, the camera keeps focusing it and tracks the subject if it moves.

* Not available when a manual focus lens is attached to the camera.

Focus Mode on the Lens

Use the switch on the lens to select the lens’s focus mode (automatic, manual). The name of the controls may
differ depending on the lens. Refer to the instruction manual of the lens used.

Set the lens’s focus mode to either automatic or manual.
e Either (automatic) or (MF) (manual) will appear on the screen.

¢ When using a lens without a focus mode switch, select MENU > ["™ Camera Setup] > [Focus Mode] > [AF]
(automatic) or [MF] (manual).

Manual Focus
Focus manually using the focus ring on the lens.

Turn the focus ring to adjust the focus.

(i) NoTES

¢ With some lenses, you may be able to operate the focus ring even when the focus mode is set to automatic.
e |f you operate the zoom after focusing, the focus on the subject may be lost.
¢ |f you focus manually and then leave the camera with the power turned on, the focus on the subject may be

lost after a while. This possible slight shift in focus is a result of the internal temperature rising in the camera
and lens. Check the focus before resuming shooting.
¢ \When adjusting the focus, be careful not to touch the front of the lens or moving parts on the lens except for
the focus ring.
¢ About focus ring operation (RF lenses):
- You can change the operation direction of the focus ring from MENU > [§ System Setup] > [Focus Ring
Direction].
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- Select MENU > [¥ System Setup] > [Focus Ring Response] to select whether the focus operation is linked
to the rotation degree or the rotation speed of the focus ring.

- When the lens focus mode is set to AF (autofocus), you can enable/disable manual adjustment from MENU
> [ System Setup] > [Focus Ring Operation].

Using the Focus Assistance Functions

In order to focus more accurately, you can use the following focus assistance functions: Dual Pixel Focus Guide,
an onscreen guide that shows you if the selected subject is in focus; peaking, which creates a clearer contrast
by emphasizing the outlines of the subject; and magnification, which enlarges the image on the screen. You can
use peaking and the focus guide or peaking and magnification simultaneously for greater effect.

Focus guide
The focus guide gives you an intuitive visual indication of the current focus distance and the direction and
amount of adjustment necessary to bring the selected subject into full focus. When used in combination with
subject detection (1] 94), the guide will focus as follows: if set to [People] / [Animals], on the face (or body, if a
face cannot be detected) of the subject. If [Eye Detection] is set to [On], the guide will focus on the vicinity of the
eyes of the detected person or animal.
1 Set the focus mode switch on the lens to MF.

o (MF) will appear on the left of the screen.
2 Select MENU > [ Assistance Functions] > [Focus Guide] > [On].
3 Touch the point where you want to focus on the LCD screen to move the focus guide.

e You can also use the joystick to move the focus guide’s frame. Press SET or the CANCEL button to return

the focus guide’s frame to the center of the screen.

4 Adjust the focus manually as necessary.

* \When the focus guide turns green, the subject is correctly focused.

Focus farther Focus farther In focus Focus closer Focus closer Cannot determine

(large adjustment) (small adjustment) (in green) (small adjustment) (large adjustment) adjustment

(i) NoTes

¢ With subjects or in situations where autofocus may not work well (1] 92), the focus guide may not work
correctly.

¢ The focus guide cannot be used in the following cases:
- While the focus is being adjusted automatically using one-shot AF or continuous AF.

- When a manual focus lens is attached to the camera, except for compatible RF/EF Cinema lenses ([1] 276).
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Peaking
The camera offers two peaking levels.

1 Press the PEAKING button.

e The peaking icon (I8 or {I®) appears on the left of the
screen and outlines (contour lines) in the image that are in
focus will be shown highlighted.

e Press the button again to turn off peaking.

e Alternatively, you can use one of the MENU > [y Assistance
Functions] > [Peaking:] settings to turn the peaking function
on/off separately on the respective terminal/output
destination.

2 To change the peaking level, select MENU > [ Assistance
Functions] > [Peaking] > [Peaking 1] or [Peaking 2].

Magnification
1 Press the MAGN. button.
U appears on the left of the screen and the center of the screen* is magnified 2 times.
¢ The orange frame displayed on the top right of the screen (magnification frame) shows the approximate part
of the image shown magnified.
® Press SET to change the magnification setting in the following order: 2x = 5x = 10x = 2x.
2 If necessary, use the joystick to move around the magnification frame and check other parts of the image.
e You can also drag your finger across the LCD screen to move the frame.
e Press the CANCEL button to return the magnification frame to the center position.

e Press the MAGN. button again to cancel the magnification.

* If one of the AF frames or subject detection frame is displayed on the screen, the area around the active frame will be magnified
instead.

(i) NoTes

¢ About Peaking/Magnification:
- You can use the MENU > [ Assistance Functions] > [Peaking 1] and [Peaking 2] settings to set the color,
gain and frequency of the two peaking levels independently of each other.
- You can use the MENU > [ Assistance Functions] > [Magn. Output] setting to select where to show the
magnified image (the LCD screen or external monitors).
- The assistance functions will not affect your recordings.
- Magnification will be turned off if you adjust one of the following menu settings or if you turn slow & fast
motion recording on/off while the magnified image is displayed.
[Sensor Mode], [Main Rec Format], [Main Resolution], [Bit Rate], [Frame Rate] or [Digital IS].
e Peaking/magnification are not available while the color bars are displayed.
¢ When MENU > [{& Assistance Functions] > [B&W during Magn.] is set to [On], the screen is set to black and
white during magnification. The assistance functions will not affect your recordings.
¢ Magnification cannot be displayed under the following conditions.

- When [Sensor Mode] is set to [Full Frame] or [Super 35mm (Cropped)] and the slow & fast motion recording
frame rate exceeds 60P.
- When [Sensor Mode] is set to [Full Frame], the main recording format is [RAW], and [SDI Output Signal] is
3840x2160 or higher.
® Peaking cannot be displayed under the following conditions.
- When [OSD Output: SDI] or [OSD Output: MON./HDMI] is set to [Off (Clean)] or [Off].
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Focus Position Guide
When a compatible lens (1] 276) is attached, you will be able to display the current focus position and the
preregistered focus positions. Depending on the lens, you may need to connect a 12-pin interface cable to the
LENS terminal on the camera.
1 Select MENU > [ Assistance Functions] > [Focus Position Guide] > [Display] > [On].
The focus position guide dedicated screen appears.
¢ You can also set [Orientation] and [Sensitivity] of [Focus Position Guide] ([11 220). [Sensitivity] is the level of
match (highlighting) between the current focus position and the registered focus positions, and the larger the
numeric value, the greater the match tolerance.
2 Set the focus position markers.
Select each of [Marker 1 Color] to [Marker 3 Color] and set the marker color.
3 Assign [Focus Position Marker 1] to [Focus Position Marker 3] to the assignable buttons (11 133).
4 Register the focus positions.
e |f you turn the lens’s focus ring, the current focus position appears. Press an assignable button at the

position you want to register. You can register up to three.
If you press and hold an assignable button, the registered focus position is cleared.

e [f the current focus position and a registered marker position match, a frame (highlighting) is displayed
around the screen.

(3: Current focus position
> P> : Registered focus positions

When normal When highlighting

(i) NoTes

e The screen display items are limited while the focus position guide is displayed. If you press the DISP button,
you can also change the DISP level from this screen (1] 59).

One-Shot AF

In this focus mode, you will focus manually in most situations but still have the option to have the camera focus
automatically only once on the subject inside the AF frame. You can change the size and position of the AF
frame.

1 Assign an assignable button to [One-Shot AF].
2 Set the focus mode switch on the lens to AF.
3 If necessary, change the type and position of the AF frame ([J1 94).

4 Press and hold the assigned button.
e As long as the assigned button is held down the camera will focus automatically.
* \When correct focus has been achieved, a green frame is displayed.

e |f [Continuous AF] is disabled and [Subject to detect] is set to [None], the AF frame will disappear when you
release the assigned button (after a certain time has passed).
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Continuous AF

The camera will focus automatically on a subject inside the area of the selected AF frame type ([ 94).
For details on compatible lenses, refer to Aopendix: Compatible Lenses and Functions ([11 276).

1 Set the focus mode switch on the lens to AR

2 Select MENU > ["™ Camera Setup] > [Continuous AF] > [Enable].
¢ A white AF frame will appear on the screen (if the AF frame type is set to an option other than [Whole Area]).
¢ When focusing nearer is not possible, the AF frame will turn red.

e If [Lens action if cannot AF] was set to [Stop], when distance measurement is not possible, the AF operation
is stopped, the focus position is fixed and the AF frame becomes yellow.

3 If necessary, change the type and position of the AF frame ([J1 94).

Subject Tracking Adjustment After Focus

After focusing manually on the desired subject, you can automatically track the subject using the [Track after
Focusing] function. When there is no subject in focus, subject tracking is not performed and the AF operation is
performed on the automatically detected subject. Available when Continuous AF is enabled.

1 Select MENU > ["®™ Camera Setup] > [Track after Focusing] > Desired option.
2 Turn the focus ring to adjust as needed.

Options for [Track after Focusing]:

[On (tracking frame)]:
An orange frame for trackable subjects is displayed on the screen during focus operation. After
the focus operation, the frame changes to a white double frame ¢ J (tracking frame) to perform
subject tracking.

[On (no tracking frame)]:
No frame for trackable subjects is displayed during focus operation. After the focus operation, a
white double frame ¢  (tracking frame) is displayed to perform subject tracking.

[Disable]: The subject is not tracked.

(i) NoTES

About the autofocus (AF) functions:

¢ The point where the camera focuses may change slightly depending on shooting conditions, such as subject,
brightness and zoom position. Check the focus before resuming shooting.

e Autofocus may take longer in the following cases.

- With some lenses, the camera may take longer to focus automatically or may not be able to focus correctly.
Visit your local Canon website for the latest information.

¢ You can change the adjustment speed and responsiveness of the autofocus function with the following
settings. Visit your local Canon website for the latest information.

- MENU > "™ Camera Setup] > [AF Speed] to set the AF speed (the speed at which the focus is adjusted)
to one of 10 levels.

- MENU > "™ Camera Setup] > [AF Response] to set the responsiveness of the autofocus function to one
of 7 levels.

- While using continuous AF, you can hold the assignable button set to [One-Shot AF] pressed down to
temporarily adjust the focus using the maximum AF speed and AF response. This is helpful when you want
to focus quickly after focus was lost.

e Continuous AF and one-shot AF will not work in the following cases.

- When the shooting frame rate in slow & fast motion recording is not set to 24, 25, 30, 48, 50, 60, 100 or

120 (fps).
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e Subject tracking after focus operation will not work in the following cases:
- During slow & fast motion recording when the frame rate is not set to 24, 25, 30, 48, 50, 60, 100 or 120
(fps).
- When the shutter speed used is slower than 1/30 (59.94 Hz recordings), 1/25 (50.00 Hz recordings) or 1/24
(24.00 Hz recordings or 59.94 Hz recordings with a 23.98P frame rate).
- When MENU > [ System Setup] > [Focus Ring Operation] is set to [Disable During AF].
- When [Tele-converter] is enabled.
- AF lock is enabled or the focus mode is set to MF.
- When there is no subject in focus on the screen.
- When operating the focus ring with a VR lens or a lens other than an RF lens attached to the camera.
- When operating the focus from a controller connected to the REMOTE terminal with an attached lens that
does not support tracking (11 276).
- When operating the focus using Browser Remote or an XC protocol-compatible device.
¢ In the following cases, you may not be able to select a subject or track the selected subject after focusing.
- When switching between multiple subjects at the same depth.
- In case of landscapes/distant subjects with a near identical depth.
- When the subject on the screen appears small.
e Autofocus may not work well on the following subjects or in the following cases. In such case, focus manually.

- Reflective surfaces - Through dirty or wet windows
- Subjects with low contrast or without vertical lines - Night scenes
- Fast moving subjects - Subjects with a repetitive pattern

- When using small apertures.

- When subjects at different distances appear in the picture.

- When an ISO speed or gain value in the extended range is selected ([1] 76).

- When the gamma curve component in the custom picture file is set to an option other than [BT.709
Standard].

- When the main recording format is set to RAW.

AF Lock
While using continuous AF, you can lock the focus on a certain subject and then move the camera to change the
composition.
1 While the autofocus is active, press the AF Lock button.
e The focus will be locked and and the AF frame will turn gray.
® Press the AF Lock button again to cancel the AF lock.
e When [Focus Guide] is set to [On], the frame on the screen changes to the focus guide frame.

¢ \When an assignable button set to [AF Lock (While Pressed)] is operated, the AF function is activated only
while the button is held pressed down.

(i) NoTes

e AF lock will be canceled automatically in the following cases:
- If the camera is turned off or the system frequency is changed.
- If the lens is removed or replaced.
- When MENU > ["™ Camera Setup] > [Continuous AF] is changed to [Disable].
- When slow & fast motion recording is activated and the shooting frame rate used is other than 24P, 25R,
30P, 48P, 50P, 60P, 100P or 120P.
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Changing the AF Frame Type

You can change the type of the AF frame that appears on the screen while using one of the autofocus functions.

1 Select MENU > ["™ Camera Setup] > [AF Frame] > Desired option.

[Small Zone] [Zone] [Large Zone: Horizontal] [Large Zone: Vertical] [Whole Area]
r i
r A r i
r A
L d
L 4 L 4
[ =l

(i) Nnotes

¢ When [Tele-converter] is enabled, the [Small Zone] frame will be displayed and the position will be [Center
Frame]. The size of the AF frame will change depending on the set magnification.

¢ On the LCD monitor, touch the subject you want to focus on to move the AF frame. You can also move the AF
frame by pressing the joystick up, down, left, or right. Press SET or CANCEL to move the AF frame back to the
center of the screen.

Subject Detection Function

The subject detection function automatically detects the face/head, eyes or body* of a person or animal,
according to the menu settings.

You can use subject detection with one of the autofocus functions to let the camera focus on the main subject
automatically. You can use the focus guide (11 89) in combination to help you focus on the main subject
manually.

* Detected when a person’s face/head (after being tracked once) is hidden from view.

1 Select MENU > ["™ Camera Setup] > [Subject to detect] > [People] or [Animals].
o B (People) or EY (Animals first) appears on the left side of the screen.

2 Select MENU > ["™ Camera Setup] > [Subj. Detect. AF] > [Detect. Priority] or [Detect. Only].
o @ (detection priority) or & (detection only) will appear on the left of the screen.

3 Select MENU > ["™ Camera Setup] > [Eye Detection] > [On].

4 Point the camera at the subject.

e \When [Subject to detect] is set to [People], a frame is displayed on all detected people. When set to [Animals],
a frame is displayed only the main subject (animals or people). The main subject is determined automatically
and is displayed in white when using autofocus, and in gray or yellow* when using manual focus.

* When [Continuous AF] is enabled, [Lens action if cannot AF] was set to [Stop], and distance measurement is not possible.

¢ \When multiple subjects are detected, < and P> are shown on the main subject frame. If [Subject to detect]
is set to [People], a gray frame is displayed on subjects other than the main subject. When < and P are
shown, pressing the joystick to the left/right switches the main subject to another subject and tracking
starts.

Options for [Subj. Detect. AF]
[Detect. Priority]: When a subject is not being detected, the camera determines the main subject and focuses on
it.
[Detect. Only]:  When a subject is not being detected, the camera locks the focus.
AF operation according to the [Subject to detect] settings is as follows:
- Continuous AF: The camera continuously focuses on the subject it determines to be the main subject.

- One-shot AF: When you press a button assigned to [One-Shot AF], the camera focuses on the subject it
determines to be the main subject.
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Operation by AF mode
Subj. Detect. AF

AF mode Focus operation [Detect Prlorl;r\ly] b — Only:l b
) 0 subject . 0 subject
Subject detected detected Subject detected detected

No button pressed
(manual focus)

Manual focus

Continuous AF: disabled
Button pressed down

(one-shot AF in operation)

Automatic

Continuous AF: enabled

Focus on the
detected subject

Focus on the
subject inside the
AF frame

Focus on the
detected subject

Focus on the
subject inside the
AF frame

Manual focus
Focus on the

Button pressed down

(one-shot AF in operation) subject inside the

AF frame

(1) NOTES

¢ |n certain cases, subjects may not be detected correctly. Typical examples include:

- Subjects extremely small, large, dark or bright in relation to the overall picture.

- Subjects that are partially hidden or upside-down.

- When the subject is blurred due to weather, the background, etc.

¢ Subject detection cannot be used in the following cases:

- When slow & fast motion recording is not in use and the shutter speed used is slower than 1/30 (59.94 Hz
recordings), 1/25 (50.00 Hz recordings), or 1/24 (24.00 Hz recordings or 59.94 Hz recordings with a 23.98P
frame rate).

- When the shooting frame rate for slow & fast motion recording is lower than 24P or higher than 120P.

- When a manual focus lens is attached to the camera.

- When [Tele-converter] is enabled.

e The camera may mistakenly detect a subject other than the desired subject. In such case, set [Subject to
detect] to [None].

e If you set an assignable button to [Subject to detect] or [Subj. Detect. AF], (11 133), you can press the button
to set the respective function.

Tracking a Specific Subject

You can have the camera track other moving subjects that are not faces and also combine the tracking function
with one of the autofocus functions to let the camera focus on the desired subject automatically.
To use the tracking function, you will need to set an assignable button to [Tracking] in advance.

1 Set an assignable button to [Tracking] (11 133).

2 Press the assignable button.
¢ The subject selection mark *2¢ will appear on the screen.
¢ Press the assignable button again or the CANCEL button to end the subject selection mode.

3 Select the subject you want to track.
e Touch the desired subject on the LCD screen.
e You can press the joystick up, down, left, or right to move to the subject you want to track, and then press
SET (or press the joystick itself) to start tracking.
4 The »Z« mark changes to a double frame ¢ ] (tracking frame) and the camera will start tracking the
selected subject.
e To stop tracking the selected subject, press CANCEL.

95



96

Focus

(i) NoTES

¢ \When the AF frame type is set to [Whole Area] or during subject tracking, you can track a subject by touching
the subject to be tracked on the LCD monitor. If [Subject to detect] is set to [People] or [Animals], you can
switch the main subject by pressing the joystick left or right and start tracking. In this case, no frame will be
displayed for subjects other than the main subject (even if set to [People]).

e The camera may start tracking the incorrect subject if there is another subject in the picture with similar color/
pattern characteristics. In that case, select the desired subject again.

¢ Tracking cannot be used in the same cases in which the subject detection function cannot be used.
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Image Stabilization

In CAMERA mode, you can use the image stabilizer to compensate for camera shake and achieve steadier
shots. The image stabilizer is more effective at wider angles and the effect is reduced the more you approach the
telephoto end.

The camera’s image stabilization is not available for RAW clips.

1 Select MENU > ["™ Camera Setup] > [Digital IS] > [On].

* \When using lenses not compatible with camera-lens communication, perform step 4 to enter the lens’s focal
length manually.

¢ Image stabilization is activated and (%0 appears on the left of the screen.
® You can also turn image stabilization on/off using an assignable button set to [Digital IS].

2 Select MENU > ["™ Camera Setup] > [Digital IS Mode] > Desired option.
o (man (standard) or (& (high) will appear on the screen.

3 Select MENU > ["™ Camera Setup] > [Motion Vector For Digital IS] > Desired option.

4 For lenses for which the focal length cannot be obtained, select MENU > ["™ Camera Setup] >
[Lens Focal Length] and enter the lens’s focal length using the data entry screen ([11 42).
¢ The image stabilization is adjusted according to the focal length entered.

5 When using an anamorphic lens, select MENU > ["™ Camera Setup] > [Anamorphic Corr.] >
Squeeze factor to use to correct the image stabilization.

e |f you selected [Lens Squeeze Factor], the anamorphic correction will be applied according to the squeeze
factor specified with the MENU > [£% Recording/Media Setup] > [Metadata] > [Lens Squeeze] setting.
Options for [Digital IS Mode]

[Standard]: Compensates for camera shake. The viewing angle is slightly reduced.

[High]: Achieves stronger compensation for camera shake. The viewing angle is further reduced.

Options for [Motion Vector For Digital IS]

[Enable]: Image stabilization using camera shake information and motion vectors. This setting allows for
very effective image stabilization.

[Disable]: Image stabilization using only camera shake information.

¢ \When recording a subject (such as a person or an animal) with a large amount movement, enabling this setting
may cause the image to shake along with the subject.

(i) NoTES

e [Digital IS Mode] will be [Standard] when all of the following conditions are met:

- [Sensor Mode] is set to [Full Frame] and [Main Resolution] is set to [4096x2160] or [3840x2160Q].

- [Recording Mode] is set to [Slow & Fast Motion] and the recording frame rate is 60P or higher, [Recording
Mode] is set to [S&F Clip / Audio (WAV)] and the recording frame rate is 60P, or [Recording Mode] is set to
another option and the recording frame rate is 59.94P.

- [SDI Output Signal] is set to [4096x2160P/3840x2160P].

e |f the IS function is turned off on a lens, the camera’s image stabilization function is deactivated too and the
&ta icon will flash on the left of the screen. When an RF-S lens is attached, select MENU > ["™ Camera
Setup] > [Lens Optical IS] > [On] to turn on the image stabilization function of the lens.

e \When an assignable button set to [Pause Digital IS] is pressed during camera image stabilization, image
stabilization will be temporarily paused. ((E&n or (&%n are displayed in gray). Even while the digital IS function
is paused, the narrower angle of view is maintained. Pressing the assignable button again will resume image
stabilization. Lens image stabilization is not affected. Even during recording, the digital IS function pause/
resume can be toggled.

¢ Depending on the subject and shooting conditions, subject blur may be more prominent (the subject may be
momentarily blurred) due to the use of image stabilization. Selecting a fast shutter speed may produce better
results.
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¢ Turning off the camera’s image stabilization is recommended in the following cases:
- When using TS-E lenses and fisheye lenses
- When the camera is expected to be stable, for example when it is mounted on a tripod

¢ |f the degree of camera shake is too high, the image stabilizer may not be able to compensate fully.

* The camera’s image stabilization will not function when using super telephoto lenses with a focal length
exceeding 1000 mm.
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Zoom

When a lens that supports zoom adjustment is attached, the zoom can be controlled from this camera (1 276).
You can also zoom remotely using Browser Remote on a connected network device (11 202).

Additionally, you can select the digital tele-converter from the menu and move the focal length to the telephoto
range (except when recording in RAW format).

Zoom Modes of the Lens
Use the switch on the lens to select the lens’s zoom mode (automatic, manual). The name of the controls may
differ depending on the lens. Refer to the instruction manual of the lens/accessory used.

Set the lens’s zoom mode to automatic.
¢ Operating the zoom from the camera is enabled.

Adjusting the Zoom

1 Enable automatic zoom adjustment (SERVO or PZ) on the lens.

2 Select MENU > ["™ Camera Setup] > [Camera Grip Zoom] > [On].

3 Select MENU > ["™ Camera Setup] > [Camera Grip Zoom Speed] > Desired zoom speed.
e Zoom speeds are constant; [1] being the slowest and [16] the fastest.

4 After closing the menu, use the joystick on the camera grip to zoom.
e Push the joystick up to zoom in (telephoto) and push it down to zoom out (wide-angle).

(i) NoTEs

¢ When using slow zoom speeds, it may take longer for the lens to start moving.

Using the digital tele-converter:
The focal length is multiplied by the selected factor when you select MENU > ["™ Camera Setup] >
[Tele-converter] > desired option.
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Displaying Live Video

You can input return signals to the camera’s G-LOCK/SYNC/RET terminal, and tally information to the Ethernet
terminal, allowing you to build a system to display live video. The resolution of signals that can be input to the G-
100 LOCK/SYNC/RET terminal is 1920x1080.

Example of live video system

SDI OUT terminal
Video output

VIDEO terminal
Monitor output

LCD monitor
MON. terminal / HDMI OUT terminal
Monitor output

External display

G-LOCK/SYNC/RET terminal

Remote Camera

E—— Controller

Ethernet terminal RC-IP100/RC-IP1000

Tally information* and

camera control input

(XC Protocol) Tally terminal Switcher
Tally information
input

* When using the RC-IP100, the only supported tally input is “PGM”.

Inputting and Outputting Return Signals
1 Select MENU > [ System Setup] > [G-LOCK/SYNC/RET Term.] > [RET Input].

2 To select the terminal for output, select MENU > [§ System Setup] > one of the [RET Output:]
options > [Enable].

3 Assign [RET] to an assignable button ([I] 133).

4 Press the assignable button to display or hide the return video.

e If you assign [RET (While Pressed)] to an assignable button, the return video can be displayed while the
button is held pressed down.

e The return video can be displayed while the RET button on the lens or the demand attached to lens is held
pressed down.

(i) NoTES

e For how to enable and disable the RET button, check the functions of your lens or demand.

¢ \When suitable return signals are input, the synchronization stabilizes after approximately 10 seconds. Button
and LCD monitor touch operations will not be possible until stabilization is completed.

¢ \When suitable return signals are detected, the icon will flash at the top right of the screen. When the
camera locks on the external signal, the icon will stay on.
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Onscreen Markers, Zebra Patterns and False Color

In CAMERA mode, using onscreen markers allows you to make sure your subject is correctly framed and is
within the appropriate safe area. Zebra patterns help you identify areas that are overexposed. The false color
overlay allows you to check if the exposure is correct. You can display the assistance overlays independently on
the LCD screen or external monitors. The assistance overlays will not affect your recordings.

Displaying Onscreen Markers

The camera offers several onscreen markers. You can display multiple onscreen markers simultaneously and
select their color individually.

[Center Marker]: Displays a small marker that indicates the center of the screen. You can select the shape of the
center marker.

[Horizontal Marker] / [Vertical Marker]: Displays a horizontal/vertical line to help you compose level shots.
[Grid Marker]: Displays a grid that allows you to frame your shots correctly (horizontally and vertically).

[Aspect Marker]: Indicates various aspect ratios by displaying border lines or by masking the image outside the
selected aspect ratio. Available options include standard aspect ratios ([4:3], [1.66:1], etc.), a vertical aspect ratio
[9:16], and [Custom], a free aspect ratio set by the user.

[Safe Area Marker]: Displays a margin from the edges of the image to indicate the action safe area, text safe
area, etc. You can select the core area used as the basis for calculating the safe area and a percentage, relative
to the side length.

[User Marker 1], [User Marker 2], [User Marker 3]: Displays up to three rectangular frames whose size and
position you can set freely and independently of each other.

Safe area 88%
by side length

®___ Horizontal
marker
User marker ~ Center marker Grid —| |7 Aspect guide 4:3
(100, 250) (ICross 1] type)

1 To display the markers overlay on individual video outputs, select MENU > [ Assistance
Functions] > the corresponding [Markers:] setting > [On].

e |f the respective setting is set to [Off], onscreen markers will not be displayed on the corresponding video
outputs even if individual markers are configured.
2 Select the marker(s) you wish to display and configure them with the following procedures.
e You can display multiple markers simultaneously.
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Center Marker / Horizontal Marker / Vertical Marker / Grid Marker
1 Select MENU > [ Assistance Functions] > Desired option > Desired marker color.

2 For [Center Marker] only: Select MENU > [ Assistance Functions] > [Center Marker Type] > Desired marker
shape.

Aspect Marker
1 Select MENU > [ Assistance Functions] > [Aspect Marker] > Desired marker color or transparency of the
masked area.
2 Select MENU > [y Assistance Functions] > [Marker Aspect Ratio] > Desired option.
e |f you selected one of the preset aspect ratios, the rest of the procedure is not necessary. If you selected
[Custom], perform step 3 to specify the aspect ratio.

3 For [Custom] only: Select MENU > [y Assistance Functions] > [Marker Custom Asp. Ratio] and enter the
aspect ratio.

Safe Area Marker

If an aspect marker is not selected, the safe area will be calculated as a percentage of the whole image and you
can only select the percentage. To calculate the safe area as a percentage of an aspect ratio marker, select an
aspect marker in advance (previous procedure).

1 Select MENU > [ Assistance Functions] > [Safe Area Marker] > Desired marker color.

2 Only when an aspect marker is already activated: Select MENU > [y Assistance Functions] > [Basis for
Marker Safe Area] > [Whole Picture] or [Selected Aspect Marker].

3 Select MENU > [ Assistance Functions] > [Marker Safe Area %] > Desired percentage.
® You can select the margin as a percentage of the width (side length).

User Markers

1 Select MENU > [ Assistance Functions] > [User Marker 1], [User Marker 2] or [User Marker 3] > Desired
marker color.

2 Select MENU > [y Assistance Functions] > [User Marker 1 Settings], [User Marker 2 Settings] or [User
Marker 3 Settings].

Size Settings

e Select [Size] > [Specification Method)].

Select the corresponding setting value according to the specification method.

The [Ref. Area & Aspect Ratio] and [Ref. Area & Magn. Ratio] methods set a ratio/magnification relative to the

whole image or other markers.

Position Settings

e Select [Position] > [Specification Method].

Select the corresponding setting value according to the specification method.

The [Center Coordinates] and [Upper-left Coordinates] methods set a position based on the center or upper-left
area of the marker.

The [Center Coordinates] method centers the position matching another user marker.

When setting a method relative to other markers, such as [Ref. Area & Aspect Ratio] or [Center Coordinates], you
can select the following markers for the reference:

- When [User Marker 1] is set: No reference marker can be selected

- When [User Marker 2] is set: [User Marker 1]

- When [User Marker 3] is set: Either [User Marker 1] or [User Marker 2] can be selected
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(i) NoTes

e After activating the onscreen markers you can set MENU > [[Z) Monitoring Setup] > [DISP Level 2] to [Only
FUNC/MENU] and then select display level 2 to turn off all other onscreen displays, leaving only the markers
(1M 59).

e |f you set an assignable button to [Markers: All] or another [Markers:] setting you can press the button to turn
the markers on and off on all monitoring devices, the supplied LCD screen or external monitors.

Displaying Zebra Patterns

The camera has a zebra pattern function that shows black and white diagonal stripes over

areas that are overexposed. There are two types of zebra patterns and you can display both \ /
simultaneously. Zebra 1 lets you identify areas within a certain range (5% of a specified level \ /
from 5% to 95%) while zebra 2 lets you identify areas that exceed a specified level (from 0%  Zebral  Zebra2
to 100%).

1 Assign the desired [Zebra:] option to an assignable button.

2 Select MENU > [ Assistance Functions] > [Zebra] > [Zebra 1], [Zebra 2] or [Zebra 1+2] (both zebra
patterns).

3 Select MENU > [ Assistance Functions] > [Zebra 1 Level] or [Zebra 2 Level] > Desired option.

4 Press the ZEBRA button to activate the selected zebra pattern on all monitoring devices at once.
e [Zebra: SDI] cannot be displayed under the following conditions.
- RAW recording with [Sensor Mode] set to [Full Frame], [SDI Output Signal] set to [3840x2160] or higher,
and [Peaking] set to [On].
- When [Sensor Mode] is set to [Full Frame] or [Super 35mm (Cropped)], the frame rate exceeds 60P, [SDI
Output Signal] is [3840x2160] or higher, and [Peaking] is set to [On].
- When [OSD Output: SDI] is set to [Off (Clean)].
e [Zebra: MON./HDMI] cannot be displayed under the following conditions.
- When [OSD Output: MON./HDMI] is set to [Off].

Displaying False Color

In this display mode 6 colors are overlaid on a black & white version of the image to identify potentially
problematic exposure areas.

To display the false color overlay select MENU > [ Assistance Functions] > the desired [False

Color:] settings > [On].

e Alternatively, you can press an assignable button ([J] 133) set to one of the above options, or to [False Color:
Alll to turn the false color overlay on and off on all monitoring devices.

(i) NoTes

* You can use the MENU > [ Assistance Functions] > [False Color Index] setting to check an index of the
colors used in the false color overlay.
Color Meaning
Red White clipping
Yellow | Just below white clipping
Pink | One stop over 18% gray
Green | 18% gray (medium gray)
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Color Meaning
Blue | Just above black clipping

Purple | Black clipping

104 . The false color overlay will not be output while color bars are displayed.

¢ \When the Look File registered to the custom picture file is active, the color displayed might not be that of the
correct brightness level.

e [False Color: SDI] cannot be displayed under the following conditions.
- When [Sensor Mode] is set to [Full Frame] or [Super 35mm (Cropped)], the slow & fast motion recording

frame rate exceeds 60P and [SDI Output Signal] is [3840x2160] or higher.

- When [OSD Output: SDI] is set to [Off (Clean)].

e [False Color: MON./HDMI] cannot be displayed under the following conditions.
- When [OSD Output: MON./HDMI] is set to [Off].
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Setting the Time Code

In CAMERA mode, the camera generates a time code signal and records it with the recorded clips. The time
code signal can be output from the SDI OUT terminal, MON. terminal, TIME CODE terminal ((11 109) or HDMI
OUT terminal. In MEDIA mode, the time code embedded in the clip being played back is output from the SDI
OUT terminal or MON. terminal.

Depending on the frame rate used, you may be able to select between a drop frame an non-drop frame time
code signal (11 106). The default mode varies depending on the country/region of purchase and, though the
time code display style is different for DF and NDF, in this section the NDF display style is used for simplicity’s
sake.

Selecting the Time Code Mode

In CAMERA mode you can select the camera’s time code mode.

Select MENU > [¥ System Setup] > [Time Code Mode] > [Preset] or [Regen.].
Options

[Preset]: The time code starts from an initial value you can select in advance. The default initial time code
is 00:00:00.00 (00:00:00:00 for NDF).
See the following procedures to select the time code running mode and set the initial time code.

[Regen.]: The camera will read the selected card and the time code will continue from the last time code
recorded on the card. The time code runs only while recording so clips recorded consecutively
on the same card will have continuous time codes.

Setting the Time Code Running Mode
If you set the time code mode to [Preset], you can select the time code running mode.
Select MENU > [¥ System Setup] > [Time Code Run] > [Rec Run] or [Free Run].

Options

[Rec Run]: The time code runs only while recording so clips recorded consecutively on the same card will
have continuous time codes.

[Free Run]: The time code starts running the moment you confirm the selection and keeps running

regardless of the camera’s operation.

Setting the Time Code’s Initial Value

If you set the time code mode to [Preset], you can set the initial value of the time code.

1 Select MENU > [¥ System Setup] > [Set Time Code] > [Change].

* The time code setting screen appears with an orange selection frame indicating the hours.

e To reset the time code to [00:00:00.00] ([00:00:00:00] for NDF), select [Reset] instead. If the running mode is
set to [Free Run], the time code will be reset the moment you confirm the selection and keep running
continuously from 00:00:00.00.

2 Enter the initial time code using the data entry screen ([1] 42).

e |f the running mode is set to [Free Run], the time code will start running from the selected time code the
moment you confirm the selection.
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Selecting Drop or Non-Drop Frame

When the frame rate is set to 59.94P, 59.94i or 29.97P, you can select between a drop frame (DF) or non-drop
frame (NDF) time code, depending on how you plan to use your recordings.

With all other frame rates, the time code is set to non-drop frame (NDF) and cannot be changed.

Select MENU > [¥ System Setup] > [Time Code DF/NDF] > [DF] or [NDF].

¢ The time code display will change depending on the setting. When you select [DF], the time code will appear
as [00:00:00.00]; when you select [NDF], it will appear as [00:00:00:00].

About the time code display
An icon may appear next to the time code depending on the operation. Refer to the following table.
Icon Description
R The time code mode is set to [Regen.].
P The time code mode is set to [Preset] and the running mode is set to [Rec Run].
F The time code mode is set to [Preset] and the running mode is set to [Free Run].
E The time code signal is coming from an external source.

No icon | Time code during clip playback.

(i) NOTES

¢ About the time code output:

- In CAMERA mode, the embedded time code signal is output from the SDI OUT terminal and MON. terminal.
With the MENU > [£% Recording/Media Setup] > [HDMI Time Code] setting you can output the time code
signal also from the HDMI OUT terminal ((11 168).

- In MEDIA mode, the time code and user bit recorded with the clip are output from the SDI OUT terminal and
MON. terminal.

e The frames value of the time code runs from O to 23 (frame rate set to 23.98P or 24.00P), from 0 to 24 (frame
rate set to 25.00P, 50.00i or 50.00P), or from 0 to 29 (all other frame rates).

However, the frames value of the time code output from the MON. terminal, HDMI OUT terminal and SDI OUT

terminal will be converted so it runs from 0 to 29 when the frame rate is 23.98P / 24.00P and the following

settings are in use:

- MENU > [¥ System Setup] > [MON. Output Signal] > [1920x1080i(PsF)] or [1280x720P]

- MENU > [¥ System Setup] > [HDMI Output Signal] > [1920x1080i] or [1280x720P]

- MENU > [¥ System Setup] > [SDI Output Signal] > [1920x1080i(PsF)] or [1280x720P]

¢ When slow & fast motion recording, frame recording or interval recording is activated, you cannot select the
[Free Run] running mode. Conversely, when pre-recording is activated, [Free Run] is set automatically and
cannot be changed.

¢ When slow & fast motion recording, frame recording or interval recording is activated, the time code and user
bit signal will not be output from any of the terminals.

¢ \When you mix drop frame and non-drop frame time codes, there might be a discontinuity in the time code at
the point where the recording starts.

¢ When you are using the [Free Run] running mode, the time code will continue running as long as the built-in
backup battery has some charge left, even if you disconnect all other power sources.

¢ If you set an assignable button to [Time Code] (11 133), you can press the button to open the
[¥ System Setup] menu page with the time code settings.
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Setting the User Bit

In CAMERA mode, you can set a user bit composed of the date or the time of recording or an identification code

consisting of 8 characters in the hexadecimal system. There are sixteen possible characters: the numbers 0 to 9

and the letters A to F. 107
The user bit is recorded with clips and can be output from the SDI OUT terminal, MON. terminal, TIME CODE E—
terminal or HDMI OUT terminal. It can be used freely to categorize and manage recordings or to keep additional
information about them.

To set an hexadecimal code
1 Select MENU > [¥ System Setup] > [User Bit Type] > [Setting] > [Changel.
¢ To reset the user bit to [00 00 00 00], select [Reset] instead.

2 Enter the user bit using the data entry screen ([1] 42).
e Press the CANCEL button to close the screen without making any changes.

To use the recording date/time
Select MENU > [¥ System Setup] > [User Bit Type] > [Date] or [Time].

(i) NoTES

e The user bit is not output during slow & fast motion recording, frame recording or interval recording.
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Synchronizing with an External Device

In CAMERA mode, you can use the camera’s TIME CODE terminal to synchronize this camera’s time code to an
external signal. Using the same external time code signal with multiple cameras allows you to set up a multi-
camera recording. You can also output the time code signal from this camera to other cameras. You can output
the time code signal from the SDI OUT terminal or MON. terminal to an editing device (while recording or during
playback), so the editor can create video with the same time code.

Additionally, you can use the camera’s G-LOCK/SYNC/RET terminal to synchronize this camera’s video signal to
a reference signal* from an external video device (Genlock synchronization) or to send out the camera’s video
signal as a synchronization reference signal*.

* As reference video signal (input signal) for Genlock synchronization, you can use an analog blackburst or tri-level HD signal. The
reference video output signal will be a tri-level HD signal.

Connecting an External Device

When synchronizing a time code signal, connect the external device to the TIME CODE terminal on the camera.
When synchronizing with a reference video signal, connect the external device to the G-LOCK/SYNC/RET
terminal on the camera. Be sure to set either terminal to input or output in advance.

Connection diagram

TIME CODE
Standard time code terminal

—

I\

Reference video signal
© @
— \Zootomers |
G-LOCK/SYNC/RET  =TC

G-LOCK/SYNC/RET

terminal

s DIN-BNC cable (commercially available)

Time Code Signal Input

An external SMPTE-standard LTC timing signal received from the TIME CODE terminal can be recorded as the
time code. The user bit of the external timing signal can also be recorded with clips. Before connecting the
device, set the TIME CODE terminal to input with the procedure below and make sure the time code running
mode is set to [Free Run] (1] 105).

1 Select MENU > [¥ System Setup] > [TC In/Out] > [In].

2 To record the external time code signal’s user bit, select also MENU > [¥ System Setup] > [User Bit
Recording Mode] > [Externall.

(i) notes

e Synchronize the camera’s time code with an external time code signal that matches the camera’s system
frequency. Use a 24-frame time code signal when the frame rate is set to 23.98P or 24.00PF, a 25-frame time
code signal when it is set to 25.00P, 50.00i or 50.00P and a 30-frame time code signal for other frame rates.
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e \When a suitable external time code signal is received, the camera’s own time code will be synchronized to it
and the synchronization will be maintained even if you disconnect the cable from the TIME CODE terminal.

e |f the external time code signal is incorrect or there is no input signal, the internal time code set in the camera
will be recorded instead.

¢ \When an external time code signal is received, the DF/NDF selection will follow the external time code signal’s 109
settings. -

e |f an external time code signal is input while pre-recording is activated, there might be a discontinuity in the
time code of the pre-recorded clip.

¢ Performing any of the following actions while the cable is not connected will cause the synchronization to be
disrupted; the correct time code will be restored once you reconnect the cable.
- Turning the camera on/off
- Switching to MEDIA mode
- Changing the video configuration

Time Code Signal Output

The time code signal output from the TIME CODE terminal will be a SMPTE-standard LTC timing signal. The user
bit will also be output.

Select MENU > [¥ System Setup] > [TC In/Out] > [Out].

(i) NoTES

¢ About the user bit output: In CAMERA mode, the user bit set by the user (11 107) will be output. In MEDIA
mode, the user bit is not output from the TIME CODE terminal.

¢ The time code and user bit will not be output when slow & fast motion recording / frame recording / interval
recording is activated.

Reference Video Signal Input (Genlock Synchronization)

When a reference sync signal (analog blackburst or tri-level signal) is input through the camera’s G-LOCK/SYNC/
RET terminal, the phases of the camera’s V and H sync will automatically be synchronized to it. The phase
difference between the external Genlock signal and the camera is initially set to 0. The H phase can be adjusted
within the range of approximately +0.4 H.

1 Select MENU > [ System Setup] > [G-LOCK/SYNC/RET Term.] > [Genlock Input].

2 Select MENU > [¥ System Setup] > [Genlock Adjustment] > [Change].
e To reset the adjustment value to [000], select [Reset] instead.

3 Enter the H-phase adjustment value.

(i) NoTEs

¢ \When a suitable Genlock signal is input, the Genlock synchronization stabilizes after approximately
10 seconds. Button and LCD monitor touch operations will not be possible until stabilization is completed.

e \When a suitable Genlock signal is detected, the icon will flash at the top right of the screen. When the
camera locks on the external Genlock signal, the icon will stay on.

e |f the external Genlock signal is incorrect, the synchronization may not be stable. In such case, the recorded
time code may be incorrect.
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Reference Video Signal Output

After changing the function of the camera’s G-LOCK/SYNC/RET terminal to [HD Sync Output], you can use the
camera’s video signal as a reference sync signal (tri-level HD signal) to synchronize an external device to this
camera. The reference signal’s configuration is determined by the video output configuration of the SDI OUT
terminal and other menu settings.

1 Select MENU > [¢ System Setup] > [G-LOCK/SYNC/RET Term.] > [HD Sync Output].
2 If necessary, select MENU > [¥ System Setup] > [SYNC Scan Mode] > [P] or [PsF].
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Recording Audio

The camera features the following options for audio recording and playback. You can record audio using an
external microphone/external line input (INPUT terminals or MIC terminal), the monaural microphone*, or an
accessory compatible with the multi-function shoe.

The audio signal will be output with the video signal from the SDI OUT/MON./HDMI OUT terminals. You can
record the audio signal on an external recorder.

* Only for recording voice memos while shooting. Recording voice memos is useful when synchronizing video and audio during
editing.

_ _ . Audio format
Video format / audio recording

function Codec Sampling Bit depth LS Bit rate
frequency audio channels
RAW Linear PCM 24 bit 4 channels 4.5 Mbps
Video XF-AVC Linear PCM 18 Kz 24 bit 4 channels 4.5 Mbps
recording XF-AVC 311 Linear PCM 24 bit 4 channels 4.5 Mbps
XF-HEVC S AAC 16 bit 2 channels? 256 Kbps
Audi For slow & fast motion recording |  Linear PCM 48 kHz 24 bit 4 channels 4.5 Mbps
udio
recording For second card recording ) .

functions Linear PCM 8 kHz 16 bit 1 channel 128 Kbps

' Audio for proxy clips is recorded in AAC format.
2 CH1 and CH2 audio is recorded.

Audio Settings and Recorded Audio Channels

Which audio inputs are recorded to which audio channels is determined by a combination of menu settings and

audio-related controls on the camera. Refer to the table below.
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[Audio Input
112 Selection] >

[CH1/CH2]

[INPUT
Terminals]

Menu settings

INPUT 1/INPUT 2

Audio source selection switches

Recorded audio channels/audio sources

[Audio Input
Selection] >  [CH2 Input] INPUT 1 INPUT 2 CH1 CH2 CH3 CH4
[CH3/CH4]
MIC/48V INPUT 2 MIC INPUT 2 MIC
MIC/48V INPUT 1 MIC INPUTTIMIC |
LINE INPUT 2 LINE INPUT 2 LINE
INPUT 2
MIC/48V INPUT 2 MIC INPUT 2 MIC
LINE INPUT 1 LINE INPUTTLINE |
INPUT LINE INPUT 2 LINE INPUT 2 LINE
Terminals] MIC/48V INPUT 2 MIC
MIC/48V INPUT 1 MIC | INPUT1MIC | INPUTIMIC
LINE INPUT 2 LINE
INPUT 1
MIC/48V INPUT 2 MIC
LINE INPUT 1 LINE | INPUT 1 LINE | INPUTTLINE
LINE INPUT 2 LINE
MIC/48V INPUT 2 MIC
MIC/48V INPUT 1 MIC
LINE INPUT 2 LINE
INPUT 2
MIC/48V INPUT 2 MIC
LINE INPUT 1 LINE
MG LINE INPUT 2 LINE
Terminal | MIC/48V INPUT TMIC | INPUT 1M | MICO MIC ()
LINE INPUT 1 LINE | INPUT 1 LINE
MIC/48V - INPUT 1 MIC [MIC
MIC ;
Terminal] Terminal]
LINE INPUT1LINE | 1)
MIC/48V INPUT 2 MIC
MIC/48V INPUT 1 MIC
LINE INPUT 2 LINE
INPUT 2
MIC/48V INPUT 2 MIC
LINE INPUT 1 LINE
LINE INPUT 2 LINE
[Monaural MIC/48V INPUT 1 MIC | INPUT 1 MIC :
Mic] INPUT 1 [Monaural Mic]
LINE INPUT 1 LINE | INPUT 1 LINE
MIC/48V - wpuT 1w | (Monaural
[Monaural Mic]
Mic
] LINE NpUT 1 LNE | (Monaural
Mic]
MIC/48V INPUT 2 MIC
MIC/48V INPUT 1 MIC
NPUT 2 LINE INPUT 2 LINE
[Multi- MIC/48V INPUT 2 MIC
Function LINE INPUT 1 LINE [Multi-Function Shoe]
LINE INPUT 2 LINE
Shoe]
MIC/48V INPUT 1 MIC | INPUT 1 MIC
INPUT 1 -
LINE INPUT 1 LINE | INPUT 1 LINE
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INPUT 1/INPUT 2

Menu settings . . ) Recorded audio channels/audio sources
Audio source selection switches

[Audio Input  [Audio Input
Selection] > Selection] >  [CH2 Input] INPUT 1 INPUT 2 CH1 CH2 CH3 CH4

[CH1/CH2] [CH3/CH4]
MIC/48V INPUT 1 MIC | INPUT 2 MIC
MIC/48V
[INPUT LINE INPUT 1 MIC | INPUT 2 LINE
Terminals] LINE MIC/48V INPUT 1 LINE | INPUT 2 MIC
LINE INPUT 1 LINE | INPUT 2 LINE
[MIC [MIC
Terminal] Terminal] MIC (1) MIC (R) MIC (1) MIC (R)
[Monaural )
Mic] _ _ [Monaural Mic]
[Multi-
Function [Multi-Function Shoe]
Shoe]
MIC/48V INPUT 1 MIC | INPUT 2 MIC
MIC/48V
[INPUT LINE INPUT 1 MIC | INPUT 2 LINE
Terminals] LINE MIC/48V INPUT 1 LINE | INPUT 2 MIC
LINE INPUT 1 LINE | INPUT 2 LINE
[Monaural [MIC )
Mic] Terminal] [Monaural Mic] MIC (L) MIC (R)
[Monaural )
Mic] _ _ [Monaural Mic]
[Multi-
Function [Multi-Function Shoe]
Shoe]
MIC/48V INPUT 1 MIC | INPUT 2 MIC
MIC/48V
[INPUT LINE INPUT 1 MIC | INPUT 2 LINE
Terminals] LINE MIC/48V INPUT 1 LINE | INPUT 2 MIC
LINE INPUT 1 LINE | INPUT 2 LINE
[Multi- MIC
Function ) - [Multi-Function Shoe] MIC (L) MIC (R)
Terminal]
Shoe] o |
onaural )
Mic] _ _ [Monaural Mic]
[Multi-
Function [Multi-Function Shoe]
Shoe]

Audio Format for Main / Sub Recording Clips
Select the audio recording format for XF-HEVC S/XF-AVC S clips (primary clips or sub recording clips).

For main clips: Select MENU > [ £% Recording/Media Setup] > [XF-HEVC S/XF-AVC S Main Audio] >
Desired option.

For sub recording clips: Select MENU > [ £% Recording/Media Setup] > [[s2] XF-HEVC S/XF-AVC S
Audio] > Desired option.
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Connecting an External Microphone or External Audio Input Source to the Camera

To each of the INPUT terminals you can attach commercially available microphones or analog line in sources with

a mini XLR connector. To the MIC terminal you can attach an external microphone/external line input (analog)
114 with a & 3.5 mm stereo mini plug.

Using the supplied microphone holder, you can fix external microphones with a diameter of 19 mm to 20 mm.

1 Loosen the microphone lock screw (D), open the
microphone holder and insert the microphone ((2).

2 Tighten the lock screw and put the microphone cable
through the cable clamp under the microphone holder

®).

3 Plug the microphone cable into the desired INPUT
terminal (@) or the MIC terminal ().

@ wPoRTANT

e Do not connect or disconnect microphones and other audio
devices from any INPUT terminal when the corresponding
INPUT (audio source selection) switch is set to the
MIC+48V position. This may damage the camera and/or
device.

Microphone lock screw

INPUT 1 terminal

INPUT 2 terminal MIC terminal

|
(@ NG J\
Ip1\ IN

Cable clamp

Switching the Input Type for the INPUT 1/INPUT 2 Terminals

Using the INPUT 1/INPUT 2 terminals, you can record audio independently from a microphone or audio input
source.
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Set the INPUT 1 or INPUT 2 switch to LINE, MIC or N o Souree

MIC+48V.

¢ \When using the INPUT terminals to record to only one channel,
use the INPUT 1 terminal.

INPUT 1 MIC MIC
LINE= | &+48V

@

INPUT 2 pic mic
LINE= | =+48V

@ vPoRTANT
¢ Using an analog microphone that requires phantom power
- Be sure to connect/disconnect the microphone with the
camera turned off or when the respective INPUT switch is set

to the MIC position. Only after the microphone is connected,
set the switch to MIC+48V.

e To connect a microphone or other audio device that is not
compatible with phantom power to an INPUT terminal, make
sure the respective INPUT (audio source selection) switch is set to a position that matches the device (LINE or
MIC). Setting the switch to MIC+48V may damage the audio device.

Selecting the Input Type for the MIC Terminal
Change the setting according to the audio device connected to the MIC terminal.

1 Select MENU > [ Audio Setup] > [MIC Input]
2 Select [MIC (with Power Supply)] or [LINE]
e Select [MIC (with Power Supply)] to supply plug-in power to the external microphone.

Selecting the Audio Input Source for Audio Channels

In CAMERA mode, you can select the audio input source that will be recorded on CH1/CH2 or CH3/CH4,
independently for each pair of audio channels. For details refer to the Audio Settings and Recorded Audio
Channels table (11 111).

1 Select MENU > [)) Audio Setup] > [Audio Input Selection] > [CH1/CH2] or [CH3/CH4].
2 Select [INPUT Terminals], [MIC Terminal], [Monaural Mic] or [Multi-Function Shoe].

Recording the Same Analog Audio Input to Two Channels

By default, each audio input is recorded to a separate audio channel (INPUT 1 to CH1 and INPUT 2 to CH2).

If necessary (for example, as an audio backup recording), you can record the same analog audio source
connected to the INPUT 1 terminal to both audio channels, CH1 and CH2. In that case, you can adjust the audio
recording levels of each channel independently of each other.

Select MENU > [D) Audio Setup] > [CH2 Input].

Options

[INPUT 2] Records audio to each channel separately. Audio input into INPUT 1 is recorded to CH1, while
audio input into INPUT 2 is recorded to CH2.

[INPUT 1] Audio input into INPUT 1 is recorded to both channels. Audio input into INPUT 2 will not be
recorded.

[Monaural Mic] / [MIC Terminal]:
Audio input into INPUT 1 is recorded to CH1, while audio input to the built-in microphone and
the MIC terminal is recorded to CH2.
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Adjusting the Audio Recording Level

In CAMERA mode, you can adjust the audio recording level of the INPUT terminals or the MIC terminal. You can
select automatic or manual audio level adjustment, and adjust each audio channel separately or adjust CH1/
CH2 or CH3/CH4 together (when the audio level adjustment of the audio channels is linked, [1] 117).

Automatic Audio Level Adjustment for CH1, CH2 or CH1/CH2

Set the audio level switch of the desired channel to A (automatic) to CH1/CH2 audio level switches
let the camera automatically adjust that channel’s audio level.

o @ = =
ST, [o
||,
Ol ool
Q10| = 8
WoT
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Manual Audio Level Adjustment for CH1, CH2 or CH1/CH2
You can set the audio level manually from —oco to +18 dB.
1 Set the audio level switch of the desired channel to M (manual). CH1/CH2 audio level switches

2 Turn the corresponding audio level dial to adjust the audio level.

e [or reference, the O corresponds to — oo, 5 corresponds to
0 dB, and 10 corresponds to +18 dB.

* As a guideline, adjust the audio recording level so that the audio
level meter on the screen will go to the right of the —18 dB mark
(one mark right of the —20 dB mark) only occasionally.

e Closing the protective cover will prevent the audio controls from
being changed inadvertently.

Using the Menu to Adjust the Audio Level for Each

Channel

1 Select MENU > [) Audio Setup] > [Audio Rec Level] > Desired option.
e Use /P to choose the desired option.
- Select [A] (automatic) to adjust the audio level automatically.
- Select [M] (manual) to manually adjust the audio level using /P .

CH1/CH2 audio level dials
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Automatic Level Control (ALC): Linking the audio level adjustment of CH1/CH2 or CH3/CH4

* \When both CH1 and CH2, or CH3 and CHA4, are set to the MIC terminal or INPUT terminals and to the
same type of audio source (external line input or external microphone), you can use the MENU >
[d) Audio Setup] > [CH1/CH2 ALC Link] or [CH3/CH4 ALC Link] setting to link the audio level adjustment 117
of both channels. -

e When CH1 and CH2 are linked, you can use the CH1 audio level switch and dial to affect both CH1 and
CH2. When CH3 and CH4 are linked, you can use the [Audio Rec Level] setting to affect both CH3 and
CH4.

Audio peak limiter

e For manual level adjustment, you can lessen audio distortion by enabling the following setting to
automatically limit the amplitude of audio input signals when they start to distort.
Select MENU > [)) Audio Setup] > [INPUT Limiter] > [On].

(i) NoTEs

¢ \We recommend using headphones when adjusting the audio level. If the input level is too high, audio may
become distorted even if the audio level indicator shows an appropriate level.

e If you set an assignable button to [Audio Level Indicator] (11 133), you can press the button to turn the
onscreen audio level indicator on and off.

¢ \When the optional the Canon DM-E1D Multi-Function Shoe Directional Stereo Microphone is attached,
adjustment with the audio level switch is also possible. In this case, CH1 settings are also applied to CH2.

Audio Input Adjustment

In CAMERA mode, you can adjust various settings that affect the audio input depending on the terminal and
audio source used.

Microphone Sensitivity (INPUT Terminals)
You can select the external microphone’s sensitivity.

Select MENU > [ M) Audio Setup] > [INPUT 1 Mic Trimming] or [INPUT 2 Mic Trimming] > Desired
sensitivity level.

e You can select one of 5 sensitivity levels from —12 dB to +12 dB.

Microphone Attenuator (INPUT Terminals/MIC Terminal)
You can activate the external microphone’s attenuator (20 dB).

INPUT Terminals: Select MENU > [§)) Audio Setup] > [INPUT 1 Mic Att.] or [INPUT 2 Mic Att.] > [On].
MIC Terminal: Select MENU > [) Audio Setup] > [MIC Att.] > [On].

Low-Cut Filter (INPUT Terminals/MIC Terminal)

You can select the characteristics of the microphone according to the sound to be recorded.

INPUT Terminals: Select MENU > [§)) Audio Setup] > [INPUT 1 Mic Low Cut] or [INPUT 2 Mic Low
Cut] > [On].

MIC Terminal: Select MENU > [M) Audio Setup] > [MIC Low Cut] > Desired option.
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Options

[Off]: For recording audio under usual conditions.

[LCA]: For recording mainly people’s voices.

[LC2]: For reducing the background sound of wind when recording outdoors in windy surroundings (for

example, on a beach or close to buildings). Note that when you use this setting some
low-frequency sounds may be suppressed along with the sound of wind.

Changing the Reference Level of the External Microphone (INPUT Terminals)
You can select the reference level of each INPUT terminal (-18 dB or —20 dB).
Select MENU > [ ) Audio Setup] > [INPUT Reference Level] > Desired option.

Setting the Multi-Function Shoe Input

Select MENU > [ ) Audio Setup] > [Multi-Function Shoe Input] > Desired option.
e Select [Shoe Mic] or [Wireless Mic], then select a menu item to set the respective settings.

Monitoring the Audio with Headphones

Connect headphones with a & 3.5 mm stereo mini-plug to the (3 ) (headphone)
(headphone) terminal to monitor the recorded audio. terminal

(i) Nnotes

¢ You can adjust the headphone volume with the MENU >
[)) Audio Setup] > [Headphone Volume] setting. If you set an
assignable button to [Headphones +] or [Headphones -] (11 133),
you can press the button to adjust the headphone volume without
using the menu.
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Colors Bars/Audio Reference Signal

In CAMERA mode, you can have the camera generate color bars and a 1 kHz audio reference signal and output
them from the following terminals. Color bars are not available when the main recording format is set to RAW.

MON. terminal/

) . A )
VIDEO terminal SDI OUT terminal HDMI OUT terminal € ) (headphone) terminal

Color bars ‘ @ ‘ @ ‘ o ‘ -

Audio reference signal ‘ - ‘ ° ‘ ® ‘ o

Color Bars
The camera offers SMPTE, EBU and ARIB color bars.

1 Select MENU > ["™ Camera Setup] > [Color Bars] > [On].

2 Select MENU > ["™ Camera Setup] > [Color Bar Type] > Desired option.
e The selected color bars appear on the screen and will be recorded when you press the REC button.
¢ Turning off the camera or changing the operating mode to MEDIA mode will deactivate the color bars.

(i) NoTes

¢ While color bars are displayed, the magnification function ([J1 90) cannot be used.

e Color bars cannot be output when the gamma curve component of the [Gamma/Color Space] setting in the
custom picture file ([J] 142) is set to an option other than [BT.709 Wide DR], [BT.709 Standard] or [Canon
709].

e If you set an assignable button to [Color Bars] ([1] 133), you can press the button to turn the color bars on/off.

Audio Reference Signal
The camera can record a 1 kHz audio reference signal with the color bars.

Select MENU > [ M) Audio Setup] > [1 kHz Tone] > Desired option.
e You can select one of three audio levels (-12 dB, —18 dB, —20 dB), or [Off] to turn off the signal.

¢ The reference signal will be output at the selected level when you display the color bars, and will be recorded
when you press the REC button.
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Video Scopes

The camera can display a simplified waveform monitor or a vectorscope to check your recordings. The selected
video scope can be output to the VIDEO terminal, SDI OUT terminal and MON. terminal/HDMI terminal.

Displaying a Video Scope
Choose between a waveform monitor or a vectorscope. You can also change opacity, position and waveform
monitor size settings.

1 Select MENU > [ Assistance Functions] >
[WFM Function] > [Waveform Monitor] or [Vectorscope].
2 Press the WFM button.

o Alternatively, you can use one of the MENU > [ Assistance
Functions] > [WFM:] settings to turn the video scope on/off
separately on the desired video output.

Configuring the Waveform Monitor
1 Select MENU > [f& Assistance Functions] > [WFM Function] > [Waveform Monitor].
2 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Size] > Desired option.
3 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Position] > Desired option.
4 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Type] > Desired option.
e |f you selected an option other than [Select Line], skip to step 7.
5 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Select Line].
6 Enter the Y coordinate of the line you want to display.

* The available range of lines that can be selected depends on the vertical component of the resolution used.

For 2160 and over: 0 to maximum value, minus 2 lines (in 2-line increments)
Example: 0 to 2158 (for 2160)

Below 2160: 0 to maximum value, minus 1 line (in 1-line increments)
Example: 0 to 1079 (for 1080)

7 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Vertical Scale for HDR] >
Desired option.
e Select the Y axis (luminance) scale used when displaying the waveform monitor of an HDR (high dynamic
range) image (PQ or HLG standard defined by ITU-R BT.2100).

8 If needed, touch the waveform monitor on the screen to change its display size (only for VIDEO
terminal/the included LCD monitor).

Options for [Type]

[Line]: Sets the waveform monitor to line display mode.

[Line+Spot]:  The waveform of the area in the red frame is displayed in red on top of the [Line] mode
waveform.

[Select Line]:  The selected horizontal line (in red) will be displayed along with its waveform.

[RGB]: Shows 3 side-by-side waveforms in an RGB parade.

[YPobPY]: Shows 3 side-by-side waveforms in a YPbPr parade.
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Options for [Vertical Scale for HDR]
[IRE]: Displays the video scope in IRE units.

[PQ/HLG]: For HDR-PQ images, displays the video scope in nits (cd/mz) (including when the gamma curve
after applying the Look File is set to [PQ]). For such images, the narrow range’s (video range)
waveform monitor is displayed.

For HDR-HLG images, the Y axis shows a relative-index value between 0 and 1000 nits
(including when the gamma curve after applying the Look File is set to [HLG]).

Configuring the Vectorscope

1 Select MENU > [ Assistance Functions] > [WFM Function] > [Vectorscope].

2 Select MENU > [ Assistance Functions] > [Vectorscope Settings] > [Position] > Desired option.
3 Select MENU > [ Assistance Functions] > [Vectorscope Settings] > [Type] > Desired option.

4 Touch the onscreen vectorscope to switch its magnification rate between [1x] and [2x].
* You can also select MENU > [f& Assistance Functions] > [Vectorscope Settings] > [Gain] > Desired option.

Options for [Type]

[Normal]: Displays the usual vectorscope.

[Spot]: The color signal of the area in the red frame is displayed in red on top of the [Normal] mode
waveform.

(i) NoTEs

e The waveform monitor will not be affected even if a LUT is applied to the image, the range is changed or
anamorphic desqueeze is used on the selected video output or screen.

¢ If the [Knee] settings in the custom picture file (11 143) were changed, a horizontal line will appear on the
waveform monitor indicating the luminance (Y) level* corresponding to the knee point.
* When a Look File registered to the custom picture file is active, the displayed luminance may not be at the correct level.

¢ \When the waveform monitor’'s Y axis is set to display in IRE units, a level of 10 bit 64 maps to O IRE and 10 bit
940 maps to 100 IRE, regardless of the custom picture settings.

121



122

Adding Marks to Clips in CAMERA Mode

Adding Marks to Clips in CAMERA Mode

In CAMERA mode, only when the recording format is set to XF-AVC, you can add marks to primary clips to set
them apart. While recording, you can add shot marks (H) to flag an important shot or frame. After recording a
clip, you can add an OK mark ([l) or check mark (M) to help you identify particular clips.

You can add and delete marks also in MEDIA mode (11 156, 157). This operation is performed using the
assignable buttons.

Marks cannot be added to proxy clips.

Adding a Shot Mark while Recording
1 Set an assignable button to [Add Shot Mark] ([1] 133).

2 While you are recording, press the assignable button at the beginning of the shot you wish to mark.
e [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.

(i) NoTES

e Up to 100 shot marks can be added to a single clip.

e There may be up to a 0.5 second delay from when you press the button to when the camera adds the shot
mark.

¢ When a clip contains a shot mark, B will appear next to the clip’s thumbnail in the playback index screen.

¢ You cannot add a shot mark before pressing the REC button when pre-recording is activated, or during
interval recording/frame recording.

Adding an OK Mark or Check Mark to the Last Clip Recorded

After recording an important clip, you can add to it a mark to set it apart. [l marks can also be used to protect
important clips, as clips with an [ mark cannot be deleted with the camera.

1 Set an assignable button to [Add [l Mark] or [Add [4 Mark] (11 133).

2 After recording a clip, press the assignable button.
o [[MAMark] or [Mark] will appear briefly and the selected clip mark will be added to the clip.

(i) NoTES

e A clip cannot have both an [l mark and a mark at the same time.

¢ When a clip has an [l mark or 4 mark, the respective icon will appear next to the clip’s thumbnail in the
playback index screen.
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Using Metadata

In CAMERA mode, when the recording format is set to XF-AVC / XF-AVC S / XF-HEVC S, the camera
automatically adds metadata to the recorded clips. You can use Canon XF Utility to check and search for specific
metadata. You can also create and transfer a user memo remotely using Browser Remote on a connected
network device (11 202).

Metadata components

Entering content Checking content
Metadata CanonxF content Canonxe  Content
Camera utilty Transfer Camera utilit Transfer
Professional y Professional
User Memo: clip title, creator, location and description. - o' - @ (] -
GPS information: altitude, latitude and longitude. @2 o - [ ) o -
Information about the recording: scene and take. o - - o' o -
Information about camera settings: shutter speed, ISO 5
) = - - @ o -
speed/gain value, etc.
Unique Material Identifiers (UMID): country, organization o _ _ Py _ _
and user codes based on the SMPTE standard. (1 216)
News Metadata ([T] 124) - - [ ) [ ) - o

1 User memo files need to be created using the software and saved on an SD card in advance.

2 Only when a GP-E2 GPS Receiver is connected to the camera. While recording, GPS information is recorded automatically by
the camera.

3 GPS information can only be added to clips already recorded.

4 Only in CAMERA mode.

5 Recording data is logged automatically by the camera.

Setting a User Memo Created with Canon XF Utility

Before you can add a user memo, you must first install Canon XF Utility ([J] 176). Next, create the user memo
and then save it to an SD card. Once you insert the SD card in the camera and select the user memo, it will be
added to clips you record.

1 Use Canon XF Utility to save a user memo to an SD card.
e User memo files are saved to the “/ XMLCMF” folder in the SD card. For details, refer to Managing User
Memo Profiles in the Canon XF Utility Instruction Manual.
2 Insert the SD card into the camera’s SD card slot.
3 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Add XML File] > [On].
4 Select MENU > [£% Recording/Media Setup] > [Metadata] > [XML File Format] > [User Memo].

5 Select MENU > [£% Recording/Media Setup] > [Metadata] > [User Memo] > Desired user memo file.

e The [ED icon appears on the left of the screen. (In CAMERA mode, only when [[Z) Monitoring Setup] >
[Custom Display 2] > [User Memo] is set to [On].)

e Select [Off] to record clips without a user memo.

(i) NoTes

e After you set a user memo, do not remove the SD card while you are recording. If the SD card is removed, the
user memo will not be added to the clip.

¢ You must set the user memo before you start recording for it to be added to the clips. You cannot change the user
memo already added to a clip using the camera but you can do so with Canon XF Utility.
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Using News Metadata

When recording, you can add News Metadata* to the recorded clips. Using Content Transfer Professional, you
can check and edit News Metadata files. The most recently set News Metadata will be prioritized and added.
See the following table for details on News Metadata settings.

* Refers to a metadata file compliant with the DPP002 Metadata Exchange for News recommendation ver. 1.1.1.

Entering content

Checking content

News Metadata Content Content
Camera Transfer Camera Transfer
Professional Professional
Story Title, Description, Keyword (Tags), Category, Contributor, Source/
L ) L - (] @ (]
Originator, Copyright Holder, Restrictions.
Genre - (] - (]
Language - - - o

(i) NoTes

¢ News Metadata files with file names that exceed 64 characters (extension included) cannot be used.

Setting News Metadata saved on an SD card

Before setting News Metadata, create a News Metadata file and save it to an SD card. Once you insert the SD
card into the camera, select the News Metadata file and start recording. The News Metadata will be added to
the recorded clips.

1 Save the News Metadata file to an SD card.
¢ News Metadata files should be saved in the “/ XMLTAG” folder of the SD card.

2 Insert the SD card into the camera’s card slot 2.
3 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Add XML File] > [On].
4 Select MENU > [ £2 Recording/Media Setup] > [Metadata] > [XML File Format] > [News Metadatal).

5 Select MENU > [ £% Recording/Media Setup] > [Metadata] > [News Metadata] > Desired News
Metadata file saved to the SD card.
* The selected News Metadata file will be saved to the camera.

(i) notes

* You cannot change the News Metadata already added to a clip using the camera but you can do so using
Content Transfer Professional.

Setting News Metadata edited with Content Transfer Professional

Before setting News Metadata, edit the News Metadata file using Content Transfer Professional. Connect the
camera to a smartphone using the smartphone application ([J1 177, 210) to transfer and save News Metadata
files from a smartphone to the camera. News Metadata will be added to the recorded clips.

1 Smartphone: edit the News Metadata file with Content Transfer Professional.
2 Connect the camera to a smartphone.
3 Operate Content Transfer Professional to transfer the News Metadata file to the camera.
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4 Save the News Metadata to the camera.
¢ News Metadata files transferred from a smartphone will be saved automatically to the camera.

¢ Automatically, MENU > [ £2 Recording/Media Setup] > [Metadata] > [Add XML File] will be set to [On], and
[XML File Format] will be set to [News Metadatal].

¢ Only the most recently transferred file can be saved.
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Resetting News Metadata
You can reset the News Metadata added to clips.

1 Select MENU > [ 2% Recording/Media Setup] > [Metadata] > [News Metadata Reset All].
2 Select [OK].

@ vrorTANT

¢ \When the camera is turned off normally, the News Metadata file is saved or a previously saved News Metadata
is reset. In the case of a power outage or if the power is not terminated normally the file will not be saved or
reset.

¢ News Metadata saved to the camera will be reset if you select MENU > [ System Setup] > [Reset] > [All
Settings], or if the camera’s firmware is updated.

Entering Slate Information About the Recording
You can enter scene and take information to help identify the recording later on.

Select MENU > [ £2 Recording/Media Setup] > [Metadata] > [Scene] or [Take] > [Change].
e Enter the desired text.
¢ To clear the scene/take information, select [Reset] instead.
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Special Recording Modes

The camera features the following special recording modes.

- Slow & fast motion recording (11 126).
Pre-recording (11 127).

- Continuous recording ([ 127).

- Frame recording (11 128).

- Interval recording ([11 129).

Slow & Fast Motion Recording

The camera can record using a progressive frame rate (shooting frame rate) that is different from the playback
frame rate. Recording a clip with a shooting frame rate higher than the [Frame Rate] setting will result in a slow
motion effect during playback. Conversely, a lower shooting frame rate will result in a fast motion effect.
Sound is not recorded when slow & fast motion recording is activated. The maximum recording time of a single
clip is the equivalent of approximately 6 hours of playback time.
For details regarding available frame rates, refer to Recording / Outout Signal and Detailed Settings (11 228).
1 Press the S&F button.
¢ Slow & fast motion recording is activated. [S&F STBY] appears
at the top of the screen and the shooting frame rate appears
next to the frame rate setting (the playback frame rate).
e To record audio, insert a card into the slot where video is not

being recorded, then select MENU > [ £ Recording/Media
Setup] > [Recording Mode] > [S&F Clip / Audio (WAV)].

2 Press the S&F FPS button and select the desired shooting
frame rate using the joystick or SELECT dial.

¢ Alternatively, you can set MENU > [£% Recording/Media
Setup] > [Recording Mode] to [Slow & Fast Motion] to activate
slow & fast motion recording and use the MENU > [£% Recording/Media Setup] > [Slow & Fast Frame
Rate] setting to set the shooting frame rate.

S&F FPS

3 Press the REC button to begin recording.
e The tally lamps illuminate in red (the rear tally lamp changes from green (power indicator) to red).
¢ [S&F STBY] changes to [S&F @ REC] while recording.
4 Press the REC button again to stop recording.
® The clip is recorded at the selected frame rate.
¢ The front tally lamp goes out and the rear tally lamp changes from red to green (power indicator) and
[S&F @ REC] changes back to [S&F STBY].

5 To end the special recording mode, press the S&F button again.

(i) Nnotes

e The shooting frame rate cannot be changed while recording.

¢ \When the slow & fast motion shooting frame rate exceeds 60P, the following functions cannot be used.
- Second card recording functions (proxy clips and sub recording clips).
- CV protocaol.

e When [S&F Clip / Audio (WAV)] is selected, slow & fast motion recording frame rates exceeding 60P cannot be
set.

¢ The time code signal will not be output from any terminal.
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e |f you change the system frequency, slow & fast motion recording will be canceled and the shooting frame rate
will be reset to its default value.
e About the time code when slow & fast motion recording is activated:
- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode.
- If the time code running mode was set to [Free Run], the time code running mode will be changed
automatically to [Rec Run] when slow & fast motion recording is activated.
- When the special recording mode is turned off, the time code running mode will return to its previous setting.
¢ \When recording in RAW format, [Sensor Mode] is set to [Super 35mm (Cropped)] and the frame rate is 120P,
the resolution will be 4096x2160.
¢ \When [Sensor Mode] is set to [Super 35mm (Cropped)] and the frame rate is 120P, the viewing angle is slightly
narrow regardless of the [Main Rec Format] and [Main Resolution] settings.

Pre-recording

When pre-recording is activated, the camera starts recording continuously onto a temporary memory (approx.
3 seconds) so when you press the REC button, the clip will contain also a few seconds of video and audio
recorded before you pressed the button. Pre-recording is not available when the main recording format is set to
RAW.

You can also use direct touch control to perform this function ([J] 63).

1 Select MENU > [£® Recording/Media Setup] > [Recording Mode] > [Pre-Recording].
¢ [PRE STBY] appears at the top of the screen.

2 Press the REC button to begin recording.
¢ The tally lamps illuminate in red (the rear tally lamp changes from green (power indicator) to red).
¢ [PRE STBY] changes to [PRE @ REC] while recording.

3 Press the REC button again to stop recording.
¢ The clip is recorded. The recorded clip will include a few seconds of video and audio recorded before the
REC button was pressed.
¢ The front tally lamp goes out and the rear tally lamp changes from red to green (power indicator) and
[PRE @ REC] changes back to [PRE STBY].

4 To end the special recording mode, select MENU > [ Recording/Media Setup] > [Recording
Mode] > [Normal Recording].

(i) NoTes

¢ About the time code when pre-recording is activated:
- The time code of the clip will start a few seconds before the REC button was pressed.
- The time code will be recorded with the running mode set to [Free Run].
- If the time code mode was set to [Regen.], or to [Preset] with [Rec Run] running mode, the time code
running mode will be changed automatically to [Free Run] when pre-recording is activated.
- When the special recording mode is turned off, the time code running mode will return to its previous
setting.

Continuous Recording

Audio and video are recorded on both cards in this mode, normal recording (following REC button operations
such as starting and stopping recording) on the CFexpress card, and continuous recording (uninterrupted
recording regardless of REC button operations) on the SD card. This function can be used when the main
recording format is set to XF-AVC S/ XF-HEVC S. Audio will be recorded in linear PCM format.
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With the exception of step 4, you can also use direct touch control to perform this function (1] 63).

1 Insert a card into each card slot (CFexpress card for normal recording, SD card for continuous
recording).

2 Select MENU > [£% Recording/Media Setup] > [Continuous Recording] > [REC].
e The continuous recording mode is activated and [CONT] appears on the screen next to the card 2 indicator.
e The tally lamp (front) illuminates in red, the power indicator/tally lamp (rear) changes from green to red, and

continuous recording starts on the SD card. The onscreen display changes to [@ CONT].

3 Press the REC button to start recording.
e Normal recording on card 1 starts.
¢ |f you press the button before step 2, recording will start on both cards.

4 Select MENU > [£% Recording/Media Setup] > [Continuous Recording] > [STBY].
e The tally lamp (front) goes out, the power indicator/tally lamp (rear) illuminates in green, and recording stops.
The onscreen display changes to [CONT].

5 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off
continuous recording.

(i) NoTES

¢ \When continuous recording is activated, if recording on the SD card (continuous recording) is not available,
normal recording will not be possible either.

e Continuous recording will continue even if the CFexpress card becomes full.

e |f [Continuous Recording] is set to [STBY] and the main recording format is changed to an option other than
XF-AVC S/ XF-HEVC S, continuous recording will be canceled.

Frame Recording Mode

Set the number of frames in advance. Each time you press the REC button the specified number of frames will
be recorded, and all of the recorded frames (until you end frame recording) are joined together into one clip. We
recommend operating the camera remotely or stabilizing the camera, for example, on a tripod. Sound is not
recorded in this mode.

You can also use direct touch control to perform this function ([11 63).

1 Select > [£¥ Recording/Media Setup] > [Recording Mode] > [Frame Recording].
¢ [FRM STBY] appears on the screen (with [FRM] flashing).
2 Select > [ £¥ Recording/Media Setup] > [Frame Rec: Frame Rate] > Desired option.
3 Press the REC button to begin recording.
e The tally lamp (front) illuminates in red, and the power indicator/tally lamp (rear) changes from green to red.
¢ [FRM STBY] changes to [FRM @ REC] while recording.
e The camera automatically records the specified number of frames. The onscreen display changes to [FRM
@STBY].
4 Repeat until you finish recording.
5 Select > [ 2 Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop frame
recording.
e Frame recording mode ends and all of the recorded frames are joined together into one clip.
e The tally lamp (front) goes out, and the power indicator/tally lamp (rear) illuminates in green.
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(i) NoTes

¢ Frame recording cannot be used simultaneously with slow & fast motion recording, pre-recording, interval
recording or continuous recording.

¢ Frame recording cannot be used when the frame rate is set to 59.94i or 50.00i. When in use, frame recording 129
will end if the frame rate is set to 59.94i or 50.00i. —

e The number of frames recorded cannot be changed while recording.

® The same image as the last frame when frame recording was stopped may be recorded and added to the end
of the clip.

¢ About the time code when frame recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. The time code
advances by the number of frames recorded every time.

- If the time code running mode was set to [Free Run] or the camera was synchronized to an external time
code signal, the time code running mode will be changed automatically to [Rec Run] when frame recording
is activated.

- When the special recording mode is deactivated, the time code running mode will return to its previous
setting.
- The time code signal will not be output from any terminal.

Interval Recording Mode

Set the interval and number of frames in advance. Sound is not recorded in this mode.
You can also use direct touch control to perform this function ([11 63).

1 Select > [ £% Recording/Media Setup] > [Recording Mode] > [Interval Recording].
¢ [INT STBY] appears at the top of the screen (with [INT] flashing).

2 Select > [£% Recording/Media Setup] > [Interval Rec: Time Interval] > Desired option.
3 Select > [ % Recording/Media Setup] > [Interval Rec: Frame Rate] > Desired option.

4 Press the REC button to begin recording.
e The tally lamp illuminates in red.
¢ [INT STBY] changes to [INT @REC] while recording.
e The camera automatically records the set number of frames at the specified interval.

5 Press the REC button again to stop recording.
¢ The tally lamp (front) goes out, and the power indicator/tally lamp (rear) illuminates in green.

6 Select > [ £¥ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop interval
recording.

(i) NoTEs

e Interval recording cannot be used simultaneously with slow & fast motion recording, pre-recording, frame
recording or continuous recording.

¢ Interval recording cannot be used when the frame rate is set to 59.94i or 50.00i. When in use, interval
recording will end if the frame rate is set to 59.94i or 50.00i.

® The interval and the number of frames recorded cannot be changed while recording.

e The same image as the last frame when interval recording was stopped may be recorded and added to the
end of the clip.
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¢ About the time code when interval recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. The time code
advances by the number of frames recorded every time.

- If the time code running mode was set to [Free Run] or the camera was synchronized to an external time
code signal, the time code running mode will be changed automatically to [Rec Run] when interval recording
is activated.

- When the special recording mode is deactivated, the time code running mode will return to its previous
setting.

- The time code signal will not be output from any terminal.
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Using Anamorphic Lenses

You can attach an anamorphic lens to the camera and set the anamorphic desqueeze ratio used to display the
image from the camera on monitoring devices while shooting or during playback.
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1 To apply the anamorphic desqueeze to individual video outputs, select MENU > [(Z) Monitoring —

Setup] > one of the [Anamorphic:] options > [On].

2 Select MENU > [[E) Monitoring Setup] > [Anamorphic Desqueeze] > Desired option.
® You can select a fixed desqueeze factor of x2.0, x1.8, x1.5 or x1.33. If you selected [Lens Squeeze Factor],
the anamorphic correction will be applied according to the factor specified with the MENU > [ £%
Recording/Media Setup] > [Metadata] > [Lens Squeeze] setting.

3 If necessary, select MENU > [[Z) Monitoring Setup] > [Desqueeze for S&F] > [Reduced Display] or
[Off].
¢ \When slow & fast motion recording is activated, the desqueezed image can only be displayed windowboxed
([Reduced Display]). You can select [Off] to display the image without correction.
¢ \When [Sensor Mode] is set to [Full Frame 3:2], the image is reduced according to the magnification set in
[Anamorphic Desqueeze], even during slow & fast motion recording.

(i) NoTes

e You can record the lens’s squeeze factor in the clip’s metadata with the MENU > [ £% Recording/Media
Setup] > [Metadata] > [Lens Squeeze] setting.

¢ \When [Sensor Mode] is set to an option other than [Full Frame 3:2] and normal recording mode is in use, if you
output 4096x2160 or 3840x2160 video at a frame rate of 59.94P or 50.00P via the HDMI OUT terminal or the
SDI OUT (12G-SDI) terminal, the video output will be as follows:
- If [Anamorphic: MON./HDMI] is set to [On]: 1920x1080
- If [Anamorphic: SDI] is set to [On]: 2048x1080, 1920x1080.

e \When outputting 4096x2160 from the SDI OUT (12G-SDI) terminal, it will output at 2048x1080 when all of the
following conditions are met.
- [Anamorphic: SDI] is set to [On]
- [Sensor Mode] is set to [Full Frame]
- [Main Rec Format] is set to RAW
- [Frame Rate] is set to 29.97P, 23.98P, 25.00P or 24.00P

e The image displayed during photo playback and the camera’s live view image in the Browser Remote
application will not be desqueezed.
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Using the Optional RC-V100 Remote Controller

Using the Optional RC-V100 Remote Controller

You can connect the optional RC-V100 Remote Controller to the camera’s REMOTE terminal in order to control
the camera (including advanced recording functions) from a distance. The remote controller lets you turn the
camera on, navigate the menus and remotely control the aperture and shutter speed, change picture-related
settings like the knee and sharpness, and more.

For details on how to connect and use the remote controller, refer to its instruction manual.

REMOTE

REMOTE

Remote cable
(supplied with the RC-V100)

1 Turn off the camera and connect the optional RC-V100 Remote Controller to the camera.
2 Turn on the camera in CAMERA mode.
3 Select MENU > [¥ System Setup] > [REMOTE Term.] > [RC-V100 (REMOTE A)].

Options

[RC-V100 (REMOTE A)]:
Select this option to use the optional RC-V100 connected to the camera with the RC-V100’s
remote cable.

[Standard]: Select this option to use commercially available remote controls.

(i) NoTES

e The AUTO KNEE button and AF button on the remote controller will have no effect on the camera.

¢ The AUTO IRIS button on the remote controller can operate the camera only when a compatible lens (11 276)
is attached to the camera.

¢ The ZOOM dial on the remote controller can operate the lens only when a compatible lens ([11 276) is
attached to the camera.



Customization

Assignable Buttons

The camera offers a number of assignable buttons to which you can assign various functions.

On the LCD monitor

>/l

INDEX/H

.

1 Press the MENU button and, while holding it pressed down, press the assignable button whose
function you wish to change.

¢ Alist of available functions appears with the current function assigned to the button highlighted.
¢ You can also select the appropriate menu setting from the various pages of the MENU > [& Assignable
Buttons] menu.
2 Select the desired function.
* The selected function will be assigned to the selected button.
¢ |f you selected one of the preset functions, the rest of the procedure is not necessary. If you selected [User
Setting], continue the procedure to register a menu setting.
3 Navigate the menus as necessary and select the menu setting you want to register.
® The selected menu setting will be assigned to the selected button. User-selected settings will be indicated
with a icon in the [@ Assignable Buttons] menu.

4 Press the assignable button to use the assigned function as described in the following table.

(i) NoTES

¢ You can check the [@ Assignable Buttons] status screens ([J] 227) to see what functions are currently
assigned to each button.

e You can reset only the functions assigned to the assignable buttons, without affecting other camera settings,
with the MENU > [ System Setup] > [Reset] > [Assignable Buttons] function. All the assignable buttons will
return to their default function.
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¢ \When you select [Enable] in MENU > [@ Assignable Buttons] > [Link to Camera], the functions assigned to
assignable buttons 1-4 on the camera can also be assigned to assignable buttons 1-4 of the RC-V100,
RC-IP100/RC-IP1000, Remote Camera Control Application, and Multi-Camera Control.

134

Assignable functions
Functions can be set separately in CAMERA mode and MEDIA mode. Refer to the following table for assignable

functions and available modes.

. - CAMERA ~ MEDIA

Function name Description mode mode n|
[One-Shot AF]1 The camera focuses automatically one time only (one-shot AF function). [ ) - 91
[AF Lock] Turns the AF lock function on/off.
[AF Lock (While Activates the AF lock function while the button is held pressed down. [ - 93
Pressed)]?
[AF Frame] Toggles the size of the AF frame. @ - 94
[AF Frame - Small Zone] | Switches the AF frame between [Small Zone] and [Whole Area]. @ -
[AF Frame - Zone] Switches the AF frame between [Zone] and [Whole Area]. [ J -
\[2 I;t]F rame - Large Zone: Switches the AF frame between [Large Zone: Vertical] and [Whole Area]. [ J - 94
I[_'IAOF”;E rame - Large Zone: Switches the AF frame between [Large Zone: Horizontal] and [Whole Area]. [ J -
[Focus Mode] Toggles the focus mode between AF (autofocus) and MF (manual focus). [ J - 88
[Face Detection AE] Turns face detection AE on/off @ - 94
(Subj. Detect. AF] Toggles the [Subj. Detect. AF] setting between [Detect. Priority] and [Detect. °® _ 94

Only].

[Subject to detect] Switches the subject to be detected. @ - 94
Ee‘:ggt to Detect - Switches the [Subject to Detect] setting between [Peaple] and [None]. ° -

: 94
E\Snl:zgfst]m Detect - Switches the [Subject o Detect] setting between [Animals] and [None]. ° -
[Eye Detection] Turns eye detection on/off. @ - -
[Tracking] Turns the tracking function on/off. @ - 95
[Focus Guide] Turns the focus guide on/off. [ ) - 89
[Focus Position
Marker 1]
[Focus Position Registers [Marker 1 Color] to [Marker 3 Color] set in MENU as the focus position

1 o - 91
Marker 2] markers.
[Focus Position
Marker 3]
[Peaking: Allj,
[Peaking: VIDEO Term.], )
[Peaking: MON./HDMI], Turns peaking on/off. @ 90
[Peaking: SDI]
[Magnification],
[Magn.: VIDEO Term.], - _
(Magn.: MON./HDMI Turns magnification on/off. @ 90
[Magn.: SDI]
Cycles through the digital tele-converter options in the following order:

[Tele-converter] X1.5 - x2.0 = x2.5 = x3.0 >Off. o %
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. L CAMERA ~ MEDIA
Function name Description mode mode RA]

[Tele-converter - x3.0] Switches the [Tele-converter] setting between [x3.0] and [Off]. @ -

[Tele-converter - x2.5] Switches the [Tele-converter] setting between [x2.5] and [Off]. [ J - 99

[Tele-converter - x2.0] Switches the [Tele-converter] setting between [x2.0] and [Off]. o -

[Tele-converter - x1.5] Switches the [Tele-converter] setting between [x1.5] and [Off]. o -

[Push Auto Iris]‘ The camera automatically adjusts the aperture only while the button is held PY _ 82
pressed down.

[Iris Mode] Switches the aperture adjustment mode between automatic and manual. o - o1

[Iris +], [Iris =] Opens up/closes the aperture, respectively. @ -

IND +], [ND ] Cycles throqgh ND filter settlr?gs in increasing (higher density) or decreasing Py _ 80
(lower density) order, respectively.

[Auto Clear Scan Setting] | Displays the [Auto Clear Scan Setting] screen @ - 74

[Base 1SO] Switches between base ISO speed settings. o - 77

[ISO/Gain Mode] Switches between automatic and manual mode. [ J - 76

[AE Shift +], [AE Shift—] | Compensates the exposure making the image brighter/darker, respectively. [ ) - 83

(Backlight], [Spotlight] Toggles. the light metering mode between [Standard] and [Backlight]/[Spotlight], ° _ 83
respectively.

[Zebra: All],

[Zebra: VIDEO Term.], _

[Zebra: MON./HDMI Turns zebra patterns on/off. o 103

[Zebra: SDI]

[WFM: Allj,

[WFM: VIDEO Term.], .

[WEM: MON./HDMI, Turns the selected video scope on/off. o o 120

[WFM: SDI]

[LUT: Allj,

[LUT: VIDEO Term.],

[LUT: MON.], Turns LUTs on/off. @ (] 171

[LUT: HDMI],

[LUT: SDI]

[False Color: All],

[False Color: VIDEO

Term.],

[False Color: MON./ Turns the false color overlay on/off. ° _ 171

HDMI],

[False Color: SDI]

[False Color Index] Displays/hides the false color index screen.

[White Balance] Enters the dlre.ct setting mode with the white balance mode highlighted and PY _ 85
ready to be adjusted.

[Set White Balance] Starts the white balance calibration for a custom white balance setting. o - 85

[AWB Lock]1 While using auto white balance (AWB), locks the current white balance settings. o - 87

[[R AwB],

[ Set A], [®4 Set B],

[se: Daylight], Changes the white balance mode/setting to the respective option. [ J - 85

[38¢ Tungsten],

[ 4 Kelvin]

[Lens Optical IS] Turn lens optical IS on/off. @ - -
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. _ CAMERA ~ MEDIA

Function name Description mode mode A

[Digital IS] Turns the digital image stabilizer (digital IS) on/off. @ -
Pauses/resumes the digital IS function. Switching is possible while recording. 97
[Pause Digital IS] The angle of view is maintained even when the digital IS function is temporarily @ -
paused.

(LCD Setup] Eggn:ctrr;z r[] Monitoring Setup] menu page with the settings for adjusting the °® °® 218
[0SD Output: MON./
HDMI], Turns the camera’s onscreen displays on/off. [ ) o 169
[OSD OQutput: SDI]
[OSD Opacity: All],
[OSD Opacity: VIDEO
Term., . Changes the transparency level of onscreen displays. @ @ 169
[OSD Opacity: MON./
HDMI],
[OSD Opacity: SDI]
[DIsP| E:;zgés the onscreen display level, replicating the function of the camera’s DISP ° ° 59
[OSD Orient.: VIDEO Changes the onscreen display direction in the following order: standard, °® _ 61
Term.] 90 degrees rotation, 270 degrees rotation.
[Markers: All],
mg: \I\lllll())EO/I-Tlgrl\r/Inl]] Turns onscreen markers on/off. @ @ 101
[Markers: SDI]
[Color Bars] Turns color bars on/off. [ J - 119
[IP Streaming] Turns the IP streaming function on/off. @ - 200
[Photo]! Records a photo. ) - 54
[Review Recording]' Plays back the last clip recorded in CAMERA mode. @ - 62
[Time Code] Opens the [§ System Setup] menu page with the time code settings. @ - 105
[Add Shot Mark]' Adds a shot mark to the clip. [ ) o 122,
{ﬁgg I\'\:::lﬂ Adds an [ or [ mark to the clip. [ ) o 11553
{:gzggﬂg:gz :r]] Increases/reduces the headphone volume, respectively. [ ) o 154
[Monitor Channels] Switches the audio channels output from the () (headphone) terminal. [ J o 175
[Audio Level Indicator] Turns the audio level meter on/off. [ J o 116
(FUNC] Ezgithe direct setting mode, replicating the function of the camera’s FUNC °® _ 64
[Slow & Fast Motion] Turns slow & fast motion recording on/off.
[Slow & Fast Frame Rate] \FIZ?:?HS(I)(:(\;\; :&t;azz jT;)ttii(:.n recording is activated, highlights the shooting frame ® - 126
[Output:
60<>60(24)fps]" 3 Turns on/off making output terminal/screen video equivalent to 24 fps (or 30 fps) o h h
[Output: when the frame rate is 59.94P or 59.94i. ° B B
60<60(30)fps]" 3
[RETJ1 Displays/hides the return video. @ - 100
[RET (While Pressed)]‘v 2 Displays the return video while the button is held pressed down. @ - 100
(ris] Enters the direct setting mode with the aperture value highlighted and ready to °® _ 81

be adjusted.
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. - CAMERA ~ MEDIA

Function name Description mode mode A
(Shutter] 52;3::3,8 direct setting mode with the shutter speed highlighted and ready to be °® _ 74
(1S0/Gain] rE:;z;st;hsed;rgjzt;:(tit.ing mode with the ISO speed or gain value highlighted and Py _ 77
[Status]' Displays the status screens. @ (] 227
[Audio Status] l[)ﬁ[;;axz ;rll:s[ BJtL )p)] /r-]\:;dniz.Setup] status screens. You can press SET to open the °® P _
[MENU] Displays the menu. @ o -
[Custom Picture] Opens the [[@& Custom Picture] menu. ] - 138
[My Menu] Opens the [ Y& My Menu] customized menu. [ J - 41
[Initialize Media] Opens the [Initialize Media] submenu. o o 45
[Play/Pause] Pauses and resumes the playback. - o 151
[INDEX/Cancel Resume] | Switches the index screen. If you select a file with a saved frame position (when ° 151
[INDEX] paused), the saved position will be reset if you perform Cancel Resume.
[Slot Selection] Switches between card slots. o o 45
[Select File] File selection. - o -
[Refine] Switches [Refine] (refining clip selection) on/off. - o -
[Frame.io Upload] Adds clip to the Frame.io upload queue. - o 210
[REC] (I;t;rrlnc;i;n: ;s the REC button. Can only be assigned to assignable button PY _ 53
[CAMERA<MEDIA]? 4 Switches between CAMERA mode and MEDIA mode. @ (] -
(EY User Setting]‘ :)eugsi;cigizable slot. Assign to the button any menu setting you would like to °® P _

! Function can be used only by assigning it to a button.
Cannot be used with XC Protocol.

3 Not available when slow & fast motion recording is activated.

4 Cannot be set with Browser Remote/XC Protocol. Even when [Link to Camera] is set to [Enable], operation from Browser
Remote or XC protocol is not possible.
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Custom Picture Settings

Custom Picture Settings

The camera lets you change many settings (11 142) that control various aspects of the image produced. As a
set, all these settings are treated as a single custom picture file. After adjusting the desired settings to your
preference, you can save up to 20 custom picture files (in the camera or on an SD card), and load them later to
apply exactly the same settings ([11] 141). You can also save the custom picture file as part of the metadata
recorded with clips (1] 142).
Custom picture settings have no effect on RAW recordings.

Selecting Custom Picture Files
In CAMERA mode, select a custom picture file to apply its settings to your recordings or to edit, rename, protect,

or transfer it.

1 Select MENU > [[@d Custom Picture] > [Select File].

e The custom picture file selection screen is displayed.

e Select one of the custom picture files saved in the camera (C1 to C20). To use the settings of a custom
picture file saved on an SD card, copy the file to the camera in advance ([J] 142).

2 Select the desired file.

¢ \When you close the menu, the selected custom picture file’s settings will be applied.

Preset Picture Settings

The following settings are saved to custom picture files C1 to C20 as preset custom picture settings. Custom
picture files C1 to C9 are protected by default and need to be unprotected before they can be edited.

Preset custom picture

file [Gamma/Color Space]* [Color Matrix]  [Look File] Characteristics
These settings produce a look appropriate also for use without
. _ post processing, featuring high contrast while ensuring a wide
C1: [Canon 709] [Canon 709/ BT.709] dynamic range optimized for playback on BT.709 compliant
monitors.
These settings use Canon Log 2 gamma and require post-
[Canon Log 2/ ) ) ; ) A
C2: [Canon Log 2] C.Gamu - production processing. They achieve superior gradation in the
’ (Neutral] shadows (dark areas of the image).
These settings use Canon Log 3 gamma and require post-
[Canon Log 3/ ) .
C3: [Canon Log 3] - production processing. They keep the [Canon Log] gamma
C.Gamut] L ) L .
characteristics while expanding its dynamic range.
) [BT.709 Wide DR/ These settings produce a wide dynamic range and are
4: [BT.709 Wide DR - ) ) .
C4: [BT.709 Wide DR] BT.709] appropriate for playback on BT.709 compliant monitors.
These settings are appropriate for playback on BT.709 compliant
BT.709 St ) .
C5: [BT.709 Standard] [ (;S)Ti?;g]dard / [Video] - monitors, and use a gamma curve that meets ITU-R BT.709

standards.
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Preset custom picture

file [Gamma/Color Space]* [Color Matrix] [Look File] Characteristics

. _ These settings use a high dynamic range gamma curve
c6: [PQ] [PQ/BT.2020] compliant with the PQ standard defined by ITU-R BT.2100.
C7: [HLG] [HLG / BT.2020] _ These settings use a high dynamic range gamma curve

compliant with the HLG standard defined by ITU-R BT.2100.

Reproduces the image quality and look of an EOS

C8: [EOS Standard] [BTJ%?;V(;S;’ DR/ On interchangeable lens DSLR camera with its picture style set to
Neutral] [Standard]. : .
) Reproduces the image quality and look of an E
BT.709 Wide DR
C9: [EOS Neutral] [BT-709 Wide DR / On interchangeable lens DSLR camera with its picture style set to
BT.709]

[Neutral].
These settings produce a look appropriate also for use without
C10: [User10] to post processing, featuring high contrast while ensuring a wide

C20: [User20] [Canon 709 /BT.709] dynamic range optimized for playback on BT.709 compliant

monitors.

* MENU > [[®@ Custom Picture] > [Edit File] > [Gamma/Color Space] setting.

(1) NoTES

¢ About the logarithmic gamma curves (Canon Log settings)
These gamma curves require post-production processing. They were designed to make the most of the
imaging sensor characteristics in order to obtain impressive levels of dynamic range.
- In CAMERA mode, you can apply a LUT to the supplied LCD screen or video output from the various
terminals to use gamma curve settings more suitable for viewing on a monitor screen.
- There are also other LUTs available that can be applied for processing in post-production. For the latest
information on available LUTs, please visit your local Canon website.
e About changing custom picture related settings using the optional RC-V100 Remote Controller
- When an optional RC-V100 Remote Controller is connected to the camera, you can press the remote
controller's CUSTOM PICT. button to open the [[@d Custom Picture] menu.
- If a protected custom picture file is selected on the camera, custom picture related settings cannot be
changed using the remote controller.
- Adjusting custom picture related settings using the remote controller will change the settings registered

under the currently selected custom picture file. If you want to keep an important custom picture file, copy it

in advance to an SD card or select in advance a custom picture file you do not mind changing.

Editing a Custom Picture File’s Settings

In CAMERA mode, adjust the image quality to your preference and save the settings as part of a custom picture

file.

1 Select a custom picture file (1 138).

2 Select MENU > [[@d Custom Picture] > [Edit File].
e Select an unprotected custom picture file.

3 Select a setting you wish to change and select the desired option.
¢ Refer to Available Custom Picture Settings (11 142) for details on the various settings.

Renaming Custom Picture Files
1 Select a custom picture file (11 138).
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2 Select MENU > [[@d Custom Picture] > [Edit File] > [Rename] > [Input].
e Enter the desired file name (Up to 16 characters) (1] 42).

Protecting Custom Picture Files
Protecting a custom picture file prevents its settings from being accidentally changed.
1 Select a custom picture file (11 138).
2 Select MENU > [[@d Custom Picture] > [Edit File] > [Protect] > [Protect].
o [od] will appear next to the file name.
¢ To remove the protection, select [Unprotect] instead.

Resetting Custom Picture Files
1 Select a custom picture file (11 138).
2 Select MENU > [[@d Custom Picture] > [Edit File] > [Reset].
3 Select a preset custom picture setting and then select [OK].
* The custom picture file will be reset to the selected values.

Look Files

You can register LUT files created with Blackmagic Design’s DaVinci Resolve as Look Files in the custom picture
file. Using a Look File allows you to adjust the video quality of the recorded video. These adjustments apply also
to proxy clips, photos, and screen/output terminals.

1 Insert the SD card with the desired Look File (.cube format, located in the root directory of the SD
card) into the camera’s SD card slot.

2 Select a custom picture file. (] 138)
3 Select MENU > [[@d Custom Picture] > [Edit File] > [Gamma/Color Space] > Desired option.

4 Select MENU > [[@ Custom Picture] > [Edit File] > [Look File Setup] > [Register].
e The Look Files in the SD card will be displayed.

5 Select the desired Look File.
e If the Look File contains settings, the message [The settings saved in the file will be loaded
simultaneously] will be displayed.
e To use the settings from the file, select [OK] and proceed to step 7.
e \When not using the settings from the file, select [Manual Setting] and proceed to step 6.

6 Select the [Gamma/Color Space] setting to use after the Look File is applied and then select [OK].

7 Select [OK].
® The selected Look File will be loaded and registered to the custom picture file.
e Then, the image quality adjustments set in the Look File will be applied, and [LOOK] will appear on the screen.

¢ When you disable the image quality adjustments set in the Look File, select MENU > [[@l Custom Picture]
> [Edit File] > [Look File] > [Off].

(i) NoTES

About Look files
- The camera supports LUT files (3D LUT/.cube format) in 17 grid or 33 grid format created with Blackmagic
Design’s DaVinci Resolve.
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- LUT files with input ranges outside the 0 to 1 range in the header (“LUT_3D_INPUT_RANGE”) are not
supported.
- LUT files which include values outside of the 0 to 1 range in the data area are not supported.
- LUT files 2 MB and larger, as well as files with a name containing over 65 characters are not supported.
- Only the following characters can be used in the file name:
Numbers 0 to 9, upper/lower case letters a to z, underscore (_), hyphen (-), period (.) and a single byte
space.
Save a Look File to the root directory of the SD card.
If the correct input/output gamma curve and color space conversion are not selected, video will not be output
correctly.
A Look File cannot be used if the [Gamma/Color Space], [HLG Color], [White Level 100%] or [Over 100%)]
settings are changed after registering it.
When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to either
[BT.709 Standard] or [BT.709 Wide DR], super-white (video signal above 100%) and super-black (video signal
below 0%) levels of brightness will be clipped. When the video signal contains super-white brightness levels,
select MENU > [[@d Custom Picture] > [Edit File] > [Other Functions] > [Over 100%] > [Press] and then
activate the Look File to apply it to a signal compressed to 100%.
When playing RAW clips, the Look File registered when the clip was recorded will only be applied to the
thumbnail and not the clip itself.

Deleting a Look File
You can delete Look Files registered in custom picture files.

1 Select a custom picture file (1] 138).
2 Select MENU > [[@d Custom Picture] > [Edit File] > [Look File Setup] > [Delete] > [OK].

¢ The Look File will be deleted and the image quality adjustments will be reversed to the original settings of the
selected custom picture file.

Saving a Custom Picture File

Copying Custom Picture Files
You can copy custom picture files between the camera and SD card

Copying Custom Picture Files

You can copy custom picture files between the camera and SD card. Insert in advance into the camera the card
where you want to save your custom picture files or the card that contains the custom picture file you want to
load.

Copying a File from the Camera to an SD Card

1 Select a custom picture file (11 138).

2 Select MENU > [[@d Custom Picture] > [Save File] > [Save to SD Card)].
3 Select the destination file on the card.

e Select an existing custom picture file to overwrite it or [New File] to save the settings as a new custom
picture file on the card.

4 Select [OK].
e The selected custom picture file is copied to the SD card.
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o |f [New File] is selected, it is automatically added at the end.

Replacing a File in the Camera with a File on an SD Card
1 Select the custom picture file that you wish to replace ([11 138).
2 Select MENU > [[@d Custom Picture] > [Save File] > [Load from SD Card].
3 Select the file with the settings that you want to replicate.
4 Select [OK].
* The selected custom picture file is overwritten.

Embedding the Custom Picture File in Clips

When you record after having set custom picture settings, you can have the custom picture file embedded in the
metadata and saved along with the clips.

Select MENU > [£% Recording/Media Setup] > [Metadata] > [Add File] > [On].

Available Custom Picture Settings

Menu items Options / Additional information

[Gamma/Color Space] [Canon Log 2 / C.Gamut], [Canon Log 3 / C.Gamut], [Canon Log 3 / BT.2020],
[Canon Log 3/ BT.709], [Canon 709 / BT.709], [BT.709 Wide DR / BT.709],
[BT.709 Standard / BT.709], [PQ / BT.2020], [HLG / BT.2020]

Combination of gamma curve and color space settings that affects the overall look and color space of
the image.

Gamma curve
[Canon Log 2]: Logarithmic gamma curve that obtains a richer color gradation in the dark areas of
the image. Requires image processing in post-production.
,’ T Canon709 [Canon Log 3]: Logarithmic gamma curve that keeps the characteristics of the [Canon Log] setting
7 o g;gg gffd[);d while expanding its dynamic range. Requires image processing in post-production.
——PQ [PQ]: HDR (high dynamic range) gamma curve compliant with the PQ standard defined by ITU-R
—HGe BT.2100.
Input [HLG]: HDR (high dynamic range) gamma curve compliant with the HLG standard defined by ITU-R
BT.2100.
[BT.709 Wide DR]: Gamma curve with a very wide dynamic range. Optimized for playback on BT.709
compliant monitors. Equivalent to the [Wide DR] setting in previous camera models.
[BT.709 Standard]: Gamma curve that meets ITU-R BT.709 standards, for playback on BT.709
compliant monitors. Equivalent to the [Normal 3] setting in previous camera models.
""" Canon Log 2 [Canon 709]: Gamma curve appropriate also for use without post processing, featuring high contrast
Canon Log 3 while ensuring a wide dynamic range. Use this when outputting to a BT.709 compliant monitor.

Output

Output

Color space
Input [C.Gamut]: Color space developed by Canon based on the specific characteristics of the camera’s
imaging sensor. It covers a wider color gamut than that of BT.2020. Use this setting with
workflows that require ACES2065-1 color space.
[BT.2020]: Color space that meets ITU-R BT.2020 standards, which defines parameters for ultra-
high-definition television (4K/8K).
[BT.709]: Standard color space that is compatible with SRGB specifications.




Menu items
[Color Matrix]

Custom Picture Settings

Options / Additional information
[Neutral], [Production Camera], [Video]
The color matrix affects the overall color tonality of the image.
[Neutral]: Reproduces neutral colors.

[Production Camera]: Reproduces colors more suitable for motion picture production.
[Video]: Reproduces colors with a contrast suitable for TV broadcasting.

[Look File]

[On], [Off]
Image quality adjustments set in the Look File will be applied.

[Look File Setup]

[Register] Registers a Look File to a custom picture file.
[Delete] Deletes a Look File registered to a custom picture file.
[HLG Color] [BT.2100], [Vivid]
Changes the quality of color reproduction when using the hybrid log gamma (HLG). This setting is
only available when [Gamma/Color Space] is set to [HLG / BT.2020].
[BT.2100]: Color reproduction according to ITU-R BT.2100 specifications.
[Vivid]: More saturated color reproduction according to the 'Traditional Colour' approach in ITU-R
BT.2390.
[Black]
[Master Pedestal] -50 to +50 (+0)
Increases or decreases the black level. Higher settings will make dark areas brighter but decrease
contrast. This setting is not available when the gamma curve component of the [Gamma/Color
Space] setting is set to one of the [Canon Log 2] or [Canon Log 3] options.
[Master Black Red)], —-50 to +50 (x0)
[Master Black Green], These settings correct the color cast in blacks. These settings are not available when the gamma
[Master Black Blue] curve component of the [Gamma/Color Space] setting is set to one of the [Canon Log 2] or [Canon

Log 3] options.

[Black Gamma]

[Level]

—-50 to +50 (x0)

[Range], [Point]

[Point]

A Level
A

. [Range_.!

Output

Input

[Low Key Saturation]

—20 to +50 (x0)

These settings control the lower part of the gamma curve (dark areas of the image). These settings
are only available when the gamma curve component of the [Gamma/Color Space] setting is set to
one of the [BT.709 Standard] options.

[Level]: Raises or lowers the lower part of the gamma curve.

[Range]: Selects the adjustment range from the selected [Point].

[Point]: Determines the shape of the lower part of the gamma curve.

[Activate] [On], [Off]
Set this setting to [On] to enable the adjustment of color saturation in dark areas with the [Level]
setting.
[Level] -50 to +50 (+0)
Specifies how saturated colors are in dark areas.
[Knee]
[Activate] [On], [Off]

Set this setting to [On] to enable the adjustment of the knee point with the following settings. These
settings are only available when the gamma curve component of the [Gamma/Color Space] setting is
set to one of the [BT.709 Standard] options.

[White Level 100%]

[On], [Off]

[Slope]

-35 10 +50 (---)
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Custom Picture Settings

Menu items
[Point]
[Saturation]
[Slope]

QOutput

Input

Options / Additional information
50% to 100% (85%)
—-10 to +10 (x0)

These settings control the upper part of the gamma curve (highlights of the image). By compressing
the highlights, you can prevent parts of the image from being overexposed.

[White Level 100%)]: Adjusts automatically to keep output at 100% even if [Point] is changed.
[Slope]: Determines the slope of the gamma curve above the knee point.

Point
Pomd [Point]: Sets the knee point of the gamma curve. When [White Level 100%] is set to [Off], it is

- - adjusted within a range of 50% to 109%.

£ [Saturation]: Adjusts the color saturation in the highlights.

O

Input

[Sharpness]

[Level] —10 to +50 (+0)

Sets the sharpness level of the video output signal and the recorded signal.
[Detail Frequency] -810 +8 (+0)

Sets the center frequency of horizontal sharpness. Setting higher values increases the frequency,
which, in turn, increases the sharpness.

[Coring Level]

-30 to +50 (x0)

Sets the level of correction of artifacts caused by high sharpness levels (coring). Higher values
prevent sharpness from being applied to minute details, resulting in less noise.

[Limit]

-50 to +50 (=0)
Restricts how much sharpness is applied.

[Noise Reduction]

[Automatic] [On], [Off]
Adaptively changes the noise reduction effect.
[Spatial Filter] [Off], 1to 12

Reduces noise by applying a soft focus-like effect on the entire picture. When set to a value other
than [Off], afterimages are not produced but the whole image will have a softer look.

[Frame Correlation]

[0ff], 1103

Reduces noise elements by comparing the current image to the previous one (field). When set to a
value other than [Off], the perceived resolution will not be affected but an afterimage may appear for
moving subjects.

[Skin Detail]
[Effect Level] [Off], [Low], [Middle], [High]
[Hue] 16 to +16 (x0)
[Chroma], [Area], [Y Level] 0to 31 (16)

The camera applies a softening filter to areas in the picture with skin tones to give a more pleasant
appearance. By changing these settings, you can determine what areas will be detected as skin
tones. A zebra pattern will appear on the screen over areas of the image that are detected as having
skin tones.

[Effect Level]: Adjusts the level of the filter.

[Hue]: Adjusts the hue for detection of skin tones.

[Chroma]: Adjusts the color saturation for detection of skin tones.

[Area]: Adjusts the color range for detection of skin tones.

[Y Level]: Adjusts the brightness for detection of skin tones.




Menu items
[Color Matrix Tuning]
[Gain]
[Phase]

Custom Picture Settings

Options / Additional information

50 t0 +50 (+0)
-1810 +18 (x0)

These settings adjust the color intensity ([Gain]) and color phase ([Phase]) of the color matrix,
affecting the color tones of the whole image.

[R-G], [R-B], [G-RY, [G-B],
[B-RI, [B-G]

-50 to +50 (x0)

Each matrix changes the tint of the picture along the color gradations detailed below, affecting the
color tones of the whole image.

[R-G]: cyan/green and red/magenta; [R-B]: cyan/blue and red/yellow;

[G-R]: magenta/red and green/cyan; [G-B]: magenta/blue and green/yellow;

[B-R]: yellow/red and blue/cyan; [B-G]: yellow/green and blue/magenta.

[White Balance]

[R Gain], [G Gain], [B Gain]

-50 to +50 (x0)

These settings adjust the amount of white balance throughout the whole image by changing the
intensity of red tones ([R Gain]), green tones ([G Gain]), and blue tones ([B Gain]).

[Color Correction]
[Select Area]

[Off], [Area A], [Area B], [Area A&B]

The camera detects areas with certain color characteristics (color phase, chroma, area and Y level)
and corrects them when recording. You can set the color correction for up to two different areas

(A and B) and apply the color correction to either one ([Area A] or [Area B]) or both of them ([Area
A&BY).

While color correction is activated, parts of the image that are not detected as having the
characteristics specified for area A or B will appear colorless on the external monitors connected to
the VIDEO, SDI OUT, MON. or HDMI OUT terminals (except when adjusting the [Revision Level]/
[Revision Phase] settings).

[Area A Setting Phase],
[Area B Setting Phase]

010 31 (0)
These settings determine the color phase of the area to be corrected (A or B, respectively).

[Area A Setting Chroma],
[Area A Setting Area],
[Area A Setting Y Level],
[Area B Setting Chroma],
[Area B Setting Area],
[Area B Setting Y Level]

0to0 31 (16)

These settings determine the following color characteristics of the area to be corrected (A or B,
respectively).

[Area A Setting Chroma], [Area B Setting Chroma]: Color saturation.

[Area A Setting Area], [Area B Setting Area]: Color range.

[Area A Setting Y Level], [Area B Setting Y Level]: Brightness.

[Area A Revision Level],
[Area B Revision Level]

—-50 to +50 (x0)

These settings adjust the amount of correction applied to the color saturation in the corrected area
(A or B, respectively).

[Area A Revision Phase],
[Area B Revision Phase]

-1810 +18 (+0)

These settings adjust the amount of correction applied to the color phase in the corrected area
(A or B, respectively).

[Other Functions]

[Over 100%]

[Through], [Press], [Clip]

Determines how the camera handles video signals exceeding 100%. This setting is not available
when the gamma curve component of the [Gamma/Color Space] setting is set to one of the
[Canon Log 2], [Canon Log 3], [PQ], [HLG] or [Canon 709] options.

[Through]: Leave the signal unchanged.

[Press]: Compress a signal of up to 108% down to 100% levels.

[Clip]: Clip the signal at 100%.
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Custom Picture Settings

(i) NoTES

¢ Depending on other menu settings, you may not be able to obtain the desired image effect even after
changing the custom picture settings.
¢ \When an optional RC-V100 Remote Controller is connected to the camera, the following custom picture
settings can be changed using the buttons and dials on the remote controller.
- [Black] > [Master Pedestal], [Master Black Red], [Master Black Blue]
- [Black Gamma] > [Level]
- [Knee] > [Slope], [Point] (only when [Knee] > [Activate] is set to [On])
- [Sharpness] > [Level]
- [White Balance] > [R Gain], [B Gain]



Saving and Loading Menu Settings

Saving and Loading Menu Settings

After you adjust settings in the various menus, you can save those settings in the camera or on an SD card. You
can load those settings at a later date or on another camera of the same model so that you can use that camera
in the same way.

Saving Menu Settings
1 Select MENU > [¥ System Setup] > [Transfer Menu/[€d] > [Save].

2 Select [To Camera] or [To SD Card] and then select [OK].

e The camera’s menu settings will be saved to the selected destination. If menu settings were previously
saved, the old file will be overwritten by the current menu settings.

Loading Menu Settings
1 Select MENU > [¥ System Setup] > [Transfer Menu/[€d] > [Load].

2 Select [From Camera] or [From SD Card] and then select [OK].

® The camera’s menu settings will be replaced by the settings in the previously saved file. Then, the screen will
turn black momentarily and the camera will restart.

(i) NoTES

¢ The following menu settings are not saved with this operation.
- MENU > "™ Camera Setup] > [ABB], [Color Bars]
- MENU > [£® Recording/Media Setup] > [Metadata] > [News Metadata], [User Memo]
- MENU > [%& Assistance Functions] > [Magnification], [Magn. Output], [False Color Index]
- MENU > [ Assistance Functions] > [Waveform Settings] > [Size: VIDEO Term.]
- MENU > [ Network Settings] > [Advanced Settings] > [FTP Transfer Settings]
- MENU > [¥ System Setup] > [Level Reference Setting]
¢ \When menu settings are loaded with this operation, even protected custom picture files in the camera will be
replaced.
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149
Playback

This section explains how to play back clips, photos and WAV audio with the camera. For details on playing back
recordings using an external monitor, refer to Connecting to an External Monitor or Recorder (1] 167).

Clip Index Screen
1 Set the switch to CAMERA.

2 Press the MEDIA button (1] 12).

e The camera is set to MEDIA mode and the clip thumbnails will
appear in the index screen.
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Playback

Key lock ([T 12)

Shot mark! (1 157)

[ mark/M mark' (1 156)

Orange selection frame

Clip identification (camera index, reel number and

clip number) (1] 49)

Recording date and time

FTP transfer ([J1 199)

8 Recording media
CFexpress card / SD card (the toggle button is
displayed on the side of the currently selected
card)

9 Index screen currently displayed ([I1] 150)

T XF-AVC clips only.

[ NGV O

~ O

Switching Index Screens

The clip index screen that appears when you switch to MEDIA
mode depends on the current recording settings. Change the index
screen to play back primary clips recorded in a different format,

proxy clips or photos.

1 Press the INDEX button.

e Press the button when an index screen is displayed to open the

index screen selection menu.
2 Select the desired index screen.
e The selected index screen appears.

e Select [Cancel] to return to the previous index screen.

Options
[RAW Index]:  Clips in RAW format
[XF-AVC Index], [XF-AVC S / XF-HEVC S Index]:

10 Clip thumbnail

11 Clip number / Total number of clips

12 Recording date (month and day only) and time

13 Clip’s start time code

14 Clip duration

15 Custom picture file embedded ([11 142)

16 Special recording mode (1] 126)

17 Color sampling and resolution ([11] 65)
For RAW clips, RAW mode (HQ/ST/LT) and
resolution are displayed.

18 Frame rate ([] 66)

INDEX/ M

Clips in XF-AVC / XF-AVC S / XF HEVC S format.

[Photo Index]: Recorded photos (SD card only)
[WAV Index]: Audio in WAV format.



Playback

Playing Back Recordings

1 In the index screen, select the thumbnail of the desired
recording and then press the /1l button.
¢ Clips: Playback of the selected clip will start.

151
e Photos: The selected photo will be displayed. —

2 Use the joystick and buttons on the camera to control the
playback.
¢ Clips: Press the /1l button to pause/resume playback.
Press the l button to stop playback and return to the index
screen.
¢ Photos: Push the joystick left/right to view other photos. Press
the I button to return to the index screen.

>/l

NDEX/H

Custom picture settings of RAW clips during playback
RAW clips are played back using the following custom picture settings.

e [Gamma/Color Space]: Same setting used for recording

e [Color Matrix]: [Neutral]

e Contour lines are de-emphasized in a way similar to setting [Sharpness] > [Level] to —10.
e Other settings are set to [Off].

Lens Correction of RAW clips during playback

e Depending on the shooting settings, peripheral illumination/chromatic aberration/distortion aberration of the
shooting lens is corrected and applied during playback.

(i) NoTES

e The following image files may not be displayed correctly.
- Images not recorded with this camera.
- Images edited on a computer.
- Images whose file names have been changed.



Playback

Onscreen Displays During Clip Playback

8 9101112
1562

00:00:03.29
180.00° 00 00,00 00

18 19 20 21 22 23
1 Fan operation ([11 51) and temperature warning 9 Frame rate? ([1] 66)
(11 250) 10 Custom picture file embedded ([1] 142)
2 LUT(@171) 11 @ mark®/M mark3/ Proxy clip (0 156, 71)
3 Output onscreen displays ([J] 169) 12 Time code ([I1 105)
4 Playback button ® 13 Video format ([1] 65)
Advance 10 seconds © 14 Color sampling and color bit depth (11 65)
Go back 10 seconds © 15 Resolution (1] 65)
5 Recording date and time! 16 Headphone volume ([1] 154)
6 Frame reverse button [4] 17 Audio level meter®
Frame advance button [ ] 18 Aperture value® (Mms1)
7 BaseISO 19 1SO speed/Gain® (11 76)
8 Playback operation 20 Progress bar
> PLAY Playback 21 Shutter speed® (11 73)
11 PAUSE Playback pause 22 User bit ({11 107)
10sec PP Advance 10 seconds 23 Audio output channels (L1 111)
<4<« 10sec Go back 10 seconds
S |l 4 Frame reverse/Frame advance
F FWD x5 Fast forward (speed: x5)
F FWD x15 Fast forward (speed: x15)
F FWD x60 Fast forward (speed: x60)
F REV x5 Rewind (speed: x5)
F REV x15 Rewind (speed: x15)
F REV x60 Rewind (speed: x60)

1 Only when (=) Monitoring Setup] > [Custom Display] > [Date/Time] is set to [On].
2 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.
3 XF-AVC clips only.
4 Only when [(Z] Monitoring Setup] > [Custom Display] > [Audio Level Indicator] is set to [On].
Only when [[E]) Monitoring Setup] > [Custom Display] > [Camera Data] is set to [On].



WAV playback screen

Playback

See Onscreen Displays During Clip Playback (11 152) for the description of onscreen displays that are common

on all playback screens.

1 Audio file name

1l PAUSE

00:00:01/00:00:11

DCINT2.0V

12112
48KHz 24bit

A_0001C431A240101_000009ZW_
\ 7 —~

Jan. 1,2024 iniminninninni 3
12:00 AM ittt

00:00:00 00:00:11

@@ STOP

3 Audio level meter

2 Sampling frequency and bit depth

Playback Controls

The following playback types are available using the joystick and the touchs screen.
You can also change the position in the video using the progress bar.

Playback type

Fast playback’
Advance 10 seconds

Go back 10 seconds

Frame advance/reverse

Skip to the beginning of the next
clip

Operation

During playback, push the joystick up or down.
Repeat to increase the playback speed to approximately 5x = 15x = 60x the normal speedz.

During playback, touch the right side of the screen twice. During playback pause, touch © on the right side
of the screen.

During playback, touch the left side of the screen twice. During playback pause, touch (2) on the left side of
the screen.

During playback pause, push the joystick up or down, or touch <@l / II»>

During playback, push the joystick right, or flick the screen to the left.

Skip to the beginning of the
current clip

During playback, push the joystick left.

Skip to the previous clip

During playback, push the joystick left twice, or flick the screen to the right.

Change the playback/playback
pause position in the video

During playback/playback pause, touch or slide the progress bar.

1 You may notice some anomalies (blocky video artifacts, banding, etc.) in the playback picture.
2 The speed indicated on the screen is approximate.

(i) NoTES

e There is no audio during any of the playback types listed in the previous table.
e You can press the B/1l button during fast playback to return to playback at normal speed.
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Adjusting the Volume

You can use headphones or the built-in speaker to listen to the audio () (headphone)
during normal playback. When you connect headphones to the (Q terminal

154 (headphone) terminal, the speaker will be muted. The audio signal
will also be output from the SDI OUT terminal, MON. terminal and

HDMI OUT terminal.

1 Select MENU > [ M) Audio Setup] > [Headphone Volume] or
[Speaker Volume].

2 Select the desired level.

(i) NoTES

e For details on changing the audio channel, refer to Audio Outout
(M 175).

e |f you set an assignable button to [Headphones +] or
[Headphones -] (11 133), you can press the button to adjust the headphone volume without using the menu.




Recording Data Operations

Recording Data Operations

You can perform various operations on the clip selected in the index screen using the clip menu. Available
options will depend on the type of recording selected.

Clip/Photo Menu Operations

1 Select the desired recording.

2 Press SET.

e The clip/photo menu will be displayed. Available functions will differ depending on the recording.

3 Select a menu

item.

Clip menu options

Index screen
Function Description [XF-AVC S /
[RAW]  [XF-AVC] XF-HEVC §] [Photo]  [WAV]
[Cancel] Closes the clip menu. [ J o o ([ ([ J
[Play] Starts playback. [ J o o ([ [ J
[Display Clip Info] Displays the clip information screen ([ 156). @ o (] - -
[Add [ Mark] or _ 2 _ _ _
[Delete G Mark]' Adds or deletes an [ mark ([31 156, 157). @
[Add [ Mark] or B 2 _ B _
[Delete 1 Mark]' Adds or deletes a [ mark ([ 156, 157). @
[Del. All Shot Marks] | Deletes all the shot marks from a clip ([J1 157). - ®? - - -
[Recover] Recovers a recording ([ 46). [ ) o o - o
[Delete] Deletes a recording ([ 158). [ ) o o o o
Deletes the user memo and GPS information of a
[Delete User Memo] dlip (CC1158) - o o - -
[FTP Transfer] Transfers a clip using the FTP protocol (1] 199). - o o - -
[Frame.io Upload] | Adds clip o the Frame.io upload queue. - o o’ - '
[Stop] Ends photo playback. - - - o -
Displays the file selection screen on the index
[Select] screen. Alternatively, selects a file on the file [ J o o - -
selection screen.
[Deselect] Clears selection for a file. [ J o ([ - -
[Deselect All Clears selection for all files and returns to the index PY ° ° _ B
screen.
[Refine] Displays the Refine screen. [ J o o - -
[Reselect] Returns from the Refine screen to the selection PY ° ° _ B
screen.
[End Refining] Returns from the Refine screen to the index screen. [ J o o - -

1 Not displayed for proxy clips
2 Depending on the status of the clip, the displayed add/delete options are switched.
3 Only proxy clips and audio recordings on the SD card (second card recording functions).

(i) NoTES

e To perform operations on XF-AVC proxy clips or photos recorded on an SD card, make sure the card is not

write-protected.



Recording Data Operations

Displaying Clip Information
1 Select the desired clip in the clip index screen.
2 Press SET (clip menu) and select [Display Clip Info].

156 e The [Clip Info] screen will appear.

e Push the joystick left/right to check the information on other clips. Press the CANCEL button to return to the
index screen.

@A 301 min

Nov. 3,2024 9:20 AM
h_0003C026H240320_06073800_
CANON

Lens Info
EF-518-55m

Start
End
Duration

=) Y News Metadata

1 Thumbnail of the selected clip 11 Custom picture file embedded ([1] 142)
2 Clip geotagged with GPS information 12 Proxy clip (10 71)
3  Thumbnail of the previous clip 13 Color sampling and color bit depth (11 65)
4 Thumbnail of the next clip  For RAW clips, RAW mode (HQ/ST/LT) and color
5 Special recording mode ([11 126) depth are displayed.
6 Recording date and time 14 Lens model name
7 Clip file name (11 49) 15 Clip’s start time code
8 Compression, bit rate and resolution ([1] 65) 16 Clip’s end time code
9 Frame rate’ (11 66) 17 Clip duration
10 Shot mark (11 157) and [ mark / M mark
(X 156)

T For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.

Displaying User Memo/News Metadata

From the [Clip Info] screen, you can push the joystick up or down, or touch [@]/[@] on the screen to display user
memo or News Metadata details. To return to the [Clip Info] screen, push the joystick in the direction displayed to
the left of [Clip Info] at the bottom of the screen ([@])/[m]) or touch [Clip Info] at the top of the screen.

Displaying Custom Picture Settings

If a custom picture file was embedded with the clip, the [[@d Data 1/3] to [[@d Data 3/3] screens show the
custom picture settings used.

Push the joystick down repeatedly or turn the SELECT dial right to check the information screens in
the following order: [[@d Data 1/4] to [[@d Data 4/4] screens - [([E®] screen.

Adding OK Marks or Check Marks

You can add an OK mark ([ll) or check mark () to XF-AVC primary clips to help you identify particular clips.
Since clips with an [l mark cannot be deleted with the camera, you can use this mark also to protect important
clips.



Recording Data Operations

Adding an [ Mark or M Mark During Playback

You can add an [l mark or [ mark to a clip during playback or playback pause.

1 Set an assignable button to [Add [ Mark] or [Add [ Mark] (1 133).

2 Select the desired clip in the [XF-AVC] index screen and press the /11 button.

3 During playback or playback pause, press the assignable button to add the clip mark.
o [[MAMark] or [MMark] will appear briefly and the selected clip mark will be added to the clip.
e Adding a clip mark to a clip during playback will pause the playback.
o [ or 4 appears at the top right of the clip playback screen.

Adding an [l Mark or [ Mark from the Index Screen
1 Select the desired clip in the [XF-AVC] index screen.

2 Press SET (clip menu) and select [Add [l Mark] or [Add ¥ Mark] > [OK].
¢ The selected clip mark is added to the clip and [l or [ appears next to the clip’s thumbnail.

(i) NoTES

e A clip cannot have both an [l mark and [ mark at the same time. When you add a [ mark to a clip with an
[ mark, the [ mark will be deleted. Similarly, when you add an [l mark to a clip with a 4 mark, the
mark will be deleted.

Deleting OK Marks or Check Marks
1 Select the desired clip in the [XF-AVC] index screen.

2 Press SET (clip menu) and select [Delete [ Mark] or [Delete [ Mark] > [OK].
® The selected mark is deleted.

Adding Shot Marks

During the playback of a primary clip recorded in XF-AVC format, you can add shot marks (H) to particular
frames in the clip that you want to single out.

1 Set an assignable button to [Add Shot Mark] ([1 133).

2 Select the desired clip in the [XF-AVC] index screen and press the /11 button.

3 During playback or playback pause, press the assignable button at the point in the clip where you
want to add the shot mark.

e [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.
e Adding a shot mark to a clip during playback will pause the playback.

Deleting All the Shot Marks from a Clip
1 Select the desired clip in the [XF-AVC] index screen.

2 Press SET (clip menu) and select [Del. All Shot Marks] > [OK].
e All shot marks in the selected clip are deleted.
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Recording Data Operations

Deleting Recordings

You can delete clips, photos and WAV audio files. To delete clips with an [l mark, you need to delete the [
mark beforehand (1] 157).

1 Select the desired file in the index screen.
e Photos are selectable on the playback screen.

2 Press SET (file menu) and select [Delete] > [OK].
e The file is deleted.
e The operation cannot be canceled.

158

@ vroRTANT
¢ Be careful when deleting recordings. Once deleted, they cannot be recovered.

Deleting the User Memo and GPS Information from a Clip
1 Select the desired clip in the index screen.

2 Press SET (file menu) and select [Delete User Memo] > [OK].
e The user memo and GPS information that were recorded in the selected clip’s metadata are deleted.



Video Output Configuration

External Connections

The video signal output from the SDI OUT terminal, MON. terminal and HDMI OUT terminal, depends on the
clip’s video configuration and on various menu settings. The camera does not output signals to the MON.
terminal and HDMI OUT terminal simultaneously and will select the active output terminal automatically. However,
simultaneous output from the MON. terminal and the HDMI OUT terminal can be activated if necessary

(0 168).

SDI OUT Terminal Video Output Configuration (Recording/Playback)

Recording video configuration

Main video
format Frame rate
29.97P
23.98P
RAW 25.00P
24.00P

Resolution

6000x4000

SDI output format

Output

SDI OUT terminal

2
resolution’ Output frame rate'
4096x2160P/3840x2160P 3840x2160 _
2048x1080P/1920x1080P 19201080 | Sameas S:‘a‘i‘;t'“g frame
1920x1080P 19201080
59.94i
_ 50.94i
1920x1080i(PsF) 19201080 :
50.00i
60.00i
50.94P
59.94P
1280x720P 1280720
50.00P
60.00P

159



Video Output Configuration

Recording video configuration SDI OUT terminal
SDI output format Output

resolution’

160 4096x2160P/3840x2160P 4096x2160

- 2048x1080P/1920x1080P 2048x1080

1920x1080P 1920x1080

Main video

format Frame rate Resolution Output frame rate?

Same as shooting frame
rate

59.94i

29.97PsF

) 59.94i
1920x1080i(PsF) 1920x1080

50.00i

6000x3164

4368x2304° 25.00PsF

60.00i

59.94pP

59.94pP

59.94pP
1280x720P 1280x720

59.94pP 50.00P

29.97P 50.00P

23.98P
RAW 50.00P 60.00P

25.00P 2048x1080P/1920x1080P* 2048x1080 Same as shooting frame
24.00P 1920x1080P 1920x1080 rate

59.94i

29.97PsF

59.94i

1920x1080i(PsF) 1920x1080 -
50.00i

25.00PsF
2184x1152

60.00i

59.94pP

59.94P
59.94P
50.00P

1280x720P 1280x720

50.00P

60.00P




Video Output Configuration

Recording video configuration SDI OUT terminal
SDI output format Output

resolution’

4096x2160 161

3840x2160 _
2048x1080 Same as shooting frame

2048x1080P/1920x1080P rate
1920x1080

1920x1080P 1920x1080

Main video

format Frame rate Resolution Output frame rate?

4096x2160P/3840x2160P

59.94i
29.97PsF
59.94i
50.00i
25.00PsF
60.00i
59.94pP
59.94P

2.4 1280x720P 1280x720 09.94P

X X
XF-AVC 29.97p 50.00P
23.98P

25.00P :
24.00P 2048x1080P/1920x1080P* 2048x1080 Same as shooting frame
1920x1080P 1920x1080 rate

59.94i
29.97PsF

59.94i

50.00i
25.00PsF

60.00i

59.94P

59.94P

59.94P

50.00P

50.00P

60.00P

4096x2160 1920x1080i(PsF) 1920x1080
3840x2160

1920x1080i(PsF) 1920x1080

2048x1080

1280x720P 1280x720




Video Output Configuration

. Recording video configuration SDI OUT terminal
Main video
: SDI output format Output 2
format Frame rate Resolution 4 Output frame rate
resolution
162 2048x1080P/1920x1080P* 1920x1080 Same as shooting frame
_ 1920x1080P 1920x1080 rate
59.94i
29.97PsF
59.94i
59.94P 1920x1080i(PsF) 1920x1080 -
29.97P 50.00i
23.98P 25.00PsF
50.00P 1920x1080 60.00i
25.00P 59.94P
24.00P
59.94P
59.94P
XF-AVC 1920x720P 1920x720
XF-AVC S 50.00p
XF-HEVC S 50.00P
60.00P
59.94P 1280x720 1280x720P* 1280x720 | Sameas shooting frame
50.00P rate
29.97P
59.94P
23.98P .
1280x720 1280x720P 1280x720
25.00P 50.00P
24.00P 60.00P
1920x1080i(PsF)* 1920x1080 | Same as shooting frame
59.94i 1920x1080 rate
50.00i 59.94P
1280x720P 1280x720
50.00P

' Color sampling will be YCC422 10 bit. The video signal’s effective bit depth will be output.
2 During slow & fast motion recording, the output frame rate will change depending on the output format of the terminal.
- When the resolution is [1920x1080i], it will be changed as follows: 59.94P / 29.97P / 23.98P - 59.94i, 50.00P / 25.00P -
50.00i, 24.00P - 60.00i.
- When the resolution is a option other than the above, it will be changed as follows: 59.94P / 29.97P / 23.98P - 59.94P,
50.00P / 25.00P = 50.00P, 24.00P - 60.00P.
3 For slow & fast motion recording, the resolution when the frame rate is 120P is 4096x2160.
4 During playback (MEDIA mode), [4096x2160P/3840x2160P)], [2048 x1080P/1920x1080P], [1920x1080P] and [1920x1080i] can
also be selected.
Available options differ depending on the output terminal.



MON. Terminal / HDMI OUT Terminal Video Output Configuration
(Recording/Playback)

Recording video

Main video configuration

format :
Frame rate  Resolution
29.97P
23.98P

RAW 25.00P 6000x4000
24.00P

Video Output Configuration

MON. terminal HDMI OQUT terminal
MON. output HDMI output
format format Output Output Output Output
resolution! ~ framerate?  resolution!  frame rate?
Same as
4096x2160P/ )
- 3840x2160P - - 3840x2160 | shooting frame
rate
2048x1080P/
1920x1080P - 19204080 | o e as - B
shooting frame Same as
1920x1080P 1920x1080P 1920x1080 rate 1920x1080 | shooting frame
rate
59.94i 59.94i
, _ 59.94i 59.94i
1920x1080i(PsF) 1920x1080i 1920x1080 - 1920x1080 — ———
50.00i 50.00i
60.00i 60.00i
59.94P 59.94P
59.94P 59.94P
1280x720P 1280x720P 1280x720 1280x720
50.00P 50.00P
60.00P 60.00P
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Main video
format

RAW

Video Output Configuration

Recording video

) . MON. terminal HDMI OUT terminal
configuration MON. output HDMI output
format format
Frame rate  Resolution Outpgt 1 g p) 0utp!1t 1 U 2
resolution frame rate resolution frame rate
_ 4096x2160P/ _ _ 4096x2160
3840x2160P Same as
2048x1080P/ 204851080 nge as shooting frame
1920x1080P 1920x1080P shooting frame | 1920x1080 rate
1920x1080P 1920x1080 rate
59.94i 59.94i
29.97PsF 59.94i
1920x1080i(PsF) |  1920x1080i 1920x1080 >9.941 1920x1080 29,94
X i(Ps! X i X X
5000X31543 50.00i 50.00i
436832304 25.00PsF 50.00i
60.00i 60.00i
59.94P 59.94P
59.94P 59.94P
59.94P 59.94P
59.94P 1280x720P 1280x720P 1280x720 1280x720
50.00P 50.00P
29.97P
23.08P 50.00P 50.00P
50.00P 60.00P 60.00P
25.00P 2048x1080P/ 204851080 Same as Same as
24.00 1920x1080P | 1920x1080P* shooting frame | 1920x1080 | shooting frame
1920x1080P 1920x1080 rate rate
59.94i 59.94i
29.97PsF 59.94i
) . 59.94i 59.94i
1920x1080i(PsF) |  1920x1080i 1920x1080 - 1920x1080 -
50.00i 50.00i
2184x1152 25.00PsF 50.00i
60.00i 60.00i
59.94P 59.94P
59.94P 59.94P
59.94P 59.94P
1280x720P 1280x720P 1280x720 1280x720
50.00P 50.00P
50.00P 50.00P
60.00P 60.00P




Main video
format

XF-AVC
XF-AVC S
XF-HEVC S

Recording video

Video Output Configuration

) ) MON. terminal HDMI OUT terminal
configuration MON. output HDMI output
format format
Frame rate  Resolution 0utp_Ut 1 Output 2 Outpyt 1 e 2
resolution frame rate resolution frame rate:
- 4096x2160P/ - - 4096x2160 shoii‘i:e f‘::me
_ 3840x2160P - - 3840x2160 9
rate
2048x1080P/ 2048x1080 | game as Same as
1920x1080P 1920x1080P 1920x1080 | shooting frame | 1920x1080 | shooting frame
1920x1080P 1920x1080 rate rate
59.94i 59.94i
29.97PsF 59.94i
59.94i 59.94i
4096x2160 | 1920x1080i(PsF) |  1920x1080i || 1920x1080 : 1920x1080 :
3840x2160 50.00i 50.00i
25.00PsF 50.00i
60.00i 60.00i
59.94P 59.94P
59.94P 59.94P
59.94P 59.94pP 59.94P
1280x720P 1280x720P 1280x720 1280x720
29.97P 50.00P 50.00P
23.98P 50.00P 50.00P
50.00P L -
25.00P 60.00P 60.00P
24.00P 2048x1080P/ 2048x1080 Same as Same as
1920x1080P 1920x1080P* || 1920x1080 | shooting frame | 1920x1080 | shooting frame
1920x1080P 1920x1080 rate rate
59.94i 59.94i
29.97PsF 59.94i
, _ 50.94i 50.94i
1920x1080i(PsF) 1920x1080i 1920x1080 - 1920x1080 -
50.00i 50.00i
2048x1080 -
1920x1080 25.00PsF 50.00i
60.00i 60.00i
59.94P 59.94P
59.94P 59.94P
59.94P 59.94P
1280x720P 1280x720P 1280x720 1280x720
50.00P 50.00P
50.00P 50.00P
60.00P 60.00P
59.94P 59.94P Same as
1280x720 1280x720P* 1280x720P* 1280x720 1280x720 | shooting frame
50.00P 50.00P
rate
29.97P
59.94P 59.94P
23.98P . .
1280x720 1280x720P 1280x720P 1280x720 1280x720
25.00P 50.00P 50.00P
24.00P 60.00P 60.00P
59.94i 59.94i Same as
_ 1920x1080i(PsF)* |  1920x1080i* || 1920x1080 _ 1920x1080 | shooting frame
50.00i 50.00i
1920x1080 rate
59.94i 59.94P 59.94P
- 1280x720P 1280x720P 1280x720 1280x720
50.00i 50.00P 50.00P
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Video Output Configuration

T Color sampling will be YCC422 10 bit. The video signal’s effective bit depth will be output.
2 During slow & fast motion recording, the output frame rate will change depending on the output format of the terminal.
- When the resolution is [1920x1080i], it will be changed as follows: 59.94P / 29.97P / 23.98P - 59.94i, 50.00P / 25.00P -
50.00i, 24.00P - 60.00i.
- When the resolution is a option other than the above, it will be changed as follows: 59.94P / 29.97P / 23.98P - 59.94P,
50.00P / 25.00P - 50.00P, 24.00P - 60.00P.
3 For slow & fast motion recording, the resolution when the frame rate is 120P is 4096x2160.
4 During playback (MEDIA mode), [4096x2160P/3840x2160P)], [2048 x1080P/1920x1080P], [1920x1080P] and [1920x1080i] can
also be selected.
Available options differ depending on the output terminal.



Connecting to an External Monitor or Recorder

Connecting to an External Monitor or Recorder

When you connect the camera to an external device, be it a monitor (to monitor the recording or for playback) or
an external video recorder (for recording), use the terminal on the camera that matches the one you wish to use
on the external device. Then, select the video signal output configuration ([J] 159).

Connection diagram
The camera does not output signals to the MON. terminal and HDMI OUT terminal simultaneously. However,
simultaneous output from the MON. terminal and the HDMI OUT terminal can be activated if necessary

(0 168).

f\ MON. terminal
"" ﬁ SDI inputs
SDIOUT

f\ SDI inputs
\--w - ]
V SDI OUT terminal
T 0000
’ HDMI inputs

HDMI OUT terminal

LE
1N0 INaH

s BNC cable (commercially available)
I HDMI cable (commercially available)

(1) NoTES

¢ Powering the camera from a power outlet using an AC adapter is recommended.

e If you set MENU > [£% Recording/Media Setup] > [Rec Command(EXT REC)] to [On] and connect the
camera to another device using the SDI OUT, MON. or HDMI OUT terminal, you can control the recording
operation on the other device in conjunction with the camera’s recording operation (REC button). However,
this function cannot be used during slow & fast motion recording, frame recording, interval recording or
continuous recording.

When connecting to the HDMI OUT terminal, select [HDMI Time Code] > [On].

Using the SDI OUT Terminal

The digital signal that is output from the SDI OUT terminal includes the video signal, audio signal, time code
signal, recording command signal, metadata and clip file name information. You can connect an external video
recorder to the SDI OUT terminal to record 4K or 2K video. For details about configuring and using external
recorders, refer to the instruction manual of the external device used.

1 Select MENU > [¥ System Setup] > [SDI Output] > [On].

2 Select MENU > [¥ System Setup] > [SDI Output Signal] > Desired option.

3 To change the 3G-SDI mapping level, select MENU > [§ System Setup] > [3G-SDI Mapping] >
[Level A] or [Level B].
e You can select a video output signal compliant with Level A or Level B of the SMPTE ST 425-1 standard.
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Connecting to an External Monitor or Recorder

(i) NoTES

* Depending on the external recorder, you may not be able to record at the desired video configuration.
e After you connect the camera to the external recorder, make a test recording first to check that audio and
video are recorded correctly on the external recorder.

Using the MON. Terminal

The digital signal that is output from the MON. terminal includes the video signal, audio signal, time code signal,
recording command, metadata and clip file name information. You can also output various assistance displays
(onscreen displays, markers, etc.) in order to check them also on an external monitor.

1 Select MENU > [¥ System Setup] > [MON. Output Signal] > Desired option.

2 To change the 3G-SDI mapping level, select MENU > [¥ System Setup] > [3G-SDI Mapping] >
[Level A] or [Level B].
e You can select a video output signal compliant with Level A or Level B of the SMPTE ST 425-1 standard.

Using the HDMI OUT Terminal

The digital signal that is output from the HDMI OUT terminal includes the video signal and audio signal. You can
output also the time code signal, recording command and various assistance displays (onscreen displays,
markers, etc.) in order to check them also on an external monitor.

1 Connect the HDMI cable to the HDMI OUT terminal.
o MOy will appear on the right of the screen and the HDMI OUT terminal will become the active output terminal.

2 Select MENU > [¥ System Setup] > [HDMI Output Signal] > Desired option.

3 CAMERA mode only: To output the time code signal, select MENU > [£% Recording/Media Setup] >
[HDMI Time Code] > [On].

(i) notes

* You can set MENU > [¥ System Setup] > [Linked to HDMI Monitor] to [On] to automatically change the HDMI
OUT terminal’s output resolution according to the capabilities of the connected monitor. When this setting is
set to [Off], the output resolution is set according to the menu settings and if the connected monitor is not
compatible with the signal output from the camera, HDMI output will stop.

e The HDMI OUT terminal is for output only. Do not connect the camera to another device’s output terminal
using the HDMI OUT terminal as this will cause a malfunction.

e Correct operation cannot be guaranteed when connecting the camera to DVI monitors.

¢ \/ideo may not be output correctly depending on the connected external monitor/recorder or the HDMI cable
used. In such case, use another terminal.

e The time code will not be output from the HDMI OUT terminal in the following cases.
- In MEDIA mode.
- When the video output signal is 720x480 / 59.94P or 720x576 / 50.00P.

Enabling simultaneous output from the MON. terminal and the HDMI OUT terminal

You can simultaneously output the same video signal from the MON. terminal and the HDMI OUT terminal.

Select MENU > [¥ System Setup] > [MON&HDMI Simuilt. Output].



Connecting to an External Monitor or Recorder

e The output resolution will be 1920x1080P ([1920x1080P]) or 1920x1080i ([1920x1080i(PsF)]).

Superimposing Onscreen Displays on Video Outputs

You can output the camera’s onscreen displays along with the video output from the MON. terminal or HDMI
OUT terminal to check the onscreen displays on an external monitor. This setting will not affect your recordings.

Select MENU > [[E) Monitoring Setup] > [OSD Output: MON./HDMI] or [OSD Output: SDI] > [On].

. appears on the right of the screen (In CAMERA mode, only if MENU > [(Z)) Monitoring Setup] >
[Custom Display 2] > [OSD Output] is set to [On]).

(i) NoTES

¢ \When the HDMI OUT terminal’s output resolution is 720x480 or 720x576, the camera’s onscreen displays will
not be output from the HDMI OUT terminal.

e Assistance functions will not be superimposed when the [OSD Output:] options are set to [Off (Clean)] or [Off],
with the following exceptions.
- Magnification
- Range display when [Custom Picture] > [Skin Detail] or [Color Correction] is set

¢ \When only peaking/zebra pattern/false color is superimposed, set the desired [OSD Output:] option to [On]
and set the onscreen display level to [DISP Level 3].

e |f you set an assignable button to, [OSD Output: MON./HDMI] or [OSD Output: SDI] (1 133), you can press
the button to turn the camera’s onscreen displays on and off on external monitors connected to the respective
terminals.

Changing the Opacity Level of Onscreen Displays
You can make onscreen displays more visible or less conspicuous by changing their opacity level.

1 To change the visibility of onscreen displays on individual video outputs, select MENU >
[(ZD Monitoring Setup] > desired [OSD Opacity:] option > [On].

2 Select MENU > [[Z) Monitoring Setup] > [OSD Opacity Level] > Desired option.
¢ The smaller the percentage the more transparent the onscreen displays.

3 Select MENU > [[Z) Monitoring Setup] > [OSD Opacity: Appl. Screens] > [All] or [Only Rec/Playback
Screens].

e You can apply the selected opacity level to all onscreen displays (including menus, etc.) or only to onscreen
displays on the shooting and playback screens.

(i) NoTES

e |f you set an assignable button to one of the [OSD Opacity:] (1] 133) settings, you can press the button to
change the opacity level of onscreen displays on the corresponding video outputs.

Selecting the Output Range

You can select the output range of video signals output from the various terminals to determine how the image
levels are mapped to code values. Moreover, you can select the setting independently for Canon Log output and
for HDR output.
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Connecting to an External Monitor or Recorder

Applied output range settings

Custom picture file
Applied range settings

[Gamma] Look File Applied [Look File]
Off -
170 [Canon Log 2] - [During Canon Log Output]
[Canon Log 3] On [Conform to Custom Picture]
PQ) off - .
[During HDR Output]
[HLG] On [Conform to Custom Picture]
[Canon 709] Off -
[BT.709 Wide DR] i Fixed [Narrow Range]
[BT.709 Standard] On [Conform to Custom Picture]
[SDR BT.709]
Fixed [Narrow Range]
0 [SDR BT.2020]
- n
[HDR PQ(BT.2100)]
[During HDR Output]
[HDR HLG(BT.2100)]

1 Select MENU > [(Z) Monitoring Setup] > [Range: SDI], [Range: MON.] or [Range: HDMI].

2 Select [During Canon Log Output] or [During HDR Output] > Desired option.
¢ Repeat the procedure as necessary to select the output range for other terminals or output signals.

Options for [Range: SDI OUT], [Range: MON.]
[Full Range]:  The signal output will use full range coding.
[Narrow Range]:
The signal output will use narrow range (video range) coding.

Options for [Range: HDMI]

[Full Range Priority]:
The signal output will use full range coding whenever possible but will change the range
automatically according to the capabilities of the connected monitor.

[Narrow Range]:
The signal output will use narrow range (video range) coding.

(i) NoTES

e Settings will change depending on the gamma curve component of the [Gamma/Color Space] setting in the
custom picture file. When a LUT is applied, settings will change also depending on the gamma curve selected
for the output signal. If a user LUT is applied, the output range will be determined by the user LUT’s [Range
(Qutput)] setting.

¢ During playback, the applied range is determined according to the gamma used at the time of recording.



Applying a LUT to Video Outputs

Applying a LUT to Video Outputs

While recording using special gamma curves, you can apply a LUT to the image displayed on external monitors
(SDI OUT terminal, MON. terminal, HDMI OUT terminal), or the supplied LCD screen (VIDEO terminal). When a
LUT is applied, the displayed image will look as if a standard gamma curve were used, making it easier to check
the image on the display device used. To check the image on an external monitor, you will need a monitor that is
compatible with the video’s color space.

You can also load and apply LUT files created with Blackmagic Design’s DaVinci Resolve ([11 173).

Available LUTs
The available LUTs depend on the [Gamma/Color Space] and [Look File] settings in the custom picture file
(13 140). If these settings are changed, LUT will be turned off.

Custom picture file Available LUTs
1o - - A (See the table below.)
[Conform to Custom Picture]
[SDR BT.709] - - - - _ _ _ _
[On] | [SDR BT.2020] - - - - - _ _ _
[HDR PQ (BT.2100)] [ J o - - - - o ™Y
[HDR HLG (BT.2100)] [ J o - - - - _ ™Y

1 Not available for the VIDEO terminal (LCD monitor).
2 Available only for the VIDEO terminal (LCD monitor).

Selectable LUTs (A)

Custom picture file Available LUTs

[HDR Assist.  [HDR Assist.

1 1 1 1
[Gamma/Color Space] [CMT 709] [Canon 709] [CMT DCI] [CMT PQ]" [CMT HLG]" [ACESproxy] i 600%)]2 ( 400%)]2

[Canon Log 2 / C.Gamut] [ ) o [ ) [ ) [ ) o o o
[Canon Log 3 / C.Gamut] [ J [ J [ [ o [ ] ) o
[Canon Log 3/ BT.2020] o o - [ ] [ ] - o )
[Canon Log 3/ BT.709] o o - - - - _ _
[Canon 709 / BT.709] - - - - - - - _
[BT.709 Wide DR / BT.709] - - - - - _ _ _
[BT.709 Standard / BT.709] - - - - — _ _ _
[PQ / BT.2020] [ ] [ ) - - — _ ™Y ™)
[HLG / BT.2020] [ ] [ ] - - - _ _ ®

1 Not available for the VIDEO terminal (LCD monitor).
2 Available only for the VIDEO terminal (LCD monitor).

1 To apply the LUT to an output destination, select MENU > [[=)] Monitoring Setup] > Desired [LUT:]
option > [On].

2 Select MENU > [[E) Monitoring Setup] > Desired [LUT Selection:] option.
e The gamma curve and color space of the video output will change.
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Applying a LUT to Video Outputs

List of LUTs
Output Settings
Applied LUT with LUT applied Description
Gamma curve  Color space
172

LUT for viewing on the included LCD screen and external monitors compatible
[CMT 709] CMT 709 BT. 709 with BT.709 specifications. It produces a look suitable for a cinema production,
keeping a wide dynamic range without clipping when log recording.

These settings produce a look appropriate also for use without post processing,
[Canon 709] Canon 709 BT.709 featuring high contrast while ensuring a wide dynamic range optimized for
playback on BT.709 compliant monitors.

LUT for viewing on external monitors that support color spaces and gamma
curves that follow the guidelines established by DCI (Digital Cinema Initiatives). It
produces a look suitable for a cinema production, keeping a wide dynamic range
without clipping when log recording.

[CMT DCI] CMT DCI DCI-P3

LUT for viewing HDR (high dynamic range) images on external monitors
compatible with the PQ standard defined by ITU-R BT.2100. It produces a look
suitable for a cinema production, keeping a wide dynamic range without clipping
when log recording.

[CMT PQ] CMT PQ BT.2020

LUT for viewing HDR (high dynamic range) images on external monitors
compatible with the HLG standard defined by ITU-R BT.2100. It produces a look
suitable for a cinema production, keeping a wide dynamic range without clipping
when log recording.

[CMT HLG] CMT HLG BT.2020

LUT for viewing on external monitors compatible with the ACESproxy standard
[ACESproxy] ACESproxy ACESproxy | established by ACES (Academy Color Encoding System). The signal output will use
narrow range (video range) coding.

LUT for viewing HDR (high dynamic range) images on the included LCD monitor.
: amma curve BT.709 The LUT follows the ITU-R BT.2100 transfer function to convert a brightness range
[HDR Assist. (400%)] | 9 of 1600% or 400% respectively into a linear brightness scale.

[HDR Assist. (1600%)] Original

(i) NoTES

¢ \When you apply the [ACESproxy] LUT to the SDI OUT terminal, MON. terminal or HDMI OUT terminal, the
terminal will output ACESproxy video data. Using a compatible monitor, you can perform on-set color grading
and check the image after color correction as you continue shooting (1] 23).

¢ If you set an assignable button to one of the [LUT:] options ([Z1] 133), you can press the button to turn the
selected LUT on and off on all monitoring devices, the supplied LCD screen or external monitors.

Adjusting the Gain Difference between HDR and SDR

You can adjust the SDR gain difference relative to HDR within a range of + 7.5 dB (in 0.5 dB increments) in the

following cases:

¢ \When the main clip is set to HDR* and a LUT that changes the color space to [CMT 709] or [Canon 709] is
applied to the output.

¢ \When the main clip is set to HDR* and [Proxy Rec Color Conversion] of the proxy clip is set to [BT.709 (Canon
709)] or [BT.709 (CMT 709)].

* When the [Gamma/Color Space] setting in the custom picture file is set to [PQ / BT.2020] or [HLG / BT.2020], or when a Look

File is activated and the [Gamma/Color space] setting after applying the Look File is set to [HDR PQ (BT.2100)] or [HDR HLG
(BT.2100)], and the [LUT] setting is set to [CMT 709] or [Canon 709].

Select MENU > [[Z) Monitoring Setup] > [Gain for HDR—>SDR Conv.] > Desired option.



Applying a LUT to Video Outputs

User LUTs

You can register in the camera up to four LUT files created with Blackmagic Design’s DaVinci Resolve as user
LUTs and apply them to video outputs/screens. User LUTs can be applied when the gamma in the custom
picture file is a log gamma curve. You can adjust the output color space and range of user LUTs.

Use an SD card to copy LUT files to the camera.

Registering a User LUT

1 Insert the SD card with the desired LUT file (.cube format) into the camera’s SD card slot.

2 Select MENU > [[E) Monitoring Setup] > [User LUT 1] to [User LUT 4] > [Register].

3 Select the LUT file on the SD card.

4 Select [BT.709 Gamut] or [BT.2020 Gamut] to change the color space for the output signal ((Color Space
(Output))).
¢ To leave the color space unchanged, select [Do Not Convert] instead.

5 Select [Narrow Range] or [Full Range] to change the output range ([Range (Output)]).

6 Select [OK].
® The selected LUT file will be registered in the camera.

Applying a User LUT

1 Select MENU > [[Z)) Monitoring Setup] > desired [LUT:] option > [On].

2 Select MENU > [[Z) Monitoring Setup] > desired [LUT Selection:] option.
e User LUT 1 to 4 are only displayed when there are registered user LUTs.
e User LUT names are marked with ¥ at the end.

Deleting a User LUT
1 Select MENU > [[E) Monitoring Setup] > [User LUT 1] to [User LUT 4] > [Delete] > [OK].
e The selected user LUT will be deleted.

Resetting All the User LUTs

1 Select MENU > [(Z) Monitoring Setup] > [Reset All User LUTs] > [OK].
¢ All registered user LUTs will be deleted.

Renaming a User LUT
You can rename each of the four user LUTs in the camera.

Select MENU > [[E) Monitoring Setup] > [User LUT 1] to [User LUT 4] > [Rename].
e Enter the desired LUT name (up to 8 characters) then select [OK].

Checking a User LUT’s Settings
Select MENU > [[=) Monitoring Setup] > [User LUT Info].

(i) NoTES

About LUT files
- The camera supports LUT files (3D LUT/.cube format) in 17 grid or 33 grid format created with Blackmagic
Design’s DaVinci Resolve.
- LUT files with input ranges outside the 0 to 1 range in the header (“‘LUT_3D_INPUT_RANGE”) are not
supported.
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- LUT files which include values outside of the 0 to 1 range in the data area are not supported.
- LUT files 2 MB and larger, as well as files with a name containing over 65 characters are not supported.
- Only the following characters can be used in the file name:
Numbers 0 to 9, upper/lower case letters a to z, underscore (_), hyphen (-), period (.) and a single byte
174 space.
e Save a LUT file to the root directory of the SD card.
e |f the correct color space for the output signal ([Color Space (Output)]) is not selected, video will not be output
correctly.
e User LUT files in the camera cannot be overwritten. If necessary, delete a user LUT file in the camera before
registering a different LUT file.



Audio Output

Audio Output

The camera can output audio from the SDI OUT terminal, MON. terminal, HDMI OUT terminal, () (headphone)
terminal or speaker. When recording or playing back clips recorded with 4-channel audio, you can select which
audio channels are output from the HDMI OUT terminal, headphones and speaker.

Audio output configuration

Recorded audio configuration Audio output during recording/playback
Audio format Audio bit depth UL HDMI OUT terminal*
MON. terminal
4-channel 4-channel 2-channel
24 bit, 16 bit linear PCM linear PCM

linear PCM, 2-channel AAC 24 bit 16 bit

* You can select the audio channels that are output.

To select the audio channels for headphone or speaker output

Select MENU > [M) Audio Setup] > [Monitor Channels] > Desired audio output option (L/R).

e Options like [CH1+2] indicate that two audio channels (CH1 and CH2 in this example) are mixed and output
from the same side.

To select the audio channels for HDMI output
In CAMERA mode, audio from two channels can be output from the HDMI OUT terminal. The audio channels for
HDMI output (CH1/CH2 or CH3/CH4) can be selected from the menu.

Select MENU > [ M) Audio Setup] > [HDMI OUT Channels] > [CH1/CH2] or [CH3/CHA4].
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Importing Files to a Computer/Smartphone

Canon offers software applications as free downloads that allow you to save on a computer/smartphone clips
recorded with the camera, develop RAW clips, and more.

Saving Files

Use Canon XF Utility to save and organize XF-AVC clips and other recorded files on a computer. You can use the
Canon XF plugins to easily use XF-AVC clips directly from Avid non-linear editing (NLE) software. The software
and plugins are available as free downloads from your local Canon website. Check the download page for the
system requirements and latest information.

You will find detailed instructions about installing and uninstalling the software in the “Read This First” file
(Install-XF Utility.pdf) included in the compressed file you will download from the website. For details about using
the software, refer to the instruction manual (PDF file) that is installed with the software.

Canon XF Utility (for Windows/macOS): Software application that allows you to save clips on a computer,
check, play back and organize clips and grab still frames from clips.

Canon XF Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import clips
from a card or a local folder in the computer to the compatible version of Avid Media Composer (an NLE
application compatible with Avid Media Access), directly from within the application.

Saving XF-AVC S/XF-HEVC S Clips

Make sure to save XF-AVC S/XF-HEVC S clips recorded with this camera to a computer. To do so, you will need
a card reader connected to a computer or a computer with a card slot. For details on transferring files from the
card, refer to the computer’s instruction manual or OS’s help modules.

Under certain circumstances, clips may be split and recorded as separate files. Using MP4 Join Tool you can join
the split XF-AVC S/XF-HEVC S clips and save them as a single seamless clip.

Transferring Files to a Computer

1 Insert the card with the desired clips into the card slot of the computer or card reader connected to the
computer.

2 Follow the OS’s onscreen instructions.

3 Copy the clips on the card to the computer.

e XF-AVC S/XF-HEVC S clips are located in folders named “XFVC/REEL_XXXX” and photos are located in
folders named “DCIM/XXX_mmdd”, where XXX is the folder number and mmdd stands for the recording
date.

Joining Clips Split by the Camera

Use MP4 Join Tool to join XF-AVC S/XF-HEVC S clips split by the camera in the following cases.
¢ When the camera switches to the other card while recording video due to the relay recording function (11 47).
¢ The video (stream) file in the clip will be split approximately every 4 GB.

MP4 Join Tool is available as a free download (for Windows or macOS) from your local Canon website. Check
the download page for the system requirements and latest information.

You will find detailed instructions about installing and uninstalling the software in the “Read This First” file (Install-
MP4 Join Tool.pdf) included in the compressed file you download. For details about using the software, refer to
the instruction manual (PDF file) that is installed with the software.
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Saving WAV Files

Audio files in WAV format can be saved to a computer in the same way as XF-AVC S/XF-HEVC S files. Copy the
desired audio files (located in the “/PRIVATE/AUDIO” folder of the SD card) to the computer.

Developing RAW Clips

Use Cinema RAW Development to develop RAW clips shot/recorded with the camera. After you develop the
clips and export them to a full-quality standard file type such as DPX, they will be ready for color grading.
Alternatively, you can use the Canon RAW Plugin to easily use RAW clips unaltered (in RAW format) directly from
major non-linear editing (NLE) applications. The software and plugin are available as free downloads from your
local Canon website. Check the download page for the system requirements and the latest information.

You will find detailed instructions about installing and uninstalling the software in the “Read This First” file
(Install-Cinema RAW Development.pdf) included in the compressed file you will download from the website. For
details about using the software, refer to the instruction manual (PDF file) that is installed with the software.

Cinema RAW Development (for Windows/macOS): Software application that allows you to develop, play back
and export RAW clips.

Canon RAW Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import RAW
clips to the compatible version of Avid Media Composer (an NLE application compatible with Avid Media
Access), directly from within the application.

Canon RAW Plugin for Final Cut Pro (macOS): Plugin that allows you to easily import RAW clips to Apple’s
Final Cut Pro, directly from the application.

Saving Recordings to a Smartphone

You can save clips (XF-AVC S, XF-HEVC S), audio (WAV), photos (JPEG) and News Metadata files to a
smartphone. Content Transfer Professional is needed for this operation. You can connect a smartphone to the
camera using a compatible USB cable* or the network functions ([11 210).

* For details on compatible USB cables, visit your local Canon website.

Smartphone

Connection port

Compatible USB cable

1 Select MENU > [¥ System Setup] > [USB Mode] > Desired option.
For iOS devices: select [Canon App(s) for iPhone].
For Android devices: select [Canon App(s)/GP-E2].

2 Connect the smartphone to the camera using a compatible USB cable.
3 Open the application on the smartphone.
4 Use the application to save the files.
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5 When the connection ends, disconnect the USB cable from the camera.

Automatically Transferring Recording Data to an FTP Server

You can use Content Transfer Professional to automatically transfer clips (XF-AVC S, XF-HEVC S), audio (WAV),
photos (JPEG) and News Metadata files to an FTP server. Install Content Transfer Professional on your
smartphone in advance ([J1 210).

1 Connect the smartphone to the camera.
When using a USB cable, perform steps 1 to 3 of Saving Recordings to a Smartohone (11 177).
When using network functions, perform steps 2 to 6 of 7ransferring Recordings to a Smartohone (11 210).

2 Smartphone: specify the destination FTP server on Content Transfer Professional, and start the
[Transfer by camera operation] function.

3 Press REC to start recording.
e Recorded clips are automatically transferred.

4 End the connection.
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To be able to use the following network functions you will need to connect to a Wi-Fi network, or use the =5
(Ethernet) terminal on the camera to connect to a wired (Ethernet) network.

Network functions and connection types

Wi-Fi
Wired network
Network function Description
¢ (Ethernet) Infrastructure e A;_’ cess [0
Point!
Transfer clips recorded with the camera to
FTP File Transfer another device connected to the network o [ J o 199
using the FTP protocol.
Stream the camera’s live video and audio over
IP Streaming IP to a compatible IP video decoder connected @ @ - 200
to the network.
Browser Remote Control the camera remotely from the Web °® °® P 202
browser of a connected device.
Transfer clips/audio recorded with the camera
Canon App

to a smartphone, or apply News Metadata
Transf - - 21
gg?‘::zitmﬁ;]s er created/edited with Content Transfer ot 0

Professional to the camera.

Control the camera remotely using a
XC Protocol controller or application compatible with the @ @ (] 208
XC Protocol via an IP connection.

Output metadata information (from the
CV Protocol Ethernet terminal) necessary for virtual ®3 - - 188
production in real time on a PC application.

4 Upload recording data from the camera using

Fi il
rame.lo Adobe’s Frame.io Camera to Cloud function.

(] [ - 210

1 Connection to a Wi-Fi network via an external access point (wireless router, etc.)

Direct connection to one Wi-Fi-enabled device where the camera serves as the Wi-Fi access point.
S IPv4 only.
4 Cannot be used outside the service area of Frame.io.

Security

When connecting the camera to a network, make sure to use a secure network environment.

It is recommended to use the camera with the default settings.

When connecting the camera to a network, there is a risk of unauthorized access from unintended third parties
or cyber-attacks. If access from an external network is not required, physically and/or virtually block access so
that only specified devices can access the network. Additionally, Wi-Fi (wireless LAN) may be intercepted by
malicious third parties, posing a risk of eavesdropping on communication content.

If access to an external network is required, it is important to implement a secure method of communication,
such as using a VPN (Virtual Private Network) that can block access from the outside. Use Wi-Fi in a secure
environment. AES encryption is recommended.

In particular, the following functions do not support protocol encryption for communication with the camera;
therefore, use these functions in a secure network environment.

e Canon App (Content Transfer Professional)
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e CV Protocol

@ vPoRTANT

e Canon shall not be liable for any direct or indirect damages caused by network security issues.

e The camera cannot be directly connected to the communication lines (including public wireless LAN) of
telecommunications carriers (mobile communications companies, fixed-line communications companies,
Internet providers, etc.). When connecting the camera to the Internet, be sure to connect via a router or similar
device.

Before using the network functions

¢ The instructions in this chapter assume you already have a correctly configured and working network and
correctly configured network device(s). If necessary, refer to the documentation provided with the network
devices you plan to use.

e Configuring the network settings requires adequate knowledge about configuring and using wired (Ethernet)
and/or wireless (Wi-Fi) networks. Canon cannot provide support regarding network configurations.

@ vroRTANT

¢ |n case it is necessary to set a password for network connections or function settings, make sure to set a
secure password that is long enough to be hard to guess, including a combination of characters and symbols.
Use caution not to lose the password.

(i) NoTES

e Do not open the card compartment cover while using network functions.

¢ Do not place cables connected to the SDI OUT, MON., HDMI
OUT, INPUT, MIC, or USB terminal near the built-in wireless
antenna. This may affect the wireless communication or the
recorded audio.

Built-in
wireless
antenna
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Using Networks
Using a Wi-Fi Network

You can connect the camera in Infrastructure mode, using an access point (wireless router etc.), or in Camera
Access Point mode, directly to a network device. The type of connection you can use, depends on the network
function you wish to use ([1 179).

For an Infrastructure connection, the camera offers 4 ways to configure an access point and the method you use
will depend on the type and specifications of the access point and network you plan to use.

Camera Access Point: When shooting in a location where there are no access points available, the camera can
serve as a wireless access point*. Wi-Fi enabled devices will be able to connect to the camera directly.

* Limited only to the connection between the camera and supported Wi-Fi enabled devices. The functionality is not the same as
that of commercially available access points.

Infrastructure connection:

WPS (button): If your wireless router supports Wi-Fi Protected Setup (WPS), setup will be @ pp—

SETUP

easy and require minimal configuring and no passwords. To check if your wireless router
has a WPS button and for details about how to activate the Wi-Fi protected setup, refer to
the instruction manual of your wireless router.

WPS (PIN code): Even if your wireless router does not have a dedicated WPS button, it may support WPS using
a PIN code instead. For setup using a PIN code, you will need to know in advance how to activate the wireless
router's WPS function. For details refer to the instruction manual of your wireless router.

Searching for Access Points: If your access point does not support the WPS function or you cannot activate fit,
you can have the camera search for access points in the area.

Entering the SSID and authentication method: Manually enter the SSID and other information about the access
point.

@ vPoRTANT

e Depending on the country/region of use, some restrictions on outdoor use or Camera Access Point
connections may apply when using the IEEE 802.11b/g/a/n/ac wireless standard. Check in advance the areas
of use and restrictions.
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Using a Wired (Ethernet) Network

Connect a commercially available Ethernet cable to the =25 (Ethernet) terminal on the camera and to the
Ethernet port on a network device. Use Category 5e, shielded twisted pair (STP) Ethernet cables compatible
182 with Gigabit Ethernet (1000BASE-T) and with good shielding capability.

== (Ethernet) terminal and
connection indicator

Ethernet port on a
network device

0DO0DO0OO0OOOD

Ethernet cable
(commercially available)

|




Configuring Connection Settings

Configuring Connection Settings

To connect to a network you will need to define in advance a connection setting (SET), which is a combination of
one or two communication settings (networks, NW) and one or two network function settings (MODE). You can
save in the camera up to 25 individual communication settings and function settings, and up to 20 combinations
of connection settings (SET1 to SET20).

To configure a connection setting for the first time, you will follow the setup wizard ([J1 184). Using the wizard,
you can set up only one network and one function per connection setting. After having configured multiple
connection settings, you can change them (for example to add a secondary network or second function) and
you can create new ones combining existing communication and function settings ([11 194).

Configure the necessary connection settings for the networks and network functions
you wish to use.

Connection setting (SET)

Communication Communication Function Function
Setting 1* (NW) Setting 2 Setting 1* (MODE) Setting 2**
* Configured using the wizard.
SiEg ** Only in CAMERA mode.
Wi-Fi — FTP transfer
—E Camera Access Point —— IP streaming
Infrastructure Browser Remote
WPS (push button)
WPS (PIN code) Canon App
Detected access points —— XC Protocol
SSID/authentication mode input L CV Protocol
\/ ——— Ethernet Frame.io

Select a connection setting appropriate for the network function you wish to use and
Step2 | start using the function.

FTP transfer (11 199)

IP streaming (11 200)

Browser Remote ([11 202)

Canon App (11 210)

XC Protocol (1] 188)

CV Protocol ([] 188)

Frame.io (11 189)

Activating a Network Connection
Activate the desired network connection to use network functions or to configure the connection setting online.

1 Select MENU > [\ Network Settings] > [Network] > [Enable].

2 When using connection settings that you saved previously, select MENU > [#\* Network Settings] >
[Connect] > Desired connection setting ([SET1] to [SET20]) > [OK].

¢ To end the network connection, set [Connect] to [Disconnect] instead.
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Adding a New Connection Setting Using the Wizard

You can use the wizard to set up a new connection setting. This section uses a connection to a Wi-Fi network
using the WPS push button method as an example. Refer to the instruction manual of the access point for
details about the location and operation of the WPS button.

1 Enable the network functions ([J] 183).

2 Select MENU > [#M Network Settings] > [New Conn. Setting (Wizard)] > Desired network function >
[OK].
3 Select [Create New Comm. Setting].

e Once you have added multiple communication settings, you can select [Select Existing Setting] to reuse the
settings for a network that you saved previously.

4 Select [Wi-Fi F].
¢ To configure a wired (Ethernet) network (11 189).
5 Select [Connect with WPS] > [WPS (Push Button)].

¢ To use a different configuration method, complete the corresponding procedure.
Camera Access Point ([J] 190)
WPS using a PIN code ([ 190)
Detected access points ([I1 191)
SSID/authentication mode input (11 191)
Manual setup without connecting to the network ([J1 192)

6 Press and hold the WPS button on the wireless router and then, on the camera, select [OK].
7 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] >
[Disable].
¢ To configure IPv4 settings manually (1] 192).
e To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6
settings as necessary ([11 195).
8 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.
e Continue with one the following procedures to configure the selected function’s settings (11 184).

(i) NoTES

e The [WPS (Push Button)] method may not work correctly depending on the devices used or the surrounding
conditions. In such case try using [WPS (PIN Code)] (11 190) or selecting one of the detected networks
(@ 191).

Function Settings
FTP Transfer

This section continues the connection settings wizard ([J] 184). In the function settings you will configure the
FTP server settings and other settings related to the handling of folders and files. If necessary, consult the
network administrator in charge of the FTP server.

1 Select [Create New Func. Setting].

¢ Once you have added multiple function settings, you can select [Select Existing Setting] to reuse the
settings for an FTP server that you saved previously.

2 Select the desired transfer mode.
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3 Configure the destination FTP server. Select [Server] and [Port No.] > [OK].

e Enter the FTP server’s IP address or host name using the keyboard screen. Enter the port number using the
data entry screen ([11 42).

e Usually, the port number used is 21 (FTP or FTPS transfers) or 22 (SFTP transfers).

* Depending on the FTP mode selected in step 2, perform either step 4 or steps 4-5 and then continue to
step 6.

SFTP transfers
4 Enter the user name and password for the SSH protocol’s authentication. Select [User Name] and [Password]

> [OK].

¢ Enter the desired user name and password using the keyboard screen ([11 42).

FTP/FTPS transfers

4 Select [Enable] to use passive mode or [Disable] to use active mode.
* In most cases, select [Disable].

5 Enter the user name and password for the FTP server. Select [User Name] and [Password] > [OK].
¢ Enter the desired user name and password using the keyboard screen ([ 42).

All transfer modes
6 Select the destination folder on the server.
7 Select [OK]
e The function settings are saved to a [MODE] file.
8 Select the connection setting (SET1 to SET20) where to save the settings.
9 Select [OK].
¢ The camera will connect to the network and will be ready to use the FTP transfer function ([J1 199).

Options for [FTP Mode]

[FTP: Transfer method where the data is not encrypted.
[FTPS]: Secure transfer method using a root certificate (11 192).
[SFTP]: Secure transfer method using an SSH secure channel.

Options for [Destination Folder]

[Root Directory]:
Files are saved on the root directory of the destination FTP server.

[Select Folder]: Enter the desired path using the keyboard screen ([1] 42). If the folder does not exist on the
destination FTP server, it will be created automatically.
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IP Streaming

This section continues the connection settings wizard ([J] 184). In the function settings you will configure the
streaming video bit rate and resolution, the protocol used and the receiver’s settings. For details refer to the
instruction manual of the decoder device or software you will use.

1 Select [Create New Func. Setting].

e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse IP
streaming settings that you saved previously.

2 Select the desired protocol.
* Depending on the selected protocol, perform steps 3 to 6 if necessary and then continue to step 7.

[UDP] / [RTP] streaming
3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].
e Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry
screen ([ 42).
e Using the default port number is recommended.
e Proceed to step 7.

[RTP+FEC] streaming
3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].

* Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry
screen ([ 42).

e Using the default port number is recommended.
4 Configure the settings used to send FEC packets. Select [FEC Port No.] and [FEC Interval] > [OK].
¢ Enter the port number using the data entry screen ([11 42).
e Using the default settings is recommended.
e Proceed to step 7.

[RTSP+RTP] streaming
3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].

* Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry
screen ([ 42).

e Using the default port number is recommended.

4 Enter the user name and password of the RTSP client. Select [RTSP: User Name] and [RTSP: Password] >
[OK].
¢ Enter the desired user name and password using the keyboard screen ([1] 42).
® Proceed to step 7.

SRT
3 Select the connection mode.
Caller: Connect to a decoder or a computer from the camera.

Listener: Listens for connections from the decoder or computer.

4 When [Caller] is selected, enter [Destination Server], [Dest. Port No.] and [Stream D], then select [OK].
e Using the default port number is recommended.

5 When [Listener] is selected, enter [Listening Port No.] then select [OK].
e Enter the port number of the decoder or computer.

6 Select [Encryption Settings], enter [Passphrase] and [Latency], and then select [OK].
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All streaming protocols

7 Select the video streaming configuration.
8 Select the audio channels.

9 Depending on the resolution and frame rate, a screen may prompt you to change other settings. Change the
settings as necessary.

10 Select [OK].

e The function settings are saved to a [MODE] file.
11 Select the connection setting (SET1 to SET20) where to save the settings.
12 Select [OK].

e The camera will connect to the network and will be ready to start streaming.

13 Connect the decoder to the network and complete any necessary configurations on the receiving side so the
decoder is ready to receive video over IP.

¢ To start streaming, refer to /P Streaming (11 200).

Options for [Protocol]

[UDP]: This protocol prioritizes transfer speeds but does not guarantee the reliability/integrity of the
data. Lost or delayed IP packets are ignored.

[RTP]: Standard protocol for video/audio broadcasts over the Internet. Lost or delayed IP packets are
ignored.

[RTP+FEC]: This setting uses the RTP protocol and adds a layer of FEC error correction so the receiving

side* can recover lost or delayed IP packets.

[RTSP+RTP]:  This setting uses the RTSP (real time streaming) protocol to control the streaming server
(camera) in real time and the RTP protocol for the broadcast over IP. With the RTSP protocol,
the receiver can control when to start and stop the broadcast.

[SRTI: A protocol for high-speed transmission that suppresses the occurrence of lost/delayed packets.
Transmitted data can be encrypted.
* A decoder compatible with FEC error correction is required.

Browser Remote

This section continues the connection settings wizard ([1] 184). A user name and password are required to log
in to the Browser Remote application. In the function settings you will configure up to three different users for
single-user or two-user operation.
1 Select [Create New Func. Setting].
e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Browser
Remote settings that you saved previously.
2 Enter the user names and passwords as necessary.
3 Select [OK] twice.
¢ The function settings are saved to a [MODE] file.
4 Select the connection setting (SET1 to SET20) where to save the settings.
5 Select [OK].

e The camera will connect to the network and will be ready to accept commands from the Browser Remote
application ([1] 202).

Canon App (Connecting to a Smartphone)

This section details the necessary settings to connect the camera to a smartphone through a network. Be sure
to connect both the smartphone and the camera to the same network in advance.

A Content Transfer Professional is necessary to connect the camera to a smartphone. For details on
downloading the necessary Content Transfer Professional, refer to 7ransferring Recordings to a Smartohone
([T 210). For more details, refer to the smartphone’s instruction manual.
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1 Select [Create New Func. Setting].

e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Canon App
settings that you saved previously.

2 Select [OK].
3 As indicated on the screen, open the application on the smartphone.
4 Select the camera using the Content Transfer Professional.

e |f the camera and the smartphone are connected to the same network, the camera will be detected
automatically.

5 Select [OK].
e The connection will be completed.
¢ The function settings are saved to a [MODE] file.
6 Select the connection setting (SET1 to SET20) where to save the settings.
7 Select [OK].
e The connection will be completed and the camera will be ready to operate with the connected smartphone

(01 210).

XC Protocol
Set a user name and password to connect to an XC Protocol compatible device connected to a network.
1 Select [Create New Func. Setting].
2 Set the authentication method used by the XC Protocol (HTTP/HTTPS) server.
e After selecting [Basic Authentication] or [Digest Authentication], set the user name and password.
User name: 5 to 15 alphanumeric characters or symbols.
Password: 8 to 32 alphanumeric characters or symbols (use at least 2 types from each).
3 Select [OK].
¢ The function settings are saved to a [MODE] file.
4 Select the connection setting (SET1 to SET20) where to save the settings.
5 When the confirmation message appears, press SET.

e The camera will connect to the network and will be ready to accept commands from the remote controller/
application ([ 208).

CV Protocol
Configure the camera to output metadata information necessary for virtual production in real time on a PC
application. Ethernet IPv4 only.
1 Select [Create New Func. Setting].
2 Enter [Destination Server] and [Dest. Port No.] as the destination settings and select [OK].
e Enter the address for the communication method (Unicast/Multicast*/Broadcast) used by the destination
server.
* Transmission is possible only within the same network segment.
e Using the default port number is recommended.
3 Select a distortion model (output signal), then select [OK].
[OpenlLenslO-Equiv. Model]: Equivalent to OpenlLenslO.
[OpenCV-Equiv. Model]: Equivalent to OpenCV.

4 Select the connection setting (SET1 to SET20) where to save the settings.
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5 When the confirmation message appears, press SET.

e Use the Canon Live Link Plugin for Unreal Engine to send metadata information to applications used for
virtual production. For details about using and downloading Live Link Plugin for Unreal Engine refer to the
Canon website.

(i) NoTES

¢ \When the set slow & fast motion recording frame rate exceeds 60P, [CV Protocol] cannot be used at the same
time.

Frame.io
Set up a connection between the camera and Frame.io.

1 Select [Create New Func. Setting].
e [f there is a previously registered function setting related to Frame.io, you can select it from [Select Existing
Setting].
2 Select the pairing destination.
[Keep Current Pairing]: Maintains the pairing status with the camera.
[Create New Pairing]: Creates a new pairing with Frame.io. If you want to re-pair when the camera is already
paired, select [OK].
3 Select [OK].
® The pairing code is displayed.
e |f [Keep Current Pairing] is selected, proceed to step 6.
4 From Frame.io: Access Frame.io and enter the pairing code.
e The camera is paired with Frame.io.

5 Select [OK].
6 Select [Auto Upload File Formats].

[XF-AVC Proxy]: Proxy clips in XF-AVC format.

[XF-HEVC S/XF-AVC S Proxy]: Proxy clips in XF-HEVC S/XF-AVC S format.

[Audio Proxy]: Audio recording files (second card recording functions).
7 Select [OK].

¢ The function settings are saved to a [MODE] file.
8 Select the connection setting (SET1 to SET20) where to save the settings, then select [OK].
¢ The connection is completed. Refer to Uploading Recording Data to Frame.io (11 210) for operation details.

Other Connection Methods

This section explains how to configure communication settings using methods other than the WPS push button.

Ethernet Settings
1 In the [Network Type] screen, select [Ethernet ==5].

2 Make sure the Ethernet cable is correctly connected ([11 182) and select [Setup with Network Connection].

e Select [Setup without Network Connection] to only configure the settings, without connecting to the
network.

3 Set the IP address (11 192).
4 Select [OK] to continue to configure the function settings.
¢ The communication settings are saved to an [NW] file.
¢ Continue with one the following procedures to configure the selected function’s settings (11 184).
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Camera Access Point

Connect a network device with the camera’s access point. Two configuration methods are available: easy
connection and manual connection.

1 In the [Select a network] screen, select [Camera Access Point Mode].
¢ Depending on the selected method, perform either step 2 or steps 2-6 and then continue to step 7.

Easy Connection

2 The camera will assign the network name (SSID) and password automatically. Review the settings for the
camera’s Wi-Fi access point and select [OK].

* These settings are necessary to connect a network device to the camera.

e QR code connection is also possible. Touch [QR] on the screen to display a QR code to be read with a
network device.

[Manual Connection]

2 Enter the SSID (network name) for the Camera Access Point and then select [OK].
¢ Enter the desired network name using the keyboard screen (11 42).
3 Select the Wi-Fi channel.

e Select [Automatic Setting] to have the camera select the channel automatically, or select [Manual Setting] >
Desired channel.

4 Select the encryption settings.
e Select [AES] to use AES encryption, or [Disable] to use no encryption.
e |f you selected [Disable], skip to step 7.

5 Enter the password for the Camera Access Point and then select [OK].
e Enter the desired password using the keyboard screen ([11 42).

6 Set the IP address ([1] 192).

Both configuration methods

7 Select [OK] to continue to configure the function settings.

e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings ([11 184).
8 Before you can save the connection setting, connect the network device to the camera.

e Activate the device’s Wi-Fi function, select the camera’s SSID (network name) from the list and enter the
password to connect to the camera.

WPS using a PIN Code

Connect to an access point using a PIN code. For most wireless routers, you must use a Web browser to
access the setup screen. For details on how to set up the access point, refer to the access point’s user manual.

1 In the [Select a network] screen, select [Connect with WPS] > [WPS (PIN Code)].
e The camera will generate and display an 8-digit PIN code.
2 Enter the PIN code into the wireless router’s WPS (PIN code) setup screen and then, on the camera, select
[OK].
3 Set the IP address ([11 192).
4 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.
¢ Continue with one the following procedures to configure the selected function’s settings (1] 184).
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Detected Access Points

The camera will automatically detect access points in the vicinity. After you select the desired access point, you
only need to enter the selected network’s password to connect the camera. Be sure to activate tethering in
advance when using a smartphone as an access point. For details about the access point’s network name
(SSID) and password refer to the wireless router’s instruction manual or consult the network administrator in
charge of the access point.
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A list of active networks detected in the vicinity
will appear after the menu settings

Point Mode

Network name Encrypted access point
(SSID, only ASCII characters)

1 In the [Select a network] screen, scroll through the list of detected networks and select the desired network.

e If the access point is encrypted, enter the password of the access point using the keyboard screen (11 42).
2 Set the IP address ([1] 192).
3 Select [OK] to continue to configure the function settings.

e The communication settings are saved to an [NW] file.

¢ Continue with one the following procedures to configure the selected function’s settings (11 184).

SSID/Authentication Mode Input

You can connect to a specific access point by manually entering its details. For details about the access point’s
network name (SSID) and password refer to the wireless router’s instruction manual or consult the network
administrator in charge of the access point.

1 In the [Select a network] screen, select [Enter SSID/Authentication Method].
2 Enter the SSID (network name) of the desired network and then select [OK].
¢ Enter the desired network name using the keyboard screen ([11] 42).
3 Select the network’s authentication method.
¢ |f you select [Open System], select [Disable] (no encryption) and skip to step 6, or select [WEP] and continue
the procedure.
e |f you select [Shared Key] or [Open System] > [WEP], select the key index.
4 Enter the password of the desired network and then select [OK].
¢ Enter the desired password using the keyboard screen ([1] 42).
5 Set the IP address (11 192).
6 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.
e Continue with one the following procedures to configure the selected function’s settings ([11 184).
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Offline Configuration without Connecting to a Network
1 In the [Select a network] screen, select [Configure Offling].

2 Select the network type.

e [f you select [Infrastructure], continue with the procedure to enter the SSID and authentication mode, from
step 2 (11 191).
If you select [Camera Access Point Mode], continue from that procedure, from step 2 ([J1 190).

Configuring the Camera’s IP Address

This section explains how to configure the IP address. Available settings will change depending on the network
function selected.

1 Select the method used to configure IPv4 settings, [Automatic Setting] or [Manual Setting].

¢ \When using the wizard to add a new connection setting, make the selection in the [IP Address Settings
(IPv4)] screen.

e If you select [Automatic Setting], skip to step 4.

Manual Setting

2 Select [IP Address] and [Subnet Mask] and enter the desired addresses using the data entry screen (11 42).
e To use a default gateway, select [Use Gateway] > [Enable] and then select [Gateway] and enter the address.
e To use a DNS address, select [Use DNS Address] > [Manual Setting] and enter the address.

3 Select [OK].

Both methods

4 Select whether to use TCP/IPv6 settings or not.
e To use IPv4 settings, select [Disable].
¢ To configure IPv6 settings (1] 195).

Other Network Settings

Reading/Deleting a Root Certificate for FTP Transfer

When you use the [FTPS] transfer mode, you will need to read onto the camera the same root certificate saved
on the FTP server. You can also check the content of a previously loaded root certificate or delete it.

1 Set the camera to MEDIA mode.
2 Save the desired root certificate file onto the root directory of an SD card and insert it into the SD card slot.
3 Select MENU > [V Network Settings] > [Advanced Settings] > [FTP Transfer Settings] > [Read Root
Certificate] > [OK].
e The root certificate file is read from the card.

e After reading a root certificate file, you can select [Root Certificate Details] to check the certificate’s issuer
and expiration date, or select [Delete Root Certificate] to delete the root certificate in the camera.

(i) notes

¢ Only one root certificate, with one of the following file names, can be read by the camera: “ROOT.CER”,
“ROOT.CRT” and “ROOT.PEM”.

e |f you transfer files using FTPS transfer with a self-signed certificate, you may not be able to trust the
destination server.
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802.1X Authentication

The camera is compatible with the following protocols.
EAP-TLS: X.509 supported
EAP-TTLS, PEAP: MS-CHAP v.2 supported

Select MENU > [V Network Settings] > [Advanced Settings] > [802.1X Authentication] > [Setup
Wizard].

¢ Follow the wizard to complete the authentication settings.
When you select the [EAP-TLS] protocol, the root certificate (8021X_R.CER), client certificate (8021X_C.CER)
and private key (8021X_C.KEY) will be read from the card.
When you select the [EAP-TTLS] or [PEAP] protocol, select [User Name] and [Password] and enter the
information. Then, read the root certificate from the card. Each must be saved directly in the card’s root
directory.

e After reading the authentication files, select [Check Settings] to check their content. Select [Delete Settings] to
delete the authentication files in the camera.

Reading/Deleting a Root Certificate for Frame.io Upload
This section describes how to read a root certificate onto the camera when using Frame.io.

1 Save the desired root certificate file onto the root directory of an SD card and insert it into the SD card slot.
2 Select MENU > [#V Network Settings] > [Frame.io] > [Root Certificate].
3 Select [Read Root certificate], then select [OK].

* The root certificate file is read from the card.

e After reading a root certificate file, you can select [Root Certificate Details] to check the certificate’s issuer
and expiration date, or select [Delete Root Certificate] to delete the root certificate in the camera.

(i) NoTES

¢ Only one root certificate, with one of the following file names, can be read by the camera: “FRAMEIO.CER”,
“FRAMEIO.CRT” and “FRAMEIO.PEM”.

Giving a Nickname to the Camera

You can give the camera a nickname that is used on network connections and network devices to make it easier
to identify.

Select MENU > [ Network Settings] > [Nickname].
¢ Enter the desired nickname using the keyboard screen (11 42).

Checking and Changing Connection Settings (SET)

You can check and, if necessary, change the settings of connection settings (SET) registered in the camera. In
addition to deleting and renaming connection settings, you can also add to a connection setting a secondary
network or second function.

Checking the Content of a Connection Setting

Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ((SET1] to [SET20])
> [Check Settings].

¢ The detailed content of the connection setting is displayed.

e Push the joystick left/right to review all the settings and press the CANCEL button to return to the menu.
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Changing Settings using the Wizard
1 Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to
[SET20]) > [Change with Wizard].

2 Select the desired network function and then follow the wizard as described in the previous procedure (from
step 3, [11 184) and make any changes as necessary.

Changing Connection Settings using Existing Settings

You can use previously registered communication settings ([NW] files) or function settings ((MODE] files) to easily
replace the content of a connection setting or to add a second network or network function in addition to those
registered using the wizard.

1 Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to
[SET20]) > [Select Existing Setting].

To add/replace a communication or function setting
2 Select the setting you want to change > [Select Existing Setting] > Desired NW or MODE file.

¢ |n the list of communication settings and function settings registered in the camera, only those that can be
selected will be displayed in white and others will be grayed out.

3 Select [Set].

¢ |f necessary, select [Check Comm. Settings] or [Check Function Settings] to check the content of the
selected file before making the change.

To delete a communication or function setting
2 Select the setting you want to remove > [Clear Selected] > [OK].

(i) NoTES

¢ A connection setting can have two communication settings (primary/secondary network) and up to two
function settings (only for [IP Streaming] and [Browser Remote]).

e |f both communication settings are deleted, the connection setting itself will be reset and will appear as
[Unspecified)].

Renaming Connection Settings
You can rename connection setting (SET) files to make them easier to identify from the list.

Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20])
> [Settings Name].
¢ Enter the desired name (up to 12 characters) using the keyboard screen ([1] 42).

Deleting Connection Settings

Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20])
> [Delete Settings] > [OK].
¢ The connection setting will be deleted.

(i) NoTES

e Even if you delete a connection setting, the individual communication/function settings stored in it are not
deleted. You can reuse these settings to configure other connection settings.
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Checking and Changing Communication Settings (NW)/Function Settings (MODE)

You can check the content of communication settings ([NW] files) and function settings ((MODE] files) saved in
the camera and change or delete them as necessary.

Checking the Content of a Communication Setting/Function Setting

1 Select MENU > [ Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].

2 Select the desired communication setting (INW1] to [NW25]) or function setting (MODE1] to [MODEZ25)).

3 Select [Check Settings].
* The detailed content of the selected setting is displayed.
e Push the joystick left/right to review all the settings and press the CANCEL button to return to the menu.

Changing/Deleting Communication Settings/Function Settings

1 Select MENU > [ Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].

2 Select the desired communication setting (INW1] to [NW25]) or function setting (MODE1] to [MODE25)).

3 Select [Change Settings] and change the various settings as necessary.
e If in step 2 you selected an [Unspecified] settings file, the only option available is [Create New with Wizard)]

(11 184).

e Select [Delete Settings] > [OK] to delete the communication setting/function setting.

Configuring TCP/IPv6 Settings
If in the wizard you selected [Enable] to use IPv6 settings, change the settings as necessary after completing the
wizard.

1 After step 3 in the previous procedure, select [TCP/IPv6] > [TCP/IPv6 Settings] > [Enable].
e This step is not necessary if you selected [Enable] when you used the wizard to add a new connection
setting.
e Continue the procedure to change the default IPv6 settings.
2 To configure the IPv6 settings manually, select [Manual Setting] > [Enable].
e [DNS Server] changes to [Manual Setting].
3 Select [DNS Server] > Desired option.
e |f you selected [Disable] in step 2, you can set [DNS Server] to [Auto Assign).
¢ \When not using a DNS server, select [Disable].
4 If you set [DNS Server] to [Manual Setting] in step 3, configure the [DNS Address].
¢ Enter the IP address using the data entry screen (11 42).

When [Manual Setting] is set to [Enable]

5 Select [Manual Address] (manually entered IPv6 address), [Prefix Length] (bits available for the network
address) and [Gateway] (gateway’s IP address) and enter the necessary information.

¢ Enter the IP addresses and prefix length using the data entry screen (11 42).

Individual settings available for manual change (communication settings)

Menu item Setting options and additional information
[Wi-Fi]

[SSID] -
[Advanced Settings] [Authentication Method], [Password]
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Menu item
[TCP/IPv4]
[IP Address Settings]
[DNS Server]

Setting options and additional information

[Automatic Setting], [Manual Setting]
[Disable], [Auto Assign], [Manual Setting]

[DNS Address], [IP Address],

[Subnet Mask], [Gateway]

[TCP/IPv6]
[TCP/IPv6 Settings] [Disable], [Enable]
[Manual Setting] [Disable], [Enable]
[DNS Server] [Disable], [Auto Assign], [Manual Setting]
[DNS Address],
[Manual Address], Enter the desired address using the data entry screen (1] 42).
[Prefix Length], [Gateway]

Individual settings available for manual change (function settings)

Menu item
[FTP Transfer]

Setting options and additional information

[Destination Server]

[Server], [Port No.]

[User Name/Password]

[User Name],
[Password]

[Destination Folder]
[Dest. Folder Structure]
[Overwrite Files]

[Default], [Camera]
[Skip], [Save As (New Name)], [Overwrite]

Determines how to deal with files to be transferred when files with the same name already exists in the
destination folder.

[Skip]: The file will not be transferred.

[Save As (New Name)]: The file will be transferred and “_1” will be added to the end of the file name.
[Overwrite]: The file will be transferred, overwriting any file with the same name on the FTP server.

[Passive Mode]

[Disable], [Enable]

[New Folder by Date]

[Enable], [Disable]

[Enable]: A new subfolder under the transfer destination folder “YYYYMMDD\HHMMSS” will be created for every
transfer operation.
[Disable]: All the files will be transferred to the folder specified for the [Destination Folder] setting.
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Menu item Setting options and additional information
[IP Streaming]
[Protocol] [UDP], [RTP], [RTP+FEC], [RTSP+RTP], [SRT]

[Destination Server], 197
[Dest. Port No.],
[FEC Port No.]

[FEC Interval] 10 to 100 (intervals of 5)

[RTSP: User Name],
[RTSP: Password]

[SRT: Connection Mode] [Caller], [Listener]
[SRT: Stream ID]

[SRT: Listening Port No.]
[SRT: Encryption Settings] | [Disable], [AES-128], [AES-192], [AES-256]
[SRT: Passphrase]
[SRT: Latency]

[Video Output Conf.] [9Mbps/1920x1080 59.94P], [4AMbps/1920x1080 59.94P], [9Mbps/1920x1080 50.00P],
[4Mbps/1920x1080 50.00P], [9Mbps/1920x1080 59.94i], [4AMbps/1920x1080 59.94i],
[9Mbps/1920x1080 50.00i], [4Mbps/1920x1080 50.00i],

[Audio Out Channels] [CH1/CH2], [CH3/CH4]

[CV Protocol]

[Destination Server]

[Dest. Port No.]

[Distortion Model] [OpenLenslO-Equiv. Model], [OpenCV-Equiv. Model]

Changing Browser Remote Settings
1 Select MENU > [ Network Settings] > [Advanced Settings] > [Browser Remote Settings].
2 Change the various settings as necessary.
e You can select [Port No. (HTTP)] or [Port No. (HTTPS)] to change the port numbers used for each
connection. Using the default port numbers (HTTP: 80, HTTPS: 443) is recommended.
e To use an HTTPS connection, select [HTTPS] > [Enable].
To use a secure HTTPS connection, use a Camera Access Point connection setting and connect the
network device to the camera using a normal HTTP connection ([J] 202) and download the necessary

certificate from the Browser Remote’s settings tab ([T1 207). After you import the certificate you
downloaded to your Web browser, you will be able to use a secure HTTPS connection.

To change XC Protocol settings
1 Select MENU > [ Network Settings] > [Advanced Settings] > [XC Protocol Settings].
2 Change the various settings as necessary.

e You can select [Port No. (HTTP)] or [Port No. (HTTPS)] to change the port numbers used for each
connection. Using the default port numbers (HTTP: 80, HTTPS: 443) is recommended.

e When [HTTPS] > [Enable] is selected, you will be able to access XC Protocol-compatible devices connected
to the network via HTTPS communication. To use HTTPS communication, first select [Save HTTPS Self-
signed Cert] to save the self-signed certificate to the SD card. Next, import the saved self-signed certificate
into the XC Protocol-compatible device to enable HTTPS communication.
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Checking the Network’s Status

Unless you selected to configure a connection setting offline (without connecting to the network), immediately
after configuring a new connection setting, the camera will connect to the network automatically and the
selected function settings will be activated. The icons displayed on the screen will indicate the type of network
selected and the connection status. When you disable the network functions or disconnect from the network,
the icons will disappear.

» A 32min [0
min XF-AV(]

Network connection icons

= Wi-Fi (Infrastructure):
In yellow — the camera is connecting to or disconnecting from the network. In white — the
network function can be used.

Wi-Fi (Camera Access Point):
In yellow — starting the camera’s access point. In white — the camera’s access point is ready.
Connect the Wi-Fi enabled device to the camera.

Ethernet:  In yellow — the camera is connecting to or disconnecting from the network. In white — the
network function can be used.

Network function icons

FTPE FTP file transfer ([11 199)
e, [P IP streaming (11 200)

CV Protocol B CV protocol ([I1 188)
)1 frameio | Frame.io (11 210)

Frame.io upload status icons
00, 00, [ Uploading, upload paused, upload requests are full.
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FTP File Transfer

In MEDIA mode, you can transfer clips from the camera to another device connected to the network, using the
FTP protocol.
The following explanations assume that the FTP server is on, ready and correctly configured.

Transferring a Single Clip

1 Connect the camera to the desired network and activate the network functions ([I] 183).
e Select a connection setting with the [FTP Transfer] function setting.

2 Select the desired clip in the [XF-AVC] or [XF-HEVC S / XF-AVC S] index screen ([11 149).
3 Press SET to open the file menu and select [FTP Transfer] > [OK].

* The camera will connect to the FTP server and the file will be transferred.
e Select [Cancel] to interrupt the file transfer in progress.

Transferring All Clips

1 Connect the camera to the desired network and activate the network functions ([I] 183).
e Select a connection setting with the [FTP Transfer] function setting.

2 Open the [XF-AVC] or [XF-HEVC S / XF-AVC S] index screen ([ 11 149).

3 Select MENU > [#W Network Settings] > [FTP Transfer All Clips] > [OK].
e The camera will connect to the FTP server and all the files will be transferred.
e Select [Cancel] to interrupt the file transfer in progress.

@ vroRTANT

¢ Observe the following precautions when transferring files. Failing to do so may interrupt the transfer and
incomplete files may remain at the transfer destination.
- Do not open the card compartment cover.
- Do not remove the power source or turn off the camera.

e |f incomplete files remain at the transfer destination, check the content and make sure they are safe to delete
before deleting them.

(i) NoTES

¢ Depending on the access point’s settings and capabilities, it may take some time to transfer files.
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IP Streaming

In CAMERA mode, you can stream the camera’s live video and audio over IP to a compatible IP video decoder*
connected to the network. You can use IP streaming for live broadcasts or to send video reports from a location

with poor network connectivity.
* This can be a dedicated video transfer device or decoder software on a computer. For details about compatible decoders,
please visit your local Canon website.

Configuration of video streamed over IP

Main recording video configuration Streamed video configuration
_ . Video Audio
Video format Resolution Frame rate - - - -
Bit rate Resolution Frame rate Audio format Bit rate
59.94P 59.94P, 59.94i
- 59.94i 59.94i .

XF-AVC, 3840x2160, 9 Mbps, 1920x1080 ' MPEG-2 AA*C 256 Kbps

XF-AVC S 1920x1080 50.00P 4 Mbps, 50.00P, 50.00i 2 channels
50.00i 50.00i

* When the audio of the primary clip uses 4 channels, you can select which channels to stream over IP.

1 On the receiver’s side: Connect the decoder to the network and complete any necessary
configurations so it is ready to receive video over IP.
e For details refer to the instruction manual of the decoder device or software you will use.

2 On the camera: Connect the camera to the desired network and activate the network functions
(M 183).
e Select a connection setting with the [IP Streaming] function setting.
3 Select MENU > [#V Network Settings] > [Activate IP Streaming] > [Enable].
e The camera will start streaming video over the selected network.
e You can press the REC button to simultaneously record the same image in the camera.
4 On the receiver’s side: Connect to the camera.
When the streaming protocol is [RTSP+RTP], access the following URL and log in using the RTSP user name
and password (1] 186).
rtsp://xXxXX.XXX.XXX.XXx/stream

Camera’s IP address

When the streaming protocol is [SRT] and the connection mode is [Listener], access the following URL.

sr't://lxxx.xxx.xxx.xx>§/lxxx...I
T T

Camera’s IP address Listener port number

¢ |f the data to be transmitted is encrypted, enter the SRT passphrase.

5 On the camera: To end the streaming, select MENU > [#\* Network Settings] > [Activate IP
Streaming] > [Disable].

@ vPoRTANT
e Streamed data is not encrypted (except when encrypted with SRT protocol).

(i) NoTES

e Except when the streaming protocol is RTSP or SRT, once IP streaming is activated, the camera will continue
to broadcast video and audio data over the network, regardless of the status of the receiver. Be careful to set
up the correct IP address and test in advance that the receiving decoder can indeed receive the signals.



IP Streaming

Depending on the network used and the connection conditions, you may experience lost or delayed IP
packets.

After streaming continuously for 24 hours, the camera will stop the IP streaming momentarily and then restart
it automatically.

When using IP streaming together with the Browser Remote function, you may experience stuttering issues in
the streamed video or audio. When the two functions are used simultaneously, it is recommended not to log
out from/reconnect to Browser Remote.

Opening the card compartment cover and removing a card while IP streaming is activated may cause brief
stops in the streamed video and audio.

IP streaming cannot be used in the following cases:

- When using a recording mode other than [Normal Recording].

- When [2nd Card Rec Functions] is set to an option other than [Off].
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Browser Remote: Controlling the Camera from a Network Device

Browser Remote: Controlling the Camera from a Network Device

In CAMERA mode, you can operate the camera remotely using Browser Remote, an application that can be
accesses on a connected network device. Using Browser Remote you can check the camera’s live image and
control various recording settings*. You can also check other important indications, such as remaining recording
time on the card, remaining battery charge/power source details, time code, etc.

* White balance, base ISO, ISO speed/gain, shutter speed, ND filter, aperture, focus and zoom.

Starting Browser Remote

After connecting the camera to the network In CAMERA mode, you can start the Browser Remote application
on the Web browser* of any network device* connected to the same network.

* A Web browser that supports JavaScript and is enabled to accept cookies is required.
** For details about compatible devices, operating systems, Web browsers, etc., please visit your local Canon website.

Preparations on the Camera

1 Connect the camera to the desired network and activate the network functions ([1] 183).
e Select a connection setting with the [Browser Remote] function setting.

2 Check the Browser Remote’s URL in the [#W® Network Settings] status screen.
¢ \When using IPv6 settings, check the camera’s IP address instead.
¢ Write down the URL or IP address if necessary.

On the Network Device
1 Connect the network device to the camera or to the same access point as the camera.
2 Start the Web browser on the network device.

3 Enter Browser Remote’s URL.
e Enter the URL / IP address you checked previously into the Web browser’s address bar as follows.

http://XXX.XXX.XXX.XXX:nNN
| S
Camera’s IP address Port No. (can be omitted when using the default port no.)

e To use an HTTPS connection, enter “https:” instead of “http:”.
¢ \When using IPv6 settings, enter the camera’s IPv6 IP address instead.
4 Enter the user name and password. S

e Be sure to log in with the user name and password of one of the
users that were set on the camera ([J] 187). If necessary, consult
the administrator who configured the camera’s settings.

Example of the login screen. The screen may

* The Browser Remote screen will appear. The screen displayed may frer depending on the Web browser and
be different depending on the user information used to log in. version used.

5 To change the application’s language, select [ $ ] > [Language &3] >
Desired language.

e Most buttons and controls emulate physical controls on the camera
and are labeled in English only, regardless of the language selected.

6 Use the Browser Remote controls to operate the camera.
e Descriptions of the controls are given in the following pages.

7 When you have finished using Browser Remote, select [ ¢ ] > [Log Out] on the Browser Remote screen to end
the application.
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(i) NoTES

¢ Depending on the network used and the connection performance, you may notice delays in the refreshing of
the live view image and other settings. If the delay is too long, changing the resolution of the live view image is
recommended ([ 207). 203

e |f Browser Remote is set to a language other than the language set on the network device, the application may
not be displayed correctly.
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Using Browser Remote

(i) NoTES

e Browser Remote does not support multi-touch gestures.

The Main Remote Operation Screen

—

LIVE VIEW OFF

@ 250 min [T STBY

a 2smn @8 00:00:00.00

Slot Select

121314 15 16

Network connection indicator

While Browser Remote is correctly connected to
the camera, the dots will keep turning on and off
in a loop.

Live view screen
Shows the camera’s live view image.

Double slot recording

Recording operation ([1] 57) and recording
command ([I] 216) (same as on the camera)

Time code (same as on the camera)
Add a shot mark
Add a [ mark

OFF

Cancel Tracking

Exposure

0

3 57min

Push Auto Iris

17 18

8 Addan [ mark

9 Camera’s nickname ([11 193) and lens model
name

10 [LIVE VIEW] button
Touch the button to display the camera’s live view
image on the Browser Remote screen.

11 [Touch Focus] button
Touch the button to unlock (enable) the touch
focus mode.

12 IP streaming

Available only when using a connection setting
with both the [Browser Remote] and [IP
Streaming] function settings.
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13 [REC] button

Touch the button to start recording. The recording
operation indicator changes to [@REC] and the
center of the button turns red.
The time code will advance while recording.
Touch the button again to stop recording. The
recording operation indicator changes back to
[STBY].

14 Card selection and approximate remaining
recording time

15 [SLOT SELECT] button
Touch to select the other card when both card
slots contain a card.

16 Assignable buttons
17 Assignable functions check
18 Remaining battery charge
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The menu is displayed in detail as follows when Full Controls is selected.

If needed, use the [Full Ctrl] switch.
4142 43

Cancel Tracking!

Push Auto Iris.

so Auto

Gain  Aufomatic

Normal Exenced OFF

shutter Angle  180.00

19 Manual zoom slider
Touch to adjust the zoom.

20 Manual focus controls

When [Focus] is active, touch [IEA], [IEl] or [IKH] to
focus closer or [IEA], [IEM] or [BA] to focus farther.
There are three levels of adjustment - [IEll]/[IEll] is the
smallest and [[B4]/[BA] the largest. Keep touching the
button (long press) for a continuous operation.

21 Continuous AF

22 AF frame

23 AF response

24 One-shot AF

25 Subject to detect
26 Tracking

27 Eye detection

28 ND filter

29 Aperture value

30 Iris increment

31 Push auto iris

32 Base ISO

33 I1SO speed/gain value
34 ISO/Gain increment
35 Shutter mode

36 Shutter increment
37 AE response

38 Face detection AE

39 White balance method selection

When the white balance mode is set to [}, touch [AWB
Lock] to lock the current white balance settings. Touch
again to resume the automatic white balance (AWB).
When the white balance mode is set to %A or B,
touch 4 to register a custom white balance.

40 Custom picture file

41 Full Ctrl (full controls) switch
Detailed settings for AF operations, aperture, ISO
speed/gain, AE operations and custom picture
42 Key lock button

Touch the icon to lock the Browser Remote screens in
order to prevent settings from being changed
inadvertently. Controls on the camera are not locked.

43 Browser Remote settings ([11 207)



44 Function shortcut button

45 [Focus Guide] switch

46 Lens action if AF is not possible

Browser Remote: Controlling the Camera from a Network Device

Displays the various adjustable functions. Touch 50 Cancel tracking
the function you wish to adjust.

Touch to display the focus guide ([1] 89). 52 Fine increment

54 AE shift

47 AF speed
48 AF lock

49 Subject detection AF

51 Extended ND range

53 1SO speed/gain extended range

55 Color temperature, Color compensation

{ Browser Remote Settings Tab

1

Language selection
Touch to select the display language for some screens and messages.

Display style
Touch to select the background color of the Browser Remote screens.

Secured connection

Touch to download the certificate required to use a secure HTTPS connection.

Live view resolution

Select [Large] (higher resolution) or [Small] (lower resolution) depending on the
quality of the connection.

Log out

Touch to log out from the Browser Remote application.

Settings

Secure Transfer

Live view resolution

Log Out
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Recording remotely using an XC Protocol compatible controller/application

Recording remotely using an XC Protocol compatible controller/
application

Set the IP address of the camera on the optional XC Protocol compatible Remote Camera Controller RC-IP100/
RC-IP1000 or Remote Camera Control Applioa’rion1 to control the camera remotely. You can also control the
camera remotely using Multi-Camera Control? on a smartphone connected to the same network as the camera.

1 Available from your local Canon website.
2 Available from the App Store.

1 In CAMERA mode, activate the network functions ([J] 183)
e Select a connection setting with the [XC Protocol] function setting.

Recording remotely using the RC-IP100/RC-IP1000 Remote Camera Controller

You can remotely control camera settings like the aperture and shutter speed, or change picture related settings
like the knee and sharpness. For more details on the connection, settings and the RC-IP100/RC-IP1000 refer to
the RC-IP100/RC-IP1000 instruction manual.

(i) notes

¢ The zoom can only be operated when a compatible lens ([J1 276) is attached to the camera.

e [PRESET] focus and zoom settings can only be used when a compatible Cinema lens is attached to the
camera (CN-E70-200mm T4.4 L IS KAS S, CN-E18-80mm T4.4 L IS KAS S or RF24-105mm F2.8 L IS USM
2).

e Even if the camera’s controls are locked (key lock), you can use the RC-IP100/RC-IP1000 to operate the
camera ([1 12).

(i) NoTES

¢ About changing custom picture related settings

- If a protected custom picture file is selected on the camera, custom picture related settings cannot be
changed using the remote camera controller or Remote Camera Control Application.

- Adjusting custom picture related settings using the remote camera controller or Remote Camera Control
Application will change the settings registered under the currently selected custom picture file. If you want to
keep an important custom picture file, backup it or select in advance a custom picture file you do not mind
changing.

Recording remotely using the Remote Camera Control Application

During recording, you can check the angle of view using Live View and adjust various picture related settings.
For details about connection/setup and the Remote Camera Control Application, refer to the Remote Camera
Control Application manual.

(i) NoTES

e Even when camera operation is disabled by key lock, operation is possible using the Remote Camera Control
Application (1] 12).
¢ \When adjusting custom picture related settings, refer to About changing custom picture related settings

(11 208).



Recording remotely using an XC Protocol compatible controller/application

Recording remotely using Multi-Camera Control

You can use a smartphone connected to the same network as the camera to remotely operate the camera and
record video. During recording, you can check the angle of view using Live View and adjust various picture
related settings.

1 Install Multi-Camera Control on your smartphone.
e Download and install Multi-Camera Control from the App Store.
e There is no need to repeat this step after the first time.

2 Connect the smartphone to the same network (access point) as the camera
e For details, refer to the smartphone’s instruction manual.

3 Activate the desired network connection ([1] 183).
e Select a connection setting with the [XC Protocol] function setting.

4 Open Multi-Camera Control on the smartphone.
5 Operate the smartphone to connect to the camera.
6 Operate Multi-Camera Control on the smartphone to record remotely.

7 When you finish the procedure, set MENU > [0 Network Settings] > [Network] to [Disable].
e You can also set MENU > [ Network Settings] > [Connect] to [Disconnect].

(i) NoTES

e Even if the camera’s controls are locked (key lock), you can use Multi-Camera Control to operate the camera

(@ 12).
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Transferring Recordings to a Smartphone

Transferring Recordings to a Smartphone

You can transfer and save clips (XF-AVC S, XF-HEVC S), audio (WAV), photos (JPEG) and News Metadata files
to a smartphone (connected to the same network as the camera) ((J1 177).

1 Install Content Transfer Professional on your smartphone.
¢ Download and install the Content Transfer Professional from the App Store or Google Play.
e There is no need to repeat this step after the first time.
2 Connect the smartphone to the same network (access point) as the camera.
® Be sure to activate tethering in advance when using a smartphone as an access point.
e [or details, refer to the smartphone’s instruction manual.
3 Activate the desired network connection ([1] 183).

e Select a connection setting with the [Canon App] function setting. However, since the Canon application
settings are saved for each smartphone, reconfiguration is required when using a different smartphone.

4 As indicated on the screen, open the application on the smartphone.

5 Operate the smartphone to connect to the camera.

6 Select [OK].

7 Using the Content Transfer Professional, transfer recordings from the camera.

8 When you finish the procedure, set MENU > [#M Network Settings] > [Network] to [Disable].

e You can also set MENU > [V Network Settings] > [Connect] to [Disconnect].

¢ \When you end the connection from the smartphone, MENU > [#V Network Settings] > [Network] will be
set to [Disable].

(i) notes

e Use a supported USB cable or the network functions to connect the camera to a smartphone. When
connecting using a USB cable, refer to Saving Recordings to a Smartohone (1 177).

Uploading Recording Data to Frame.io

Once paired with the camera, you can use Adobe’s Frame.io Camera to Cloud function to upload proxy clips
(XF-AVC, XF-HEVC S, XF-AVC S) and WAV audio (second card recording functions) recorded on the SD card.

Automatic upload
1 Activate the network functions (1] 183).
e Select a connection setting with the [Frame.io] function setting.

2 Select MENU > [#W Network Settings] > [Frame.io] > [Auto Upload On Recording] > [On], then start
recording.

e The data is added to the upload queue and uploaded to Frame.io sequentially.

Manual upload
1 Switch to MEDIA mode.
2 Activate the network functions (1] 183).
e Select a connection setting with the [Frame.io] function setting.

3 Select the recording data to be uploaded from the [XF-AVC], [XF-HEVC S/XF-AVC S] or [WAV] SD
card index screen.
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4 Select the clip menu > [Frame.io Upload] > [OK].

e You can also add the recording data to the upload queue by pressing an assignable button set to [Frame.io
Upload].

® The data is added to the upload queue and uploaded to Frame.io sequentially.

(1) NoTES

e You can check the upload status from MENU > [#M Network Settings] > [Frame.io] > [Upload Status/Del.
Request]. If you want to delete a request, select the clip and select SET > [OK].

e Select MENU > [V Network Settings] > [Frame.io] > [Delete All Requests] > [OK] to clear all upload
requests.

e Select MENU > [V Network Settings] > [Frame.io] > [Pause Uploading] > [Enable] to pause the upload.
e During recording, uploads to Frame.io are paused.
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Updating the Firmware Automatically

Updating the Firmware Automatically

If the server has the latest firmware when the camera is connected to a network using a function setting other
than the CV protocol, an asterisk will be shown on & on the menu. In this case, you can update the camera’s
firmware using the following procedure.

1 Insert an SD card into the camera’s SD card slot.
2 Select MENU > [¥ System Settings] > [Firmware] > [Download Latest Firmware] > [OK].
3 Read the End User License Agreement (EULA) carefully and agree to it.

e The latest firmware is downloaded to the SD card.

4 After downloading is complete, select [OK] twice.
e The firmware update starts and cannot be aborted.

5 When the update is complete, select [OK].
e The camera's settings are reset and the PIN code setting screen appears.

@ vPoRTANT

* Make sure that you observe the following during firmware update:
- Do not turn off power. Do not remove the battery or power supply.
- Do not perform any other button operation.
- Do not open the memory card cover and remove the SD card.

(i) NoTES

e Connect the AC adapter or attach a fully charged battery to the camera.



Additional Information

213
Menu Options

For details about how to select an item, refer to Using the Menus ([11 40). For details about each function, see
the reference page or the explanation accompanying the menu entry. Setting options in boldface indicate default
values.

Depending on the camera’s operating mode and the settings, some menu items may not be available. Such
menu items do not appear or appear grayed out in menu screens.

To skip directly to the page of a specific menu:

("™ Camera Setup] menu 213 (%4 Assistance Functions] menu [ 220
[[@d Custom Picture] menu 214 [swv Network Settings] menu 222
[£¥ Recording/Media Setup] menu 215 [@ Assignable Buttons] menu 11223
[ Audio Setup] menu @217 [§ System Setup] menu [ 224
(=) Monitoring Setup] menu 11218 [ My Menu] customized menu {1226
["™ Camera Setup] menu (CAMERA mode only)

Menu item Setting options and additional information
[Iris Mode] [Automatic], [Manual] (3 81)
[Iris Increment] [1/2 stop], [1/3 stop] (T 81)
[Fine Increment] [On], [Off] ([ 81)
[Zoom-Iris Correction] [On], [Off]

If you are using a compatible lens, when this setting is set to [On], the camera will adjust the aperture as
needed to keep the selected aperture value while zooming. Because of this adjustment, the brightness of

the image might flicker slightly or you may hear the operation sound.

[ND Display Units] [Stop], [Transmittance], [Optical Density] (T3 80)
[Extended ND Range] [On], [Off] (T 80)
[Shutter Mode] [Speed], [Angle], [Clear Scan], [Slow], [Off] (73)
[Shutter Increment] [1/3 stop], [1/4 stop] (74
[Auto Clear Scan Setting] - (74
[Flicker Reduction] [Automatic], [0ff] (@ 75)
[Base 1SO] Available settings differ depending on the [Gamma/Color Space] component in the custom (@77

picture file and the recording format settings.
[1S0/Gain] [1S0], [Gain] (@ 76)
[ISO/Gain Mode] [Automatic], [Manual] (@77
[ISO/Gain Extended Range] [On), [0ff] (@76)
[ISO/Gain Increment] [1 stop], [1/3 stop] / [Normal], [Fine] (3 76)
[Limit for Auto Mode] [1S0]: [Off/ISO 25600], [IS0400] to [ISO020000] (T 79)

[Gain]: [0ff/42 dB], [6 dB] to [39 dB]

When the [Gamma/Color Space] gamma curve is set to [Canon 709] and the [Base ISO] is set

to [Auto Selection].

Available values differ depending on the [Gamma/Color Space] gamma curve settings and

[ISO/Gain] settings.
[Light Metering] [Backlight], [Standard], [Spotlight] (3 83)
[AE Shift] —2.0to +2.0in 0.25 point intervals (+0) (T3 83)
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Menu item Setting options and additional information
[AE Response] [High], [Normal], [Low] (82
Determines how quickly the exposure (aperture, shutter speed and gain) changes when using the
automatic adjustment mode.

[Shockless WB] [On], [Off] (189
[AWB Response] [High], [Normal], [Low] (87
[C. Temp. Increment] [Mired], [Kelvin] (11 85)
[Continuous AF] [Disable], [Enable] (17 88)
[Lens action if cannot AF] [Continue Focus Search], [Stop] (92
[Track after Focusing] [On (tracking frame)], [On (no tracking frame)], [Disable] (1192
[AF Frame] [Small Zone], [Zone], [Large Zone: Vertical], [Large Zone: Horizontal], [Whole Area] (94)
[AF Speed] +1t0+10 (7) (92
[AF Response] +3t0-3 (0) (92
[Focus Mode] [AF], [MF]

[Focus Control] [Camera], [Lens]

[Subject to detect] [People], [Animals], [None] (94
[Subj. Detect. AF] [Detect. Priority], [Detect. Only] (94
[Eye Detection] [On], [Off] (@294
[Face Detection AE] [On], [Off] (@134
[Camera Grip Zoom] [On], [Off] (@99)
[Camera Grip Zoom Speed] 11016 (8) (399
[Tele-converter] [x3.0], [x2.5], [x2.0], [x1.5], [Off] (1199
[ABB] [Cancel], [OK] (1152
[Color Bars] [On], [Off] (@Mm119)
[Color Bar Type] [SMPTE], [EBU]*, [ARIB] (@119
[Periph. lllum. Corr] [On], [Off] (@3
[Chromatic Aberr. Corr.] [on], [Off] (@m3y)
[Diffraction Correction] [On], [Off] (@masn
[Distortion Aberr. Corr.] [On], [Off] (@3
[Lens Optical IS] [On], [Off] (m97)

When an RF-S lens is attached, set this setting to [On] to compensate for camera shake using optical

image stabilization.

[Digital IS] [on], [Off] (m97)
[Digital IS Mode] [High], [Standard] (@moav)
[Motion Vector For Digital IS] [Enable], [Disable] (@moav)
[Lens Focal Length] 1 to 1000 (50) (@moa7)
[Anamorphic Corr.] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.5], [x1.33], [Off] (M97)
* The default value depends on the country/region of purchase.
[[@@ Custom Picture] menu (CAMERA mode only)
Menu item Setting options and additional information
[Select File] [C1:Canon 709], [C2:Canon Log 2], [C3:Canon Log 3], [C4:BT.709 Wide DR], [C5:BT.709 (I 138)

Standard], [C6:PQ], [C7: HLG], [C8:EOQS Standard], [C9:EQS Neutral], [C10:User10] to

[C20:User20]
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Menu item Setting options and additional information
[Edit File]

[Rename] - (I 139)

[Protect] [Unprotect], [Protect] (3 140)

[Reset] [Canon 709], [Canon Log 2], [Canon Log 3], [BT.709 Wide DR], [BT.709 Standard], [PQ],

[HLG], [EOS Standard], [EOS Neutral], [User (Canon 709)]
Detailed custom picture Refer to the tables in the Available Custom Picture Settings section
settings (7 142).
[Save File]
[Save to SD Card], - (T 141)
[Load from SD Card]
[£% Recording/Media Setup] menu
Menu item Setting options and additional information
[Initialize Media]
[CFexpress], [SD Card] [Cancel], [OK] (1 45)
[Sensor Mode] [Full Frame 3:2], [Full Frame], [Super 35mm (Cropped)], [Super 16mm (Cropped)] (17 65)
[System Frequency] [59.94 Hz], [50.00 Hz]", [24.00 Hz] (T2 65)
[Main Rec Format] [RAW HQ], [RAW ST], [RAW LT], [XF-AVC YCC422 10 bit], [XF-HEVC S YCC422 10 bit], (@1 65)
[XF-HEVC S YCC420 10 bit], [XF-AVC S YCC422 10 bit], [XF-AVC S YCC420 8 bit]

[Main Recording Destination] [CFexpress], [SD Card] (T2 65)

[Main Resolution] Available values depend on the [Sensor Mode], [Main Rec Format] and [Main Recording (12 65)
Destination] settings.

[Frame Rate] Available values depend on the [System Frequency] settings. (@3 66)
[59.94 Hz]: [59.94P], [59.94i], [29.97P], [23.98P]
[50.00 Hz]: [50.00P], [50.00i], [25.00P]
[24.00 Hz]: [24.00P]

[Bit Rate] Available values depend on the [Main Rec Format] and [Main Resolution] settings. (11 66)

[XF-HEVC S/XF-AVC S Main Audio] ~ [AAC 16 bit 2ch], [LPCM 24 bit 4ch] (@ 113)

[Recording Mode] [Normal Recording], [Slow & Fast Motion], [S&F Clip / Audio (WAV)], [Pre-Recording], (3 47)
[fer Main / Continuous Rec], [Frame Recording], [Interval Recording]

[Slow & Fast Frame Rate] Available options and default value vary depending on other settings. See the tables on the (I 126)
reference page.

[Continuous Recording] [REC], [STBY] (mMm127)

[Frame Rec: Frame Rate] [11, [3], [6], [9] (2 128)

[Interval Rec: Time Interval] [1 sec], [2 sec], [3 sec], [5 sec], [10 sec], [15 sec], [30 sec], [1 min], [2 min], [3 min], [5 min], (11 129)
[10 min]

[Interval Rec: Frame Rate] [11, (3], [6], [9] (129

[2nd Card Rec Functions] [Off], [icrx] Main / Proxy Rec], [icrx Main / Sub Rec], [icr] Main / Audio Rec], (@47
[Relay Recording], [Double Slot Recording]

[(s0] Rec Format] Available options vary depending on the main recording’s settings.

[[s0] Resolution] Available options vary depending on the main recording’s settings.

[(s2] Frame Rate] [Same as Main Recording], [59.94i], [50.00i]

[(so] Bit Rate] Available options vary depending on the main recording’s settings.

[[s0] XF-HEVC S/XF-AVC S Audio] [AAC 16 bit 2CH], [LPCM 24 bit 4CH]

[Proxy Rec Color Conversion] [Conform to Custom Picture], [BT.709 (Canon 709)], [BT.709 (CMT 709)] (Raa))
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Menu item Setting options and additional information
[Metadata]

[Camera Index] [A_]to[ZZ] (M 49)
[Reel Number] [0001] to [9999] (M 49)
[Clip Number] [001] to [999]

[User Defined)] User defined string up to 5 characters ((CANON]) (12 50)
[Scene], [Take] Scene description up to 16 characters / Take description up to 8 characters (0 125)
[Lens Squeeze] [x2.0], [x1.8], [x1.5], [x1.33], [Off] (131
[Add XML File] [On], [Off] (M123)
[XML File Format] [News Metadata], [User Memo] (0 124)
[News Metadata] [Off], list of available News Metadata files (0 124)
[News Metadata Reset All] - (0 125)
[User Memo] [Off], list of available user memo files (2 123)

[Country Code], [Organization],
[User Code]

Identifiers up to 4 characters ([00__] default for [Organization] only)

[Country Code]: This identifier is the country code defined by ISO-3166-1 and is to be entered starting
from the left.

[Organization]: This identifier represents the organization that owns or operates the camera and can be
obtained by registering with the SMPTE Registration Authority. If the organization is not registered,

enter [0000].
[User Code]: This identifier designates the user. Leave this blank if [Organization] is set to [0000].
[Add [ File] [On], [Off] (142
[Clip Numbering] [Reset], [Continuous] (12 50)
[Rec Command(EXT REC)] [On], [Off] (@m1e7)
[HDMI Time Code] [On], [Off] (@ 168)
[Photo Numbering] [Reset], [Continuous]

Photos are saved as files in folders. You can select the numbering method for those files. File numbers
appear on screens in playback mode in a format such as “101-0107”. The first 3 digits indicate the folder
number and the last 4 digits are different for each file in a folder.

[Reset]: File numbers will restart from 100-0001 every time you insert a new (or initialized) card. If the
card already contains previous recordings, numbers will continue from the number following that of
the last photo on the card.

[Continuous]: File numbers will continue from the number following that of the last photo recorded with
the camera. This setting is the most convenient for managing files on a computer. We recommend
using the [Continuous] setting.

Folder names

e An example folder name is “101_1103". The first 3 digits indicate the folder number (from 100 to 999)

and the last 4 digits indicate the month and day when the folder was created. In the example, the folder
numbered 101 was created on November 3.

e Each folder can contain up to 500 files. When that number is exceeded, a new folder is created

automatically.

File names

e File names follow the pattern “IMG_xxxx.jpg” (photos) where xxxx represents the photo number (0001

t0 9999).

[Volume Label]

[Canon], [Canon + Metadata] (49

" The default value depends on the country/region of purchase.
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Menu Options

Menu item Setting options and additional information
[Audio Input Selection] (M 115)
[CH1/CH2] [INPUT Terminals], [MIC Terminal], [Monaural Mic], [Multi-Function Shoe]
[CH3/CH4] [INPUT Terminals], [MIC Terminal], [Monaural Mic], [Multi-Function Shoe]
[CH2 Input] [INPUT 2], [INPUT 1], [Monaural Mic], [MIC Terminal] (@ 115)
[CH1/CH2 ALC Link], [Linked], [Separated] (@M117)
[CH3/CH4 ALC Link]
[Audio Rec Level] [A] (Automatic), [M] (Manual) (T 116)
0 to 100 (50)
[INPUT 1 Mic Trimming], [+12 dB], [+6 dB], [0 dB], [-6 dB], [-12 dB] (@M117)
[INPUT 2 Mic Trimming]
[INPUT 1 Mic Att.], [On], [Off] (@117)
[INPUT 2 Mic Att.]
[INPUT 1 Mic Low Cut], [0ff], [LC1], [LC2] (@117)
[INPUT 2 Mic Low Cuf]
[INPUT Reference Level] [-18 dB], [-20 dB] (@ 118)
[INPUT Limiter] [On], [Off] (@117)
[MIC Att.] [On], [Off] (@M117)
[MIC Low Cut] [Off], [LC1], [LC2] (M7
[MIC Input] [MIC (with Power Supply)], [LINE] (M 115)
[Multi-Function Shoe Input] (118)
[Shoe Mic]
[Shoe Mic Attenuator] [On], [Off]
[Shoe Mic Low Cut] [On], [Off]
[Shoe Mic Directionality] [Shotgun (Monoaural)], [90°(Stereo)], [120°(Stereo)]
[Wireless Mic]
[Audio Rec Level] [A] (Automatic), [M] (Manual)
0 to 100 (50)
[¥icc1 Wind Filter], [On], [Off]
[®icc2 Wind Filter]
[Gicc1 Attenuator], [On], [Off]
[%icc2 Attenuator]
[Wireless Mic Mixing] [Enable], [Disable]
[MUTE button] [Enable], [Disable]
[Movie recording button] ~ [Enable], [Disable]
[Tally Lamp] [On], [Off]
[Display Wireless Mic -
Status]
[1 kHz Tone] [-12 dB], [-18 dB], [-20 dB], [Off] (@119
[Headphone Volume] [0ff], 1 to 15 (8) (2 154)
[Speaker Volume] [Off], 1 t0 15 (8)

[Monitor Channels]

[HDMI OUT Channels]

In MEDIA mode only, this setting is an alternative way to adjust the built-in speaker’s volume (1 154).

[CH1/CH2], [CH1/CH1], [CH2/CH2], [CH1+2/CH1+2], [CH3/CHA4], [CH3/CH3], [CH4/CH4],

[CH3+4/CH3+4], [CH1/CH3], [CH2/CH4], [CH1+3/CH2+4]
[CH1/CH2], [CH3/CH4]

(175

(175

[Level Meter Display Color]

[Color], [White]
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[ED Monitoring Setup] menu

Menu item Setting options and additional information
[LCD Brightness], [LCD Contrast] 50 to 50 (+0) (M 33)
[LCD Color] —20 to 20 (0) (@3y)
[LCD Sharpness] 1104 (2) (@3y)
[LCD Luminance] [Normal], -2 to +6 (A 33)
[Anamorphic: Video Term.], [On], [Off] (@131)
[Anamorphic: MON./HDMI],
[Anamorphic: SDI]
[Anamorphic Desqueeze] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.5], [x1.33] (T 131)
[Desqueeze for S&F] [Reduced Display], [0ff] (Mm131)
[B&W Image: Video Term.], [On], [Off] (33)
[B&W Image: MON./HDMI],
[B&W Image: SDI]
[OSD Qutput: MON./HDMI] [On], [Off] (07 169)
[OSD Output: SDI] [On], [Off (Clean)] (11 169)
[Tally OSD: VIDEO Term.], [On], [Off] (T 60)
[Tally OSD: MON./HDMI],
[Tally OSD: SDI]
[Tally OSD Settings] [REC/Tally In (PGM/PVW)], [REC], [Tally In (PGM/PVW)] (T2 60)
[Tally OSD Position] [Frame], [Top], [Bottom] (@60
[DISP Level 1] [All Displays], [All Displays (Periph. Border)] (3 59)
[DISP Level 2] [Main Recording Displays], [Only FUNC/MENU]
[DISP Level 3] [Only REC/STBY], [No Displays]
[Apply Peripheral Border] [DISP Level 1/2/3], [DISP Level 1/2], [DISP Level 1], [DISP Level 2], [DISP Level 3], [Off] (@ 59)
[Custom Display 1] (d355)

[Light Metering],

[Custom Picture],

[Focal Length], [ND Filter],
[Focus Mode], [Key Lock],
[White Balance], [AE Shift],
[Iris], [ISO/Gain], [Shutter],
[Base IS0], [Peaking],
[Tele-converter], [Digital IS],
[Magnification], [LUT], [Lens]

[Object Distance (Numeric)],
[Object Distance (Bar)]

[Level (Numeric)]
[Level (Bar)]

[On], [Off]

[Always On], [Only in MF Mode], [Off]

[On], [Off]
[Tilt+Roll], [Roll], [Tilt], [OFf]

[Exposure Bar]

[On], [Disable During AE], [Off]




Menu item
[Custom Display 2]

[Remaining Battery],
[Remaining Rec Time]

Menu Options

Setting options and additional information
(AR5
[Only Warnings], [Normal], [Off]

[Recording Mode],
[Interval Counter],
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[On], [Off] —

[Genlock/RET],

[Time Code],

[Reel/Clip Number]

[Photo] [Only Warnings], [Normal], [Off]
[Temperature/Fan], [On], [Off]

[Sensor Mode],
[Resolution/Color Sampling],
[Frame Rate],

[Output Terminals Status],
[OSD Output]*,

[Rec Command(EXT REC)],
[User Memo]*, [User Bit]*,
[Monitor Channels]*,

[Audio Level Indicator],
[Multi-Function Shoe]

[On], [Normal]: Show the icon/onscreen display always or whenever the necessary conditions are
triggered.

[Only Warnings]: Show the icon/onscreen display only when a critical level is reached.

o The default setting for items marked with an asterisk (*) is [Off].

[Wireless Mic] [Only Warnings], [Normal], [Off]
[Network Functions], [GPS] [On], [Off]
[Date/Time] [Date/Time], [Time], [Date], [Off]

[Custom Display]

(152
These settings are available only in MEDIA mode and determine whether the following onscreen displays
will appear on the playback image.

[Audio Level Indicator]

[On], [Off]

[Date/Time], [Camera Data]

[On], [Off]

[Audio Level Indicator]: The audio level meter (clips only).

[Date/Time]: The date and time when the clip/photo was recorded.

[Camera Data]: The aperture value, shutter speed and ISO speed/gain value used to record the clip (clips
only).

[Displayed Units]

[Meters], [Feet]'
Changes the distance units used in camera displays between meters and feet.

[OSD Opacity: Video Term.],
[0SD Opacity: MON./HDMI]
[OSD Opacity: SDI]

[On], [Off] (11 169)

[OSD Opacity Level]

[75%), [62.5%], [50%], [37.5%], [25%]

[OSD Opacity: Appl. Screens]

[All], [Only Rec/Playback Screens]

[OSD Orient.: VIDEO Term.] [0 Degrees], [ (< 90 Degrees Left], [ >\ 90 Degrees Right] (M e61)

[OSD Orient.: MON./HDMI], [Linked to VIDEO Term.], [ f< 90 Degrees Left], [ >\ 90 Degrees Right] (e1)

[OSD Orientation: SDI]

[LUT: VIDEO Term.], [LUT: MON.], [On], [Off] (@171)

[LUT: HDMI], [LUT: SDI

[LUT Selection: VIDEQO Term.] [CMT 709], [Canon 709], [HDR Assist. (1600%)], [HDR Assist. (400%)], [UserLUT1]* to (@171)
[UserLUT4]*

* Available only when user LUTs have been registered in the camera ([ 173).

[LUT Selection: MON.],
[LUT Selection: HDMI],
[LUT Selection: SDI]

[CMT 709], [Canon 709], [CMT DCI], [CMT PQ], [CMT HLG], [ACESproxy], [UserLUT1]* to
[UserLUT4]*

* Available only when user LUTs have been registered in the camera ([ 173).
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Menu item Setting options and additional information
[Gain for HDR—SDR Conv.] —7.5dB to +7.5 dB (-3.0 dB) (172
[User LUT 1] to [User LUT 4] (@173)
[Register] -
[Color Space (Output)] [BT.709 Gamut], [BT.2020 Gamut], [Do Not Convert]
[Range (Output)] [Narrow Range], [Full Range]

[Delete], [Rename]

[Reset All User LUTSs]
[User LUT Info]

[Range: SDI], [Range: MON.] (I 169)
[During Canon Log Output] [Full Range], [Narrow Range]
[During HDR Output] [Full Range], [Narrow Range]
[Range: HDMI]
[During Canon Log Output] [Full Range Priority], [Narrow Range]
[During HDR Qutput] [Full Range Priority], [Narrow Range]
" The default value depends on the country/region of purchase.
[ Assistance Functions] menu
Menu item Setting options and additional information
[Focus Guide] [On], [Off] (T 89)
[Focus Position Guide] (9t
[Display] [On], [Off]
[Orientation] [Horizontal], [Vertical]
[Sensitivity] 1t05(3)
[Delete All Markers] [Cancel], [OK]
[Marker 1 Color] [Yellow], [Blue], [Green], [Red], [Purple], [White]
[Marker 2 Color] [Yellow], [Blue], [Green], [Red], [Purple], [White]
[Marker 3 Color] [Yellow], [Blue], [Green], [Red], [Purple], [White]
[Peaking: Video Term.], [On], [Off] (3 90)
[Peaking: MON./HDMI],
[Peaking: SDI]
[Peaking] [Peaking 1], [Peaking 2] (13 90)
[Peaking 1]
[Color] [White], [Red], [Yellow], [Blue]
[Gain] [0ff], 1 to 15 (8)
[Frequency] 1104 (2)
[Peaking 2] (9
[Color] [White], [Red], [Yellow], [Blue]
[Gain] [0ff], 1 to 15 (15)
[Frequency] 1t04(1)
[Magnification] [On], [Off] (T3 90)

[Magn. Output]
[B&W during Magn.]

[VIDEO Term.], [MON./HDMI], [SDI]
[On], [Off] (390




Menu Options

Menu item Setting options and additional information
[False Color: Video Term.], [On], [Off] (2 103)
[False Color: MON./HDMI],
[False Color: SDI]
[False Color Index] -
[Zebra: Video Term.], [On], [Off] (3 103)
[Zebra: MON./HDMI],
[Zebra: SDI]
[Zebra] [Zebra 1], [Zebra 2], [Zebra 1+2]
[Zebra 1 Level] [5 +5%] to [95 +5%)] in 5 percentage point intervals ([70 £5%)])
[Zebra 2 Level] 0% to 100% in 5 percentage point intervals (100%)
[WFM: Video Term.], [on], [Off] (@ 120)
[WFM: MON./HDMI],
[WFM: SDI]
[WFM Opacity Level] [Linked to 0SD Opacity], [100%)], [80%)], [60%)], [40%], [20%] (07 120)
Select the WFM opacity level. If set to [Linked to OSD Opacity], it will be linked to the [0SD
Opacity Level] setting.
[WFM Function] [Waveform Monitor], [Vectorscope]
[Waveform Settings] (2120
[Size: VIDEO Term.] [Normal], [2X]
Changes the size of the waveform displayed on the screen.
[Position] [Right], [Left]
[Type] [Line], [Line+Spot], [Select Line], [RGB], [YPbPr]
[Vertical Scale for HDR] [IRE], [PQ/HLG]
[Select Line] 2160 or higher: 0 to maximum value -2 lines (2-line increments)
Example: 0 to 2158 (for 2160)
Below 2160: 0 to maximum value —1 line (1-line increments)
Example: 0 to 1079 (for 1080)
Available options depend on the resolution and operating mode (CAMERA / MEDIA mode).
[Vectorscope Settings] (121)
[Position] [Right], [Left]
[Type] [Normal], [Spot]
[Gain] [1x], [2X]
[Markers: Video Term.], [On], [Off] (1o1)
[Markers: MON./HDMI],
[Markers: SDI]
[Playback Marker Display] [Enable], [Disable] (Ca1o1)
[Center Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (102
[Center Marker Type] [Cross 1], [Cross 2], [Dot 1], [Dot 2]
[Horizontal Marker], [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off]
[Vertical Marker], [Grid Marker]
[Aspect Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%)], [Mask 75%], (102
[Mask 50%)], [Mask 25%)], [Off]
[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1],
[9:16], [4:5], [2:1], [1:1], [Custom]
[Marker Custom Asp. Ratio] 0.01:0.01 t0 9.99:9.99 (1.00:1:00)
[Safe Area Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%)], [Mask 75%], (102

[Basis for Marker Safe Area]

[Mask 50%)], [Mask 25%)], [Off]
[Whole Picture], [Selected Aspect Marker]
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Menu Options

Menu item
[Marker Safe Area %)

Setting options and additional information

[80% (Side Length)], [88% (Side Length)], [90% (Side Length)], [93% (Side Length)],
[95% (Side Length)]

[User Marker 1], [User Marker 2],
[User Marker 3]

[Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off]

[User Marker 1 Settings],

[User Marker 2 Settings], (102
[User Marker 3 Settings]
[Size]
[Specification Method] [Pixel], [Ref. Area & Aspect Ratio], [Ref. Area & Magn. Ratio]
[Pixel] [Width]: 2 to 2048 (only even numbers) (1000)
[Height]: 2 to 1280 (only even numbers) (1000)
[Reference Area] [Whole Picture], [User Marker 1], [User Marker 2]
Available options differ depending on the settings for [User Marker 1 Settings] to [User Marker
3 Settings].
[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1],
[9:16], [4:5], [2:1], [1:1], [Custom]
[Marker Custom Asp. [Available Range]: 0.01:0.01 t0 9.99:9.99 (1.00:1.00)
Ratio]
[Magnification Ratio] [Available Range]: 50 to 150% (95%)
[Position]
[Specification Method] [Center Coordinates], [Upper-left Coordinates], [Centering (User Marker 1)], [Centering (User
Marker 2)]
Available options differ depending on the settings for [User Marker 1 Settings] to [User Marker
3 Settings].
[Center Coordinates] [Horizontal]: —1024 to 1024 (0)
[Vertical]: —540 to 540 (0)
[Upper-left Coordinates]  [Horizontal]: 0 to 2048 (0)
[Vertical]: 0 to 1080 (0)
[imn Network Settings] menu
Menu item Setting options and additional information
[Network] [Enable], [Disable] (1 183)
[Connect] [Disconnect], [SET1] to [SET20] (I 183)
[Connection Setting] [SET1] to [SET20]
[Create New with Wizard] -
[Create with Existing Setting] -
[Check Settings] -
[Change with Wizard] -
[Select Existing Setting] -
[Settings Name] File name up to 12 characters
[Delete Settings] -
[New Conn. Setting (Wizard)] [FTP Transfer], [IP Streaming], [Browser Remote], [XC Protocol], [CV Protocol], [Frame.io] (1 184)




Menu Options

Menu item Setting options and additional information
[Advanced Settings]
[Communication Settings] [NW1] to [NW25] (11 195)
[Function Settings] [MODE1] to [MODE25] 2923
[Browser Remote Settings] [User Name/Password], [Port No. (HTTP)], [Port No. (HTTPS)], [HTTPS] (I3197) E—
[FTP Transfer Settings] [Read Root Certificate], [Root Certificate Details], [Delete Root Certificate] (13192
[XC Protocol Settings] [Authentication Method], [Usgr Name/Password], [Port No. (HTTP)], [Port No. (HTTPS)], (D 189)
[HTTPS], [Save HTTPS Self-signed Cert]
[802.1X Authentication] [Setup Wizard], [Check Settings], [Delete Settings] (13 193)
[Nickname] User defined string up to 16 characters ([G400]) (2 193)
[Activate IP Streaming] [Enable], [Disable] (3 200)
[Frame.io] (2 210)
[Pair] -
[Unpair] -

[Pairing Information] -
[Upload Status/Del. Request]
[Delete All Requests] .

[Pause Uploading] [Disable], [Enable]

[Auto Upload On Recording] [On], [Off]

[Auto Upload File Formats] [XF-AVC Proxy], [XF-HEVC S / XF-AVC S Proxy], [Audio Proxy]

[Root Certificate] [Read Root Certificate], [Root Certificate Details], [Delete Root Certificate]
[IPv4 address name] (3 184)
[View Error Info]
[FTP Transfer All Clips] In MEDIA mode only. (@ 199)

[€ Assignable Buttons] menu

Following are the default settings for each assignable button. For a complete list of the functions that can be
assigned, refer to the detailed table (11 134).

Menu item Setting options and additional information

[Camera] 1: [Magnification], 2: [Peaking: All], 3: [WFM: All], 4: [Slow & Fast Motion],
5: [IS0/Gain], 6: [Shutter], 7: [Slow & Fast Frame Rate], 8: [Audio Status],
9: [White Balance], 10: [Set White Balance], 11: [FUNC], 12: [(NONE)], 13: [AF Lock]

[Grip] 1,2, 3: [(NONE)]
[LCD] 1: [FUNC], 2: [DISP]
[Browser Remote/XC Prot.]
[Link to Camera] [Enable], [Disable]
1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All]
[REMOTE A]
[Link to Camera] [Enable], [Disable]

1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All]
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[¥ System Setup] menu

Menu item Setting options and additional information
[Reset] [All Settings], [Assignable Buttons], [Level]
These settings reset the following camera settings to default values/settings.
[All Settings]: All the camera’s settings except for the hour meter.
[Assignable Buttons]: Only the assignable buttons.
[Level]: The level reference angle settings (CAMERA mode only).
[Transfer Menu/ [€] (@147)
[Save] [To Camera], [To SD Card]
[Load] [From Camera], [From SD Card]
[Time Zone] List of world time zones. (1 39)
[UTC-05:00 New York] or [UTC+01:00 Central Europe]'
[Date/Time] - (1 39)
[Date Format] [YMD], [YMD/24H], [MDY], [MDY/24H], [DMY], [DMY/24H]'
[Language &3 ] [Deutsch], [English], [Espafiol], [Frangais], [Italiano], [Polski], [Portugués], (2 39)
[Pycckuit], [Ykpaincbka], [ ik dhsz], [81=204], [B&FE]
[REMOTE Term.] [RC-V100 (REMOTE A)], [Standard] (M132)
[MON&HDMI Simult. Output] [1920x1080P], [1920x1080i(PsF)], [Off] (T 168)
[MON. Output Signal] [2048x1080P/1920x1080P], [1920x1080P], [1920x1080i(PsF)], [1280x720P] (d7168)
[HDMI Output Signal] [4096x2160P/3840x2160P], [1920x1080P], [1920x1080i], [1280x720P] (1 168)
[Linked to HDMI Monitor] [On], [Off] (11 168)
[SDI Output] [On], [Off] (@167
[SDI Output Signal] [4096x2160P/3840x2160P], [2048x1080P/1920x1080P], [1920x1080P], (T 167)
[1920x1080i(PsF)], [1280x720P]
[3G-SDI Mapping] [Level A], [Level B] ([T 167, 168)
[G-LOCK/SYNC/RET Term.] [HD Sync Output], [Genlock Input], [RET Input] (109, 110)
[Genlock Adjustment] -1023 to +1023 (0) (2 109)
[SYNC Scan Mode] [P], [PsF] (3110
[RET Output: VIDEO Term.] [Enable], [Disable] (T 100)
[RET Output: MON.] [Enable], [Disable] (2 100)
[RET Output: HDMI] [Enable], [Disable] (1 100)
[Time Code Mode] [Preset], [Regen.] (2 105)
[Time Code Run] [Rec Run], [Free Run] (2 105)
[Time Code DF/NDF] [DF], [NDF] (07 106)
[Set Time Code] [00:00:00.00] to [23:59:59.29] (59.94 Hz recordings), [23:59:59:24] (T 105)
(50.00 Hz recordings), or [23:59:59:23] (24.00 Hz recordings)
[TC In/Ouf] [In], [Out] (108, 109)
[User Bit Recording Mode] [Internal], [External] (1 108)
[User Bit Type] [Setting], [Time], [Date] (Q107)
[Camera Ctrl Dial], [Iris], [ISO/Gain], [White Balance Mode], [White Balance (K)], (79,82
[Grip Ctrl Dial], [Control Ring] [White Balance (CC)], [Select Subject], [Clear Scan (Steps)], [Shutter], [Off]
The default setting for the control ring is [Off].
[Camera Ctrl Dial Dir.], [Reverse], [Normal]
(Grip Ctrl Dial Direction], Changes the direction of the adjustment when operating the control dials/ring.
[Control Ring Dir.], [SELECT Dial Dir.]
[Grip Dial in Menus] [Disable], [Enable] (17 40)

Enables or disables the use of the grip dial to navigate the setup menus, direct touch control, direct setting

mode and status screens.



Menu item
[Focus Ring Operation]
[Focus Ring Direction]

Menu Options

Setting options and additional information
[Enable During AF], [Disable During AF]
[Reverse], [Normal]
Changes the direction of the adjustment when operating the focus ring on an RF lens.

[Focus Ring Response]

[Varies with Rotation Speed], [Linked to Rotation Degree]

[Focus/Control Ring]

[Focus Ring], [Control Ring]

Selects the function assigned to the RF-S lens focus/control ring. When set to [Control Ring], focus is set
to AR

[Key Lock] [All Buttons], [All Except REC Button] (@12
[Camera REC Button], [Disable], [Enable] (@53
[Camera Grip REC Button] Enables or disables the use of the REC buttons.

[Assign. Button 12 as REC] [On], [Off] (@133

[Onscreen REC/STBY Button]

When this setting is set to [On], assignable button 12’s function changes to [REC] and cannot be changed.
This turns assignable button 12 to an alternative REC button.

[On], [Off] ((T153)
When this setting is set to [On], the recording operation indicator (REC/STBY) on the CAMERA mode
screen becomes an onscreen button you can touch to start/stop recording.

[Touch Screen Response] [Normal], [Low] (1133
[Review Recording] [Entire Clip], [Last 4 sec] (62
[Tally Lamp (Front)], [On], [Off]

[Tally Lamp (Rear)] When this setting is set to [On], the tally lamp illuminates while recording.

[Tally Lamp Settings] [Power/Media/Tally In (PGM)], [REC/Tally In (PGM)], [REC], [Tally In (PGM)] (@ 53)

[Card Access LED]

[=% (Ethernet) LED]

When this setting is set to [Power/Media/Tally In (PGM)], the tally lamp illuminates/flashes according to
battery and recording warnings and the SD card recording status.

[On], [Off]

When this setting is set to [On], the CFexpress/SD card access indicator illuminates when the camera is
accessing the card.

[On], [Off]

When this setting is set to [On], the % (Ethernet) indicator illuminates/flashes when the camera is
accessing a wired network.

[Button Illumination] [On], [Off] (R RE))
[USB Mode] [Canon App(s) for iPhone], [Canon App(s)/GP-E2] (M177)
Select [Canon App(s)/GP-E2] when connecting the GP-E2 GPS Receiver to the camera using an optional
interface cable.
[GPS Auto Time] [On], [Off]
When this setting is set to [On], the camera automatically adjust its date and time settings according to
the information received from the GPS signal. The date and time will be updated automatically the first
time a correct GPS signal is acquired after turning on the camera. This setting is available only in CAMERA
mode.
o While the automatic date/time adjustment is activated, the MENU > [¥ System Setup] > [Date/
Time] setting will not be available.
e The time will not be updated while recording video.
[Fan Mode] [Automatic], [Always On] (M 51)
[Fan Speed (STBY)] [Maximum], [High], [Middle], [Low]
[Fan Speed (REC)], [High], [Middle], [Low]
[Fan Speed (Always)]
[Fan Speed] [High], [Middle], [Low] (M 51)
[Level Sensitivity] [x16], [x8], [x4], [x2], [Standard] (@3 50)
[Level Reference Setting] [Cancel], [OK] (@3 50)
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Menu item Setting options and additional information

[DC IN Warning (V)] 11.5V1015.0Vin 0.1 Vintervals (12.0 V) (T 28)

[Retract Lens] [On], [Off]
When a supported lens ([ 276) is attached to the camera and the focus mode switch on the lens is set
to AF, if this setting is set to [On], the lens will retract fully when the camera is turned off.
When this setting is set to [On], turning off the camera will move the focus position. To prevent this, set
this setting to [Off]. Note that there is no guarantee that the focus position will not move, so checking the
focus position is recommended when turning on the camera.

[Reset Hour Meter] -
The camera has two “hour meters” — the first keeps track of total operation time and the second keeps
track of operation time since the last time the second hour meter was reset with this function. This setting
is available only in CAMERA mode.

[Firmware]

[Camera] -

Displays the current firmware version of the camera and is used to update the firmware.

[Lens], [Mount Adapter],
[Power Zoom Adapter],
[Accessory]

- (71 36)

[Download Latest Firmware]

Download the latest firmware and update the camera. (M 212

[PIN Code Management]

(11 38)

[PIN Code Request]

[Disable], [Enable]

[PIN Code Change]
[Access Log Display]

- (01 261)

" The default value depends on the country/region of purchase.

[Y My Menu] menu (CAMERA mode only)

Menu item

[CAMERA-1: Edit] to
[CAMERA-5: Edit]

Setting options and additional information
[Register], [Move], [Delete], [Reset All], [Rename] (M 41)



Displaying the Status Screens

Displaying the Status Screens

You can use the status screens to check the camera’s various settings. You can also output the status screens
to an external monitor.

1 Set an assignable button to [Status] ([1] 133).

2 Press the assignable button to open the status screens.
e The status screen most recently displayed will appear unless you turned off the camera or changed the
operating mode.
3 Scroll through the status screens to check the desired settings.
¢ Navigate the status screens in the same way you do the setup menus.
4 Press the assignable button again or select [X CLOSE] to close the status screens.
® You can also press the MENU button to close the status screens and open the menu instead.
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Recording / Output Signal and Detailed Settings

Recording / Output Signal and Detailed Settings
Sub Recording Clips (11 70)

Main clip: RAW

Sub recording clip: XF-AVC, XF-AVC S (XF-AVC S YCC422 10 bit)

Primary clip Sub recording clip
Frame rate Recording format Resolution Bit rate Resolution, bit rate
ST 2130 Mbps / 1780 Mbps | e 4096x2160
600 Mbps / 500 Mbps Intra-frame
59.94P / 50.00P 250 Mbps Long GOP
LT 1380 Mbps / 1160 Mbps | ® 2048x1080
300 Mbps / 250 Mbps Intra-frame
50 Mbps Long GOP
Ha 2160 Mbps / 1800 Mbps / | @ 4096x2160
1730 Mbps / 1730 Mbps | 600 Mbps / 500 Mbps / 480 Mbps /
6000x3164 1070 Mbps / 886 Mbps / 480 Mbps Intra-frame
ST 850 Mbps / 850 Mbps | 450 Mbps / 375 Mbps / 360 Mbps /
360 Mbps Intra-frame
29.97P / 25.00P / 24.00P / 300 Mbps / 250 Mbps / 240 Mbps /
23.98P 240 Mbps Intra-frame
T 690 Mbps / 576 Mbps / | 150 Mbps Long GOP
553 Mbps / 552 Mbps | ® 2048x1080
150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame
50 Mbps Long GOP
HQ 2290 Mbps / 1910 Mbps | ® 4096x2160
ST 1130 Mbps / 939 Mbps 600 Mbps / 500 Mbps Intra-frame
250 Mbps Long GOP
59.94P / 50.00P o 2048x1080
ol 732 Mbps /611 Mbps | 300 Mbps / 250 Mbps Intra-frame
50 Mbps Long GOP
Ho 1150 Mbps / 954 Mbps / | » 4096x2160
916 Mbps /915 Mbps | 600 Mbps / 500 Mbps / 480 Mbps /
4368x2304 563 Mbps / 470 Mbps / 480 Mbps Intra-frame
ST 451 Mbps / 451 Mbps | 450 Mbps / 375 Mbps / 360 Mbps /
360 Mbps Intra-frame
29.97P / 25.00P / 24.00P / 300 Mbps /250 Mbps / 240 Mbps /
23.98P 240 Mbps Intra-frame
" 366 Mbps / 306 Mbps / | 150 Mbps Long GOP
293 Mbps / 293 Mbps | ® 2048x1080
150 Mbps /125 Mbps / 120 Mbps /
120 Mbps Intra-frame
50 Mbps Long GOP
HQ 574 Mbps / 479 Mbps | » 2048x1080
59.94P / 50.00P ST 283 Mbps / 236 Mbps | 300 Mbps / 250 Mbps Intra-frame
T 184 Mops / 154 Mpps | 20 Mops Long GOP
Ha 287 Mbps / 240 Mbps / | @ 2048x1080
2184x1152 230 Mbps / 230 Mbps | 150 Mbps / 125 Mbps / 120 Mbps /
29.97P / 25.00P / 24.00P / 142 Mbps / 118 Mops / | 120 Mbps Intra-frame
ST 50 Mbps Long GOP
23.98P 114 Mbps / 113 Mbps p 9
T 92 Mbps / 77 Mbps /
74 Mbps / 74 Mbps




Sub recording clip: XF-AVC S (XF-AVC S YCC420 8 bit)

Recording / Output Signal and Detailed Settings

Primary clip Sub recording clip
Frame rate Recording format Resolution Bit rate Resolution, bit rate
ST 2130 Mbps / 1780 Mbps | » 4096x2160
50.94P / 50.00P 150 Mbps Long GOP
T 1380 Mbps / 1160 Mbps | ® 2048x1080
35 Mbps Long GOP
HO 2160 Mbps / 1800 Mbps / | » 4096x2160
6000x3164 1730 Mbps / 1730 Mbps | 100 Mbps Long GOP
29.97P / 25.00P / 24.00P / - 1070 Mbps / 886 Mbps / | ® 2048x1080
23.98P 850 Mbps / 850 Mbps | 35 Mbps Long GOP
I 690 Mbps / 576 Mbps /
553 Mbps / 552 Mbps
HQ 2290 Mbps / 1910 Mbps | » 4096x2160
ST 1130 Mbps / 939 Mops | 150 Mbps Long GOP
59.94P / 50.00P « 2048¢1080
LT 732 Mbps / 611 Mbps 35 Mbps Long GOP
HO 1150 Mbps / 954 Mbps / | ® 4096x2160
4368x2304 916 Mbps / 915 Mbps | 100 Mbps Long GOP
29.97P / 25.00P / 24.00P / 563 Mbps / 470 Mbps / | ® 2048x1080
ST 35 Mbps Long GOP
23.98P 451 Mbps / 451 Mbps ps Long
I 366 Mbps / 306 Mbps /
293 Mbps / 293 Mbps
HQ 574 Mbps / 479 Mbps | ® 2048x1080
59.94P / 50.00P ST 283 Mbps / 236 Mbps | 35 Mbps Long GOP
LT 184 Mbps / 154 Mbps
HO 287 Mbps / 240 Mbps / | » 2048x1080
2184x1152 230 Mbps / 230 Mbps | 35 Mbps Long GOP
29.97P / 25.00P / 24.00P / ST 142 Mbps / 118 Mbps /
23.98P 114 Mbps / 113 Mbps
7 92 Mbps / 77 Mbps /
74 Mbps / 74 Mbps
Sub recording clip: XF-HEVC S (XF-HEVC S YCC422 10 bit)
Primary clip Sub recording clip
Frame rate Recording format Resolution Bit rate Resolution, bit rate
ST 2130 Mbps / 1780 Mbps | ® 4096x2160
50.94P / 50.00P 225 Mbps Long GOP
r 1380 Mbps / 1160 Mbps | ® 2048x1080
50 Mbps Long GOP
HO 2160 Mbps / 1800 Mbps / | » 4096x2160
6000x3164 1730 Mbps / 1730 Mbps | 135 Mbps Long GOP
29.97P / 25.00P / 24.00P / 1070 Mbps / 886 Mbps / | ® 2048x1080
ST 50 Mbps Long GOP
23.98P 850 Mbps / 850 Mbps ps Long
7 690 Mbps / 576 Mbps /
553 Mbps / 552 Mbps
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Recording / Output Signal and Detailed Settings

Primary clip Sub recording clip
Frame rate Recording format Resolution Bit rate Resolution, bit rate
HQ 2290 Mbps / 1910 Mbps | » 4096x2160
ST 1130 Mbps / 939 Mbps | 225 Mbps Long GOP
59.94P / 50.00P 20481080
LT 732 Mbps / 611 Mbps 50 Mbps Long GOP
HO 1150 Mbps / 954 Mbps / | ® 4096x2160
4368x2304 916 Mbps /915 Mbps | 135 Long GOP
29.97P/ 25.00P / 24.00P / ST 563 Mbps / 470 Mbps / | ® 2048x1080
23.98P 451 Mbps / 451 Mbps | 90 Mbps Long GOP
T 366 Mbps / 306 Mbps /
293 Mbps / 293 Mbps
HQ 574 Mbps / 479 Mbps | » 2048x1080
59.94P / 50.00P ST 283 Mbps / 236 Mbps | 90 Mbps Long GOP
LT 184 Mbps / 154 Mbps
Ha 287 Mbps / 240 Mbps/ | » 2048x1080
2184x1152 230 Mbps / 230 Mbps | 50 Mbps Long GOP
29.97P / 25.00P / 24.00P / ST 142 Mbps / 118 Mbps /
23.98P 114 Mbps / 113 Mbps
T 92 Mbps / 77 Mbps /
74 Mbps / 74 Mbps
Sub recording clip: XF-HEVC S (XF-HEVC S YCC420 10 bit)
Primary clip Sub recording clip
Frame rate Recording format Resolution Bit rate Resolution, bit rate
ST 2130 Mbps / 1780 Mbps | » 4096x2160
59.94P / 50.00P 10 Mops Long GOP
LT 1380 Mbps / 1160 Mbps | ® 2048x1080
35 Mbps Long GOP
Ho 2160 Mbps / 1800 Mbps / | » 4096x2160
6000x3164 1730 Mbps / 1730 Mbps | 100 Mbps Long GOP
29.97P / 25.00P / 24.00P / ST 1070 Mbps / 886 Mbps / | ® 2048x1080
23.98P 850 Mbps / 850 Mbps | 35 Mbps Long GOP
T 690 Mbps / 576 Mbps /
553 Mbps / 552 Mbps
HQ 2290 Mbps / 1910 Mbps | » 4096x2160
ST 1130 Mbps / 939 Mops | 150 Mbps Long GOP
59.94P / 50.00P « 20481080
LT 732 Mbps / 611 Mbps 35 Mbps Long GOP
HO 1150 Mbps / 954 Mbps / | » 4096x2160
43682304 916 Mbps /915 Mbps | 100 Mbps Long GOP
29.97P / 25.00P / 24.00P / ST 563 Mbps / 470 Mbps / | ® 2048x1080
23.98P 451 Mbps / 451 Mbps | 35 Mbps Long GOP
T 366 Mbps / 306 Mbps /
293 Mbps / 293 Mbps




Frame rate

59.94P / 50.00P

Primary clip

Recording format
HQ
ST

Resolution

LT

29.97P /25.00P / 24.00P /
23.98P

HQ

2184x1152

ST

Recording / Output Signal and Detailed Settings

Bit rate
574 Mbps / 479 Mbps
283 Mbps / 236 Mbps

184 Mbps / 154 Mbps

Sub recording clip
Resolution, bit rate

* 2048x1080
35 Mbps / 35 Mbps Long GOP

287 Mbps / 240 Mbps /
230 Mbps / 230 Mbps

142 Mbps / 118 Mbps /
114 Mbps / 113 Mbps

92 Mbps / 77 Mbps /

* 2048x1080
35 Mbps Long GOP

LT

74 Mbps / 74 Mbps

Main clip: XF-AVC
Sub recording clip: XF-AVC

Primary clip

Frame rate Resolution

59.94P / 50.00P

4096x2160

29.97P/25.00P / 24.00P /
23.98P

59.94P / 50.00P

3840x2160

29.97P/25.00P / 24.00P /
23.98P

Bit rate
1200 /1000

900/750
600 /500
250 /250

Intra-frame

Long GOP

Sub recording clip
Resolution, bit rate

® 2048x1080
300 Mbps / 250 Mbps Intra-frame
50 Mbps Long GOP

50 Mbps Long GOP

600 /500 / 480 / 480

450/375/360 / 360

300/ 250/ 240/ 240

Intra-frame

® 4096x2160

150 Mbps Long GOP

* 2048x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

150/150/150/150

1200/ 1000

900/ 750

600 /500

Long GOP

Intra-frame

® 2048x1080
50 Mbps Long GOP

* 1920x1080

300 Mbps / 250 Mbps Intra-frame
50 Mbps Long GOP

For 59.94i / 50.00i:

150 / 125 Mbps Intra-frame

50 Mbps Long GOP

25 Mbps Long GOP

250/250

600 /500 /480 /480

450/ 375/ 360/ 360

300/250/240/240

150/150/150/150

Long GOP

Intra-frame

Long GOP

* 1920x1080

50 Mbps Long GOP
For 59.94i / 50.00i:
50 Mbps Long GOP
25 Mbps Long GOP

® 3840x2160

150 Mbps Long GOP

¢ 1920x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

* 1920x1080
50 Mbps Long GOP
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Recording / Output Signal and Detailed Settings

Frame rate

59.94P / 50.00P

29.97P / 25.00P / 24.00P /
23.98P

59.94P / 50.00P

29.97P / 25.00P / 24.00P /
23.98P

59.94i / 50i

Primary clip Sub recording clip
Resolution Bit rate Resolution, bit rate
® 2048x1080
300/250 Intra-frame 50 Mbps Long GOP
50/50 Long GOP -
2048x1080 2048x1080
. X
150/125/120/120 Intra-frame 50 Mbps Long GOP
50/50/50/50 Long GOP -
* 1920x1080
300/250 Intra-frame 50 Mbps Long GOP
50/50 Long GOP -
* 1920x1080
150/125/120/120 Intra-frame 50 Mbps Long GOP
1920x1080 50/50/50/50 Long GOP | —
* 1920x1080
150/125 Intra-frame 50 Mbps / 25 Mbps Long GOP
50/50 Long GOP -
25/25 Long GOP -

Sub recording clip: XF-AVC S (XF-AVC S YCC422 10 bit)



Frame rate

59.94P / 50.00P

29.97P/25.00P / 24.00P /
23.98P

Primary clip

Resolution

4096x2160

Bit rate
1200/ 1000

900/750

600 /500

Recording / Output Signal and Detailed Settings

Intra-frame

Sub recording clip
Resolution, bit rate

® 2048x1080
300 Mbps / 250 Mbps Intra-frame
50 Mbps Long GOP

250/ 250

Long GOP

® 2048x1080
50 Mbps Long GOP

600 /500 / 480 / 480

450/375/ 360/ 360

300/250/240/ 240

Intra-frame

* 4096x2160

600 Mbps / 500 Mbps / 480 Mbps /
480 Mbps Intra-frame

450 Mbps / 375 Mbps / 360 Mbps /
360 Mbps Intra-frame

300 Mbps / 250 Mbps / 240 Mbps /
240 Mbps Intra-frame

150 Mbps Long GOP

® 2048x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

® 4096x2160

450 Mbps / 375 Mbps / 360 Mbps /
360 Mbps Intra-frame

300 Mbps / 250 Mbps / 240 Mbps /
240 Mbps Intra-frame

150 Mbps Long GOP

® 2048x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

® 4096x2160

300 Mbps / 250 Mbps / 240 Mbps /
240 Mbps Intra-frame

150 Mbps Long GOP

® 2048x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

150/150/150/150

Long GOP

* 4096x2160

150 Mbps Long GOP
® 2048x1080

50 Mbps Long GOP
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Frame rate

59.94P / 50.00P

29.97P / 25.00P / 24.00P /
23.98P

Recording / Output Signal and Detailed Settings

Primary clip

Resolution

3840x2160

Bit rate
1200/ 1000
900/ 750

600/ 500

Intra-frame

Sub recording clip
Resolution, bit rate

e 1920x1080
350 Mbps / 250 Mbps Intra-frame
50 Mbps Long GOP

250/ 250

Long GOP

¢ 1920x1080
50 Mbps Long GOP

600 /500 /480 / 480

450/375/360/ 360

300/250/240/240

Intra-frame

® 3840x2160

600 Mbps / 500 Mbps / 480 Mbps /
480 Mbps Intra-frame

450 Mbps / 375 Mbps / 360 Mbps /
360 Mbps Intra-frame

300 Mbps / 250 Mbps / 240 Mbps /
240 Mbps Intra-frame

150 Mbps Long GOP

* 1920x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

* 3840x2160

450 Mbps / 375 Mbps / 360 Mbps /
360 Mbps Intra-frame

300 Mbps / 250 Mbps / 240 Mbps /
240 Mbps Intra-frame

150 Mbps Long GOP

* 1920x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

* 3840x2160

300 Mbps / 250 Mbps / 240 Mbps /
240 Mbps Intra-frame

150 Mbps Long GOP

* 1920x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

150/150/150/150

Long GOP

* 3840x2160

150 Mbps Long GOP
* 1920x1080

50 Mbps Long GOP

59.94P / 50.00P

29.97P /25.00P / 24.00P /
23.98P

2048x1080

300/ 250

Intra-frame

® 2048x1080
300 Mbps / 250 Mbps Intra-frame
50 Mbps Long GOP

50/50

Long GOP

* 2048x1080
50 Mbps Long GOP

150/125/120/120

Intra-frame

® 2048x1080

150 Mbps / 125 Mbps / 120 Mbps /
120 Mbps Intra-frame

50 Mbps Long GOP

50/50/50/50

Long GOP

® 2048x1080
50 Mbps Long GOP




Recording / Output Signal and Detailed Settings

Primary clip Sub recording clip
Frame rate Resolution Bit rate Resolution, bit rate
¢ 1920x1080
300/250 Intra-frame | 300 Mbps / 250 Mbps Intra-frame
59.94P / 50.00P 50 Mbps Long GOP
¢ 1920x1080
50750 Long 0P| 5 Mbps Long GOP
1920x1080 ¢ 1920x1080
150/125/120/120 Intra-frame | | 20 MDPS /125 Mbps /120 Mops /
29.97P / 25.00P / 24.00P / 120 Mbps Intra-frame
23.98P 50 Mbps Long GOP
¢ 1920x1080
50/50/50/50 Long GOP 50 Mbps Long GOP
Sub recording clip: XF-AVC S (XF-AVC S YCC420 8 bit)
Primary clip Sub recording clip
Frame rate Resolution Bit rate Resolution, bit rate
1200/ 1000 ® 2048x1080
900/ 750 Intra-frame | 35 Mbps Long GOP
59.94P / 50.00P
600/ 500
250/ 250 Long GOP
4096x2160
600 /500 / 480 / 480 * 4096x2160
29.97P/25.00P / 24.00P / 450/ 375/ 360/ 360 Intra-frame | 100 Mbps Long GOP
® 2048x1080
23.98P 950/ 240/ 24
300/250/240/ 240 35 Mbps Long GOP
150/150/150/ 150 Long GOP
1200/ 1000 ¢ 1920x1080
900/ 750 Intra-frame | 35 Mbps Long GOP
59.94P / 50.00P
600/ 500
250/ 250 Long GOP
3840x2160
600 /500 / 480 / 480 * 3840x2160
29.97P/25.00P / 24.00P / 450/ 375/ 360/ 360 Intra-frame | 100 Mbps Long GOP
1920x1080
23.98P ¢
300/250/240/240 35 Mbps Long GOP
150/150/150/150 Long GOP
50.94P / 50.00P 300/ 250 Intra-frame | ® 2048x1080
’ ' 50/50 Long GOP 35 Mbps Long GOP
2048x1080
29.97P / 25.00P / 24.00P / 150/125/120/120 Intra-frame ® 2048x1080
23.98P 50 /50 /50 /50 Long GOP | 35 Mbps Long GOP
50.94P / 50,00P 300/ 250 Intra-frame | ® 1920x1080
’ ' 50/50 Long GOP 35 Mbps Long GOP
1920x1080
29.97P / 25.00P / 24.00P / 150/125/120/120 Intra-frame | ® 1920x1080
23.98P 50/50/50/50 Long GOP | 35 Mbps Long GOP
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Recording / Output Signal and Detailed Settings

Main clip: XF-AVC S (YCC422 10 bit)

Sub recording clip: XF-AVC S (XF-AVC YCC422 10 bit)

Primary clip Sub recording clip
Frame rate Resolution Bit rate Resolution, bit rate
1200/ 1000 ® 2048x1080
900/ 750 Intra-frame | 300 Mbps / 250 Mbps Intra-frame
59.94P / 50.00P 600 /500 50 Mbps Long GOP
® 2048x1080
250/ 250 Long GOP 50 Mbps Long GOP
A095:2160 600 /500 /480 / 480 * 4096x2160
X
450/ 375/ 360 / 360 150 Mbps Long GOP
Intra-frame * 2048x1080
29.97P/25.00P / 24.00P / 150 Mbps / 125 Mbps / 120 Mbps /
23.98P 300/250/240/ 240 120 Mbps Intra-frame
50 Mbps Long GOP
* 2048x1080
150/150/150/ 150 Long GOP 50 Mbps Long GOP
1200 /1000 * 1920x1080
900/ 750 Intra-frame | 300 Mbps / 250 Mbps Intra-frame
59.94P / 50.00P 600/ 500 50 Mbps Long GOP
* 1920x1080
250/ 250 Long GOP 50 Mbps Long GOP
3840x2160 600 /500 /480 /480 Intra-frame ® 3840x2160
X
450/ 375/ 360 / 360 Intra-frame | 150 Mbps Long GOP
* 1920x1080
29.97P/ 25.00P / 24.00P / 150 Mbps / 125 Mbps / 120 Mbps /
23.98P 300/250/240/240 Intra-frame 120 Mbps Intra-frame
50 Mbps Long GOP
* 1920x1080
150/150/150/ 150 Long GOP 50 Mbps Long GOP
® 2048x1080
300/250 Intra-frame
59.94P / 50.00P 50 Mbps Long GOP
50/50 Long GOP -
2048x1080 20481080
. X
29.97P / 25.00P / 24.00P / 150/125/120/120 Intra-frame 50 Mbps Long GOP
23.98P
50/50/50/50 Long GOP -
* 1920x1080
300/250 Intra-frame
59.94P / 50.00P 50 Mbps Long GOP
50/50 Long GOP -
1920x1080 1920x1080
. X
29.97P / 25.00P / 24.00P / 150/125/120/120 Intra-frame 50 Mbps Long GOP
23.98P
50/50/50/50 Long GOP -




Sub recording clip: XF-AVC S (XF-AVC YCC420 8 bit)

Recording / Output Signal and Detailed Settings

Primary clip Sub recording clip
Frame rate Resolution Bit rate Resolution, bit rate
1200/ 1000 * 2048x1080
900/ 750 Intra-frame | 35 Mbps Long GOP
59.94P / 50.00P
600/ 500
250/ 250 Long GOP
4096x2160
600 /500 /480 /480 * 4096x2160
29.97P / 25.00P / 24.00P / 450/ 375 / 360 / 360 Intra-frame | 100 Mbps Long GOP
2048x1080
23.98P N
300/250/240/240 35 Mbps Long GOP
150/150/150/150 Long GOP
1200/ 1000 * 1920x1080
900/ 750 Intra-frame | 35 Mbps Long GOP
59.94P / 50.00P
600 /500
250/ 250 Long GOP
3840x2160
600 /500 /480 /480 ® 3840x2160
29.97P / 25.00P / 24.00P / 450 /375 /360 / 360 Intra-frame | 100 Mbps Long GOP
1920x1080
23.98P N
300/250/ 240/ 240 35 Mbps Long GOP
150/150/150/ 150 Long GOP
59.94P / 50.00P 300/250 Intra-frame ® 2048x1080
) ’ 50/ 50 Long GOP 35 Mbps Long GOP
2048x1080
29.97P / 25.00P / 24.00P / 150/125/120/120 Intra-frame * 2048x1080
23.98P 50/50/50/ 50 Long GOP | 35 Mbps Long GOP
50.94P / 50.00P 300/250 Intra-frame * 1920x1080
: ) 50/50 Long GOP 35 Mbps Long GOP
1920x1080 * 1920x1080
29.97P / 25.00P / 24.00P / 150/125/120/120 Intra-frame 35 Mbps Long GOP
23.98P
50/50/50/50 Long GOP -
Main clip: XF-AVC S (YCC420 8 bit)
Sub recording clip: XF-AVC S (YCC420 8 bit)
Primary clip Sub recording clip
Frame rate Resolution Bit rate Resolution, bit rate
* 2048x1080
59.94P / 50.00P 150/150 Long GOP 35 Mbps Long GOP
29.97P / 25.00P / 24.00P / 4096x2160 2048x1080
. . . . X
93.98P 100/100/100/100 Long GOP 35 Mbps Long GOP
* 1920x1080
59.94P / 50.00P 150/ 150 Long GOP 35 Mbps Long GOP
29.97P / 25.00P / 24.00P / 38402160 1920x1080
. . . . X
93.98P 100/100/100/100 Long GOP 35 Mbps Long GOP
59.94P / 50.00P 35/35 Long GOP -
29.97P / 25.00P / 24.00P / 2048x1080 -
93.98P 35/35/35/35 Long GOP
59.94P / 50.00P 35/35 Long GOP -
1920x1080 _
29.97p1 225:;0:;'3/ 24.00p/ 35/35/35/35 Long GOP
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Recording / Output Signal and Detailed Settings

Main clip: XF-HEVC S (YCC422 10 bit)
Sub recording clip: XF-HEVC S (YCC422 10 bit)

Primary clip Sub recording clip
Frame rate Resolution Bit rate Resolution, bit rate
® 2048x1080
59.94P / 50.00P - 225/225 Long GOP 50 Mbps Long GOP
X
29.97P/25.00P / 24.00P / ® 2048x1080
23.98P 135/135/135/135 Long GOP 50 Mbps Long GOP
* 1920x1080
59.94P / 50.00P . 225/225 Long GOP 50 Mbps Long GOP
X
29.97P/25.00P / 24.00P / * 1920x1080
23.98P 135/135/135/135 Long GOP 50 Mbps Long GOP
59.94P / 50.00P 50/50 Long GOP -
29.97P/25.00P/24.00P/ | 2048x1080 _
23.98P 50/50/50/50 Long GOP
59.94P / 50.00P 50/50 Long GOP -
29.97P/25.00P / 24.00P / 1920x1080 -
23.98P 50/50/50/50 Long GOP
Sub recording clip: XF-HEVC S (YCC420 10 bit)
Primary clip Sub recording clip
Frame rate Resolution Bit rate Resolution, bit rate
* 2048x1080
59.94P / 50.00P 225/225 Long GOP 35 Mbps Long GOP
4096x2160 * 4096x2160
29.97P/ 25.00P / 24.00P / 100 Mbps Long GOP
23.08P 135/135/135/135 Long GOP « 2048x1080
35 Mbps Long GOP
* 1920x1080
59.94P / 50.00P 225/225 Long GOP 35 Mbps Long GOP
3840x2160 * 3840x2160
29.97P/25.00P / 24.00P / 100 Mbps Long GOP
23.98P 135/135/135/135 Long GOP « 19201080
35 Mbps Long GOP
* 2048x1080
59.94P / 50.00P — 50/50 Long GOP 35 Mbps Long GOP
X
29.97P/ 25.00P / 24.00P / 50/50/50 /50 Lona GOP * 2048x1080
23.98P 9 35 Mbps Long GOP
* 1920x1080
59.94P / 50.00P — 50/50 Long GOP 35 Mbps Long GOP
X
29.97P/25.00P / 24.00P / 50/50/50 /50 Lona GOP * 1920x1080
23.98P 9 35 Mbps Long GOP




Recording / Output Signal and Detailed Settings

Main clip: XF-HEVC S (YCC420 10 bit)
Sub recording clip: XF-HEVC S (YCC420 10 bit)

Primary clip Sub recording clip
Frame rate Resolution Bit rate Resolution, bit rate
® 2048x1080
59.94P / 50.00P 150/ 150 Long GOP 35 Mbps Long GOP
29.97P/25.00P / 24.00P / 4096x2160 2048x1080
. . . . X
23.98P 100/100/100/100 Long GOP 35 Mbps Long GOP
* 1920x1080
59.94P / 50.00P 150/150 Long GOP 35 Mbps Long GOP
29.97P/25.00P / 24.00P / 3840x2160 1920x1080
. . . . X
23.98P 100/100/100/100 Long GOP 35 Mbps Long GOP
59.94P / 50.00P 35/35 Long GOP -
29.97P/25.00P/24.00P/ | 2048x1080 _
23.98P 35/35/35/35 Long GOP
59.94P / 50.00P 35/35 Long GOP -
1920x1080 _
29.97P/225é0;);P/ 24.00p/ 35/35/35/35 Long GOP

Slow & Fast Motion Recording ([1] 126)

Available frame rates

Frame rate Available shooting frame rate (fps) during slow & fast motion recording
59.94P 1,2,3,6,15, 30, 44, 48, 52, 56, 60, 90, 120, 150, 180
29.97P 1,2,3,6, 15,22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60, 90, 120, 150, 180
50.00P 1,5, 15, 25, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120, 125, 150, 175, 180
25.00P 1,5,15,17,19, 21, 23, 25, 26, 28, 30, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120, 125, 150, 175, 180
23.98P, 24.00P 1,2,3,6,12,16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60, 72, 96, 120, 144, 168, 180

Available shooting frame rates (RAW)

Recording format ~ Main resolution Bit rate Frame rate Shooting frame rate during slow & fast motion recording

RAW HQ 2730

RAW ST 1340 29.97

RAW LT 871

RAW HQ 2280

RAW ST 1120 25.00

6000x4000 11030

RAW LT 727

RAW HQ 2180

RAW ST 1080 24.00

RAW LT 698" 23.98

RAW LT 6972
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Recording / Output Signal and Detailed Settings

Recording format ~ Main resolution Bit rate Frame rate Shooting frame rate during slow & fast motion recording
RAW ST 2130
- 59.94 11060
RAW LT 1380
240 RAW HQ 2160 11030
RAW ST 1070 29.97
B 110 60
RAW LT 690
RAW ST 1780
_ 50.00 11060
RAW LT 1160
6000x3164
RAW HQ 1800 11030
RAW ST 886 25.00
11060
RAW LT 576
RAW HQ 1730 11030
RAW ST 850 24.00
RAW LT 553" 23.98 11060
RAW LT 5522
RAW HQ 2290 11060
RAW ST 1130 59.94
_— 110100
RAW LT 732
RAW HQ 1150 11060
RAW ST 563 29.97
_— 110100
RAW LT 366
RAW HQ 1910 11060
RAW ST 939 50.00
4 2304 110100
RAW LT 368x230 611
RAW HQ 954 11060
RAW ST 470 25.00
110100
RAW LT 306
RAW HQ 916
11060
RAW HQ 9152 24.00
RAW ST 451 2398
_— 110100
RAW LT 293




Recording / Output Signal and Detailed Settings

Recording format ~ Main resolution Bit rate Frame rate Shooting frame rate during slow & fast motion recording
RAW ST 993
I 59.94
RAW LT 645
RAW ST 497 241
29.97
RAW LT 323
RAW ST 828
- 50.00
RAW LT 538
— 4096x2160 120
RAW ST 414
25.00
RAW LT 269
RAW ST 398
24.00
RAW LT 259
RAW ST 397
23.98
RAW LT 258
RAW HQ 574
RAW ST 283 59.94
RAW LT 184
RAW HQ 287
RAW ST 142 29.97
RAW LT 92
RAW HQ 479
RAW ST 236 50.00
_—— 2184x1152 110180
RAW LT 154
RAW HQ 240
RAW ST 118 25.00
RAW LT 77
RAW HQ 230
1
RAW ST 114 24.00
RAW ST 1132 23.98
RAW LT 74

1 When the frame rate is 24.00
2 When the frame rate is 23.98



Recording / Output Signal and Detailed Settings

Available shooting frame rates (XF-AVC)

Main recordin ) .
9 Main resolution
format

242

YCC422 4096x2160
10 bit 3840x2160

Compression
method

Intra-frame

Long GOP

Recorang Frame rate Bit rate Shooting framg rate dunr.lg slow & fast
media motion recording
CFexpress 1200 1t0 60
CFexpress 900 1t0120
59.94
CFexpress 600 1t0120
SD 600 11060
CFexpress 600 1t0 60
CFexpress 450 1t0120
CFexpress 300 1t0120
29.97
SD 600 11030
SD 450 11030
SD 300 1t0 60
CFexpress 1000 1t0 60
CFexpress 750 1t0120
50.00
CFexpress 500 1t0 120
SD 500 1t0 60
CFexpress 500 1t0 60
CFexpress 375 1t0120
CFexpress 250 1t0 120
25.00
SD 500 11030
SD 375 11030
SD 250 11060
CFexpress 480 1t0 60
CFexpress 360 1t0120
CFexpress 240 1t0120
24.00/23.98
SD 480 11030
SD 360 11030
SD 240 11060
CFexpress, SD 59.94 250 110120
CFexpress 150 1t0120
SD 29.97 150 120
SD 150 110100
CFexpress, SD 50.00 250 110120
CFexpress 150 1t0120
SD 25.00 150 1t0 100
SD 135 120
CFexpress 150 1t0120
SD 24.00/23.98 150 1t0 100
SD 130 120




Recording / Output Signal and Detailed Settings

Main recording . . Compression Recording . Shooting frame rate during slow & fast
Main resolution ) Frame rate Bit rate ) .
format method media motion recording
CFexpress 1t0 180
59.94 300
SD 110120
CFexpress 1t0 180
29.97 150
SD 110120
CFexpress 1t0 180
Intra-frame 50.00 250
SD 110120
CFexpress 1t0 180
YCC422 2048x1080 25.00 125
10 bit 1920x1080 SD 110120
CFexpress 1t0 180
24.00/23.98 120
SD 110120
59.94
50.00
29.97
Long GOP CFexpress, SD 95 00 50 1t0 180
24.00
23.98
During proxy clip recording
Recording Resolution Compression Recorqlng Frame rate Bit rate Shooting frame. rate durlpg slow & fast
format method media motion recording
59.94
50.00
YCC420 29.97
8 bit 2048x1080 Long GOP SD 95,00 35 110 60
24.00

23.98
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Recording / Output Signal and Detailed Settings

Available shooting frame rates (XF-AVC S)

Main recording ) . Compression Recording : Shooting frame rate during slow & fast
Main resolution . Frame rate Bit rate . )
format method media motion recording
244 1200 11060
- CFexpress 900 1t0120
59.94
600 110120
SD 600 11060
600 11060
CFexpress 450 1t0 120
300 110120
29.97
600 11030
SD 450 11030
300 11060
1000 1t0 60
CFexpress 750 1t0120
50.00
YCC422 40062160 | o 500 110120
500 1t0 60
CFexpress 375 1t0120
250 110120
25.00
500 11030
SD 375 11030
250 11060
480 11060
CFexpress 360 110120
240 110120
24.00/23.98
480 11030
SD 360 11030
240 11060




Main recording . . Compression Recording . Shooting frame rate during slow & fast
Main resolution . Frame rate Bit rate ) )
format method media motion recording
CFexpress, SD 59.94 250 1t0120
CFexpress 150 1t0120
SD 29.97 150 120
SD 150 110100
CFexpress, SD 50.00 250 1t0120
4096x2160
CFexpress 150 1t0120
sgaoet0 | om9 GOP P
SD 25.00 135 120
SD 150 110100
CFexpress 150 1t0120
SD 24.00/23.98 130 120
SD 150 110100
CFexpress 1t0 180
59.94 300
YCC422 SD 110120
10 bit
CFexpress 1t0 180
29.97 150
SD 110120
CFexpress 1t0 180
Intra-frame 50.00 250
SD 110120
CFexpress 1t0 180
2048x1080 25,00 125
1920x1080 SD 110120
CFexpress 1t0 180
24.00/23.98 120
SD 110120
59.94
50.00
29.97
Long GOP CFexpress, SD 95 00 50 1t0 180
24.00
23.98
59.94,
4096x2160 °0.00 i
X
3840x2160 CFexpress, SD 29.97, 1t0120
24.00, 100
YCC420 2398
Long GOP
8 bit g 59.94
29.97
2048x1080 50.00
19201080 CFexpress, SD 95,00 35 1t0 180
24.00

Recording / Output Signal and Detailed Settings

23.98
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Recording / Output Signal and Detailed Settings

During proxy clip recording

Recording . Compression Recording . Shooting frame rate during slow & fast
Resolution . Frame rate Bit rate . )
format method media motion recording

59.94
246 50.00

29.97
2048x1080 9500 11060

YCC420 24.00

8 bit Long GOP SD 23.98 16,9

29.97
25.00
1920x1280 9400 11030

23.98

Available shooting frame rates (XF-HEVC S)

Main recording . . Compression Recording . Shooting frame rate during slow & fast
Main resolution ) Frame rate Bit rate . )
format method media motion recording
CFexpress, SD 59.94 225 1t0120
CFexpress, SD 29.97 135 1t0 120
CFexpress, SD 50.00 225 110120
4096x2160
3840x2160 CFexpress, SD 25.00 135 110120
CFexpress, SD 135 110120
. 24.00
YCC422 10 bit
SD 23.98 135 110100
SD 130 120
59.94
50.00
2048x1080 29.97
1920x1080 Long GOP CFexpress, SD 95,00 50 1t0 180
24.00
23.98
59.94
50.00 150 110120
4096x2160 29.97
3840x2160 CFexpress. SD | e 100 10 120
24.00 0
YCC420 10 bit 23.98
59.94
50.00
2048x1080 29.97
1920x1080 CFexpress, SD 95,00 35 110180
24.00
23.98




Recording / Output Signal and Detailed Settings

During proxy clip recording

Recording . Compression Recording . Shooting frame rate during slow & fast
Resolution . Frame rate Bit rate ) )
format method media motion recording

59.94
50.00 247

29.97
2048x1080 95,00 110 60

24.00

YCC420 23.98
10 bit Long GOP SD 16,9

29.97
25.00
1920x1280 2400 11030

23.98
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Troubleshooting

Troubleshooting

If you have a problem with your camera, refer to this section. Consult your dealer or a Canon Service Center if
the problem persists.

Power source

The camera will not turn on or it turns off by itself.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Shortly after turning it on, the camera turns off on its own.
- You are using a battery pack that is not compatible for use with this camera. Use a recommended battery pack

(0O 266).

Cannot charge the battery pack.

- The temperature of the battery pack is outside the charging range. If the battery pack’s temperature is below 0 °C
(82 °F), warm it before charging it; if it is above 40 °C (104 °F), let the battery pack cool down before charging it.

- Charge the battery pack in temperatures between 0 °C and 40 °C (32 °F and 104 °F).

- The battery pack is faulty. Replace the battery pack.

- If the CHARGE indicator on the battery charger does not switch from blinking to solid, unplug the power cord from the
power outlet, remove and reattach the battery, then wait 2 to 3 minutes before plugging the power cord back into the
power outlet.

The battery pack is depleted extremely quickly even at normal temperatures.
- Check the [ System Setup] status screen ([I] 227) to check if the battery pack has reached the end of its battery
life. If so, buy a new battery pack.

Recording

The camera’s controls are not responsive/disabled.
- When the switch is set to i@, all buttons (or all buttons with the exception of some REC buttons) are locked
and cannot be operated. Set the [MED switch to CAMERA. You can change which controls are locked with the
MENU > [¥ System Setup] > [Key Lock] setting.

The camera’s grip controls are not responsive/disabled.
- The camera grip’s plug may not be correctly connected to the camera’s GRIP terminal. Disconnect the camera grip’s
cable and then connect it again, firmly ([1] 34). If you changed the angle of the camera grip, make sure you did not
partially disconnect the plug by mistake.

Pressing the REC button will not start recording.

- The card is full or it already contains the maximum number of clips (999 clips). Delete some clips ([11 158) or save your
recordings and initialize the card ([11 45) to free some space. Alternatively, replace the card.

- The REC button that was used may be disabled. Change the current settings in the MENU > [§ System Setup] >
[Camera REC Button] or [Camera Grip REC Button] setting to enable the use of the desired REC buttons.

- Power supply to the camera has reached the level set for the power level warning ([1] 226). Check the power source.

- The camera cannot record while the [Color Correction] settings in the custom picture file (11 145) are being adjusted
(except for the [Revision Level]/[Revision Phase] settings).

The point where the REC button was pressed does not match the beginning/end of the recording.
- There may be a slight interval between pressing the REC button and the actual start/end of recording. This is not a
malfunction.

The camera will not focus.
- The camera may not be able to focus on certain subjects using autofocus. Focus manually ([ 88).
- When [Continuous AF] is enabled and [Lens action if cannot AF] is set to [Stop], start focusing manually until the AF
frame changes from yellow to white.
- The lens is dirty. Clean the lens with a soft lens-cleaning cloth.



Troubleshooting

When a subject flits across in front of the lens, the image appears slightly bent.
- This is a phenomenon typical of CMOS image sensors. When a subject crosses very quickly in front of the camera, the
image may seem slightly warped. This is not a malfunction.

Bright red, green or blue dots appear on the screen.

- Try adjusting the black balance ([11 52). The camera’s CMOS sensor is a delicate piece of precision engineering. Direct
exposure of the sensor to ion rays or other types of cosmic radiation may affect it and this may rarely appear as bright colored
dots on the screen. This is the nature of CMOS image sensors and does not represent a malfunction.

- The effects of the damage may be more noticeable when the camera is used in places subject to high temperatures,
when a high ISO speed or gain level is used and when slow shutter speeds are used.

Abnormal images appear on the screen and the camera cannot record properly.
- While recording using an almost empty battery pack together with an AC adapter, the AC adapter was inadvertently
disconnected or the power supply was suddenly interrupted. Reconnect the AC adapter and turn the camera off and
then on again or replace the battery pack with a fully charged one.

Changing between recording (@ REC) and record standby (STBY) takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings
and initialize the card ([T] 45). Alternatively, replace the card.

Clips or photos cannot be recorded properly.
- This may occur as clips and photos are recorded/deleted over time. Save your recordings and initialize the card

([ 45).
After using the camera for a long time, it becomes hot.
- The camera may become hot after using it continuously for long periods of time; this is not a malfunction. If the
camera becomes unusually hot or it becomes hot after using it only for a short while, it may indicate a problem with
the camera. Consult a Canon Service Center.

Playback

Cannot delete clips/photos
- XF-AVC clips with an [ld mark cannot be deleted with the camera. Remove the [ mark (00 157).
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- Photos that were protected using other devices cannot be deleted with this camera.

Deleting clips takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings
and initialize the card ([1 45).

Indicators and Onscreen Displays

appears in red on the screen.
- Battery pack is depleted. Replace or charge the battery pack.

appears on the screen.
- The camera cannot communicate with the battery pack attached so the remaining battery time cannot be displayed.

The tally lamp does not illuminate.
- Set MENU > [¥ System Setup] > rl'ally Lamp (Front)] or [Tally Lamp (Rear)] to [On].

The tally lamp flashes quickly. | (4 flashes per second)
- The battery pack is depleted. Replace or charge the battery pack.
- There is not enough available space on the CFexpress / SD card. Delete recordings ([11 158) to free some space or
replace the card.
- A system error has occurred. Turn the camera off and then on again. If this does not solve the problem, consult a
Canon Service Center.

The tally lamp flashes slowly. g3 20 (1 flash per second)
- Available space on the CFexpress / SD card is low. Replace the card that is not being used for recording.
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(s%d appears in red on the screen.
- An SD card error occurred. Remove and reinsert the SD card. If the display does not change back to normal, save your
recordings and initialize the SD card ([]] 45).

/ (0] appears in red on the screen followed by [End].
- The indicated card is full. Delete recordings ([11 158) to free some space or replace the card.

Even after stopping recording, the access indicator stays illuminated in red.
- The clip is being recorded on the card. This is not a malfunction.

E3 appears in yellow on the screen.
- The camera’s internal temperature has reached a predetermined level. You can continue using the camera.

E3 appears in red on the screen.

- The camera’s internal temperature has risen further while B8 appeared in yellow on the screen.

- If the icon appears in red in CAMERA mode while MENU > [§¥ System Setup] > [Fan Mode] is set to [Always On] or in
MEDIA mode while MENU > [¥ System Setup] > [Fan Speed] is set to [High], turn off the camera and wait until the
temperature has decreased.

- In CAMERA mode, if the fan mode is set to [Automatic] and the fan was turned off while recording, the fan will turn on
automatically (in that case, IZX will appear on the screen).

appears in red on the screen.
- The cooling fan may not be working properly. The camera will automatically turn off after a few minutes. Consult a
Canon Service Center.

[R4{N) appears on the screen.
- The camera and lens cannot communicate normally. Clean the lens’s contacts and reattach the lens.

The aperture value (F or T) appears in gray on the screen.

- When using a compatible EF Cinema lens ([11 276), the aperture value will appear in gray when the camera detects
that the aperture may be close to fully closed. As you continue to close down the aperture further, the display will
change to [closed].

The ND filter indicator appears in red or as [- -] on the screen.
- The ND filter mechanism may not be working properly. Consult a Canon Service Center.

Picture and Sound

The screen of the monitoring device connected to the VIDEO terminal does not turn on.
- Make sure the unit cable connecting the camera’s VIDEO terminal and the monitoring device’s VIDEO terminal is
correctly connected on both sides.

There is no picture from an external monitor.
- Make sure the cable connecting the camera to the monitor is correctly connected on both sides.

- Check that the correct video input is selected on the external monitor.

There is no picture or sound from an external monitor connected to the MON. terminal

- If an HDMI cable is connected to the HDMI OUT terminal, disconnect it.

- Check that the external monitor’s settings match the configuration of the output signal selected on the camera
(M 159).

- [MON&HDMI Simult. Output] is set to [Off].

There is no picture or sound from an external monitor/recorder connected to the HDMI OUT terminal

- Disconnect the HDMI cable and then restore the connection or turn the camera off and then on again.

- Check that the settings of the external monitor/recorder match the configuration of the output signal selected on the
camera ([1] 159).

An assistance display (peaking/zebra pattern/video scope/onscreen markers/magnification/B&W image/anamorphic
desqueeze/LUT) does not appear or is not applied on the screen.

- These assistance displays have separate settings that allow you to turn the display on/off on individual monitoring
devices/video outputs. Check the settings to see that the desired function is enabled on the desired monitor/video
output.

- Onscreen displays output has not been enabled. Activate the output of the camera’s onscreen displays ([ 1] 169).



Troubleshooting

Screen displays turn on and off repeatedly.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Abnormal characters appear on the screen and the camera does not operate properly.
- Remove all the cards and disconnect the power source. After a moment, reconnect the power and reinsert the cards. 251
If the problem still persists, use the MENU > [§ System Setup] > [Reset] > [All Settings] function. This resets all the —
camera’s settings to default values, except for the hour meter.

Video noise appears on screen.
- Keep a distance between the camera and devices that emit strong electromagnetic fields such as near powerful
magnets and motors, MRI machines or high-voltage power lines.

Horizontal bands appear on the screen.

- This is a phenomenon typical of CMOS image sensors when recording under some types of fluorescent, mercury or
sodium lamps. This is not a malfunction. You may be able to reduce the symptoms by setting the shutter speed mode
to [Speed] and the shutter speed to a value matching the frequency of the local electrical system: 1/50* or 1/100 for
50 Hz systems, 1/60 or 1/120 for 60 Hz systems.

* May not be available depending on the frame rate.
When recording LED panels, horizontal bands may flicker on the screen.

- Depending on the timing of the camera's image capture and the LED panel's flickering, horizontal bands may appear.
This is not a malfunction. Because this phenomenon is caused by the specifications and settings of the camera and
the LED panel, it cannot be completely eliminated, but it can sometimes be reduced by the following measures:
¢ Use the GENLOCK function ([1] 109).
¢ In [Shutter Mode], select [Clear Scan] and adjust the frequency (1 73).

e Change the LED panel’s refresh rate.
e If available, use the LED panel’s functions to synchronize its refresh rate with the camera’s shutter speed and to fine-
tune the phase of the synchronization signal.

Audio cannot be recorded.

- When using the INPUT 1/INPUT 2 terminals, make sure you are using a mini XLR connector. When using the MIC
terminal, make sure you are using a condenser microphone with a & 3.5 mm stereo mini plug.

- The external microphone connected to the INPUT 1/INPUT 2 terminal requires phantom power. Set the corresponding
INPUT 1/INPUT 2 audio input selection switch to MIC+48V ([1] 114).

- The external microphone connected to the MIC terminal is not turned on or its battery is depleted. Alternatively, an
external microphone compatible with plug-in power is connected to the MIC terminal but MENU > [§*)) Audio Setup]
> [MIC Input] is set to [LINE].

Audio is recorded at an extremely low level.
- When using the INPUT 1/INPUT 2 terminals or MIC terminal: The audio level switch for CH1 or CH2 is set to M, and
the recording level is set too low. Check the audio level meter on the screen and adjust the audio level correctly
(M 116).

- The microphone attenuator is on. Turn off the microphone attenuator ([11 117).

Sound is distorted or is recorded at lower levels.
- When recording near loud sounds (such as fireworks, shows or concerts), sound may become distorted or it may not
be recorded at the actual levels. Activate the microphone attenuator ([1] 117), or adjust the audio recording level
manually.

Cards and Accessories

Cannot insert the card.
- The card you are trying to insert is not facing the correct direction. Turn it over and insert it.

Cannot record on the CFexpress card.
- A compatible card must be used ([11 43).
- Initialize the card ([T] 45) when you use it with the camera for the first time.
- The card is full or it already contains the maximum number of clips (999 clips). Delete recordings ([1] 158) to free some
space or replace the card.
- The clip number has reached its maximum value. Save your recordings and initialize the card ([J] 45) or delete all the
clips (11 158).



252

Troubleshooting

Cannot record on the SD card.
- A compatible card must be used ([] 43).
- Initialize the card ([11 45) when you use it with the camera for the first time.
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- The card is full. Replace the card or delete recordings ([1] 158) to free some space on the card.
- The folder and file numbers for photos have reached their maximum value. Set MENU > [£3 Recording/Media Setup]
> [Photo Numbering] to [Reset] and insert a new card.

Recording to and playing back from a CFexpress or SD card is slow.

- This may occur as recordings are made and deleted repeatedly over time. Save your recordings and initialize the card
([T 45).

The optional RC-V100 Remote Controller or commercially available remote control does not work.

- Make sure that MENU > [ System Setup] > [REMOTE Term.] is set to [RC-V100 (REMOTE A)] when using the
optional RC-V100 Remote Controller, [Standard] when using a commercially available remote control, or [Standard +
RC-V100] to use both simultaneously ([1] 132).

- Turn off the camera, reconnect the remote controller and then turn the camera back on again.

- When the currently selected custom picture file is protected, detailed custom picture settings cannot be adjusted
using the RC-V100. Unprotect the file (11 140).

Cannot adjust the custom picture settings using the RC-IP100/RC-IP1000 Remote Camera Controller.
- When the currently selected custom picture file is protected, detailed custom picture settings cannot be adjusted
using the RC-IP100/RC-IP1000. Unprotect the file (1] 140).

Connections with External Devices

Video noise appears on a nearby TV screen.
- When using the camera in a room where a TV is located, keep a distance between the AC adapter and the power or
antenna cables of the TV.

Network Functions

Check This First

¢ Are the camera, computer or other network devices all turned on?

e |s the camera properly powered on and ready for use? Is the PIN code correctly configured and entered if
required?

e |s the network working and correctly configured?

¢ Are all network devices correctly connected to the same network as the camera?

¢ When using a Wi-Fi network, are there any obstructions between the camera and the access point or
between the network device used and the access point?

Cannot connect with an access point.
- Check that the settings on the network device the camera is trying to connect with are correct.
- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal.
Refer to Precautions Regarding Wi-Fi Networks ([1] 253).

Cannot establish a Camera Access Point connection with a network device.
- When you reset all the camera settings, all network settings are lost as well. Set up the Camera Access Point settings
again (11 190).
- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal.
Refer to Precautions Regarding Wi-Fi Networks ([1] 253).
- If you cannot connect to the camera from a mobile device, change the [Network] setting to [Disable] and then change
it back to [Enable].
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Cannot transfer clips
- Canceling data transfer or opening the card compartment cover may cause an unexpected error due to inconsistency
with the connection destination. Reconnect the AC adapter or reattach the battery and turn the camera off and then
back on.
- Clips that have not been recovered cannot be transferred. Recover clips in advance ([] 46).
Cannot connect with a wired (Ethernet) network.
- Use a category 5e or better shielded twisted pair (STP) Ethernet cable.
- Try replacing the Ethernet cable.
- When you reset all the camera settings, all network settings are lost as well.
- Check that the network device to which the camera is connected is on and functioning properly. To use 1000BASE-T
connection speeds, make sure to use network devices compatible with Gigabit Ethernet (1000BASE-T).

The =25 (Ethernet) indicator is illuminated or flashing in red or is turned off.
- The Ethernet cable was disconnected or the camera cannot connect to the network device. Check the cable
connection and the network device.

The Browser Remote application will not start on the Web browser.
- Make sure to use a connection setting with the [Browser Remote] function setting.
- The URL entered into the Web browser’s address bar is incorrect. Select MENU > [#N Network Settings] >
[Connection Setting] > Connection setting in use > [Check Settings] and check the camera’s IP address. Use this IP
address as the URL ([1] 202).

The Browser Remote screen is not displayed correctly on the Web browser.
- The device, operating system or Web browser used may not be supported. For the latest information about supported
systems, visit your local Canon website.
- Enable JavaScript and cookies in your Web browser’s settings. For details, refer to the help modules or online
documentation of the Web browser used.
- Delete the cache and cookies for Browser Remote’s URL in your Web browser and restart Browser Remote.

Cannot start IP streaming.

- Verify that MENU > [#N# Network Settings] > [Activate IP Streaming] is set to [Enable] (11 200).

- If the IP streaming protocol is set to an option other than [RTSP+RTP], make sure the [Dest. IP Address] is set correctly
(11 186).

- IP streaming cannot be used in the following cases. Check the settings.
* When the main recording format is set to RAW.
* When slow & fast motion recording, pre-recording, relay recording or double slot recording is activated.
* When the system frequency is set to 24.00 Hz.

Cannot connect the optional XC Protocol compatible Remote Camera Controller or application.
- Make sure to use a connection setting with the [XC Protocol] function setting.
- Check that the settings on the Remote Camera Controller or application the camera is trying to connect with are
correct.

Precautions Regarding Wi-Fi Networks

When using a Wi-Fi network, try the following corrective actions if the transmission rate drops, the connection is
lost, or other problems occur.

Positioning a network device (access point, mobile device, etc.)
- When using a Wi-Fi network indoors, place the network device in the same room as the camera.
- Place the network device in an open, unobstructed location, where people or objects do not come between it and the
camera.
- Place the network device as close as possible to the camera. Change the height or facing of the network device, as
necessary.

About camera installation and setup when using the 2.4 GHz band.
The following operations may improve the communication status.
- Do not install the handle unit so as not to block the signal.
- When using Browser Remote, set the Browser Remote [Live view resolution] to [Small] ((T] 207).
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Nearby electronic devices
- If the transmission rate over a Wi-Fi network drops because of interference from the following electronic devices,
switching to the 5 GHz band or to a different channel may solve the problem.
- Wi-Fi networks using the IEEE 802.11b/g/n protocol operate in the 2.4 GHz band. For this reason, the transmission
rate may drop if there are nearby microwave ovens, cordless telephones, wireless microphones and Bluetooth or
similar devices operating on the same frequency band.

Using multiple cameras/wireless transmitters/access points

- Check that there are no IP address conflicts among the devices connected to the same network.

- If multiple cameras are connected to a single access point, connection speeds may be reduced.

- To reduce radio wave interference when there are multiple access points using IEEE 802.11b/g or IEEE 802.11n (in the
2.4 GHz band), leave a gap of four channels between each wireless access point. For example, use channels 1, 6, and
11, channels 2, 7, and 12, or channels 3, 8, and 13.

If you can use IEEE 802.11a/n/ac (in the 5 GHz band), switch to IEEE 802.11a/n/ac and specify a different channel,
leaving an appropriate gap between channels according to the wireless standard and frequency band used. For
example, when using IEEE 802.11ac (VHT80), leave a gap of 8 channels between access points.

List of Messages

Refer to this section if a message appears on the screen. The messages in this section appear in alphabetical
order. Note that for some messages, an indication of the recording media involved ([CFexpress], [SD Card] or a
combination thereof) may appear above the message itself.

Attached lens accessory not supported by the camera. It may not work properly.
- The attached lens accessory is not supported. Some functions may not work correctly.

Attached lens not supported by the camera. It may not work properly.
- The attached lens is not supported. Some functions may not work correctly.

Attached lens’s firmware must be updated for the lens to work properly with this camera.
- For details about available firmware updates for the lens used, visit your local Canon website.

Battery communication error. Does this battery display the Canon logo?
- You attached a battery pack that is not recommended by Canon for use with this camera.
- If you are using a battery pack recommended by Canon for use with this camera, there may be a problem with the
battery pack or camera. Consult a Canon Service Center.

Battery internal temperature is rising. Power supply from the battery may stop. Do not disconnect the AC adapter.
- Power supply from the battery may stop automatically if the internal temperature rises. Do not unplug the AC adapter

Buffer overflow. Recording was stopped.
- The data transfer rate was too high for the card in use and the recording was stopped. Use a recommended card
(1 43).

- Save your recordings and initialize the card ([11 45).

Camera ® Lens communication error. Clean the lens’s contacts and reattach the lens.
- The camera cannot correctly communicate with the lens due to dirty lens contacts. After the message disappears, the
1Ay icon appears on the screen. Clean the lens contacts with a soft cloth and reattach the lens.

Cannot play back
- The clip’s file control information is corrupted or there was a decoder error. Turn the camera off and then on again. If
this does not solve the problem, consult a Canon Service Center.
* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information cannot
be read by the software (Canon XF Utility or plugins for NLE applications).
- Played back a clip recorded with AAC audio format from approximately 1 to 2 frames before the final frame. Play back
using frame reverse/frame advance.

Cannot record at current bit rate.
- Check the main recording format, main resolution and the recording mode.

Cannot switch card slots
- There was an attempt to switch card slots while the camera is recording. Wait until recording is finished to change the
card slot.
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CFexpress / SD Card: Check the data.
- Cannot access the card. Check the card and make sure it is inserted correctly.
- A card error occurred and recording/playback is not possible. Try removing and reinserting the card or replace it.
- You inserted a MultiMedia Card (MMC) into the camera. Use a recommended SD card ([] 43).
- If after the message disappears, & or 5% appears in red, perform the following: Turn off the camera and remove and
reinsert the card. If &n or turns back to green you can resume recording/playback. If the problem persists, save
your recordings and initialize the card ([I1] 45).

CFexpress—>SD Card / SD Card—>CFexpress Will switch in a moment
- The card is almost full so recording will continue on the other card in approximately 1 minute.

CFexpress—>SD Card / SD Card—~>CFexpress Switched
- This message appears when recording continued from one card to the other.

Check the device or cable connected to the VIDEO terminal.
- Used exclusively for connection with the included LCD monitor. Use the included MC-5U Monitor Cable.

Check the remaining battery charge
- Low power warning.

Cover is open
- The card compartment cover is open. Insert a card and close the card compartment cover.

Currently, the accessory cannot be used
Please check the accessory power status
- Low remaining battery charge for the accessory attached to the multi-function shoe. Use a fully charged battery.

Currently, the accessory cannot be used
- There was a communication error between the camera and the accessory attached to the multi-function shoe. Turn
the camera off and then on again.

False color cannot be used when [Sensor Mode] is RAW recording in full frame, and [SDI Output Signal] is 3840x2160
or higher.
- False color cannot be used. Check the settings.

False color cannot be used when [Slow & Fast Frame Rate] exceeds 60 and [SDI Output Signal] is 3840x2160 or
higher.
- False color cannot be used. Check the settings.

Fan error
- The cooling fan may not be working properly. The camera will turn off automatically after a few minutes. Consult a
Canon Service Center.

File name error

- The clip number has reached its maximum value. Save your recordings and initialize the card ([ 45) or delete all the
clips (11 158).

- Photo numbers have reached their maximum value. Set MENU > [ % Recording/Media Setup] > [Photo Numbering] to
[Reset] and initialize the SD card ([I] 45) or delete all the photos ([11 158).

[Gamma/Color Space] ([HLG Color], [Over 100%] or [White Level 100%])
Look File not available because these settings are different from those registered with the Look File.

- A Look File is disabled if the [Gamma/Color Space], [HLG Color], [Over 100%] or [White Level 100%] settings are
changed after registering it. Restore the setting or register the Look file again.

If you change this setting, you will not be able to use the current Look File.

- The Look File’s adjustments to the image quality cannot be applied because the [Gamma/Color Space], [HLG Color],
[White Level 100%], [Over 100%] settings in the custom picture file are different from those registered with the Look
File. Change these settings or register a different Look File.

Invalid operation

- The following are not valid operations and cannot be performed.
¢ In MEDIA mode, during playback, trying to add a shot mark to a frame that has one already.
¢ Trying to add an [l mark and a [ mark to the same clip.
¢ Pressing the REC button when no cards are inserted in the camera.

Lens error Turn the camera off, then on again.

- There was a communication error between the camera and the lens. Turn the camera off and then on again.
Lens Power zoom adapter firmware update Firmware update failed. Try updating again.

- The power zoom adapter firmware update did not complete successfully. Try updating the lens’s firmware again.
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Low Power Warning Check the power supply.
- The input power supplied to the camera (DC IN 12V terminal) has reached the level set for the power level warning
(11 226). Check the power source.

- The message appears every time you press the REC button when the power supply is too low (as described above).

Magnification cannot be used when [Sensor Mode] is RAW recording in full frame, and [SDI Output Signal] is
3840x2160 or higher.
- Magnification cannot be used. Check the settings.

Management file error
- Cannot record because the camera cannot write to the file control information. This may occur if the files on the card
were accessed using another device. Save your recordings and initialize the card ([1] 45).

May not be possible to record clips on this media
- You may not be able to record clips on an SD card without a Speed Class rating or rated Class 2 or 4. Use a
recommended card ([] 43).
Media full
- The card is full. Replace the card or delete recordings ([1] 158) to free some space on the card.
- Recording will not start because the CFexpress card is full. Switch to the other card slot to record.
Media is almost full

- During relay recording, the combined space available on the CFexpress card and SD card is low.

- During double slot recording, the space available on the CFexpress card or SD card (the fullest one) is low.

- During normal recording, the space available on the CFexpress card or SD card (the card being used for recording) is
low.

- The amount of available space on the SD card is low. Replace the card or delete recordings ([J] 158) to free some
space on the card.

Memory card is write-protected
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
No clips
- There are no clips of the selected video format on the selected card.
No photos
- There are no photos on the SD card.
Noise levels will rise on the image of the sub recording and on video outputs not in RAW.

- The main recording format is set to RAW and the gamma curve component of the [Gamma/Color Space] setting in the
custom picture file is set to an option other than [Canon Log 2] or [Canon Log 3]. Under such conditions, there may be
more noise on the recorded proxy clips (SD card) and on video output from the various terminals.

Number of clips already at maximum

- The card selected for recording already contains the maximum number of clips (9999 clips). Replace the card or use
the other card slot.

- Because both cards reached the maximum number of clips, double slot recording is not available.

Number of Shot Marks at maximum

- The shot mark could not be added because the clip already contains 100 shot marks.

Peaking and zebra cannot be used at the same time when [Sensor Mode] is RAW recording in full frame, and [SDI
Output Signal] is 3840x2160 or higher.
- Peaking and zebra cannot be used at the same time. Check the settings.
Peaking and zebra cannot be used at the same time when [Slow & Fast Frame Rate] exceeds 60 and [SDI Output
Signal] is 3840x2160 or higher.
- Peaking and zebra cannot be used at the same time. Check the settings.
Power Zoom Adapter Check the power supply.
- The power zoom adapter’s remaining battery charge is low. Replace the power zoom adapter’s batteries.
Power Zoom Adapter Temperature too high. Cannot perform task.

- The power zoom adapter cannot be operated because its temperature is too high. Stop using the power zoom adapter

and let it cool down before using it again.

RAW recording to SD card is not possible.
- Change the main recording destination.
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Recommend checking the data and initializing
- The card cannot be used for any of the following reasons. Save your recordings and initialize the card ([1] 45).
e A problem has occurred with the card.
® The camera cannot read the data on the card.
* The card was initialized using a computer.
e The card is partitioned.
e The file version is different.
Recommended settings for attached lens:
Sensor Mode: Full Frame
Digital I1S: Off
Main Resolution: 3840x2160 or higher
- Adjust the menu settings as indicated in the message.

Recorded at 50.00 Hz (24.00 Hz, 59.94 Hz)

CFexpress / SD Card: Recommend checking the data and initializing
- The card contains clips that were recorded using a system frequency different from the one currently used by the
camera. To record on this card, save your recordings and initialize the card with the camera ([1 45). To play back the
XF-AVC / XF-AVC S / XF-HEVC S clips recorded on the card, change the camera’s system frequency ([11 65) to match
the recordings on the recording media.

Recording was stopped.

- The file control information is corrupted or there was an encoder error. Turn the camera off and then on again. Then,
remove the card being used and reinsert it. Alternatively, replace the card. If this does not solve the problem, consult a
Canon Service Center.

* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information cannot
be read by the software (Canon XF Utility or plugins for NLE applications).
Set the lens to the shooting position.

- The collapsible lens attached to the camera is not set to the shooting position (with the barrel extended and locked).

Set the lens to the shooting position.

Some clips require data recovery
- The power may have been suddenly turned off or the card may have been removed while the camera was recording.
As a result, one or more clips contain corrupted data. You can try to recover the clips ([1] 46).

The following cannot be used when this battery is installed.
[Communication by LENS terminal]
[Power multi-function shoe from camera]

- Attach a BP-AB0N (included) or an optional BP-A30N battery.

The following settings were changed.
- The settings displayed on the screen were changed automatically due to a change in one of the [ £% Recording/Media
Setup] settings. Check the settings before you continue recording.

The management file’s version is different. Recommend full backup and initializing.
- Perform a full backup and initialize the card.

The memory card is not compatible with the current recording settings.

- The frame rate for slow recording (slow & fast motion recording) was selected but the SD card used does not have a
Video Speed Class of V90.

- An SD card with a Video Speed Class other than V90 was inserted into the card slot when the main recording format
was [XF-AVC YCC422 10 bit] or [XF-AVC S YCC422 10 bit], and the main resolution was 4096x2160 (Intra-frame) or
3840x2160 (Intra-frame).

- An SD card with a Video Speed Class other than V60/V90 was inserted into the card slot when the main recording
format was [XF-AVC YCC422 10 bit] or [XF-AVC S YCC422 10 bit] and the main resolution was Intra-frame.

- An SD card with a Video Speed Class other than V60/V90 was inserted into the card slot when the main recording
format was [XF-AVC YCC422 10 bit], [XF-HEVC S YCC422 10 bit] or [XF-AVC S YCC422 10 bit] and the main
resolution was 4096x2160 or 3840x2160.

The number of ND filters used has changed. Check the focus.
- When using ND filter settings in the extended range (8 stops or 10 stops), the number of ND filters used changes and
this may result in a shift in focus. Check the focus before resuming shooting.

The video configuration was changed. Check the settings.
- Following the last change made to the recording/media settings, some of the video configuration settings were
changed automatically by the camera. Check the settings before you continue recording.
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This function is not compatible with the current lens.
- The selected setting is not compatible with the lens currently attached to the camera and cannot be used.
This photo cannot be displayed
- You may not be able to display photos taken with other devices or image files created or edited on a computer.
Unable to recover data
- Could not recover the selected clip. Save your clips and delete the clips that could not be recovered ([1] 158).
- The camera may not be able to recover clips when there is not enough space on the card. Delete recordings (11 158)
to free some space.
Using a fast shutter (approx. equivalent to 1/250 shutter speed) is recommended for handheld shooting.
- A telephoto lens without optical IS was attached. When shooting handheld, subject blur (where the subject appears
momentarily out of focus) may become noticeable. It is recommended to use a faster shutter speed.
With the current combination of lens and mount adapter, some functions' performance may not be precise. Visit your
local Canon web site for details.
- With the current combination of lens and mount adapter used, the focal length and aperture value displayed by the
camera may not be accurate and should be considered only as a reference. Additionally, some functions may not work
as precisely.

Network Functions

Along with this list, refer also to the instruction manuals of the access point or other external devices you are
using.
A streaming error occurred.
- CV protocol data could not be sent to the receiver. Check the receiver’s [Destination Server] and [Dest. Port No.]
settings on the camera.
A user with the same login name is already accessing the camera.
- This message appears on the screen of the connected device. Another device connected to the network is already
operating the camera. To use this device, first end the connection on the device accessing the camera.
Another device with the same IP address already connected to the network.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting
device or the camera.
- When using a network with a DHCP server, if the camera’s IP address assignment is set to [Manual Setting], change it
to [Automatic Setting] (11 192).
Communication with Frame.io failed.
- Check if there are any issues with the network connection or Frame.io.
Connection refused by FTP server.
- The FTP server is set to allow connections only with specific IP addresses. Check the camera’s IP address ([I] 193),
and add it to the FTP server’s permission list settings.
Error code returned from the FTP server for the data session.
- The FTP server terminated the connection. Restart the FTP server.
- Change the file access permission settings on the FTP server to allow reading, writing and accessing logs.
- Allow access permissions to the selected destination folder on the FTP server.
- Check that the FTP server is turned on and working properly.
- Check that there is enough available space on the storage device (hard disk drive, etc.)
Ethernet connection lost.
- Check that any network hubs, routers and servers are turned on and working properly.
Failed to add to upload queue
- Upload request to Frame.io failed. Check the network connection or any problems with Frame.io.
File access error occurred during Frame.io upload.
- Check the SD card:
® The memory card cover may be open.
¢ A compatible card must be used ([1] 43).
e |Initialize the card ([11] 45) when you use it with the camera for the first time.
e The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
¢ The card is full. Replace the card or delete recordings ([1] 158) to free some space on the card.
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File transfer completion was not confirmed by FTP server.
- The camera did not receive a transfer completion notification from the FTP server for an unknown reason. Turn the
camera and FTP server off and then on again and try the file transfer again.

Firmware download failed.
File is write-protected.
- A file with the same name on the SD card is write-protected. Delete the corresponding file.

Incorrect Wi-Fi password.
- Set the correct encryption key on the camera and the access point. If the authentication method is set to [Open
System], the error message [Unable to connect to FTP server.] may appear.

Invalid root certificate.
- Check the date and time settings on the camera.
- The root certificate has expired. Load a root certificate from MENU > [#A# Network Settings] > [Frame.io] > [Root
Certificate] > [Read Root Certificate].

Multiple access points detected. Unable to connect. Retry from the beginning.
- Other Wi-Fi devices are using the WPS function (push button method) to connect. Try the operation again or use other
methods to configure the network ([11 189).

No address assigned by the DHCP server.

- The camera is set to automatic IP address assignment. If the selected network does not use a DHCP server, change
the camera’s IP address assignment to [Manual Setting] and configure the IP address ([11 192).

- Check the DNS server.
e Check that the DHCP server is turned on and working properly.
* Make sure the DHCP server has enough IP addresses to assign.

- Check the network.
¢ Check if a router with an active gateway function is not being used on the network you are trying to connect to.
e Set the correct gateway address on the camera and on all the devices connected to the same network.
e Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the

camera’s network settings.

No response from access point.
- Check that the access point is working properly.
- Refer to Precautions Regarding Wi-Fi Networks ([11 253) and check if there are applicable steps you can take.

No response from DNS server.
- The camera is set to automatic IP address assignment. If the selected network does not use a DNS server, change the
camera’s DNS address to [Disable] and configure the IP address ([J1 192).
- Enter the same IP address of the DNS server used in the camera’s network settings.
- Check the DNS server.
e Check that the DNS server is turned on and working properly.
* On the DNS server, set the correct IP address and the name corresponding to the same address.
- Check the network.
e Check if a router with an active gateway function is not being used on the network you are trying to connect to.
¢ Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the
camera’s network settings.
¢ Set the correct gateway address on the camera and on all the devices connected to the same network.

No Wi-Fi network found with the selected SSID.
- Check the access point’s SSID (network name) and make sure the same name is used in the camera’s settings.
- Check that the access point is working properly and try again.

Pairing with Frame.io is disabled. Re-pair.
- The pairing has expired or was canceled from the menu settings. Select MENU > [#AA# Network Settings] > [Frame.io]
> [Pair] to re-pair.
Security of server connection cannot be verified. To always trust this server and connect, set [Trust Destination
Server] to [Enable].

- Check that the necessary certificate is correctly configured.
- To trust and use this server even without the proper certificate, set [Trust Destination Server] to [Enable].

The camera’s temperature is too high. Wi-Fi connection terminated.
- The network connection has been terminated because the camera’s internal temperature is too high. Turn off the
camera and wait until the temperature has decreased.
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Unable to connect to access point. Retry from the beginning.
- To configure a new network connection using the WPS function (push button method), refer to the access point’s
instruction manual and check how to activate the WPS function on the wireless router.

Unable to connect to access point.
- The camera’s encryption method is different from that of the access point. Change the settings on the camera to
match the access point.

Unable to connect to FTP server. Error code returned.
- The maximum number allowed of connections to the FTP server was reached. Reduce the number of network devices
connected to the FTP server or increase the number of connections allowed.

Unable to connect to FTP server.
- Enter the correct address for the FTP server in the camera’s network settings.
- The authentication method is set to [Open System] but the encryption key is incorrect. Check uppercase/lowercase
letters and other characters and make sure to enter the correct encryption key.
- The default port number is 21 (or 22 for SFTP transfers). Check the FTP server’s port number and enter the same port
number in the camera’s network settings.
- Check that the server name of the selected FTP server is correctly configured on the DNS server and that the same
name is used also in the camera’s network settings.
- Check the FTP server.
® Check that the FTP server is turned on and working properly.
* Check that the correct IP address assigned to the FTP server is the same as the FTP server’s IP address in the
camera’s network settings.
e Access to the FTP server may be protected by a firewall due to security software or broadband routers. Change the
firewall’s settings to allow connection to the FTP server.
¢ You may be able to access the FTP server by setting the camera’s passive mode to [Enable] (1] 184).
e Contact the network’s administrator and obtain the correct IP address and port number for the FTP server. Enter the
same information in the camera’s network settings.
- Check the network.
e Check if a router with an active gateway function is not being used on the network you are trying to connect to.
e Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the
camera’s network settings.
¢ Set the correct gateway address on the camera and on all the devices connected to the same network.

Unable to disconnect from FTP server. Error code returned.
- The camera could not disconnect from the FTP server for an unknown reason. Turn the camera and FTP server off and
then on again.

Unable to log in to FTP server. Error code returned.
- Check the FTP server’s [User Name] and [Password] in the camera’s network settings.
- Change the file access permission settings on the FTP server to allow reading, writing and accessing logs.
- Change the destination folder so the path includes only ASCII characters.

Wi-Fi authentication unsuccessful

- The camera’s authentication mode and/or encryption key are different from those of the access point. Change the
settings on the camera to match the access point.

Wi-Fi connection lost.
- The camera could not connect to the access point or network device.
- The wireless signal may be affected by nearby cordless telephones, microwave ovens, refrigerators or other devices.
Operate the camera in a place more distant from such interference.

Wi-Fi error. Incorrect encryption method.
- Make sure the camera and access point are using the same authentication/encryption method.
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Access Log

When security-related settings are changed or when device authentication/user authentication fails
consecutively, the information is saved as an access log in the camera. From a security perspective, it is
recommended to regularly check the access logs ([11 226). 261

Access Log List

Access Log Description
Change PIN code The PIN code was changed.
Update PIN code request setting The PIN code request setting was enabled/disabled.
Update Browser Remote settings The browser remote user name/password was changed, or HTTP/HTTPS were switched.
Update Function settings The RTSP user name/password was changed.
Update XC Protocol settings The XC Protocol authentication method/port number/user name/password was changed, or
HTTP/HTTPS were switched.
Update Communication settings The Camera Access Point password or Wi-Fi connection parameters were changed.
Update Connection settings The network connection settings (SET) were changed.
Update FTP root certificate The root certificate for FTP transfer was changed or deleted.
Update 802.1X authentication The root certificate for 802.1X authentication was changed or deleted.
Update Frame.io root certificate The root certificate for Frame.io upload was changed or deleted.
Save Camera settings on camera Menu/Custom Picture settings were saved to the camera.
Save Camera settings on card Menu/Custom Picture settings were saved to the SD card.
Load Camera settings from camera Menu/Custom Picture settings were loaded from the camera.
Load Camera settings from card Menu/Custom Picture settings were loaded from the SD card.
Reset all settings The camera’s settings were reset or the firmware was updated.
Maximum PIN code attempts exceeded An incorrect PIN code was entered consecutively.
Browser Remote Login Fail Failed to log in consecutively with Browser Remote.
IP Streaming Login Fail Failed to log in consecutively with IP Streaming.
XC Protocol Login Fail Failed to log in consecutively with XC Protocol.

(1) NoTES

e The access log is cleared when you reset the camera's settings.
¢ \When the number of access logs exceeds 100, the oldest ones will be deleted.
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Handling Precautions

Camera

Be sure to observe the following precautions to ensure maximum performance.

e Do not use or store the camera in dusty or sandy places. The camera is not waterproof — avoid also water,
mud or salt. If any of the above should get into the camera it may damage the camera and/or the lens. Consult
a Canon Service Center as soon as possible.

Be careful to avoid dust and dirt particles accumulating on the lens or entering the camera. When you finish
using the camera, make sure to attach the body cap to the lens mount and the lens cap and dust cap to the
lens.

Do not use the camera near strong electromagnetic fields such as near powerful magnets and motors, MRI
machines or high-voltage power lines. Using the camera in such places may cause anomalies in the video, or
audio/video noise.

¢ Do not point the camera toward an intense light source, such as the sun on a sunny day or an intense artificial
light source. Doing so may damage the image sensor or the camera’s internal components. Be especially
careful when using a tripod or shoulder strap. When you are not using the camera, make sure to attach the
lens cap to the lens.

Do not carry the camera by the LCD monitor. Be especially careful of the LCD monitor’s position when
transporting or storing the camera.

Do not touch the lens contacts on the lens mount. Dirty contacts may cause a poor
contact between the camera and the lens resulting in incorrect operation of the
camera. After removing the lens, make sure to attach the body cap to the lens mount
and the lens cap and dust cap to the lens.

About cables connected to the SDI OUT ([1 167), MON. ([11 168) and G-LOCK/
SYNC/RET ([Z1 100, 108) terminals

Connect the power supply or the battery to the camera (and devices connected to the camera) before
connecting cables. Also, be sure to disconnect the cables before removing the power supply or the battery.

Long-term storage
If you do not intend to use the camera for a long time, store it in a place free of dust, in low humidity, and at
temperatures not higher than 30 °C (86 °F).

Battery Pack

DANGER!

Treat the battery pack with care.
e Keep it away from fire (or it might explode).

¢ Do not expose the battery pack to temperature higher than 60 °C (140 °F). Do not leave it near a heater or
inside a car in hot weather.

* Do not try to disassemble or modify it.
e Do not drop it or subject it to shocks.
e Do not get it wet.

¢ Dirty terminals may cause a poor contact between the battery pack and the camera. Wipe the terminals with a
soft cloth.
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Long-term storage

e Store battery packs in a dry place at temperatures no higher than 30 °C (86 °F).

e Before storing battery packs, charge them until two lamps (on the indicator on top of the battery) illuminate
(@ 27).

e Charge all your battery packs fully at least once every six months.
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Always attach the battery terminal cover.

Do not allow any metal objects to touch the terminals (Figure 1), as this can
cause a short circuit and damage the battery pack. Attach the terminal cover
whenever the battery pack is not being used (Figure 2).

The battery terminal cover has a [[—_1]-shaped hole. This is useful when you
wish to differentiate between charged and uncharged battery packs. For
example, with charged battery packs, attach the terminal cover so that the

=

[]-shaped hole shows the colored label. @

Figure 1 Figure 2

Terminal cover attached
Back side of the l v

battery pack Charged Uncharged
)
e
(@} <)
I§ ()

Remaining battery time

The correct remaining battery time may not be displayed if a fully charged battery pack is used continuously in
high temperatures or is left unused for long periods of time. Also, the correct remaining time may not be
displayed, depending on the battery life. Use the time shown on the screen as an approximation.

Lithium Button Battery

WARNING!

e The battery used in this device may present a fire or chemical burn hazard if mishandled.
¢ Do not disassemble, modify, immerse in water, heat above 100 °C (212 °F) or incinerate the battery.

e Do not insert the battery into the mouth. If swallowed, seek medical assistance immediately. The battery
case may break and the battery fluids may cause internal injuries.

e Keep the battery out of the reach of children.
¢ Do not recharge, short-circuit or insert the battery in the wrong direction.

¢ Dispose of the used battery according to applicable recycling regulations. In Europe, the used battery
should be returned to the supplier for safe disposal.

¢ Do not pick up the battery using tweezers or other metal tools, as this will cause a short circuit.
¢ Wipe the battery with a clean dry cloth to ensure proper contact.
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Recording Media

e Periodically backing up recordings from the cards used to a computer is recommended. Data may be
corrupted or lost due to defects or exposure to static electricity. Canon shall not be liable for lost or corrupted
data.

e Do not touch or expose the terminals to dust or dirt.

® Do not use cards in places subject to strong magnetic fields.

® Do not leave cards in places subject to high humidity and high temperature.

e Do not attach any labels or stickers on the cards.

e Do not disassemble, bend, drop, or subject cards to shocks and do not expose them to water.

Disposal

When you delete data on a card, only the file allocation table is altered and stored data is not physically erased.
Take the necessary precautions when you dispose of the card, for example by physically damaging it to prevent
the leakage of private data.

If giving the card to another person, initialize it. Fill it up with unimportant recordings, and then initialize it again.
This makes recovering the original recordings very difficult.

Built-in Backup Battery

The camera has a built-in rechargeable lithium battery to keep the date/time and other settings. The built-in
backup battery is recharged while you use the camera; however, it will be depleted completely if you do not use
the camera for about 3 months.

To recharge the built-in backup battery: Turn off the camera and attach a power source (sufficiently charged
battery or DC IN 12V terminal). The built-in backup battery will be fully charged in approx. 24 hours.
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Maintenance/Others
Cleaning

Camera body

e Use a soft, dry cloth to clean the camera’s body. Never use chemically treated cloths or volatile solvents such
as paint thinner.

Lens
* Remove any dust or dirt particles using a non-aerosol type blower.
¢ Use a clean, soft lens-cleaning cloth to gently wipe the lens. Never use tissue paper.

LCD screen
¢ Clean the LCD screen using a clean, soft lens-cleaning cloth and commercially available cleaning fluid for
eyeglasses.

e Condensation may form on the surface of the screen when the temperature changes suddenly. Wipe it with a
soft dry cloth.

Condensation

Moving the camera rapidly between hot and cold temperatures may cause condensation (water droplets) to form
on its internal surfaces. Stop using the camera if condensation is detected. Continued use may damage the
camera. Condensation may form in the following cases:

¢ \When the camera is moved quickly from cold to warm places
¢ \When the camera is left in a humid room
¢ \When a cold room is heated rapidly

When condensation is detected

Disconnect the battery or AC adapter. The precise time required for water droplets to evaporate will vary
depending on the location and weather conditions. As a general rule, wait for 2 hours before resuming use of the
camera.

To avoid condensation
Remove the battery pack and any cards. Then, place the camera in an airtight plastic bag and let it adjust
gradually to temperature changes before removing it from the bag.

Using the Camera Abroad

Power Sources

You can use the battery charger and compact power adapter to charge battery packs in any country/region with
power supply between 100 and 240 V AC, 50/60 Hz. Consult a Canon Service Center for information on plug
adapters for overseas use.
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Optional Accessories

The following optional accessories are compatible with this camera. The availability differs from area to area.
For details on using the optional accessories and on their specifications, refer also to the Cinema EOS System
266 Expansion User Guide (PDF file), available from your local Canon website.

1 1 1 ] CG-A20 Battery Charger
BP-A30N', BP-A60N BP-A30', BP-A60 CG-A10 Battery Charger and CA-CP300 B Compact
Battery Pack Battery Pack Power Adapter

PL-RF Mount Adapter MC-5U Monitor Cable RC-V100 RC-1P100
Remote Controller Remote Camera Controller

RC-IP1000 DM-E1D Multi-Function Shoe OC-E4A IFC-100U / IFC-400U
Remote Camera Controller Directional Stereo Microphone Off-Camera Shoe Cord Interface Cable

" These battery packs are Intelligent Lithium-ion batteries. The camera can communicate with the battery pack and display a more
accurate approximate remaining usage time (in minutes). The following functions are not available when the BP-A30/BP-AB0 is in

use.
e Communication via the LENS terminal
® Power supply from the camera to multi-function shoe

For our customers in the USA: Call or visit your local retailer/dealer for genuine Canon video accessories. You
can also obtain genuine accessories for your Canon camera by calling: 1-800-828-4040, Canon U.S.A.
Information Center.

e This mark identifies genuine Canon video accessories. When you use Canon video equipment, we
§ recommend Canon-brand accessories or products bearing the same mark.




Specifications

System

Clips:
RAW
Video format:
Audio format:
File format:
XF-AVC

Video compression:

Audio format:
File format:
XF-AVC S, XF-HEVC S

Video compression:

Audio format:
File format:

WAV
Audio format:

File format:

Specifications

Cinema RAW Light
Linear PCM, 24 bit, 48 kHz, 4 channels
CRM (Canon RAW Movie; Canon proprietary file format)

MPEG-4 AVC / H.264
Linear PCM, 24 bit, 48 kHz, 4 channels
MXF

XF-AVC S MPEG-4 AVC / H.264, XF-HEVC S HEVC / H.265
Linear PCM, 24 bit, 48 kHz, 4 channels

MPEG-2 AAC-LC, 16 bit, 48 kHz, 2 channels

MP4

Audio files for slow & fast motion recording
Linear PCM, 24 bit, 48 kHz, 4 channels

Audio files for second card recording functions
Linear PCM, 16 bit, 8 kHz, 1 channel

BWF

Photos: DCF (Design rule for Camera File system), compatible with Exif Ver. 2.31, JPEG compression

e Video Configuration (recording/playback)

Primary clips:
RAW

Bit rate:

Resolution:

Color bit depth:

Frame rate:
XF-AVC

Bit rate:

Resolution:
Color sampling:
Frame rate:

XF-AVC S, XF-HEVC S
Bit rate:

2730 Mbps, 2290 Mbps, 2280 Mbps, 2180 Mbps, 2160 Mbps, 2130 Mbps,
1910 Mbps, 1800 Mbps, 1780 Mbps, 1730 Mbps, 1380 Mbps, 1340 Mbps,
1160 Mbps, 1150 Mbps, 1130 Mbps, 1120 Mbps, 1080 Mbps, 1070 Mbps,
954 Mbps, 939 Mbps, 916 Mbps, 915 Mbps, 886 Mbps, 871 Mbps,

850 Mbps, 732 Mbps, 727 Mbps, 698 Mbps, 697 Mbps, 690 Mbps, 611 Mbps,
576 Mbps, 574 Mbps, 563 Mbps, 553 Mbps, 552 Mbps, 479 Mbps, 470 Mbps,
451 Mbps, 366 Mbps, 306 Mbps, 293 Mbps, 287 Mbps, 283 Mbps, 240 Mbps,
236 Mbps, 230 Mbps, 184 Mbps, 154 Mbps, 142 Mbps, 118 Mbps, 114 Mbps,
113 Mbps, 92 Mbps, 77 Mbps, 74 Mbps

6000x4000, 6000x3164, 4368x2304, 2184x1152

12 bit

59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

1200 Mbps, 1000 Mbps, 900 Mbps, 750 Mbps, 600 Mbps, 500 Mbps,

480 Mbps, 450 Mbps, 375 Mbps, 360 Mbps, 300 Mbps, 250 Mbps, 240 Mbps,
150 Mbps, 125 Mbps, 120 Mbps / Intra-frame

250 Mbps, 150 Mbps, 50 Mbps, 25 Mbps / Long GOP

4096x2160, 3840x2160, 2048x1080, 1920x1080

YCbCr 4:2:2, 10 bit

59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00F, 24.00P, 23.98P

XF-AVC S

1200 Mbps, 1000 Mbps, 900 Mbps, 750 Mbps, 600Mbps, 500 Mbps,

480 Mbps, 450 Mbps, 375 Mbps, 360 Mbps, 300 Mbps, 250 Mbps, 240 Mbps,
150 Mbps, 125 Mbps, 120 Mbps / Intra-frame

250 Mbps, 150 Mbps, 100 Mbps, 50 Mbps, 35 Mbps / Long GOP
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XF-HEVC S
225 Mbps, 150 Mbps, 135 Mbps, 100 Mbps, 50 Mbps, 35 Mbps
Resolution: 4096x2160, 3840x2160, 2048x1080, 1920x1080
Color sampling: XF-AVC S XF-AVC S YCC422 10 bit, XF-AVC S YCC420 8 bit,
268 XF-HEVC S YCC422 10 bit, XF-HEVC S YCC420 10 bit
— Frame rate: 59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P
Proxy clips:
XF-AVC
Bit rate: 35 Mbps / Long GOP
Resolution: 2048x1080, 1920x1080
Color sampling: YCDbCr 4:2:0, 8 bit
Frame rate: 59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P
XF-AVC S, XF-HEVC S
Bit rate: 16 Mbps, 9 Mbps, 6 Mbps / Long GOP
Resolution: 2048x1080, 1920x1280, 1920x1080, 1280x720
Color sampling: 4:2:0 10 bit, 4:2:0 8 bit
Frame rate: 59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

¢ Recording Media
Clips (RAW): CFexpress cards compliant with CFexpress 2.0 Type B specifications
Clips (all main recording formats) / photos: SD, SDHC (SD High Capacity) or SDXC (SD eXtended Capacity)
cards'
1 Used also to save/read other files in addition to proxy files.

¢ Image Sensor
Full frame back-illuminated stacked CMOS sensor
Total number of |oixels1 (approximate): 26,700,000 pixels
Maximum effective camera |oixe|s1 (approximate): 24,100,000 pixels
1 Rounded to the nearest 10,000.

e Lens Mount
Canon RF mount
- RF lenses (including RF-S lenses/RF Cinema lenses)
- EF lenses (Including EF-S lenses/EF Cinema lenses, when using the EF-EOS R Mount Adapter)
- PL lenses (when using a PL-RF Mount Adapter)

¢ Approximate lens multiplication factor (for 35mm equivalent focal length)
[Full Frame 3:2] sensor mode:
Actual focal length x 1.00% when the horizontal resolution is 6000
[Full Frame] sensor mode:
Actual focal Iength1 x 1.062 when the horizontal resolution is 6000 / 4096 / 2048
Actual focal Iength1 x 1.122 when the horizontal resolution is 3840 / 1920
[Super 35mm (Cropped)] sensor mode:
Actual focal length! x 1.46° when the horizontal resolution is 4368 / 4096 / 2048
Actual focal length? x 1.542 when the horizontal resolution is 3840 / 1920
[Super 16mm (Cropped)] sensor mode:
Actual focal Iength1 x 2.922 when the horizontal resolution is 2184 / 2048
Actual focal Iength1 x 3.072 when the horizontal resolution is 1920
1" Lens focal length
Conversion factor
¢ Lens Correction
Peripheral illumination/chromatic aberration/diffraction/distortion aberration correction is available? for Canon
RF/EF lenses and RF/EF Cinema lenses. Only RF lenses/RF cinema lenses support distortion correction.
2 Some lenses are not compatible with in-camera correction.

e Shutter Speed
Speed (1/3-stop increments, 1/4-stop increments), angle, clear scan, slow, off
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Iris
Manual (1/2-stop increments, 1/3-stop increments, fine adjustment available), push auto iris, automatic
aperture

ISO Speed/Gain

[Automatic] and [Manual] settings.

ISO speed ([1 stop] and [1/3 stop] settings): 100 to 102400
Gain ([Normal] and [Fine] settings): -6 dB to 54 dB

ND Filter: Built-in (Off, 2, 4, 6, 8* or 10% stops), motor operated

4 With extended ND range.

Exposure: AE shift, light metering modes (standard, spotlight, backlight)
White Balance

Custom white balance (two sets, A and B); two preset settings (daylight, 5,600 K5 and tungsten lamp,
3,200 K9); color temperature setting (2,000 K to 15,000 K); automatic white balance (AWB)

Color temperature and color compensation (CC) adjustment available for all settings except custom white

balance and AWB.
5 Color temperatures are approximate and given only as a reference.

Focus
Manual focus, autofocus (one-shot AF, continuous AF, subject detection AF); subject tracking available
AF type: Dual Pixel CMOS AF

Sensor Sensitivity (ISO 800, 2000 lux, 89.9% reflection)

59.94 Hz: F10 (59.94P), F14 (29.97P)

50.00 Hz: F11 (50.00P), F16 (25.00P)

Wi-Fi

Wireless standard: IEEE 802.11b/g/n (2.4 GHz band), IEEE 802.11a/n/ac (5 GHz band)

Connection methods:  Infrastructure (Wi-Fi Protected Setup (WPS), search for access points, manual),
Camera Access Point

Authentication methods: Open, shared key, WPA/WPA2/WPAS3-Personal, WPA/WPA2/WPAS3-Enterprise

Encryption methods: WEP-64, WEP-128, TKIP, AES

Built-in Microphone: Monaural electret condenser microphone
Size of Photos: 4096x2160, 3840x2160, 3240x2160, 2048x1080, 1920x1080

Input Terminals

MIC Terminal

& 3.5 mm stereo mini-jack (unbalanced, supports plug-in power)
Sensitivity: =72 dBV (auto volume, full scale -18 dB)
Attenuator: 20 dB
Plug-in power supply: 2.4 V DC (bias resistance 2.2 kQ)
During LINE: =12 dBV (volume center, full scale —18 dB)

REMOTE Terminal
& 2.5 mm stereo sub-mini jack

INPUT Terminals (INPUT 1 and INPUT 2)
Mini XLR 3-pin jack (pin1: shield, pin2: hot, pin3: cold), balanced
MIC
Input impedance: 600 Q
Sensitivity: =60 dBu (volume center, full scale —18 dB)
Attenuator: 20 dB
LINE
Input impedance: 10 kQ
Sensitivity: +4 dBu (volume center, full scale —18 dB)
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e GRIP Terminal
USB Type—C® jack, Canon proprietary signal (for connection to the included camera grip)

Output Terminals

e MON. Terminal
BNC jack
Video: HD: SMPTE 292
3G: SMPTE 424, SMPTE 425
Audio: SMPTE ST 299-1, SMPTE ST 299-2
Output signal level: 0.8 Vp-p
Output impedance: 75 Q
Others: The 3G-SDI mapping method can be selected from the menu.

¢ VIDEO Terminal
usB Type-C® jack, Canon proprietary signal (for connection to the included LCD monitor)

e SDI OUT Terminal
BNC jack

Video: HD: SMPTE 292
3G: SMPTE 424, SMPTE 425
6G: SMPTE ST 2081
12G:SMPTE ST 2082

Audio: SMPTE ST 299-1, SMPTE ST 299-2

Output signal level: 0.8 Vp-p

Output impedance: 75 Q

Others: The 3G-SDI mapping method can be selected from the menu.

e HDMI OUT Terminal
HDMI connector (type A)
The time code signal can be output (proprietary standard)
Video/audio output: Conforming to HDMI specifications.

¢ () (Headphone) Terminal
& 3.5mm stereo mini-jack
Output signal level: =17 dBV (32 Q load, Max volume)

Input/Output Terminals

e USB Terminal
usB Type—C® jack, equivalent to SuperSpeed USB (USB 3.2 Gen 1x1), smartphone/GP-E2 connection
supported.

e TIME CODE Terminal
DIN 1.0/2.3 jack
Input Input impedance: 100k Q
Signal level: 0.5 - 4.5 Vp-p
Output Output impedance: 50 Q
Signal level: 1.3 Vp-p

e G-LOCK/SYNC/RET Terminal
DIN 1.0/2.3 jack
Input
For [Genlock Input]
Signal level: 1.0 Vp-p
Input impedance: 75 Q
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For [RET Input]

Video: 3G-SDI (SMPTE 424, SMPTE 425 compliant)
HD-SDI (SMPTE 292 compliant)
Signal level: 0.8 Vp-p
Input impedance: 75 Q
Output

For [HD Sync Output]
Signal level: 1.0 Vp-p
Output impedance: 75 Q

e LENS Terminal
Circular 12-pin jack

e Ethernet Terminal
RJ45 connector (1000BASE-T supported)

Other Terminals

e DC IN 12V Terminal
XLR 4-pin jack

e Multi-Function Shoe Terminal
Proprietary Canon connector

Power/Others
e Power Supply (rated) =
Battery pack: 14.4\V DC GND (ground)—\ ¥~ 11.5V1020.0V
N o O DC
DC IN 12V terminal: N/A_&,o Ol)_N/A
XLR 4-pin jack (male connector), 11.5V t0 20.0 VDC, 10 A

(acceptable maximum load current)
e Operating Temperature: 0 — 40 °C (32 — 104 °F)

e Dimensions (W x H x D)®
Camera body only: 142 x 135 x 135 mm (5.6 x 5.3 x 5.3 in.)
Camera and camera grip, handle unit, LCD monitor, LCD attachment unit, microphone holder and battery.:
361 x 274 x 363 mm (14.2 x 10.8 x 14.3in.)

* Weight®
Camera body only: 1,540 g (3.4 Ib.)

Accessories

Handle Unit

e Multi-function shoe support

e Dimensions® (WxHxD): 79.5x90.4 x 167.8 mm (3.1 x 3.6 x 6.6 in.)
* Weight®: 300 g (10.6 0z.)

LCD Monitor

e |LCD Screen
8.8 cm (3.5 in.) color LCD, 16:9 aspect ratio, approx. 2,760,000 dots, 100% coverage, capacitive touch
screen operation
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¢ VIDEO Terminal
Proprietary connector for connection to the camera; input only

e Dimensions® (W x Hx D): 113 x 73 x 30 mm (4.4 x 2.9 x 1.2 in.)
o WeightG: 155g (6.5 0z)

LCD Attachment Unit

Includes pivots that allow for rotation

e Dimensions® (WxHxD): 114.7 x 108.9 x 149.4 mm (4.5 x 4.3 x5.91in.)
* Weight®: 260 g (9.2 oz.)

Camera Grip

Modular unit can be attached at any of 24 positions (6° intervals); includes limited recording controls.
e Dimensions® (WxHxD):59.8x132.8x74.8mm (2.4x5.2x2.9in.)

* Weight®: 270 g (9.5 0z.)

6 All dimensions and weights are approximate.

CG-A20 Battery Charger

e Rated Input: 24 VDC, 1.8 A

¢ Rated Output: 16.7 VDC, 1.5 A

e Operating Temperature: 0 — 40 °C (32 — 104 °F)

e Dimensions® (WxHxD): 100 x24 x 100 mm (3.9 x 0.9 x 3.91in.)
 Weight®: 145 g (5.1 0z.)

CA-CP300 B Compact Power Adapter (for the CG-A20)

e Rated Input: 100 - 240 V AC, 50/60 Hz, 0.88 A (100 V) - 0.43 A (240 V)
e Rated Output: 24 VDC, 1.8 A

e Operating Temperature: 0 — 40 °C (32 — 104 °F)

e Dimensions® (WxHxD):52.0x31.5x128.0mm (2.0x 1.2 x5.01in.)

* Weight®: 219 g (7.7 0z,

BP-AG60N Battery Pack

e Battery Type: Rechargeable lithium ion battery, compatible with Intelligent System
¢ Rated Voltage: 14.4V DC

¢ Rated Battery Capacity: 6,400 mAh / 93 Wh

e Operating Temperature: 0 — 40 °C (32 — 104 °F)

* Dimensions® (WxHxD):41.5x82.5x69.7mm (1.6 x3.2x2.7in.)

Weight®: 465 g (16.4 0z.)

6 All dimensions and weights are approximate.

Errors and omissions excepted.
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Approximate Recording Time on a Card

Reference Tables

Approximate times, for reference only, based on a single recording that continues until the card is full. Recording
times are determined by the bit rate used, which in turn is determined by various video configuration settings

(11 66). See the tables on the reference page for details.

Primary clips (CFexpress card)

Recording format
RAW

Bit rate 512 GB
2730 Mbps 23 min.
2290 Mbps 27 min.
2180 Mbps 29 min.
2160 Mbps 29 min.
2130 Mbps 29 min.
1730 Mbps 36 min.
1380 Mbps 46 min.
1340 Mbps 47 min.
1150 Mbps 55 min.
1130 Mbps 56 min.
1080 Mbps 58 min.
1070 Mbps 59 min.
915 Mbps 69 min.
871 Mbps 72 min.
850 Mbps 74 min.
732 Mbps 86 min.
697 Mbps 91 min.
690 Mbps 91 min.
574 Mbps 109 min.
563 Mbps 112 min.
552 Mbps 114 min.
451 Mbps 139 min.
366 Mbps 171 min.
293 Mbps 213 min.
287 Mbps 216 min.
283 Mbps 216 min.
230 Mbps 269 min.
184 Mbps 324 min.
142 Mbps 424 min.
113 Mbps 528 min.
92 Mbps 633 min.
74 Mbps 779 min.

Recording format Bit rate 512 GB
XF-AVC 1200 Mbps 53 min.
900 Mbps 70 min.

600 Mbps 104 min.

480 Mbps 131 min.

450 Mbps 140 min.

360 Mbps 174 min.

300 Mbps 206 min.

250 Mbps 245 min.

240 Mbps 259 min.

150 Mbps 406 min.

120 Mbps 502 min.

50 Mbps 1044 min.

25 Mbps 1943 min.

XF-AVC S 1200 Mbps 53 min.
900 Mbps 71 min.

600 Mbps 106 min.

480 Mbps 133 min.

450 Mbps 142 min.

360 Mbps 177 min.

300 Mbps 212 min.

250 Mbps 254 min.

240 Mbps 266 min.

150 Mbps 422 min.

120 Mbps 530 min.

100 Mbps 635 min.

50 Mbps 1237 min.

35 Mbps 1740 min.

XF-HEVC S 225 Mbps 282 min.
150 Mbps 422 min.

135 Mbps 471 min.

100 Mbps 635 min.

50 Mbps 1237 min.

35 Mbps 1740 min.
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Primary clips (SD card)

Recording format
XF-HEVC S

Bit rate 512 GB 128 GB
225 Mbps 282 min. 70 min.
150 Mbps 422 min. 105 min.
135 Mbps 471 min. 117 min.
100 Mbps 635 min. 158 min.
50 Mbps 1237 min. 309 min.
35 Mbps 1740 min. 435 min.

Recording format Bit rate 512 GB 128 GB
XF-AVC 600 Mbps 105 min. 26 min.
480 Mbps 131 min. 32 min.

450 Mbps 140 min. 35 min.

360 Mbps 174 min. 43 min.

300 Mbps 206 min. 51 min.

250 Mbps 245 min. 61 min.

240 Mbps 259 min. 64 min.

150 Mbps 406 min. 101 min.

120 Mbps 502 min. 125 min.

50 Mbps 1044 min. 261 min.

25 Mbps 1943 min. 485 min.

XF-AVC S 600 Mbps 106 min. 26 min.
480 Mbps 133 min. 33 min.

450 Mbps 142 min. 35 min.

360 Mbps 177 min. 44 min.

300 Mbps 212 min. 53 min.

250 Mbps 254 min. 63 min.

240 Mbps 266 min. 66 min.

150 Mbps 422 min. 105 min.

120 Mbps 531 min. 132 min.

100 Mbps 635 min. 158 min.

50 Mbps 1237 min. 309 min.

35 Mbps 1740 min. 435 min.

Charging Times

Charging times are approximate and vary according to charging conditions, ambient temperature and initial
charge of the battery pack.

Battery pack

Charging time using the supplied
CG-A20 Battery Charger

BP-AGON (supplied)

BP-A30N (optional)

310 min.

175 min.
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Approximate Usage Times with a Fully Charged Battery Pack

The recording times in the tables below are approximate and were measured recording on a CFexpress card
(single recording), using an RF50mm F1.8 lens and the LCD monitor/MON. terminal/SDI OUT terminal. Actual

times may vary.
Video configuration Recording times
Main recordin Power BP-AG6ON BP-A30N
Sensor mode g Resolution  Framerate Color depth Bit rate consumption ) )
format (supplied) (optional)
Full frame 6000x3164 2.13 Gbps 325W 155 min. 70 min.
RAW ST 12 bit
Super 35mm 4368x2304 1.13 Ghps 30.4W 165 min. 80 min.
(cropped) 50.94P
XF-AVC 4096x2160 ' 1.2 Gbps 31.6W 160 min. 75 min.
- YCC422 - ) )
10 bit 2048x1080 300 Mbps 29.7W 170 min. 80 min.

Maximum power consumption: 78 W
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Appendix: Compatible Lenses and Functions

Following is a list of lenses compatible with this camera and the various functions that can be used depending
on the lens. Depending on the lens’s purchase date, you may need to update the lens’s firmware to use these
276 functions. For details, visit your local Canon website or consult a Canon Service Center.

— PL mount lenses can only be used after attaching the optional PL-RF Mount Adapter. In addition, connection to

the LENS terminal on the camera or an external device is required.

L Iris control from the camera Zoom control from the
ens
Manual Push auto iris Automatic camera

RF lenses @2 @2 o’ ®°

EF lenses’ ™) ° _ ®°

EF lenses compatible with auto iris o o o -

RF / EF' Cinema lenses / PL! lenses

CN7x17 KAS S/E1*
CN10x25 IAS S/E14
CN20x50 IAS H/E1*
CN8x15 IAS S/E1*

CN-E18-80mm T4.4 LIS KAS S
CN-E70-200mm T4.4 L IS KAS S
CN7x17 KAS S/P1*

CN20x50 IAS H/P14

CN10x25 IAS S/P1*

CN8x15 IAS S/P1*

CN7x17 KAS T/P14

CN7x17 KAS T/R1

CN5x11 IAS T/P14

CN5x11 IAS T/R1

Manual focus lenses compatible with
focus guide

CN-E15.5-47mm T2.8 L S
CN-E15.5-47mm T2.8 L SP
CN-E30-105mm T2.8 L S
CN-E30-105mm T2.8 L SP

o { M o° o°

T A mount adapter is required.

2 Excluding RF600mm F11 IS STM and RF800mm F11 IS STM.
Only lenses with an attached PZ-E1 Power Zoom Adapter.

4 The EF response setting is not supported.

5 Only lenses with an attached PZ-E2/PZ-E2B Power Zoom Adapter.

6 For PL lenses, aperture and zoom adjustment is possible by connecting to the camera’s LENS terminal using the lens’s 12-pin
interface cable.
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Focus control from the camera Focus

Lens Manual One-shot  Continuous  Subject Trackin Focus Guide  Position
AF AF detection AF E Guide

RF / EF! lenses ®? o’ o2 o’ o’ [ o 277

RF / EF! Cinema lenses, PL lenses’ B
CN7x17 KAS S/E1
CN7x17 KAS T/R1
CN8x15 IAS S/E1 o o [ ) o o [ ) o
CN10x25 IAS S/E1
CN5x11 1AS T/R1

CN20x50 IAS H/E1
CN7x17 KAS S/P13
CN20x50 IAS H/P13
CN10x25 IAS S/P1° ° - - - - - °
CN8x15 IAS S/P13
CN7x17 KAS T/P13
CN5x11 1AS T/P13

CN-E18-80mm T4.4 LIS KAS S
CN-E70-200mm T4.4 LIS KAS S
Manual focus lenses compatible with
focus guide

! A mount adapter is required.

2 Except for the RF5.2mm F2.8 L Dual Fisheye lens

3 When the lens's 12-pin interface cable is connected to the camera’s LENS terminal.
4 Only RF35mm F1.4 L VCM, RF50mm F1.4 L VCM and RF24mm F1.4 L VCM.

Lenses compatible with auto iris:
e EF lenses:

EF85mm F1.4L IS USM EF70-200mm FAL IS Il USM EF400mm F2.8L IS Il USM
EF600mm F4L IS Il USM

¢ EF Cinema lenses (only CINE-SERVO lenses and COMPACT-SERVO lenses).
¢ RF Cinema lenses (excluding Prime lenses).

Manual focus lenses compatible with focus guide:

CN-E14mm T3.1 LF CN-E24mm T1.5LF CN-ES5mm T1.5LF
CN-ESOmm T1.3LF CN-E85mm T1.3LF CN-E135mm T2.2L F
CN-E20mm T1.5LF CN-E20-50mm T2.4 L F CN-E14-35mm T1.7L S
CN-E45-135mm T2.4 L F CN-E31.5-95mm T1.7L S CN-R24mm T1.5LF
CN-R35mm T1.5LF CN-R50mm T1.3LF CN-R85mmM T1.3LF
CN-R14mm T3.1LF CN-R20mm T1.5LF CN-R135mm T2.2LF

Lens compatible with the [Retract Lens] function ([] 226)

EF40mm F2.8 STM EF-S 24mm F2.8 STM EF50mm F1.8 STM
RF35mm F1.8 MACRO IS STM RF85mm F2 MACRO IS STM RF50mm F1.8 STM
RF24mm F1.8 MACRO IS STM RF16mm F2.8 STM
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Appendix: Camera Dimensions

Unless indicated with the " (inch) mark, all units are in mm. J represents the depth of a hole or socket.
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Camera with camera grip, handle unit, microphone holder, LCD monitor (open), LCD attachment unit and

battery pack BP-AG6ON

273.6

Slide range 307 to 361

Slide range 183 to 237

209.6

170

153.6

28.5

Slide range 152 to 192
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Slide range 323 to 363
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Index

() (headphones) terminal .. ........... 118, 154
B9K/MAKRAWVIdEO . ... oo 65
5.9K/M4K workflow .. ... 22
802.1X Authentication .. ................. 193
A
ABB (automatic black balance) ............. 52
Abroad, usingthecamera . ............... 265
AcCessLog ... 261
Access point ... 179, 181
ACCESSONBS . v v oo et et 10, 266
ACES color, ACESProxy .................. 23
AEshift ... . . 83
Airvents ........... ... ... .. .. ... 13, 14, 51
Anamorphic lenses and desqueeze . ........ 131
Aperture ... 81

Automatic aperture (auto iris) ......... 83

Push autoiris ............ .. ... ... 82
Assignable buttons . .......... . L. 133
Audio

Format ....... ... .. ... .. ... . ... 113
Audio outputchannels . .................. 175
Audio peak limiter . .......... ... ... ..., 117
Audiorecording . ... .. 47,111
Audio recordinglevel .................... 116
Audio reference signal . .................. 119
Authentication ..................... 191, 193
AWB (auto white balance) ................. 87
AWB LOCK ..o 87
B
BaselSO ... 77
BrowserRemote ........... ... .. ... .... 202
Built-in backup battery . . ........ ... L. 264
Button connection mode (WPS) . .. ... .. 181, 184
C
Camera Access Point . .................. 190
Cameradimensions .. ................... 278
Cameragrip ... 34
Cameranickname ...................... 193
Canon App v 187, 210
Canon Log 2, Canon Log 3

(Qammacurves) . ... 142

Canon XF Utility (download) .. ............. 176

Card
Recording method ................. a7
Switchingcardslots ................ 45
Cardvolumelabel ....................... 49
CFexpress card
Compatiblecards . ................. 43
Initializing . ... 45
Inserting/Removing . .. .............. 44
Check marks (M) .................. 122, 156
Cinema EOS System Expansion
UserGuide .................. ... ..., 266
Cinema RAW Development (download) . .. ... 177
Clips
Adding [ marks/[® marks .. ... 122, 156
Adding shotmarks ............ 122,157
Clipinformation .................. 156
Clipnameformat .................. 49
Clipnumbering .................... 50
Deleting ...t 158
Playback ....................... 151
Proxyclips ... 71
Recording ...........coouiiii.n. 53
Recovering . ... 46
Colorbars ....... ... 119
Color compensation (CC)value ............. 85
Colorsampling ....... ... .. i 65
Colorspace . ..ovvvii i 142,171
Communication setting (NW) .............. 183
Computer ... . 176
Condensation . .......... ... . ... .. .... 265
Connection setting (SET) ................. 183
Connection to external devices . ........... 167
Content Transfer Professional ............. 177
Continuous recording . ... ... 127
Customdisplays . ................... 55,218
Customopicture .......... ... ... ... .. ... 138
Detailed custom picture settings . . . . . . 142
LookFile....... ... .. i i 140
Presetsettings ................... 138
CVProtocol ............ ... . .. 188
D
Data entry / keyboardscreen . .............. 42
Dateandtime ............ . ... .. ... .... 39
DCIN12Vterminal .................. 27, 271
Deleting recordings . .................... 158

Detection of access points . ... ............ 191



Developing RAW clips . ... ......... ... ... 177
Digital tele-converter . .................... 99
Direct settingmode ...................... 64
Direct touch control .. .................... 63
Double slotrecording .. ... ... 47
Drop frame (timecode) . ................. 106
E
EF Cinemalenses ................... 35, 276
Encryption . ...... ... .. o 190, 191
Exposure compensation . ................. 83
F
Falsecolor ......... ... . ... .. .. 103
Fan ... 51
FEC errorcorrection . . ................... 187
File numbering (photos) . ................. 216
Flicker reduction .......... ... .. ... .. .... 75
FOCUs ... 88
AFspeed ....... .. ... ... 92
Continuous AF . ................... 92
Focus assistance functions .. ......... 89
Manualfocus . .................... 88
One-shotAF .......... ... ... ...... 91
Subject detection AF ... ... ... ... 94
Tracking .. ... 95
Focusguide .......... .. ... .. ... 89
Focus Position Guide .. ................... 91
Focusring(lens) .......... ... . .. 88
Framerate ........ .. ... .. ... .. ... ... ... 66
Framerecording ................ ... ..., 128
Frameio ..... ... .. ... . . 210
Free-run (timecode) . .................... 105
FTPtransfer ........ ... .. ... .. ... .. .... 199
Full-frame sensor . ......... ... .. ... .. .... 65
Full range/Video range (level mapping) . . . . ... 169
Function setting MODE) .. ............... 183
G
Gain .. 76
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Trademark Acknowledgements
e SD, SDHC and SDXC Logos are trademarks of SD-3C, LLC.
e CFexpress and CFexpress Type B logo are trademarks licensed by the CompactFlash Association.

¢ Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United
States and/or other countries.

e Apple, macOS, App Store are trademarks of Apple Inc., registered in the U.S. and other countries.

e Adobe, Camera to Cloud, Frame.io, and the Frame.io logo are either registered trademarks or trademarks of
Adobe in the United States and/or other countries.

Avid and Media Composer are trademarks or registered trademarks of Avid Technology, Inc. or its
subsidiaries in the United States and/or other countries.

Wi-Fi is a registered trademark of the Wi-Fi Alliance.
Wi-Fi Certified, WPA, WPA2, WPA3 and the Wi-Fi Certified logo are trademarks of the Wi-Fi Alliance.
WPS as used on the camera’s settings, onscreen displays and in this manual signifies Wi-Fi Protected Setup.

JavaScript is a trademark or registered trademark of Oracle Corporation, its affiliates or subsidiaries in the
United States and other countries.

The terms HDMI, HDMI High-Definition Multimedia Interface, HDMI Trade dress and the HDMI Logos are
trademarks or registered trademarks of HDMI Licensing Administrator, Inc.

USB Type—C® and USB-C® are trademarks of USB Implementers Forum.
DaVinci Resolve™ is the trademark of Blackmagic Design Pty. Ltd.

Other names and products not mentioned above may be trademarks or registered trademarks of their
respective companies.
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This device incorporates exFAT technology licensed from Microsoft.

This product is licensed under AT&T patents for the MPEG-4 standard and may be used for encoding
MPEG-4 compliant video and/or decoding MPEG-4 compliant video that was encoded only (1) for a personal
and noncommercial purpose or (2) by a video provider licensed under the AT&T patents to provide MPEG-4
compliant video. No license is granted or implied for any other use for MPEG-4 standard.

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE
OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (jii) DECODE AVC VIDEO THAT
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM
A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C.
SEE HTTP://WWW.MPEGLA.COM

Third Party Software

For details regarding third party software, refer to Software Used in This Product (PDF) available on the
download page of the Instruction Manual.


HTTP://WWW.MPEGLA.COM

CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN THE UNITED
STATES

The limited warranty set forth below is given by Canon U.S.A., Inc. (‘Canon USA') with respect to (a) the Canon Cinema EOS Product, and (b) the accessories
for the Canon Cinema EOS Product (if any), packaged with this limited warranty (collectively the “Products”)* and purchased in the United States. This limited
warranty is only effective upon presentation of your Bill of Sale or other proof of purchase. The Products are warranted to the original end-user purchaser,
when delivered in new condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At Canon USA's
option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the date of original purchase. Labor: For a
period of ONE YEAR from the date of original purchase, labor will be provided free of charge by Canon USA's factory service centers or designated service
facilities located in the United States. When returning Products under this warranty, you must pre-pay the shipping charges, and you must enclose a copy of
the Bill of Sale or other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period, repairs will be made and the
Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be given an estimate of the cost of repair and an
opportunity to approve or disapprove of the repair expense before it is incurred. If you approve, repairs will be made and the Products will be returned to you
at your risk and expense. If you disapprove, we will return-ship the Products to you at no charge to you to an address within the United States.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as
to which items Canon USA will have no responsibility. Canon USA shall have no responsibility under this limited warranty for use of the
Products in conjunction with incompatible peripheral equipment and/or incompatible software. Non-Canon brand peripheral equipment and
software which may be distributed with, or factory loaded on, the Products, are sold ‘AS IS’ without warranty of any kind by Canon USA,
including any implied warranty regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such non-
Canon brand items is given by the manufacturer or producer thereof.

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the Products or contact the CANON
INFORMATION CENTER AT 855-CINE-EQS (855-246-3367) or on the internet at pro.usa.canon.com/support. You will be directed to the nearest service
facility for your Products.

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon accessories or failure to follow
operating, maintenance or environmental instructions prescribed in Canon USA’s user’s manual;

B. If the Products are defective as a result of leaking batteries, sand, dirt or water damage;

C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon USA) that cause damage to the Products or that
cause abnormally frequent service calls or service problems;

. If defects or damages are caused by service other than Canon USA's factory service centers or authorized service facilities;

. Any internal modification to product hardware or firmware;
Any applicable fee for Maintenance of the Products;

. If the Product has had its serial number or dating altered or removed.

oM mMmo

This Limited Warranty does not apply to Products purchased outside the United States. This Limited Warranty does not apply to accessories or
consumables not originally packaged with the Product. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This
card ensures that you are contacted promptly should there be a safety inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE PRODUCTS AFTER THE
APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON, FIRM OR CORPORATION
WITH RESPECT TO THE PRODUCTS SHALL BIND CANON USA (SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON USA SHALL NOT BE LIABLE FOR LOSS OF
REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE PRODUCTS OR SERVICE, STORAGE CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING
WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’ HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON
WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY
OF ANY KIND AGAINST CANON USA BE GREATER THAN THE PURCHASE PRICE OF THE PRODUCTS SOLD BY CANON USA AND CAUSING THE
ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND
YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE, MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED
DIRECTLY BY THE NEGLIGENCE OF CANON USA (SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE
OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

CANON U.S.A., INC
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CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN CANADA

The limited warranty set forth below is given by Canon Canada Inc. (‘Canon Canada’) with respect to (a) the Canon Cinema EOS product, and (b) the
accessories for the Canon Cinema EOS Product (if any), packaged with this limited warranty (collectively the “Products”)* and purchased in Canada. This
limited warranty is only effective upon presentation of your Bill of Sale or other proof of purchase. The Products are warranted to the original end-user
purchaser, when delivered in new condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At
Canon Canada’s option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the date of original
purchase. Labor: For a period of ONE YEAR from the date of original purchase, labor will be provided free of charge by Canon Canada’s factory service
center or designated service facilities located in Canada. When returning Products under this warranty, you must pre-pay the shipping charges, and you
must enclose a copy of the Bill of Sale or other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period,
repairs will be made and the Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be given an
estimate of the cost of repair and an opportunity to approve or disapprove of the repair expense before it is incurred. If you approve, repairs will be made
and the Products will be returned to you at your risk and expense. If you disapprove, we will return-ship the Products to you at no charge to you to an
address within Canada.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as to
which items Canon Canada will have no responsibility. Canon Canada shall have no responsibility under this limited warranty for use of the
Products in conjunction with incompatible peripheral equipment and/or incompatible software. Non-Canon brand peripheral equipment and
software which may be distributed with, or factory loaded on, the Products, are sold ‘AS IS’ without warranty of any kind by Canon Canada,
including any implied warranty or condition regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such
non-Canon brand items is given by the manufacturer or producer thereof.

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the Products or contact the CANON
PROFESSIONAL SERVICE CENTRE 1-800-667-2666 or on the internet at www.canon.ca/pro. You will be directed to the nearest service facility for your
Products.

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon accessories or failure to follow
operating, maintenance or environmental instructions prescribed in Canon Canada’s user’s manual;

B. If the Products are defective as a result of leaking batteries, sand, dirt or water damage;

C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon Canada) that cause damage to the Products or
that cause abnormally frequent service calls or service problems;

D. If defects or damages are caused by service other than Canon Canada’s factory service centers or authorized service facilities;

E. Any internal modification to product hardware or firmware;

F. Any applicable fee for Maintenance of the Products;

G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside Canada. This Limited Warranty does not apply to accessories or consumables not
originally packaged with the Product. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This card ensures
that you are contacted promptly should there be a safety inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY OR CONDITION, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE
PRODUCTS AFTER THE APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON,
FIRM OR CORPORATION WITH RESPECT TO THE PRODUCTS SHALL BIND CANON CANADA (SOME PROVINCES DO NOT ALLOW LIMITATIONS ON
HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON
CANADA SHALL NOT BE LIABLE FOR LOSS OF REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE PRODUCTS OR SERVICE, STORAGE
CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’
HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE
PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON CANADA HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON CANADA BE GREATER THAN THE PURCHASE PRICE OF
THE PRODUCTS SOLD BY CANON CANADA AND CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK
AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE,
MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF CANON CANADA (SOME PROVINCES DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).
THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR
WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from province to province.

CANON CANADA INC.
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Canon

Canon Inc. 30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan
Canon Europa N.V. Bovenkerkerweg 59, 1185 XB Amstelveen, The Netherlands  http://www.canon-europe.com
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